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Module overview 
Description 
Microsoft Outlook 2019 is an app in the Microsoft Office suite that you can use to 
communicate with others, track your schedule, manage your contact list, and even stay 
on track with your to-do list. This module introduces you to Outlook and sets you up for 
using it at school, at home, and in the workplace. 

At the end of this module, you’ll be able to browse within Outlook, add an Outlook 
account, establish your standard working times, and create an email signature that will 
automatically appear in any new email messages. The skills you acquire and practice 
during the try-it activities, discussions, and Cornerstone project will prepare you for the 
next module, in which you’ll start managing your emails. 

The following table outlines the lessons in this module and their corresponding learning 
objectives. 

Lesson Learning objective Exam 
objectives 

Welcome to Outlook Browse the Outlook interface and add 
an account. 

• 1.1.2

Customizing the 
interface 

Browse the ribbon in Outlook and 
customize the ribbon and the Quick 
Access Toolbar. 

• None

Customizing views Use multiple options for observing your 
mail, calendar, and contacts. 

• 1.1.1

Setting your account 
preferences 

Customize your calendar working times, 
automatic signatures, and email reply 
settings. 

• 1.1.1
• 1.2.1
• 1.2.2
• 1.2.3
• 2.2.3
• 3.1.1
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Lesson Learning objective Exam 
objectives 

Cornerstone: Modifying 
Outlook settings 

Modify your Outlook settings to 
accommodate extended duties at the 
farm. 

• 1.1.1
• 1.2.1
• 1.2.2
• 1.2.3
• 3.1.1

Table 1: Objectives by lesson 

Scenario 
The Media and Communications department at Munson’s Pickles and Preserves Farm is 
excited to welcome you as an intern for the upcoming year. They anticipate a busy 
schedule during the spring farming season and feel eager for your help with several 
projects. To support the upcoming communication initiatives, you’ll need to become 
familiar with Outlook 2019 and your new account. Before you can get to work, you’ll 
need to configure the mailbox settings for your provided account. As your list of tasks 
grows, you’ll need to change your Outlook settings to manage your busier schedule. 

Cornerstone 
This module concludes with a Cornerstone project, during which you’ll change the 
settings of your Outlook account so you can better manage your increasingly busy 
schedule. During the Cornerstone, you’ll: 

• Manage the ribbon display options.
• Modify the Quick Access Toolbar.
• Customize the Mail, Calendar, and People views.
• Update your calendar because of expanded work duties.
• Add signatures to your emails.



Getting started with Outlook 
 

 
7 

Lesson 1: Welcome to Outlook 
Overview 
This lesson introduces you to Outlook 2019 and explains how to browse within Outlook. 
In this lesson, you'll create a new account that you'll use to communicate with others, 
manage your schedule, and track your tasks. 

Warm-up 
How well do you know Outlook 2019? Be prepared to share your experience with 
Outlook with your classmates. 

Topic 1: Get to know the Outlook 
interface 

 Keeping track of your emails and attachments, to-do lists, and schedule might 
become challenging, especially when you’re busy at school and work. Whether you’re 
new to Outlook or previously used it, you'll find that it offers many features to help you 
become more productive and efficient. This topic introduces the user interface (UI) of 
Outlook 2019 and explains how you can browse it and find various elements. 

 

Video 

To review a video about getting to know Outlook, refer to: What is 
Outlook? 

  

https://aka.ms/What_is_Outlook
https://aka.ms/What_is_Outlook
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The following screenshot depicts the Outlook UI. 

 
Figure 1: The Outlook interface 

The following table describes the Outlook interface elements. 

Tabs Multiple tabs that you can select to reveal the ribbon 
commands 

Microsoft Office 
Backstage view 

A view, which is available when you select the File tab, 
where you can change the settings and options for Outlook 

Ribbon The set of tabs at the top (or beginning) of the Outlook 
workspace 

Navigation Pane The pane where you can switch among the Mail, Calendar, 
Contacts, Tasks, Notes, and other areas and select folders 
within each area 

Navigation Bar Icons at the bottom of the Navigation Pane that you can 
use to switch among the Mail, Calendar, People, Tasks, 
Notes, Folders, and Shortcuts areas 

Folder Pane The pane that displays all the folders in Outlook 

Mail Pane The pane where you can observe, select, and manage the 
messages in your Inbox and other folders 
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Reading Pane The pane that previews the content of your messages 

To-Do Bar A customizable pane that displays calendar, task, or people 
information based on your individual preferences 

Status bar The horizontal bar at the bottom of the screen that displays 
the status of the Outlook app 

Window control Icons to maximize, minimize, and restore the size of your 
Outlook window and to exit Outlook 

Table 2: The elements of the Outlook interface 

Activity: Show me how 
The teacher will guide the class through each of the workspace elements and 
demonstrate how to identify each one. 

Resources required 
You’ll need the following resources for this activity: 

• None

Activity instructions 
Follow along with your classmates as your teacher helps you to: 

1. Open Outlook 2019.

2. Identify the primary elements of the Outlook workspace.

3. Use the File tab to explore the options in the Backstage view.

4. Customize the Navigation Bar.

5. Customize the Reading Pane.

6. Customize the To-Do Bar.

Try-it: Get to know the Outlook interface 
 In this leveled try-it activity, you'll assess your knowledge of the Outlook interface. 

You'll identify the different elements of the workspace and customize Outlook to work 
for you. 
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Try-it 1 
In this try-it, you'll pair up with a classmate and identify the different UI elements in the 
Outlook workspace. 

Resources 
You’ll need the following resource for this try-it: 

• Open L1_T1_try1_matching_starter.docx in this lesson’s Learning Activity 
Resources. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open L1_T1_try1_matching_starter.docx, and then follow the instructions to 
complete the matching activity. 

2. Work with a classmate, compare answers, and help each other identify all the 
elements of the workspace. 

Try-it 2 
In this try-it, you'll customize the Navigation Bar to change the number and order of 
items on display. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Change the Navigation Bar to display five items. 

2. Disable compact navigation. 

3. Reorder the links in this order: People, Mail, Calendar, Folders, Notes, Tasks, 
Shortcuts. 

Try-it 3 
In this try-it, you'll change the layout according to your preferences. You'll customize, 
resize, and move various panes. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Hide, display, and move the Reading Pane. 

2. Minimize and maximize the Folder Pane. 

3. Customize the To-Do Bar. 
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Topic 2: Add an account to Outlook 
Before you can use Outlook, you need to configure an email account. Your school, your 
organization, or another provider will supply the settings for this account. 

An Outlook account helps you access and manage email messages, calendars, contacts, 
and tasks. Depending on your preference, you can also create your Outlook account by 
adding it from Office 365 or from one of several third-party email providers. 

Understand the types of email accounts 
The following table describes the types of accounts you can add to Outlook. 

Office 365 or 
Microsoft 
Exchange Server 

Businesses of all sizes that use the Microsoft platform (either 
onsite or in the cloud) to manage their email accounts use 
Exchange Server for the primary email format. When used 
with Outlook, Exchange Server accounts make the greatest 
number of capabilities available, such as out-of-office 
messages, the sharing of calendars and contacts, and the 
use of the Scheduling Assistant for managing meetings. 

Post Office 
Protocol version 3 
(POP3) 

POP3 is the standard format for most web-based email 
providers and offers the most-common and most-flexible 
type of email account. POP-3 can be used to connect to 
most mailboxes. The content is stored on a server and 
delivered to Outlook in a folder structure. Depending on the 
email provider, the folders—such as Email, Calendar, and 
Tasks—might vary, and some of the more-advanced 
features of Outlook might not be available. 

Internet Message 
Access Protocol 
(IMAP) 

Large organizations, such as corporations and universities, 
commonly use IMAP accounts. As with Exchange Server 
accounts, messages stay on the server, but you can access 
your mailbox by using the Outlook app. 
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HTTP HTTP accounts, such as MSN.com and Outlook.com 
accounts, primarily access web-based email. As with 
Exchange Server and IMAP accounts, messages stay on the 
server, and you can observe or manage your mailbox by 
either signing in on the web or using the Outlook app. The 
features of an HTTP account tend to be limited. 

Table 3: Types of email accounts 

The newer versions of Outlook have evolved to the point that the app can usually figure 
out the setup details without you having to know about usernames, authentication 
protocols, and server protocols. Occasionally, you might need to have some support and 
manually set up the account, but for the most part, the Outlook Account Wizard does 
all the hard work for you. 

 

Additional information 

For more information, refer to: POP and IMAP email settings for 
Outlook 

Activity: Show and tell 
In this activity, your teacher will demonstrate how to add a new account to Outlook. 

Resources required 
You’ll need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions:  

1. Observe your teacher demonstrate the process of adding an account to Outlook. 

2. Discuss the demonstration, and ask questions. 

  

https://aka.ms/pop_and_imap_email_settings_for_outlook
https://aka.ms/pop_and_imap_email_settings_for_outlook
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Try-it: Add an account to Outlook 
 In this standalone try-it, all the students will add an email account to Outlook. 

Depending on your organization, your ability to do so might be limited. If your 
organizational settings prevent you from completing the steps in this activity, let your 
teacher know at what point you had to stop. 

Resources 
You’ll need the following resource for this try-it: 

• A school or web-based email account 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. On the File tab, in the details pane, select Add Account. 

2. Follow the steps to add your account to Outlook. 

3. Exit and then restart Outlook to start using your email account. 

 

Additional information 

Some email providers require specialized settings that don't work with 
the Outlook Account Wizard. If you have issues adding an account, 
you might need to manually add the account or use the advanced 
setup options. For more information, refer to: Add an email account 
using advanced setup 

 

Video 

If you can’t add an account because of restrictions by your 
organization, review the Add an email account to Outlook video. 

Wrap-up 
Consider your comfort level with Outlook at the beginning of the module. Did you feel 
that you could find and browse your Outlook workspace? What’s your comfort level 
now? 

  

https://aka.ms/add_an_email_account_using_advanced_setup
https://aka.ms/add_an_email_account_using_advanced_setup
https://aka.ms/Add_an_email_account_to_Outlook
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Use these questions to check what you learned in this lesson: 

1. Which of the following elements can you change to customize your workspace in 
Outlook? 

Select the correct option. 

a. Navigation Pane 

b. Reading Pane 

c. To-Do Bar 

d. All of the preceding answers 

2. On which tab do you find the options to customize the Reading Pane? 

a. File tab 

b. Folder tab 

c. Help tab 

d. View tab 

3. To add an account to Outlook, you use the following steps. 

Indicate the correct sequence by adding numbers 1–4 next to the following items. 

a. Select the File tab. - _________________________ 

b. Provide the email address. - _________________________ 

c. Provide the password. - _________________________ 

d. Add the account. - _________________________ 

4. Which type of account do businesses and universities use the most? 

Select the correct option. 

a. POP3 

b. IMAP 

c. Exchange Server 

d. HTTP 
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Lesson 2: Customizing the 
interface 
Overview 
In this lesson, you'll learn about the ribbon and tabs in Outlook and how you can 
customize the ribbon to maximize the efficiency of your tasks. You'll also learn to use 
and customize the Quick Access Toolbar so the options you use most often will be 
more-quickly available to you. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. The element at the top (or beginning) of the window that has a lot of options is
commonly known as the _________________________

Fill in the blank space.

2. What’s the name of the toolbar you can customize to have easy access to the
commands you often use in Outlook?

Select all that apply.

a. Shortcuts Bar

b. Navigation Bar

c. Quick Access Toolbar

d. Options tab

3. In which of the following ways can you customize the Outlook interface?

Select all that apply.

a. Add and remove tabs

b. Change the icons on the buttons

c. Create contextual tabs

d. Create your own tabs that have groups and buttons
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4. Which of the following tabs exist on the ribbon in all areas of Outlook? 

Select all that apply. 

a. Insert 

b. Format Text 

c. Message 

d. Help 

Topic 1: Customize the ribbon 
The ribbon in Outlook resides at the top (or beginning) of the window and supplies 
options on different tabs. The following screenshot depicts the ribbon and points out 
the tabs. 

 
Figure 2: The Outlook ribbon tabs 

Understand the ribbon display options 
You can manage your display of the ribbon by selecting Ribbon Display Options, which 
the following screenshot points out. 

 
Figure 3: The options that Ribbon Display Options offers 

Ribbon Display Options offers three options: 

• Auto-hide Ribbon. This option hides the ribbon. To display the ribbon, you must 
then select the top pane in the app. 

• Show Tabs. This option displays only the tab names. When you select a tab, the 
commands on that tab become available. 

• Show Tabs and Commands. This option displays the tabs and their command 
names. 
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Understand tabs 
The most commonly used commands in the app reside on the Home tab. Other tabs 
have commands for distinct functions of the app. For example, if you need to insert a 
picture or attach a file to an email message, you’ll select the Insert tab, which the 
following screenshot depicts. 

 
Figure 4: The Insert tab 

The Insert tab supplies various commands for including information or inserting 
attachments into your Outlook items. 

Understand contextual tabs 
Occasionally, you might notice more tabs appear when you’re working with certain 
objects, such as pictures or tables. These are special tabs that appear only when needed 
to supply commands relevant to that type of object. For example, the following 
screenshot depicts the Format contextual tab. 

 
Figure 5: The Format contextual tab 

Understand tab groups 
Outlook divides each tab into more manageable sections known as groups. Each group 
has options that are related to specific tasks, thereby helping you to find certain 
commands. For example, the following screenshot depicts the groups on the Insert tab. 

 
Figure 6: The groups on the Insert tab 
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Customize the ribbon 
You can customize the ribbon to display and arrange the tabs according to your 
preferences. You can hide, remove, or rearrange tabs to make certain commands easier 
to find. You can even create your own specialized tabs. 

 

Did you know? 

Unlike other Office apps, Outlook displays different tabs and 
commands depending on where you’re working in Outlook. For 
example, the Appointment/Meeting window displays a Scheduling 
tab, whereas the Contact window displays a Contact tab. 

 

Additional information 

For more information, refer to: Customize the ribbon in Office 

Activity: Discuss and learn 
The teacher will demonstrate how to customize the ribbon. Be prepared to discuss the 
advantages and disadvantages of making customizations. 

Resources required 
You’ll need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe as your teacher demonstrates customizing the ribbon. 

2. Participate in the discussion with your teacher and classmates. 

  

https://aka.ms/customize-the-ribbon-in-office
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Did you know? 

If you select the Alt key, Outlook assigns a keyboard shortcut to each 
tab, as the following screenshot depicts. When you then choose a tab 
by selecting its keyboard shortcut, Outlook assigns a keyboard 
shortcut to each command on that tab, as depicted in the following 
screenshot. 

Figure 7: The ribbon with keyboard shortcuts 

Try-it: Customize the ribbon 
  Now that you’re familiar with the ribbon, it’s time to discover whether you can find 
some common commands in Outlook and make some customizations to the ribbon. In 
this leveled try-it activity, you'll explore the tabs and identify the groups and options on 
the ribbon. You'll also change the default ribbon and save your customizations. Making 
these changes should help you get right to work on your first day at Munson’s! 

Try-it 1 
In this try-it, you'll explore the ribbon and identify the common groups and commands 
on each tab. 

Resources 
You’ll need the following resources for this try-it: 

• None
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Team up with a couple of your classmates according to your teacher's directions. 

2. Explore the tabs for the following items: 

o Send/Receive All Folders 
o New Email 
o Unread/Read 
o Folder Pane 

3. Identify the tabs found in the interface. 

4. Identify the groups and commands on the different tabs. 

Try-it 2 
In this try-it, you'll customize the Outlook interface by changing the default ribbon. 
You'll then save your customizations. 

Resources 
You’ll need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Open the Outlook Options dialog box. 

2. Reorder the tabs so the first three tabs are Send/Receive, Folder, and View in that 
order. 

Try-it 3 
In this try-it, you'll hide and display tabs. You'll also customize the Outlook interface by 
changing the default ribbon. You'll then save your customizations. 

Resources 
You’ll need the following resources for this try-it: 

• None 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Change the ribbon display option in Outlook to Show Tabs. 

2. Open the Outlook Options dialog box. 

3. Display the Developer tab. 

4. Hide the Folder tab. 

5. Reorder the tabs so the first three tabs are Send/Receive, Folder, and View in that 
order. 

6. Save your customizations. 

Topic 2: Customize the Quick Access 
Toolbar 
The Quick Access Toolbar resides at the top (or beginning) of the screen, as the 
following screenshot depicts. As its name implies, this toolbar gives you quick access to 
the commands you most often use. As your schedule becomes busier, you'll find the 
Quick Access Toolbar handy, because it displays your most-used options at all times, 
and you don't have to browse through the interface to get to those options. 

 
Figure 8: The Quick Access Toolbar 

  



Getting started with Outlook 
 

 
22 

By default, the Quick Access Toolbar displays a minimal number of options, which the 
following table describes. You can fully customize the Quick Access Toolbar by adding 
or removing options. 

Icon Function Description 

 Send/Receive All Sends and receives all items, such as 
messages and calendar items 

 Undo Reverses the last action performed 

 Customize Quick Access 
Toolbar 

Displays a menu of options for the Quick 
Access Toolbar 

Table 4: The default buttons on the Quick Access Toolbar 

As you work with any Office app, you’ll find yourself consistently using certain options 
on the tabs. This should help you identify the options that you might like to have readily 
available on the Quick Access Toolbar. 

Add and remove options 
The purpose of the Quick Access Toolbar is to display the commands that are most 
important to each user. Therefore, it makes sense that you can customize this toolbar. 
One way to do so is to use Customize Quick Access Toolbar. The following screenshot 
depicts the items that display when you select Customize Quick Access Toolbar. 
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Figure 9: The Customize Quick Access Toolbar menu 

By selecting and clearing the menu items, you can add commonly used commands, such 
as Print, Reply, and Delete, to the Quick Access Toolbar. 

Another way to add a command to the Quick Access Toolbar is to right-click or access 
the context menu of any option on the ribbon and then select Add to Quick Access 
Toolbar. The following screenshot depicts this process. 

 
Figure 10: The context menu for a ribbon option 
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The new button appears at the end of the Quick Access Toolbar, as the following 
screenshot depicts. 

Figure 11: A new button added to the Quick Access Toolbar 

Customize the Quick Access Toolbar 
Not all functions in Outlook appear on the ribbon. Sometimes, the most helpful options 
appear on menus or in obscure dialog boxes. The Quick Access Toolbar provides a 
solution if you want to make these options readily available. You can customize the 
Quick Access Toolbar by selecting More Commands on the Customize Quick Access 
Toolbar menu to find and add more commands, as the following screenshot depicts. 

Figure 12: The Customize Quick Action Toolbar menu with More Commands pointed 
out 
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The Outlook Options dialog box appears. In the navigation pane on the left side, 
select Quick Access Toolbar, and then observe the options in the Popular Commands 
box. The following screenshot depicts this process. 

 
Figure 13: Popular Commands in the Outlook Options dialog box 

To include an option on the Quick Access Toolbar, add it from the Popular 
Commands box to the Customize Quick Action Toolbar box. To do so, select an 
option, and then select Add, as the following screenshot depicts. Similarly, you can 
remove an option from the Quick Access Toolbar by selecting it in the Customize 
Quick Action Toolbar box and then selecting Remove. 
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Figure 14: The Add and Remove buttons 

You can also change the order of the options on the Quick Action Toolbar. In the 
Customize Quick Action Toolbar box, select an option, and then use Move Up and 
Move Down (which display the arrow icons) to move that option up or down. Select OK 
to save your customizations. The following screenshot depicts this process. 
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Figure 15: The reordering buttons 

 

Did you know? 

In the modern Office UI, the Quick Access Toolbar fades into the 
title bar. Did you know that you can move it below the ribbon? This 
makes the Quick Access Toolbar closer, more visible, and of a 
full-screen width, with the icons appearing in color. You can find 
Show Below the Ribbon on the Customize Quick Access Toolbar 
menu. 

 

Additional information 

For more information, refer to: Add commands to the Quick Access 
Toolbar 

https://aka.ms/Add-commands-to-the-Quick-Access-Toolbar
https://aka.ms/Add-commands-to-the-Quick-Access-Toolbar
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Activity: Think-pair-share 
In this activity, your teacher will demonstrate how to access and customize the Quick 
Access Toolbar. You’ll pair up with a classmate to explore, find, and share diverse ways 
to customize the Quick Access Toolbar. 

Resources required 
You’ll need the following resources for this activity: 

• None

Activity instructions 
Participate in the activity by following these instructions: 

1. Open Outlook.

2. Follow along with the teacher.

3. Collaborate with a partner to explore the ribbon.

4. Identify the options you use most often that you’d find helpful to add to the Quick
Access Toolbar.

5. List from three through five of these options in the following spaces:

o _________________________
o _________________________
o _________________________
o _________________________
o _________________________

6. In the discussion with your class, ask and answer questions about the options for the
Quick Access Toolbar.

Try-it: Customize the Quick Access Toolbar 
Now that you’ve explored the tabs, it’s time to make the Quick Access Toolbar 

your own so you can be more productive. In this leveled try-it activity, you'll customize 
the Quick Access Toolbar by using the Customize Quick Access Toolbar menu, the 
context menu for assorted options, and More Commands. 
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Try-it 1 
In this try-it, you'll add common options to the Quick Access Toolbar by using the 
Customize Quick Access Toolbar menu. 

Resources 
You’ll need the following resources for this try-it: 

• None

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Go to the Customize Quick Access Toolbar menu.

2. Add the following commands to the Quick Access Toolbar:

o Print
o Reply

Try-it 2 
In this try-it, you'll add common options to the Quick Access Toolbar by using the 
Customize Quick Access Toolbar menu and the context menu. 

Resources 
You’ll need the following resources for this try-it: 

• None

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Go to the Customize Quick Access Toolbar menu.

2. Add the Forward command to the Quick Access Toolbar.

3. Use the context menu to add Delete and Read Aloud to the Quick Access Toolbar.

Try-it 3 
In this try-it, you'll add commands to the Quick Access Toolbar by using More 
Commands. You'll also remove some commands and rearrange the commands on the 
Quick Access Toolbar. 
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Resources 
You’ll need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Go to the Customize Quick Access Toolbar menu. 

2. Select More Commands. 

3. Add Reply All and Save As from the Popular Commands box to the Quick Access 
Toolbar. 

4. Remove Reply All from the Quick Access Toolbar. 

5. Use the context menu to add New Email and New Contact to the Quick Access 
Toolbar. 

6. Save your customizations. 

 

Did you know? 

To ensure that your customizations are complete, it’s always a good 
idea to close and reopen Outlook. If you don’t restart Outlook, you'll 
lose your customizations if the app becomes unresponsive and you 
need to restart it. 
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Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Which of the following are common options that you can add to the Quick Access
Toolbar by using the Customize Quick Access Toolbar menu?

Select all that apply.

a. Delete

b. Reply

c. Address Book

d. Print

2. In which of the following ways can you customize the ribbon?

Select all that apply.

a. Add commands to a default group

b. Create a custom tab

c. Hide a default tab

d. Remove a group of commands from a default tab

3. What are some of the changes you can make to the tabs on the ribbon, and why
might you want to do so?

_________________________

Fill in the blank space.

4. Match each of the following groups on the Insert tab to the option—Pictures,
Hyperlink, Calendar, or Attach File—it contains.

o Include
o Tables
o Illustrations
o Links
Categorize the following options by adding the appropriate group name next to each 
item. 

a. Pictures - _________________________

b. Hyperlink - _________________________

c. Calendar - _________________________

d. Attach File - _________________________
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Lesson 3: Customizing views 
Overview 
Outlook offers several options for customizing your view, or display, of the interface, so 
you can change the display according to your work requirements. You can change which 
items appear or stay hidden, the size of certain items, and the arrangement of items so 
your interface is clean and focuses on the tasks at hand. At the end of this lesson, you'll 
be able to use multiple options for observing your mail, calendar items, tasks, and 
contacts. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Who can customize the Mail workspace in Outlook?

Select the correct option.

a. My teacher

b. The IT department

c. Anyone

d. None of the preceding answers

2. Which areas of Outlook can you observe by using peeks?

Select all that apply.

a. Email messages

b. Calendar

c. To-Do List

d. Contacts

3. Outlook supplies several ways for you to observe your contacts. How might that be
helpful when you’re completing different tasks?

_________________________

Fill in the blank space.
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4. Which of the following panes can you display in any workspace in Outlook?

Select all that apply.

a. Reading Pane

b. Folder Pane

c. Daily Task List

d. People Pane

Topic 1: Customize the Mail view 
The default view when you open Outlook is the Mail, or Inbox view. Lesson 2 described 
the different areas of the workspace known as panes, including: 

• Folder Pane
• Mail Pane
• Reading Pane
• To-Do Bar
That’s a lot going on! Although these panes are helpful and informative, sometimes it
makes sense to simplify your workspace by hiding, displaying, and minimizing the panes
in your view. The workspace layout is flexible, and you can improve your efficiency by
changing it according to your requirements. This capability might be convenient when
you're working on a smaller screen, for example, and want to hide certain UI elements to
make the interface less crowded and jumbled.

The following table lists the options for controlling the different panes in the workspace. 

Pane Views Options

Folder Pane • Normal
• Minimized
• Off

• Favorites
• Hide/Show specific folder types

Message 
Preview 

• 1 Line
• 2 Lines
• 3 Lines

• None

Reading Pane • Right
• Bottom
• Off

• When to mark items as read
• Full-screen reading
• Preview mode
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Pane Views Options

To-Do Bar • Calendar
• People
• Tasks
• Off

• None

Table 5: The Outlook interface panes 

In this lesson, you'll explore how to change the views to be more useful. Outlook offers 
various techniques for controlling the panes; however, the View tab in the Mail 
workspace offers the most robust options. 

Use the View tab 
The groups on the View tab, as the following screenshot depicts, have workspace 
customization options. 

Figure 16: The groups on the View tab 

When you select some options, Outlook just switches between turning it on and turning 
it off. For most options, selecting it displays a menu, as the following screenshot depicts. 

Figure 17: The expanded Folder Pane menu 
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The expanded menu displays the commands that you can select. It might also have an 
Options command that supplies even more ways to customize the interface. 

Figure 18: The Options command 

Customize the workspace from the View tab 
Use the following steps to customize your Mail workspace layout: 

1. Browse to the Mail workspace in Outlook.

2. Select the View tab.

3. Select the command to customize the pane to expand the Options menu.

4. Select options according to your preferences.

Customize panes by using the panel arrows 
In addition to using the View menu, you can minimize and display different panels by 
using the arrows in each pane, which the following screenshot depicts. 
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Figure 19: Arrows for minimizing and expanding panes 

The arrows change depending on the state of the pane. To expand a panel, select the 
Expand arrow, as the following screenshot depicts. 

Figure 20: The expand panel arrow 

To open the pane and lock it in place, select the arrow, and then select the Pin, as the 
following screenshot depicts. 

Figure 21: The pin panel icon 



Getting started with Outlook 

37 

If the panel is expanded, you can minimize it again by selecting the minimize panel 
arrow, as the following screenshot depicts. 

Figure 22: The minimize panel arrow 

You can also select the border of any pane and then drag it to resize it to your liking, as 
the following screenshot depicts. 

Figure 23: The border you can drag to resize a pane 

Before you get too settled into using the default layout of the Mail workspace, take 
some time to explore the available options, and then set up your workspace in the way 
that’s most useful to you. 

Additional information 

For more information, refer to: 

• Change the appearance of the Navigation Pane
• Use and configure the Reading Pane to preview messages
• Use and customize the To-Do bar

https://aka.ms/Change-the-appearance-of-the-Navigation-Pane
https://aka.ms/Use_and_configure_the_Reading_Pane_to_preview_messages
https://aka.ms/Use_and_customize_the_To_Do_bar
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Activity: Show me how 
In this activity, your teacher will demonstrate different techniques for hiding and 
displaying different panes in the interface, including the Folder Pane, Preview Pane, 
and To-Do Bar. 

Resources required 
You’ll need the following resources for this activity: 

• None

Activity instructions 
Participate in the activity by following these instructions: 

1. Follow along with the teacher.

2. Ask questions about the customization options.

3. Answer questions from the teacher.

Try-it: Customize the Mail view 
 In this leveled try-it activity, you'll customize the Mail view to make it your own. 

You'll explore the options, turn the options on and off, and find out what works best for 
you. 

Try-it 1 
In this try-it, you'll observe the current configuration of the workspace. You'll then hide 
and display different panes by using the options on the View tab. 

Resources 
You’ll need the following resources for this try-it: 

• None

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Use the options on the View tab to customize the Reading Pane.

2. Use the options on the View tab to display the calendar in the To-Do Bar.
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Try-it 2 
In this try-it, you'll hide and display panes by using the collapse and expand arrows. 

Resources 
You’ll need the following resources for this try-it: 

• None

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Use the View tab to minimize the Folder Pane.

2. Display the Folder Pane, and then pin it so it is always available.

3. Resize the Folder Pane.

Try-it 3 
In this try-it, you'll customize the To-Do Bar. You'll use the options on View tab and in 
the To-Do Bar to customize the workspace. 

Resources 
You’ll need the following resources for this try-it: 

• None

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Use the options on the View tab to add the following sections to the To-Do Bar:

o Calendar
o People
o Tasks

2. Select Close to remove the People section.

3. Use dragging to size the Calendar pane so it displays your upcoming appointments.
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Did you know? 

Hover over the buttons in the Navigation Bar to “peek” at your 
upcoming appointments, tasks, or frequent contacts. 

The following screenshot depicts the Calendar peek that appears when you hover over 
Calendar. 

Figure 24: The Calendar peek 
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Topic 2: Customize the Calendar view 
As your schedule gets busier, and you progress in working with your calendar, you 
might notice that the default views become a little busy. Luckily, Outlook offers several 
ways of observing the appointments and events in your calendar. This topic describes 
ways that you can change the Calendar view to maximize its use for you. The following 
table describes the variety of options for this purpose. 

View Description Options

Month 
(default) 

Observe appointments and events in a 
monthly display. 

• Full month
• Rolling five-week

display

Week Observe appointments and events in a 
seven-day format with details for 
appointment times. 

• First day of the week
• Time increments

Work Week Observe appointments and events in a 
multiple-day format with details for 
appointment times. This view displays the 
days that the designated working times 
include. The default working times are 
Monday through Friday, from 8:00 AM 
through 5:00 PM. 

• Days of the week
• Hours of the day
• Time increments

Day Observe appointments and events in a 
one-day format with details for 
appointment times. 

• Time increments

Schedule 
View 

Note that this alternate view is most 
useful as a rollup view of multiple 
calendars. 

• Automatic switching
to the Schedule
view

Time Scale Change the time increments that the 
Day, Week, and Work Week views 
display. 

• Increments from 5
minutes through 60
minutes

Table 6: The Calendar view options 
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Change the Calendar view 
Customizations to the Calendar view depend on the preferences that each user sets. 
Others who use the Scheduling Assistant or those who have the Sharing permission for 
the calendar can review these customizations. 

To change the Calendar view, use the options in the Arrange group on the Home tab, 
as the following screenshot depicts. 

Figure 25: The Arrange group on the Home tab 

You can switch your view at will to use the one that’s most useful for the current task. 
Need to review your month all at once? Use the Month view. Need to review your 
availability this week? Use the Week or Work Week view. 

In the Folder pane, you can change the current view of the calendar to a specific period. 
Note that selecting a date displays that date within the current view of the calendar. For 
example, if you’ve selected the Work Week option, the calendar will display the date 
you select within that work week. The following screenshot depicts the Work Week 
view with a single week pointed out. 

Figure 26: The Work Week view of the calendar 
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Use the arrows at the top of the pane to move forward or backward by a month. The 
following screenshot depicts these arrows. 

Figure 27: The navigation arrows in the Calendar pane 

You can also resize the Calendar pane to display one or two months, depending on 
your preference and screen size. To do so, drag the divider till you achieve the size that’s 
most suitable for you, as the following screenshot depicts. 

Figure 28: The pane border in the Calendar pane 
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Use the Go To group 
In addition to the calendar navigation arrows, two helpful options exist for navigation in 
the Go To group on the Home tab. They are Today and Next 7 Days, as the following 
screenshot depicts. 

Figure 29: The Go To group of the Home tab 

With Today, you can go to today's date (in the current view). With Next 7 Days, you can 
go to the next seven days beginning with today's date (in the Week view)—even if 
today is in the middle of the week. The following screenshot depicts the Next 7 Days 
option. 

Figure 30: The Week view that displays after you select Next 7 Days 
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Customize the Calendar workspace layout 
Just as you can customize the Mail workspace, you can also customize the layout of the 
Calendar workspace according to your preferences. You can: 

• Select Minimized on the Folder Pane menu to minimize and expand the Calendar
navigator and the Folder Pane.

• Select Pin the Folder Pane to restore the pane.
• Drag the vertical border of the pane to resize the pane.
• Hide or display the Daily Task List pane.
You can also hide or display panes in the Calendar workspace just like you can in the
Mail workspace. You can manage the panes by using the Layout group on the View
tab, which the following screenshot depicts.

Figure 31: The Layout group on the View tab 

Use the Daily Task List layout 
In addition to having the standard workspace panes, the Calendar view has an option 
called Daily Task List. To observe the tasks due on their due dates in your Calendar 
view, you can display this optional pane in the Calendar window. This option resides in 
the Layout group on the View tab, as the following screenshot depicts. 

Figure 32: The Daily Task List option 

To display the available commands for Daily Task List, select the arrow next to Daily 
Task List. The following screenshot depicts these menu commands. 
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Figure 33: The Daily Task List menu 

On the Daily Task List menu, you can set your preferences for the pane (Normal, 
Minimized, or Off). You can also set what to arrange the tasks by (Start Date or Due 
Date) and whether you want the completed tasks to display. 

Find appointments and meetings 
When you first start, your calendar might seem pretty bare, but your schedule might 
eventually abound with meetings and appointments. Forgot when you scheduled a 
meeting? No problem! You can use the Search Calendar option to find any 
appointment or meeting in your calendar. 

To find an event, select the Search Calendar box in the Calendar workspace, which the 
following screenshot depicts. 

Figure 34: The Search Calendar box in the Calendar workspace 
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When you enter text in the Search Calendar box, the Search contextual tab displays. 
The following screenshot depicts this tab. 

Figure 35: The Search contextual tab 

Search for an event by using any of the information it might contain, such as its name, 
location, organizer, or event attendees. If needed, you can use the options in the Refine 
group on the Search contextual tab to narrow down the results. The following 
screenshot depicts the Refine group on the Search contextual tab. 

Figure 36: The Refine group on the Search contextual tab 

You can explore even more options by expanding the More menu. As you continue to 
work with the calendar in Outlook, you’ll encounter situations for which one view is 
more helpful than the others. Be sure to explore the views and configure your Calendar 
workspace in a way that’s the most useful for you. 

Additional information 

For more information about customizing the Calendar workspace in 
Outlook, refer to: Change how you view your Outlook calendar 

https://aka.ms/Change_how_you_view_your_Outlook_calendar
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Activity: Discuss and learn 
Discuss with the teacher and your classmates when different views of the calendar might 
prove beneficial and help with productivity. 

Resources required 
You’ll need the following resources for this activity: 

• None

Activity instructions 
Participate in the activity by following these instructions: 

1. Follow along with the teacher to change the views of the Calendar workspace.

2. Discuss with your classmates how different views might prove useful.

3. Ask and answer questions about the view customization options.

Try-it: Customize the Calendar view 
 It's your first day at the farm, and scheduling will be a big part of your duties as an 

intern. By setting up your Calendar workspace, you can make it as easy as possible to 
manage your schedule. In this leveled try-it activity, you'll customize the Calendar view. 

Try-it 1 
In this try-it, you'll use the options on the Home tab to observe the calendar in diverse 
ways. 

Resources 
You’ll need the following resources for this try-it: 

• None

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Change the view to the Week view. Observe the order in which the days display.

2. Change the view to the Work Week view. Observe the order in which the days
display.

3. Select a Wednesday date in the next couple of weeks in the calendar.

4. Display the next seven days. Observe the order in which the days display.
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Try-it 2 
In this try-it, you'll use the options on the View tab to observe the calendar in diverse 
ways. 

Resources 
You’ll need the following resources for this try-it: 

• None

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Change the view to the Day view. Observe the times available for scheduling.

2. In the Arrangement group, change the Time Scale option to 60 Minutes, and then
10 Minutes. Observe the appointment times available for scheduling.

Try-it 3 
Use the Layout group on the View tab to customize the Calendar view. 

Resources 
You’ll need the following resources for this try-it: 

• None

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Display the Daily Task List arranged by Due Date.

2. Display the Reading Pane on the right side, and then select an appointment.
Observe the details that the Reading Pane supplies.

Topic 3: Customize the People or 
Contacts view 
The People workspace in Outlook gives you a place to store information about the 
people you interact with on a regular basis. You can update your contact cards with vital 
information, such as email addresses and phone numbers, and even personal 
information, such as birthdays. In the People workspace, you can keep the lines of 
communication open and foster relationships with your contacts. 
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Did you know? 

The People view was previously known as the Contacts view. If you 
select People in the navigation bar, your Outlook window displays 
Contacts on the title bar. 

The People workspace has several options for helping you find a contact. The following 
table describes these options. 

View Description What to use for

People 
(default) 

This list of your contacts includes their names, 
pictures (when available), and presence 
information (also when available). 

Internal contacts for 
quick 
communication 
options 

Business 
Card 

Each contact appears on a virtual card that 
displays the primary contact information. The 
card also includes a picture when available. 

External contacts or 
when you need 
quick contact 
information 

Card Each contact appears on a card that displays 
basic information, such as their full name, job 
title, department, and email. The card doesn’t 
include a picture. 

Sorting and finding 
people by their job 
title or company 

Phone This simple list of contacts includes each 
person’s company and up to four phone 
numbers in the default view. You can sort this 
information by any of the displayed columns. 

Printing a version of 
your contacts with 
their phone 
numbers 

List This simple list of contacts includes each 
person’s job title, company, department, and 
country/region. You can sort this information 
by any of the displayed columns. 

Printing a version of 
your contacts with 
their titles and 
companies or 
locations 

Table 7: The view options in the People workspace 
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Change the People view 
The default view is the People view. To change to another view, use the Current View 
group on the Home tab, which the following screenshot depicts. 

Figure 37: The Current View group 

Note that depending on your screen resolution, you might need to use the scroll arrow 
or select More to select a different view. The following screenshot depicts the Current 
View gallery. 

Figure 38: The Current View gallery 

Use list views 
If you choose one of the list views (that is, Phone or List), you can select any column 
heading to sort the list in ascending (A to Z) or descending (Z to A) order. An arrow 
appears in the column heading that you select. The arrow indicates whether the sort is 
ascending (up) or descending (down). The following screenshot depicts the list sorted by 
full name in ascending order. 

Figure 39: The List view sorted by full name in ascending order 
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Sort list views 
You can change the sort order of contact list views. To do so, perform the following 
steps: 

1. Go to the People workspace.

2. On the Home tab, in the Current View group, select a list view (that is, Phone or
List).

3. Select a column header to sort the values in ascending order.

4. If needed, select the column header again to reverse the order to descending.

Customize the workspace from the View tab 
As with the other workspaces in Outlook, you can customize the People workspace. To 
do so, use the Arrangement and Layout groups on the View tab. The following 
screenshot depicts these groups. 

Figure 40: The Arrangement and Layout groups on the View tab 

Note that some options on the View tab might not be available, because they aren’t 
available for the particular view that’s selected. In the following screenshot, several 
options aren’t available. 

Figure 41: Options on the View tab in the People view that aren’t available 

The Layout group in the People workspace has the same panel control options that the 
Mail and Calendar workspaces have. These options are Folder Pane, Reading Pane, 
and To-Do Bar. 

To change to a different view from the View tab, go to the Current View group, select 
the arrow next to Change View to display the Change View menu, and then select 
another view, as the following screenshot depicts. 
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Figure 42: The Change View menu 

Sort and group items 
In the People, Business Card, and Card views, you can use Reverse Sort in the Arrange 
group to change the sort order of the list. Reverse Sort is based only on the contact 
name but might be helpful when you have a lengthy list of names, and the last one 
starts with Z. 

Another helpful element of the People view is the alphabetical set of buttons that 
appears on the left side of the names. Select the letter of the alphabet for the contact 
you want to find to go directly to that letter in the contact list. The following screenshot 
depicts the alphabetical set of buttons. 

Figure 43: The alphabetical set of buttons in the People view 

Understand the Arrangement group 
The list views offer more options in the Arrangement group, including: 

• Categories. Group your contacts by category.
• Company. Sort the list by company.
• Location. Sort the list by country/region.
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To add or remove columns from a list view, go to the Arrangement group, and then 
select Add Columns. The following screenshot depicts this button. 

Figure 44: Add Columns in the Arrangement group 

The Show Columns dialog box appears, displaying a catalog of columns grouped by 
category in the Available columns list, as the following screenshot depicts. 

Figure 45: The Show Columns dialog box 

Add columns to a list view 
1. Go to the People workspace.

2. In the Current View gallery, select a list view.

3. On the View tab, in the Arrangement group, select Add Columns.

4. In the Select available columns from field box, select the category you want.
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5. In the Available columns pane, select the column you want, and then select Add.

6. Repeat this procedure for other columns as needed.

7. If you want to remove columns, select them in the Show these columns in this
order pane, and then select Remove.

8. Use Move Up and Move Down to rearrange the columns.

9. Select OK to save the customizations.

Find people and contacts 
Even if you currently have only a few contacts, you might eventually have hundreds, and 
digging through your list of contacts might become time consuming. Outlook saves you 
time by supplying the Search box in the People workspace. 

To find a contact, select the Search Contacts box in the People workspace, as the 
following screenshot depicts. 

Figure 46: The Search box 

The Search contextual tab displays, as the following screenshot depicts. 

Figure 47: The Search contextual tab 

Search for contacts by any information that their cards might contain, including the 
name, company, or location. If needed, you can narrow down the results by using the 
options in the Refine group, which the following screenshot depicts. 
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Figure 48: The Refine group on the Search contextual tab 

You can also select More to become familiar with even more options. As you progress 
in working with the People workspace, you’ll encounter situations for which one setup is 
more helpful than the others. Be sure to explore the views and configure your People 
workspace in a way that’s the most useful for you. 

Activity: Pose a challenge 
In this activity, your teacher will supply different scenarios. Use them to think of different 
ways in which you can review your contact lists. 

Resources required 
You’ll need the following resources for this activity: 

• None

Activity instructions 
Participate in the activity by following these instructions: 

• Participate in the discussion with the teacher.
• Ask and answer any questions.

Try-it: Customize the People or Contacts view 
  You’re just getting started with tracking your contacts in the People workspace in 
Outlook. This is all new, so you want to explore how to set up your workspace to 
become more efficient at finding and communicating with your peers, volunteers, and 
vendors at the farm. In this leveled try-it activity, you'll customize how you review your 
contacts list. 

Try-it 1 
In this try-it, you'll change the contacts view by using the Current View options on the 
Home tab. 
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Resources 
You’ll need the following resources for this try-it: 

• None

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Go to the People workspace.

2. Change the view to the Business Card view.

3. Change the view to the Phone view.

4. Sort the Phone view by company.

Try-it 2 
In this try-it, you'll change the view of your contacts by using the arrangement options 
on the View tab. 

Resources 
You’ll need the following resources for this try-it: 

• None

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Go to the People workspace.

2. Select the Business Card view.

3. On the View tab, reverse the sort order of the view to descending.

4. Change to the Phone view.

5. Arrange the contacts by category.

Try-it 3 
In this try-it, you'll customize your contacts layout by using the Layout options on the 
View tab. 

Resources 
You’ll need the following resources for this try-it: 

• None
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Go to the People workspace. 

2. Change the view to the List view. 

3. Display the Reading Pane on the right side. 

4. Select any contact, and then observe the changes in the Reading Pane. 

5. Minimize the Folder Pane. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Which of the following is not a Reading Pane configuration? 

Select the correct option. 

a. Top 

b. Right 

c. Bottom 

d. Off 

2. Which of the following is not a component in the Navigation Pane? 

Select the correct option. 

a. Buttons 

b. Folder list 

c. Shortcut key list 

d. Favorite folders 

3. What’s the name of the pane that displays a list of active tasks? 

Select the correct option. 

a. Task List 

b. Actions Pane 

c. To-Do Bar 

d. None of the preceding answers 
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4. Name three scenarios where reviewing your contacts in a list view might be helpful. 

_________________________ 

Fill in the blank space. 
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Lesson 4: Setting your account 
preferences 
Overview 
Your calendar settings and email signatures help you maximize efficiency by informing 
others of your general schedule, your available times, and your vacation schedules. This 
lesson describes how to customize your calendar working times, automatic signatures, 
and email reply settings. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Why might you want to share your working times on your calendar? 

_________________________ 

Fill in the blank space. 

2. An Outlook account can have multiple signatures. 

Select the correct option. 

a. True 

b. False 

3. What options can you apply to your text when creating a new message? 

Select all that apply. 

a. Color 

b. Font style 

c. Font size 

d. Bold  
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Topic 1: Set your working times 
 The calendar in Outlook helps you keep track of the appointments and events in 

your schedule. When you're working in an organization, it can also help peers and 
coworkers coordinate schedules for meetings. But, not all schedules are created equally! 
The default schedule in Outlook assumes that everyone works from 8:00 AM through 
5:00 PM, Monday through Friday, but that isn't always the case. Your Outlook calendar 
helps you communicate your availability and work hours to your contacts. In your 
calendar views, nonworking times aren’t available either for you or for any coworkers 
reviewing your schedule, as the following screenshot depicts. 

 
Figure 49: Nonworking times (which appear shaded) 

For accurate scheduling, it's a good idea to customize your work schedule by using the 
options in the Outlook Options dialog box, such as: 

• Start time 
• End time 
• Work week 
• First day of week 
• First week of year 
The following screenshot depicts the Work time section in the Outlook Options dialog 
box. 



Getting started with Outlook 
 

 
62 

 
Figure 50: Work time options for the calendar 

Change your working times in Outlook 
To change your workdays and work times in Outlook, perform the following steps: 

1. In the Calendar workspace, on the File tab, select Options. 

2. In the Outlook Options dialog box, in the navigation pane on the left side, select 
Calendar. 

3. In the Work time section, select the Start time and End time values for your 
standard workday. 

4. Select the Work week check boxes for the days of the week that you work, and clear 
the check boxes for the days that aren’t part of your work week. 

5. For First day of week, select the day that you start working. 
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6. To change the first week of the year, select an option in the First week of year list. 

7. Select OK to confirm the customizations. 

It's important to note that the working times in Outlook don’t accommodate schedules 
that change from day to day or from week to week. The settings assume that the weekly 
schedule is consistent. 

Activity: Tell a story 
In this activity, you'll review scenarios with your teacher and classmates and discuss 
reasons why people might have nontraditional schedules. Discuss why someone might 
become more productive after setting their work hours on the calendar. 

Resources required 
You’ll need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Consider the diverse types of work schedules that people in your circle might have. 

2. Participate in the discussion. 

3. Ask your teacher clarifying questions. 

Try-it: Set your working times 
 Your internship at the farm is an exciting opportunity! For now, you’re available 

only on a part-time basis, but that might change during breaks or when your school 
schedule changes. In this standalone try-it activity, you'll set your working times so your 
coworkers will be aware of your availability at all times. You'll observe the calendar in 
Work Week view and customize your working times by using the options on the File 
tab. 

Resources 
You’ll need the following resources for this try-it: 

• None 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Observe the calendar in the Work Week view. 

2. Change your working times in the calendar, including: 

o The days of the week 
o The times of day 
o The first day of the week 

3. Observe the changes to the calendar in the Work Week view. 

Topic 2: Create signatures 
 Signatures can save a lot of time by adding a standard block of information about 

you to the end of your email messages. You can also set up different signatures for 
different email accounts, quick replies, or distinct roles you might have at your school or 
future job. The following screenshot depicts a sample signature. 

 
Figure 51: An example of a signature block 

Signatures typically include a variety of information about the sender, including their 
company, role, and contact information. The recipient can then more easily respond or 
contact the sender if necessary. 

Create a signature 
Use the following steps to create a signature in Outlook: 

1. In the Calendar workspace, on the File tab, select Options. 

2. In the Outlook Options dialog box, in the navigation pane on the left side, select 
Mail. 

3. Select Signatures. 
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4. In the Select Signature to edit section, select New. 

5. Enter a name for the signature. 

6. In the Edit Signature box, enter the content for the signature. 

7. Format the text by using the options provided, including fonts, bold and italic 
formatting, and colors. 

8. To add a logo or other image, select Image , find your image file, and then 
select Insert. 

9. To tell Outlook to automatically add a signature to new messages, select that 
signature in the New Messages box. 

10. To tell Outlook to add a specific signature to message replies or forwarded 
messages, select that signature in the Replies and forwards box. 

11. Select OK to confirm the changes. 

It's important to note that when you create a new signature, Outlook automatically 
assigns it as the default signature for new messages. 

Assign signatures to specific messages 
In some cases, you might want to insert an alternate signature into a message instead of 
the default signature. Several reasons exist for doing so. You might have distinct roles in 
your organization or standard responses to different email inquiries. Whatever the case, 
you can add a different signature right from the message itself by using the Signature 
option in the Include group on the Message tab, as the following screenshot depicts. 

 
Figure 52: The Include group 

Insert an alternate signature into an email message 
1. Create a new email message. 

2. In the email message, select the Message tab. 

3. In the Include group, expand the Signature menu. 

4. Select the signature you want. 
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Additional information 

To discover more about using signatures, refer to: Create and add a 
signature to messages 

Activity: The one-question quiz 
In this activity, you'll take part in a discussion by posing one question that addresses an 
important concept from the day’s lesson. An example is: What types of information are 
useful to share in a signature? 

Resources required 
You’ll need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Consider which details might be either helpful to share with the recipients of your 
emails or representative of your company. 

2. Be prepared to take part in the discussion with your classmates. 

Activity: Show me how 
The teacher will guide the class on creating, formatting, and editing signatures. Follow 
along, and ask questions about adding signatures to distinct types of messages. 

Resources required 
You’ll need the following resources for this activity: 

• Open L4_T2_act_signaturesample.docx in this lesson’s Learning Activity Resources.  

Activity instructions 
Follow along with your classmates as your teacher helps you to: 

1. Create a new signature. 

2. Edit the formatting and indentation options. 

3. Add the signature to all new emails. 

4. Add the signature to replies and forwarded messages. 

https://aka.ms/Create_an_email_signature
https://aka.ms/Create_an_email_signature
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Try-it: Create signatures  
  Because you’re getting your Outlook account set up, it’s time to create a custom 
signature in accordance with the company standards. Your teacher has given you an 
example of what it should be like. In this leveled try-it activity, you'll create custom 
signatures to include in your messages. 

Try-it 1 
In this try-it, you'll create a formal signature and then choose it as the signature for all 
your new messages. 

Resources 
You’ll need the following resources for this try-it: 

• Open L4_T2_try1_signaturesample.docx in this lesson’s Learning Activity 
Resources. 

• Open Munsons_logo_square_illustration.png in the Media folder under Student 
Materials. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Use L4_T2_try1_signaturesample.docx as a guideline to create the default 
signature for all new messages. 

2. Name the signature Formal, and then format it as displayed in the sample. 

3. Insert the logo into the signature. 

4. Choose the new signature as the signature for all new messages. 

Try-it 2 
In this try-it, you'll create a formal signature and a second signature for replies and 
forwarded messages. 

Resources 
You’ll need the following resources for this try-it: 

• Open L4_T2_try2_signaturesample.docx in this lesson’s Learning Activity 
Resources. 

• Open Munsons_logo_square_illustration.png in the Media folder under Student 
Materials.  
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Use L4_T2_try2_signaturesample.docx as a guideline to create a new signature for 
all new messages. 

2. Name the signature Formal2, and format it as displayed in the sample. 

3. Insert the logo into the signature. 

4. Choose the new signature as the signature for all new messages. 

5. Create a second signature by using the Reply / Forward sample signature in 
L4_T2_try2_signaturesample.docx. 

6. Name the signature Formal3, and format it as displayed in the sample. 

7. Confirm that the signature for new messages is Formal2 and that the one for replies 
and forwarded messages is Formal3. 

8. Save the customizations. 

Topic 3: Customize your message 
settings 

 Do you ever feel that all the messages you receive seem the same? They use the 
same font, same size, and same color, but do they have to? The truth is that you can 
customize all these settings in Outlook to differentiate not just the appearance of your 
email messages but also how they function as you manage the messages in your Inbox. 

If you’re involved in a long trail of emails, it might be helpful to differentiate which 
responses were yours and which came from other participants. Changing the font size or 
color might make your messages be easier to identify. The Mail settings in the Outlook 
Options dialog box, which the following screenshot depicts, makes customizing your 
message settings available. 
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Figure 53: The Mail settings in the Outlook Options dialog box 

To access the settings to change the default fonts, styles, and colors in your messages, 
select Stationery and Fonts, which the following screenshot depicts. 



Getting started with Outlook 
 

 
70 

 
Figure 54: The Stationery and Fonts button 

The Signatures and Stationery dialog box opens, which offers formatting options for 
new messages, replies, and forwarded messages. The following screenshot points out 
the New mail messages and Replying or forwarding messages sections in the 
Signatures and Stationery dialog box. 
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Figure 55: The Signatures and Stationery dialog box 

Customize your message fonts 
To customize your message fonts in Outlook, perform the following steps: 

1. In the Calendar workspace, on the File tab, select Options. 

2. In the Outlook Options dialog box, in the navigation pane on the left side, select 
Mail. 

3. Select Stationery and Fonts. 

4. In the Signatures and Stationery dialog box, select Font, and then select the 
formatting options you want. 

5. Select OK to close the Font window. 

6. In the Signatures and Stationery dialog box, select OK to save your customizations. 

7. Select OK to close the Outlook Options dialog box. 
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In addition to formatting options, other options exist that specify how Outlook will 
process messages in your Inbox when you reply to messages or forward them. The Mail 
settings of the Outlook Options dialog box also makes these options available, as the 
following screenshot depicts. 

 
Figure 56: The Replies and forwards section 

With some of the options for replies and forwarded messages, you can: 

• Open the message in a new window. 
• Close the original message. 
• Preface comments with your name or custom information. 
• Include the original content in your replies and forwarded messages. 

Customize your reply settings 
1. In the Calendar workspace, on the File tab, select Options. 

2. In the Outlook Options dialog box, in the navigation pane on the left side, select 
Mail. 
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3. Scroll to the Replies and forwards section. 

4. Explore the options, and set them according to your preferences. 

5. Select OK to save your customizations. 

6. Select OK to close the Outlook Options dialog box. 

Activity: Show and tell 
In this activity, your teacher will demonstrate how to customize your settings for replies 
and forwarded messages in Outlook. 

Resources required 
You’ll need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the teacher's demonstration of the settings. 

2. Ask and answer questions. 

Try-it: Customize your message settings 
 You’re almost done setting up your new account! The last step is to customize how 

your content will appear in new messages, replies, and forwarded messages and how 
Outlook will automatically process your messages. In this leveled try-it activity, you'll 
customize how your replies and forwarded messages will appear and the other settings 
available for those messages. 

Try-it 1 
In this try-it, you'll customize the default fonts for new messages, replies, and forwarded 
message. 

Resources 
You’ll need the following resources for this try-it: 

• None 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Customize the default font for new messages.

2. Customize the default font for replies and forwarded messages.

Try-it 2 
In this try-it, you'll customize the available settings for replies and forwarded messages. 

Resources 
You will need the following resources for this try-it: 

• None

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Customize the default font for new messages.

2. Customize the default font for replies and forwarded messages.

3. In the When replying to a message list, select Include and indent original
message text.

4. In the When forwarding a message list, select Attach original message.

Wrap-up 
How confident do you feel about what this lesson covered? Participate in the activity to 
share your comfort level with what you learned. 

Use these questions to check what you learned in this lesson: 

1. Which type of account can have signatures automatically added to messages?

Select the correct option.

a. Web-based email (HTTP) account

b. POP3 email account

c. Exchange Server account

d. All of the preceding answers
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2. What’s the least amount of time for defining a workday? 

Select the correct option. 

a. 1 minute 

b. 30 minutes 

c. 2 hours 

d. 8 hours 

Glossary 
The following table defines the key terms used in the module. 

Backstage view The view on the File tab, where you can access all the settings and 
options. 

Default setting A preset value for an option that the app has set. 

Folder Pane The place to review all your folders, including those for mail, the 
calendar, tasks, and notes. 

Message Pane The place that displays the messages for the currently selected folder. 

Navigation Bar Icons at the bottom of the Navigation Pane that you can use to 
switch among Mail, Calendar, People, Tasks, Notes, Folders, and 
Shortcuts. 

Navigation Pane The place where you can switch among different areas of Outlook, 
such as Mail, Calendar, Contacts, Tasks, Notes, and other folders. 

Quick Access 
Toolbar 

A customizable toolbar that contains a set of commands determined 
by individual preferences. 

Ribbon The command bar found at the top (or beginning) of the workspace 
that consists of multiple tabs and options. 

Signature A customizable block of contact information that Outlook 
automatically adds to new messages. 

Status bar The horizontal bar at the bottom of the screen that displays the 
status of the app. 
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Tabs UI elements you can select to reveal the options. 

Time zone A region of the globe that determines the standard time for 
scheduling. 

To-Do Bar The customizable pane that displays Calendar, Tasks, or People 
information based on individual preferences. 

View A preset or customizable way to observe information in an Outlook 
workspace. 

Table 8: Glossary terms and definitions 
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Cornerstone 
Overview 
In this Cornerstone, you’ll refine the settings in Outlook to accommodate expanded 
duties at the farm. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding 
Microsoft Office Specialist (MOS) exam objectives. 

Cornerstone project objective MOS exam objectives 

Get familiar with the ribbon and manage 
the ribbon display options 

• None 

Change the Quick Access Toolbar to help 
you work efficiently 

• None 

Explore the different ways to review your 
mail 

• 1.1.1: Change the display of messages, 
calendar items, contact records, and 
tasks 

Explore the different ways to review and 
navigate your calendar 

• 1.1.1: Change the display of messages, 
calendar items, contact records, and 
tasks 

Explore the different ways to review your 
contacts 

• 1.1.1: Change the display of messages, 
calendar items, contact records, and 
tasks 

Customize your calendar by setting 
working times 

• 3.1.1: Set calendar work times 

Create and assign automatic signatures • 1.2.3: Create, assign, and modify 
signatures 

Customize the settings for new messages, 
replies, and forwarded messages 

• 1.1.1: Change the display of messages, 
calendar items, contact records, and 
tasks 

• 1.2.1: Specify default fonts for new 
messages and responses 

• 1.2.2: Customize reply message 
settings 

Table 9: Cornerstone objectives mapped to MOS exam objectives 
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Duration 
50 minutes 

Instructions 
1. Complete the tasks in following section for each file.

2. When you’re done with the Cornerstone, assess your completion, and then enter the
points you think you earned in the task lists. You can get help from your teacher if
needed.

Tasks 
You’ll need two files for this Cornerstone: 

• Open Email_signature.docx in the Cornerstone’s Learning Activity Resources.
• Open Munsons_logo_square_illustration.png in the Media folder under Student

Materials.
The following sections describe the tasks you’ll need to do for this Cornerstone. 

Task: Customize the ribbon display options (4 points) 
1. Open Outlook 2019, and then hide the Send/Receive tab. (2 points)

2. Rearrange the tabs so that the first three are View, Folder, and Home in that order.
(2 points)

Points scored: ________ / 4 

Task: Customize the Quick Access Toolbar (4 points) 
1. Add Print and Find a Contact to the Quick Access Toolbar. (2 points)

2. Remove Print and Find a Contact from the Quick Access Toolbar. (2 points)

Points scored: ________ / 4

Task: Customize the Mail, People, and Calendar workspaces (12 
points) 
1. Change the Mail view to Compact. (2 points) (Exam objective 1.1.1)

2. In the Mail workspace, change the message preview to three lines. (2 points) (Exam
objective 1.1.1)
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3. In the Calendar workspace, change the color to light blue. (2 points) (Exam objective 
1.1.1) 

4. Set the time scale to 15 minutes. (2 points) (Exam objective 1.1.1) 

5. In the People workspace, display your contacts by phone number. (2 points) (Exam 
objective 1.1.1) 

6. Minimize the Folder Pane. (2 points) (Exam objective 1.1.1) 

Points scored: ________ / 12 

Task: Create a signature and assign it to messages (10 points) 
1. Create a new signature, and name it Events. (3 points) (Exam objective 1.2.3) 

2. Format the signature by using the formatting in Email_signature.docx and by 
inserting Munsons_logo_square_illustration.png. (4 points) (Exam objective 1.2.3) 

3. Apply the signature to new email messages. (3 points) (Exam objective 1.2.3) 

Points scored: ________ / 10 

Task: Update your working time (6 points) 
1. Change your working days so you have a four-day work week (from Wednesday 

through Saturday). (2 points) (Exam objective 3.1.1) 

2. Set your daily schedule to 12:00 PM or 12:00 through 6:00 PM or 18:00. (2 points) 
(Exam objective 3.1.1) 

3. Change the first day of the week to Monday. (2 points) (Exam objective 3.1.1) 

Points scored: ________ / 6 

Task: Customize your message settings (6 points) 
1. For new messages, apply Arial for the font, 12 for the font size, and italic. (3 points) 

(Exam objective 1.2.1) 

2. For replies and forwarded messages, apply Calibri for the font, 14 for the font size, 
and bold. (3 points) (Exam objective 1.2.2) 

Points scored: ________ / 6 

Total points: ________ / 42 
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Module overview 
Description 
Email is an important productivity tool in your own life and in the modern workplace. 
Microsoft Outlook 2019 supports basic email features such as Cc and Bcc, but it also 
offers unique features to make email even more useful, such as @mentions, attachment 
previewing, and robust formatting options. This module covers composing emails and a 
variety of tools for managing the content of both incoming and outgoing messages. 

The following table outlines the lessons in this module and their corresponding learning 
objectives. 

Lesson Learning objective Exam objectives 

Composing 
email messages 

Compose emails, add content, and format 
the content in emails. 

• 2.1.2 
• 2.1.3 
• 2.1.5 
• 2.1.6 
• 2.2.1 
• 2.2.2 
• 2.2.3 

Corresponding 
via email 

Share message content in print and 
electronic format. 

• 1.4.1 
• 2.1.4 

Working with 
message 
attachments 

Add attachments to outgoing messages 
and preview or manage attachments in 
incoming messages. 

• 1.4.2 
• 1.4.3 
• 1.4.4 
• 2.1.1 
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Lesson Learning objective Exam objectives 

Cornerstone: 
Managing the 
communications 
for a planting 
project 

Create new email messages, respond to 
email by using reply and forward, and 
manage email attachments. 

• 1.4.2 
• 1.4.4 
• 2.1.1 
• 2.1.2 
• 2.1.3 
• 2.1.4 
• 2.1.5 
• 2.1.6 
• 2.2.1 
• 2.2.2 

Table 1: Objectives by lesson 

Scenario 
Munson’s Pickles and Preserves Farm takes pride in its efforts to protect the 
environment and conserve scarce resources through environmentally sound farming 
practices. Last fall, the farm planted a cover crop on hillier fields to reduce soil erosion, 
and this spring, it’s using no-till planting equipment to further protect the soil. As an 
intern in the Media and Communications department, your job is to manage the 
communications related to this planting project. 

Cornerstone 
This module concludes with a Cornerstone activity, in which you’ll create new email 
messages, forward and respond to email, and manage attachments to both incoming 
and outgoing email. 
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Lesson 1: Composing email 
messages 
Overview 
In this lesson, you'll learn how to compose email messages, format the text of a 
message, indicate that a message is of high importance or requires follow-up, and add 
content to a message. The activities, discussions, and demonstrations in this lesson will 
strengthen your learning and give you the opportunity to practice what you learn. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which of the following features can you use to confirm that a recipient has opened a 
message? 

Select the correct option. 

a. @mention 

b. Bcc 

c. Follow Up 

d. High Importance 

e. Read Receipt 

2. Which of the following do you use to mark a message that you must remember 
later? 

Select the correct option. 

a. @mention 

b. Bcc 

c. Follow Up 

d. High Importance 

e. Read receipt 
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3. How can you add a hyperlink to the body of a message? 

Select all that apply. 

a. From the Insert tab on the ribbon 

b. From the Format Text tab on the ribbon 

c. By dragging a page from your web browser 

d. By entering the web address and selecting the Spacebar, Tab, or Enter. 

4. To include a/an ________________________ in a message, you can add it as an 
attachment or insert it in the body of the message. 

Fill in the blank space. 

5. To flag a message that you want to remember later, use the ________________________ 
command. 

Fill in the blank space. 

6. To send a copy of an email to someone who isn’t a recipient, use the 
________________________ line. 

Fill in the blank space. 

Attach the module .pst file 
To provide the most effective learning experience, this module includes several starter 
elements such as emails, calendar appointments, tasks, and contacts. These elements are 
stored in an external Outlook Data File, or .pst file. It resides in a location that your 
teacher will provide. To complete this module, you must attach this .pst file into Outlook 
before you can perform any try-its. You’ll also store the results of your try-its in this .pst 
file. This allows your teacher to assess your work by examining the .pst file’s contents. 

To open the .pst file in Outlook: 

1. Open Outlook. 

2. Select the File tab, and then select Open & Export. 

3. In the Open pane, select Open Outlook Data File. 

4. In the Open Outlook Data File dialog box, use the navigation pane to locate the .pst 
files provided by your instructor for your use throughout this module of the course. 

5. Open the file named M2_module_PST_starter. Note that a folder 
M2_module_PST_starter is now available in the navigation pane. This folder 
contains any required starter elements for the module, such as emails, calendar 
appointments, tasks, and contacts. 
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6. Right-click or access the context menu for the M2_module_PST_starter folder, and 
then select Properties. 

7. In the M2_module_PST_starter Properties dialog box, select Advanced. 

8. In the Outlook Data File dialog box, in the Name box, append your name to the 
end of the existing name by using underscores instead of spaces. For example, enter 
_Firstname_Lastname. The folder name should now resemble 
M2_module_PST_starter_Firstname_Lastname. 

9. Select OK twice. 

Copy content into the module .pst file 
As you proceed through this module’s try-its, you should copy the resulting elements, 
such as emails, calendar appointments, tasks, and contacts, to the 
M2_module_PST_starter_Firstname_Lastname folder by using the following 
instructions: 

1. After you attach the .pst file, you should be able to observe duplicate folders for 
items such as emails, calendar appointments, tasks, and contacts. 

2. After you complete a try-it exercise, select your resulting items in the navigation 
pane. Make sure you select the items that are associated with your email account. 

3. In the details pane, right-click or access the context menu for each item, and then 
select Copy or select Ctrl+C. 

4. Select the M2_module_PST_starter_Firstname_Lastname folder. 

5. Select Ctrl+V to copy the item to the .pst file. 

6. Repeat steps 3 through 5 for any additional items that you want to copy. 

Topic 1: Compose an email message 
 One of the most common tasks that you'll undertake in Outlook is creating a new 

email to send to one or more recipients. Composing a simple email message is very 
straightforward, but Outlook makes this process easier. You can also take advantage of 
a variety of features to make your messages more useful for recipients. In addition to 
specifying one or more recipients, you can use Cc and Bcc to communicate with 
additional people. You can also use @mentions to get someone's attention or request a 
read receipt to let you know who has read your message. 
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Create and address an email message 
To begin composing a new message, select the Home tab on the ribbon, and then in 
the New group, select New Email or select Ctrl+N. The following screenshot depicts the 
New group with New Email highlighted: 

 
Figure 1: The New group with New Email highlighted 

Outlook will open a Message window for new email. In this window, you can compose 
your email, and as you'll learn in the next lesson, format the text of your message. When 
starting a new email, Outlook opens a new window with a different ribbon that has a 
variety of options to customize the new message. You can also specify the recipients of 
your message. The following screenshot depicts the Message window: 

 
Figure 2: The Message window 

To specify recipients for the message, select the To text box. Enter the email address of 
the recipient of the message. If you want to send the message to more than one person, 
separate each email address with a semicolon. 
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Send copies of email 
Sometimes, you might want someone else to get a copy of a message even though they 
aren't the primary recipient. For example, if you’re working on a group project and have 
a question for one of your partners, you might want the other students in the group to 
observe the message as well so that they don't get left out of the conversation. To send 
a copy of the message to someone who isn’t the recipient, you can use the Cc or 
courtesy copy option. Select the Cc text box and enter their email address. You can use 
semicolons to separate multiple addresses, just like you can with the To text box. 

There’s one other way to send a copy to someone who isn’t the primary recipient. This is 
the Bcc or blind courtesy copy option, which sends a copy of an email message to an 
individual without the recipients in the To and Cc boxes knowing. A blind copy is a great 
way to preserve privacy. Email addresses that you enter in the To or Cc boxes are 
available to everyone who gets the message, but email addresses in Bcc box are not. For 
example, suppose you want to send product information to a variety of customers, but 
you don't want to send separate emails for each. Customers might not appreciate the 
sharing of their email addresses, so you could put them in the Bcc line to keep them 
private. Bcc is often used when sending information to many addresses while keeping 
those conversations separate. When you use Bcc and one of your recipients sends a 
reply by using Reply to All, other Bcc recipients won’t receive those replies. 

By default, Bcc isn’t available in the Message window. To display it, select the Options 
tab, and then select Bcc in the Show Fields group. After you turn on Bcc, it will display 
each time you compose a new message until you turn it off again. The following 
screenshot depicts the Show Fields group with Bcc highlighted. 

 
Figure 3: The Show Fields group with Bcc highlighted 
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Did you know? 

Some email systems might flag messages with Bcc recipients as junk 
or spam, so make sure the recipient is expecting the message. 

 

Additional information 

For more information on composing and addressing an email, go to: 
Create and send email in Outlook 

 

Video 

To review the video on composing and addressing an email, go to: 
Create an email message 

Use @mentions 
You often might send email to several people at the same time, and it's easy for a 
recipient to miss something that was intended just for them. You can use @mentions to 
get the attention of individuals in your message. When you do, that person's name will 
be highlighted in the message body and their email address will be added to the To box 
if it isn't already there. They will also notice the @ symbol next to the message in their 
Inbox, notifying them that they are mentioned specifically in the message. 

Add an @mention to the body of a message by entering the at sign (@) and the first 
few letters of the contact's first name, last name, or email address. Outlook will offer 
suggestions based on that information. Select the contact from the suggestions list. The 
following screenshot depicts this: 

https://aka.ms/create-and-send-email-in-outlook
https://aka.ms/create-an-email-message
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Figure 4: Example of the suggestions that Outlook supplies when creating an @mention 

By default, an @mention displays the full name, but you can delete portions of the 
name. The following screenshot depicts an @mention with the last name deleted, 
leaving only the first name: 

 
Figure 5: Example of an @mention with the last name deleted, leaving only the first name 

 

Video 

To review the video on @mentions, go to: Use @mentions to get 
someone's attention 

  

https://aka.ms/Use-mentions-to-get-someones-attention
https://aka.ms/Use-mentions-to-get-someones-attention
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Add a read receipt to a message 
Sending a message and not knowing if anybody has read it can be very frustrating! To 
help with this, Outlook supports read receipts, which is a confirmation that email 
recipients have read your message. Outlook also gives recipients the option to decline 
sending a read receipt, and some email programs don’t support them. Therefore, the 
lack of a read receipt doesn’t necessarily mean that the recipient didn’t read the 
message. However, read receipts can be useful as a way for recipients to acknowledge 
messages without replying. 

You must add a read receipt request before you send the message. To add a read 
receipt, perform the following steps: 

1. In the Message window, select the Options tab on the ribbon. 

2. In the Tracking group, select Request a Read Receipt. The following screenshot 
depicts the Tracking group with the Request a Read Receipt check box selected: 

 
Figure 6: The Tracking group with the Request a Read Receipt check box selected 

 

Did you know? 

To observe read receipts, you must open the original message that 
you sent, which is in the Sent Items folder. Then, select the Message 
tab, and select Tracking in the Show group. Tracking doesn't appear 
until at least one receipt has been received. 

 

Additional information 

To review the video on requesting and reviewing read receipts, go to: 
Add and request read receipts and delivery notifications 

  

https://aka.ms/add-and-request-read-receipts-and-delivery-notifications
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Activity: Pick a card, any card 
In this activity, you’ll work with other students to create an email based on the card that 
you received (or the prompt that you were assigned) at the start of the lesson. 

Resources required 
You’ll need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Find the other student or students with the same card or prompt. 

2. Working as a group, compose an email to other students based on the prompt, as 
directed. 

Try-it: Compose an email message 
 In this leveled try-it activity, you’ll practice composing a new email message that 

will include both a message body and one or more recipients. 

Try-it 1 
Resources 
You’ll need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you must perform during this try-it: 

1. Use the ribbon to create a new email message. 

2. Set the Subject line to Quotations for a news article. 

3. Set the To line to marcos@munsonspicklesandpreservesfarm.com or to your 
teacher's email address as directed. 
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4. Edit the body of the message to include the following text: 

Hi Marcos, 

I've received an inquiry from a local journalist who is interested in writing an 
article about our no-till planting initiative. Can you provide a short quotation 
about the long-term impact it will have on the farm? 

5. Copy the Quotations for a news article message to 
M2_module_PST_starter_Firstname_Lastname. 

Try-it 2 
Resources 
You’ll need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you must perform during this try-it: 

1. Use a keyboard shortcut to create a new email message. 

2. Set the Subject line to Quotations for a news article. 

3. Set the To line to marcos@munsonspicklesandpreservesfarm.com or to your 
teacher's email address as directed. 

4. Edit the body of the message to include the following text: 

Hi Marcos, 

I've received an inquiry from a local journalist who is interested in writing an 
article about our no-till planting initiative. Can you provide a short quotation 
about the long-term impact it will have on the farm? 

5. Remember to send or save your draft as directed by the teacher. 

6. Copy the Quotations for a news article message to 
M2_module_PST_starter_Firstname_Lastname. 
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Try-it 3 
You’ll need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you must perform during this try-it: 

1. Use the ribbon or a keyboard shortcut to create a new email message. 

2. Set the Subject line to Quotations for a news article. 

3. Set the To line to marcos@munsonspicklesandpreservesfarm.com or to your 
teacher's email address as directed. 

4. Add the email address danielle@munsonspicklesandpreservesfarm.com to the Cc 
line, or add the email address of a student as directed. 

5. Add the email address fernando@munsonspicklesandpreservesfarm.com to the 
Bcc line, or add the email address of a student as directed. 

6. At the beginning of the message body, use an @mention for 
marcos@munsonspicklesandpreservesfarm.com, or add an @mention for 
another student as directed. 

7. Following the @mention, add the following text: 

I've received an inquiry from a local journalist who is interested in writing an 
article about our no-till planting initiative. Can you provide a short quotation 
about the long-term impact it will have on the farm? 

8. Copy the Quotations for a news article message to 
M2_module_PST_starter_Firstname_Lastname. 

Topic 2: Apply formatting and setup 
options 

 Email has evolved beyond simple text-only messages. Adding some formatting to 
your messages can make them easier to read and much more professional. Before you 
send a message, Outlook can also help you find and correct misspelled words and 
indicate the importance of the message to its recipients. You can also flag messages so 
that you remember to follow up on them later. 
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Apply formatting to a message 
Outlook provides tools for formatting email messages that are very similar to formatting 
features in other Microsoft Office apps, such as Microsoft Word. 

To change the size, font, or formatting of text in a message, begin by selecting the text 
that you want to format. Next, select the Message tab on the ribbon. The Basic Text 
group includes some of the most used formatting options, such as Font, Font Size, 
Bullets, and Numbering. Select the formatting that you want to apply. The following 
screenshot depicts the Basic Text group on the Message tab: 

 
Figure 7: The Basic Text group on the ribbon 

To access additional formatting features, select the text to format and then select 
Format Text on the ribbon. Commands in the Font group make it possible to change a 
variety of font settings. The following screenshot depicts the Font group in the Format 
Text tab: 

 
Figure 8: The Font group on the Format Text tab 

The Paragraph group includes tools for creating lists, changing alignment, and other 
paragraph formatting options. The following screenshot depicts the Paragraph group 
on the Format Text tab: 

 
Figure 9: The Paragraph group on the Format Text tab 
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You can use the Styles group on the Format Text tab to apply a predefined text style. 
Select the text that you want to style, and then select Format Text. In the Styles group, 
use the Styles gallery to select the style that you want to apply. To access additional 
styles, select More, which is depicted as a Down arrow on the right-hand side of the 
Styles gallery. The following screenshot depicts the Styles group on the Format Text 
tab. 

 
Figure 10: The Styles group on the Format Text tab with More highlighted 

 

Additional information 

For more information on applying formatting to a message, go to: 
Change the size or formatting of text 

Check for spelling errors 
As you compose a message, Outlook will automatically check your spelling. It will 
indicate a misspelled word by underlining it with a wavy line. You can get help 
correcting the error by right-clicking or accessing the context menu on the misspelled 
word. Then, select the correction that you want. If you want to ignore the misspelling, 
select Ignore All and Outlook won’t flag the misspelling again in that message. If the 
word is spelled correctly, select Add to Dictionary to add the word to the Outlook 
spelling dictionary, and Outlook won’t flag the added word as wrong in any future 
messages. The following screenshot depicts the context menu for a misspelled word: 

https://aka.ms/Change-the-size-or-formatting-of-text
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Figure 11: The context menu for a misspelled word 

You can also check and correct the spelling of the entire message at once. Select the 
Review tab on the ribbon, and then in the Proofing group, select Spelling & 
Grammar. The following screenshot depicts the Proofing group on the Review tab, 
with Spelling & Grammar highlighted: 

 
Figure 12: The Proofing group on the Review tab, with Spelling & Grammar highlighted 
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If Spelling & Grammar finds a misspelled word, it will open the Spelling and Grammar 
dialog box. To replace the word, select a new word in Suggestions, and then select 
Change. Select Ignore Once to skip just this instance of the misspelling or select Ignore 
All to ignore the misspelling throughout the message. Selecting Add to Dictionary will 
add the flagged word to the Outlook dictionary so it’s not flagged in future messages. 
The following screenshot depicts the Spelling and Grammar dialog box:

 

Figure 13: The Spelling and Grammar dialog box 
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Outlook includes a setting to check the spelling of all messages before they are sent. To 
enable this setting, select File on the ribbon, and then select Options in the Microsoft 
Office Backstage view. In the Outlook Options dialog box, select Mail. In the 
Compose messages section, select the Always check spelling before sending check 
box, and then select OK. The following screenshot depicts a part of the Outlook 
Options dialog box with Mail and Always check spelling before sending highlighted: 

 
Figure 14: A part of the Outlook Options dialog box with Mail and Always check 
spelling before sending highlighted 

With this option enabled, Outlook will run Spelling & Grammar automatically when 
you select Send. If it doesn’t detect any misspelled words, it will send the message 
immediately. If it does find misspellings, it will open the Spelling and Grammar dialog 
box. Select Cancel to stop the spell check and continue editing the message. 

 

Additional information 

For more information on spell checking, go to: Check spelling before 
sending a message 

  

https://aka.ms/Check-spelling-before-sending-a-message
https://aka.ms/Check-spelling-before-sending-a-message
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Mark a message for high importance 
You can use Outlook to mark a message with an indicator of the message’s importance. 
If the message is urgent or particularly important, you can set the message as High 
Importance. If the message isn’t related to work or is otherwise not urgent, you can set 
the message as Low Importance. The effect of this might vary depending on the email 
application the recipients are using, but most email programs use a highlight or icon to 
indicate the importance level. 

It's important to be consistent and thoughtful with these indicators. If you unnecessarily 
mark messages as High Importance, recipients might become frustrated and could 
even start to ignore the tag. Likewise, messages that you mark as Low Importance 
might not be read until much later, when the recipient has free time. When everyone in 
the workplace uses flags appropriately, everyone can be more productive and manage 
their email inboxes more efficiently! 

To set the importance indicator, select New Email to open the Message window. Select 
the Message tab on the ribbon, and then in the Tags group, select High Importance or 
Low Importance. The following screenshot depicts the Tags group on the Message 
tab: 

 
Figure 15: The Tags group on the Message tab 

 

Additional information 

To review the video on importance indicators, go to: Mark a message 
as high or low importance 

Flag a message for follow-up 
Many people receive a lot of email messages over the course of a day or week, and it's 
easy to become overwhelmed and lose track of all the things that need your attention. 
For example, you might send a message to a coworker asking for a copy of a document 
that you need this week, but you don't want to forget if they don't send it. 

Outlook provides a follow-up option to help with just that kind of situation. When you 
send an email, you can mark the message for follow-up. 

https://aka.ms/Mark-a-message-as-high-or-low-importance
https://aka.ms/Mark-a-message-as-high-or-low-importance
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Select New Message to begin composing a new email message. Select the Message 
tab on the ribbon, and then in the Tags group, select Follow Up. In the drop-down 
options, select the day that you want to follow up on the message: Today, Tomorrow, 
This Week, or Next Week. If you don’t want to assign a specific date to the flag, select 
No Date. The following screenshot depicts the Tags group on the Message tab, with 
Follow Up selected: 

 
Figure 16: The Tags group on the Message tab, with Follow Up selected 

The message will now be marked with the corresponding flag, which darkens as the 
follow up date approaches. Because the message will be in your Sent Items folder, 
where you might not notice the flag, you might want to add a reminder. A reminder is 
an alert dialog box that appears when the follow-up is due—the same dialog box for 
upcoming calendar events. To add a reminder, select the Message tab on the ribbon, 
and then in the Tags group, select Follow Up. In the drop-down options, select Add 
Reminder to open the Custom dialog box. Select the Reminder drop-down, select the 
date and time for the reminder to appear, and then select OK. The following screenshot 
depicts the Custom dialog box with the Reminder options highlighted: 
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Figure 17: The Custom dialog box with the Reminder options highlighted 

 

Did you know? 

In the Flag for Recipients section in the Custom dialog box, you can 
specify a follow-up reminder date for recipients of the message. 
Recipients who use Outlook will observe the flag in their message list 
and before the From line when they open the message. The flag will 
also add an item to their to-do list in Outlook. 
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In the Custom dialog box, you can also choose any date as the due date for a follow-up. 
To set a custom date to follow up, select the Message tab on the ribbon, and then 
select Follow Up in the Tags group. In the drop-down options, select Custom to open 
the Custom dialog box. Select Due date and choose the date on which you’ll follow up. 

 

Additional information 

To review the video on follow-up reminders, go to: Send an email 
message with a follow-up reminder 

Activity: Think-pair-share 
In this activity, you’ll discuss message setup options with a partner and then share your 
ideas with the group. 

Resources required 
You’ll need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Think about how message tagging features can help communicate with your 
recipients more efficiently. 

2. When directed by the teacher, pair up and discuss your ideas with your partner. 

3. Share your responses with the group. 

Try-it: Apply formatting and setup options 
 In this leveled try-it activity, you’ll practice formatting a message and setting 

Follow Up flags. 

Try-it 1 
In this try-it, you’ll create a message with custom formatting. 

Resources 
You’ll need the following resources for this try-it: 

• None 

https://aka.ms/Send-an-email-message-with-a-follow-up-reminder
https://aka.ms/Send-an-email-message-with-a-follow-up-reminder
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Instructions 
The following are the general tasks that you must perform during this try-it: 

1. Use the ribbon to create a new email message. 

2. Set the Subject line to Profiles for the news article. 

3. Set the To line to marcos@munsonspicklesandpreservesfarm.com or to your 
teacher's email address as directed. 

4. Edit the body of the message to include the following text: 

Hi Marcos, 

Thank you for providing a quotation to the local writer. They would like some 
information about the staff members who are working on these initiatives. Is 
there someone here who can provide some basic profiles or biographies? 

5. Select all the message body text from the previous step, and then set the Font to 
Arial and the Font Size to 14. 

6. In the message body text, apply the Bold style to the text basic profiles or 
biographies. 

7. Remember to send or save your draft as directed by the teacher. 

Try-it 2 
In this try-it activity, you’ll create an email message that includes custom flags. 

Resources 
You’ll need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you must perform during this try-it: 

1. Use the ribbon to create a new email message. 

2. Set the Subject line to Profiles for the news article. 

3. Set the To line to marcos@munsonspicklesandpreservesfarm.com or to your 
teacher's email address as directed. 
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4. Edit the body of the message to include the following text: 

Hi Marcos, 

Thank you for providing a quotation to the local writer. They would like some 
information about the staff members who are working on these initiatives. Is 
there someone here who can provide some basic profiles or biographies? 

5. Mark the message High Importance. 

6. Set a Follow Up flag for Next Week. 

7. Remember to send or save your draft as directed by the teacher. 

Topic 3: Add content to an email 
message 

 In addition to the many text formatting features that are available in Outlook, you 
can also add links and images to your messages. You can incorporate this content 
directly in the body of a message so that it’s easily accessible to recipients. In this topic, 
you'll also learn how to save a draft of a message so that you don't lose your work. 

Insert an image into the body of a message 
You might be familiar with the idea of attaching an image to an email message, which 
you'll explore in Lesson 3 of this module. However, Outlook also makes it possible to 
insert pictures into the body of a message. These images appear as part of the message, 
so recipients don’t need to open them individually to review their content. This helps 
you add helpful context. For example, if you’re sending along two different design ideas, 
you can insert an image of each with your comments about each proposal. 

To insert a picture in a message, while editing your message in the Message window, 
position the cursor where you want to insert the image. Select the Insert tab on the 
ribbon, and then select Pictures in the Illustrations group. The following screenshot 
depicts the Illustrations group with Pictures highlighted: 

 
Figure 18: The Illustrations group with Pictures highlighted 



Composing and managing email 
 

 
28 

This opens the Insert Picture dialog box. Browse to the location of the image that you 
want to insert, select the file, and then select Insert. 

 

Did you know? 

To insert a picture by using the keyboard, select Alt+N to select the 
Insert tab, and then select P to select Pictures. 

 

Additional information 

For additional information on inserting a picture into the body of an 
email message, go to: Attach files or insert pictures in Outlook email 
messages 

Add a hyperlink to a message 
Outlook automatically creates a hyperlink when it detects the address to a webpage. 
Simply input the address of the website and then select Enter, Space, or Tab to move 
the cursor. Outlook will then convert the address into a link. 

To add a hyperlink manually, select the text or image that you want to convert to a link. 
Select the Insert tab on the ribbon, and then select Link in the Links group. The 
following screenshot depicts the Links group with Link highlighted: 

 
Figure 19: The Links group with Link highlighted 

The Insert Hyperlink dialog box will appear. In the Link to section, select Existing File 
or Web Page, select Address, enter the address that you want to link, and then select 
OK. The following screenshot depicts the Insert Hyperlink dialog box with Address 
highlighted: 

https://aka.ms/Attach-files-or-insert-pictures-in-Outlook-email-messages
https://aka.ms/Attach-files-or-insert-pictures-in-Outlook-email-messages
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Figure 20: The Insert Hyperlink dialog box with Address highlighted 

 

Did you know? 

The keyboard shortcut to insert a hyperlink is Ctrl+K. 

You can also create a hyperlink from the context menu. Right-click or access the context 
menu for the image that you want to link, and then select Link to open the Insert 
Hyperlink dialog box. The following screenshot depicts the context menu with Link 
highlighted: 
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Figure 21: The context menu with Link highlighted 

 

Additional information 

For additional information on adding a hyperlink to a message, go to: 
Create or edit a hyperlink 

Save a message as a draft 
As you compose an email message, Outlook saves your work every three minutes. A 
saved copy of an unsent message is called a draft, and it’s saved in your Drafts folder. 
To open it, select Drafts in the Folder Pane, and then double-click the message or 
select the message and select Enter. This opens the draft in a Message window, where 
you can finish and send the message when you're ready. 

 

Did you know? 

If you use Outlook for iOS or Outlook for Android, your unsent drafts 
will sync between devices. This means that you can start a message 
on your mobile device and finish it on your computer! 

https://aka.ms/Create-or-edit-a-hyperlink
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To save a draft manually, select Save in the Quick Access Toolbar or select the File tab, 
and then select Save. The following screenshot depicts a part of the Message window 
with the Save icon highlighted: 

 
Figure 22: A part of the Message window with the Save icon highlighted 

 

Additional information 

For additional information on saving a draft, go to: Save or delete 
drafts of unsent messages 

Activity: Each one, teach one 
In this activity, you’ll review documentation. Then you'll share what you learned with 
another student. 

Resources required 
You’ll need the following resources for this activity: 

• None 

https://aka.ms/Save-or-delete-drafts-of-unsent-messages
https://aka.ms/Save-or-delete-drafts-of-unsent-messages
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Activity instructions 
Participate in the activity by following these instructions: 

1. Read the article that the teacher assigned to you. 

2. Share two or three things that you learned with the group. 

Try-it: Add content to an email message 
 In this leveled try-it activity, you’ll work on adding pictures and hyperlinks to an 

outgoing email message. You’ll choose between adding an image and a hyperlink with 
the ribbon or by using keyboard shortcuts. 

Try-it 1 
In this try-it activity, you’ll add an image and a hyperlink to a new message by using 
commands on the ribbon. 

Resources 
You’ll need the following resource for this try-it: 

• Farmer_Danielle_Gousse_agricultural_technologist_illustration.png in the Media 
folder. 

Instructions 
The following are the general tasks that you must perform during this try-it: 

1. Use the ribbon to create a new email message. 

2. Set the Subject line to Our Agricultural Technologist. 

3. Set the To line to marcos@munsonspicklesandpreservesfarm.com or to your 
teacher's email address as directed. 

4. Edit the body of the message to include the following text: 

Hi Marcos, 

The reporter who is doing a story on the Farm’s no-till planting initiative 
requested a photograph of Danielle to run with a short description of her 
involvement in the process. Should we use this photograph from last year? 

5. Use the ribbon to add 
Farmer_Danielle_Gousse_agricultural_technologist_illustration.png to the body 
of the message after the paragraph that you added in the previous step. 
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6. After the photograph, add the following text: 
For the description of Danielle’s work, I’m going to direct them to the Farm’s 
home page. 

7. Using the ribbon, edit the last four words of the sentence (the Farm’s home page) 
to be a hyperlink to http://www.munsonspicklesandpreservesfarm.com. 

8. Copy the Our Agricultural Technologist message to 
M2_module_PST_starter_Firstname_Lastname. 

Try-it 2 
In this try-it activity, you’ll add an image and a hyperlink to a new message by using 
keyboard shortcuts. 

Resources 
You’ll need the following resource for this try-it: 

• Farmer_Danielle_Gousse_agricultural_technologist_illustration.png in the Media 
folder. 

Instructions 
The following are the general tasks that you must perform during this try-it: 

1. Use the ribbon to create a new email message. 

2. Set the Subject line to Our Agricultural Technologist. 

3. Set the To line to marcos@munsonspicklesandpreservesfarm.com or to your 
teacher's email address as directed. 

4. Edit the body of the message to include the following text: 

Hi Marcos, 

The reporter who is doing a story on the Farm’s no-till planting initiative 
requested a photograph of Danielle to run with a short description of her 
involvement in the process. Should we use this photograph from last year? 

5. Use the ribbon to add 
Farmer_Danielle_Gousse_agricultural_technologist_illustration.png to the body 
of the message after the paragraph that you added in the previous step. 

6. After the photograph, add the following text: 
For the description of Danielle’s work, I’m going to direct them to the Farm’s 
home page. 
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7. Using the ribbon, edit the last four words of the sentence (the Farm’s home page)
to be a hyperlink to http://www.munsonspicklesandpreservesfarm.com.

8. Copy the Our Agricultural Technologist message to
M2_module_PST_starter_Firstname_Lastname.

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Which of the following do you use to send a copy of a message to additional
recipients without other recipients knowing?

Select the correct option.

a. @mention

b. Bcc

c. Cc

d. Forward

e. To

2. Which tab on the ribbon includes extensive features for changing the font and
paragraph settings, in addition to applying a style?

Select the correct option.

a. Message

b. Insert

c. Options

d. Format Text

e. Review

3. An ________________________ gets a recipient's attention by highlighting their name in
the message body.

Fill in the blank space.

4. To confirm that a recipient opens a message, request a ________________________ prior
to sending the message.

Fill in the blank space.
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Lesson 2: Corresponding via 
email 
Overview 
In this lesson, you'll learn how to print email messages, reply to a message, and forward 
a message to a new recipient. The activities, discussions, and demonstrations in this 
lesson will strengthen your learning and give you the opportunity to practice printing, 
replying to, and forwarding messages. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Commands that are related to printing an Outlook message are primarily located in 
the ________________________. 

Fill in the blank space. 

2. Which of the following should you use to send a message to someone who isn’t on 
the message's To or Cc lines? 

Select the correct option. 

a. Reply 

b. Reply All 

c. Forward 

d. New Email 

3. Use ________________________ to send a response to all original recipients. 

Fill in the blank space. 

4. Use ________________________ to send a response only to the original sender. 

Fill in the blank space. 
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Topic 1: Preview and print message 
content 

 Email has revolutionized the way the modern workplace communicates. In the past, 
correspondence often involved memos that people printed and distributed to each 
person who needed to read it. Just think of all the paper a typical office would use! 
Email has largely replaced the role of the memo, giving us an environmentally friendly 
and efficient way to ensure that everyone has the information they need for their jobs. 

However, there are still times when it’s helpful to print an email message. For example, 
you might be meeting in a setting without computer access, or you might want an easy 
way to make notes on the contents of a message. Even if you aren't printing a message 
on paper, you can use the print feature in Outlook to create a PDF version of a message, 
which people can open without using Outlook. 

 

Did you know? 

Many of the features that you use in email go back to the days of 
printed memos. For example, when you wanted to give a copy to 
someone who wasn’t directly receiving the memo, you'd make a 
courtesy copy (cc). 

To print a message in Outlook, select the message, select File to open the Backstage 
view, and then select Print. Outlook will display a preview in the details pane of the 
window that depicts exactly what will print. The following screenshot depicts the 
Backstage view with Print selected: 
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Figure 23: The Backstage view with Print selected 

Use the Printer drop-down list to select your printer or select Microsoft Print to PDF 
to create a PDF file, and then select Print to send your message to the printer. If you 
selected Microsoft Print to PDF, you’ll receive a prompt for a save location and file 
name. 

Before you print, you can choose which page or pages to print. Select File to open the 
Backstage view, select Print, and then select Print Options. The following screenshot 
depicts a part of the Backstage view with Print Options highlighted: 
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Figure 24: A part of the Backstage view with Print Options highlighted 

This opens the Print dialog box. Select the Pages text box, and then enter the pages 
that you want to print. You can specify multiple pages by using commas, or you can 
specify a range of pages by using a hyphen. The following screenshot depicts the Print 
dialog box with Pages highlighted, and the settings are configured to print only page 1 
and page 5: 
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Figure 25: The Print dialog box with Pages highlighted 

 

Additional information 

For more information on printing messages, go to: Print a page or part 
of an email message 

Activity: Show and tell 
In this activity, your teacher or a fellow student will demonstrate how to preview and 
print an email message in Outlook. 

Resources required 
You’ll need the following resources for this activity: 

• None 

https://aka.ms/Print-a-page-or-part-of-an-email-message
https://aka.ms/Print-a-page-or-part-of-an-email-message
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Activity instructions 
Participate in the activity by following these instructions: 

1. Observe the demonstration of print preview, print settings, and Microsoft Print to 
PDF. 

2. Ask the teacher clarifying questions. An example is: How can you print a range of 
pages of a message? 

3. Participate in the discussion. 

Try-it: Preview and print message content 
 In this single-level try-it activity, you’ll review the content of a message in the print 

preview. You’ll then print the message to a PDF. 

Resources 
You’ll need the following resource for this try-it: 

• The message with the subject line Staff profiles. 

Instructions 
The following are the general tasks that you must perform during this try-it: 

1. In the Inbox, select the message with the subject line Staff profiles. 

2. Use the Backstage view to preview how the message will print. 

3. Configure the settings to print pages 1 and 2. 

4. Print the pages by using Microsoft Print to PDF. 

5. Save the PDF in your student folder with the file name M2_L2_try_staff_profiles.pdf. 

Topic 2: Reply to or forward an email 
message 

 Email works well for distributing information for people to read, but its real power 
is facilitating two-way communication. You might receive some email that you simply 
read and either delete or save for later. In many cases, however, you'll want to respond 
to a message or share it with others. You have several options to respond to a message 
in Outlook. 
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Use Reply to send a message only to the sender. If you want to reply to the sender and 
all the recipients of the message, use Reply All, which will include every recipient on the 
To and Cc lines of the message. Finally, use Forward to send the message to someone 
who isn’t on the To or Cc lines of the message. 

You can find the Reply, Reply All, and Forward commands on the Home tab in the 
Respond group. The following screenshot depicts the Respond group on the ribbon’s 
Home tab: 

 
Figure 26: The Respond group on the ribbon’s Home tab 

After you select Reply, Reply All, or Forward, you’ll be able to compose your new 
message. If the reply or forwarded message opens in the Reading Pane, select Pop Out 
to open the new message in the Message window, which offers more features for 
composing a message. The following screenshot depicts the Reading Pane with Pop 
Out highlighted: 

 
Figure 27: The Reading Pane with Pop Out highlighted 
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To add or remove recipients, select and edit the To text box and Cc text box. By default, 
Outlook will add “RE:” to the front of the subject line for a reply and “FW:” to the 
beginning of the subject line for a forwarded message. To change the subject line, select 
and edit the Subject text box. 

Outlook will add the original message in the lower part of the message body, leaving a 
little space for you to add your own content. Outlook doesn’t include attachments when 
you use Reply or Reply All, because it’s assumed that the recipients would have 
received the attachments in the original message. If you select Forward, attachments 
are included because you’ll be sending the message to people who didn’t receive the 
original message. After finishing your reply or forward, select Send. 

 

Did you know? 

To access these commands with the keyboard, use these shortcuts: 

• Ctrl+R to Reply. 
• Ctrl+Shift+R to Reply All. 
• Ctrl+F to Forward. 

 

Additional information 

For more information on replying to or forwarding email, go to: Reply to 
or forward an email message 

Activity: Discuss and learn 
In this activity, the group will discuss ways to respond to messages that have been sent 
to multiple people. 

Resources required 
You’ll need the following resources for this activity: 

• None 

Activity instructions 
Participate in the discussion that your teacher prompts. 

  

https://aka.ms/reply-to-or-forward-an-email-message
https://aka.ms/reply-to-or-forward-an-email-message
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Try-it: Reply to or forward an email message 
 In this leveled try-it activity, you’ll practice replying to an email message. You’ll 

either reply by using the ribbon or by using a keyboard shortcut. 

Try-it 1 
In this try-it activity, you’ll respond to an email message by using the ribbon. 

Resources 
You’ll need the following resource for this try-it: 

• The message with the subject line Staff profiles. 

Instructions 
The following are the general tasks that you must perform during this try-it: 

1. In the Inbox, select the message with the subject line Staff profiles. 

2. Use the ribbon to access the Reply command. 

3. In the message body, add the following text before the quoted message: 

Hi Genevieve, 

Thank you for sending these staff profiles. Does our webpage about the no-till 
planting initiative mention the individuals involved in the project? I’d like to 
refer the reporter to that page so they can gather additional information. 

4. Copy the Staff profiles message to M2_module_PST_starter_Firstname_Lastname. 

Try-it 2 
In this try-it activity, you’ll forward an email message by using the keyboard shortcut. 

Resources 
You’ll need the following resource for this try-it: 

• The message with the subject line Staff profiles. 

Instructions 
The following are the general tasks that you must perform during this try-it: 

1. In the Inbox, select the message with the subject line Staff profiles. 

2. Use the keyboard shortcut to access the Forward command. 
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3. Set the To line to eugenia@munsonspicklesandpreservesfarm.com or to your 
teacher's email address as directed. 

4. In the message body, add the following text before the quoted message: 

Hi Eugenia, 

Genevieve sent me these great staff profiles to share with the reporter who is 
doing the feature on our no-till planting initiative. Is it okay to send these all to 
the reporter, or should I remove profiles of staff who aren’t directly involved in 
the initiative? 

5. Copy the Staff profiles message to M2_module_PST_starter_Firstname_Lastname. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Where can you find a preview before you print a message? 

Select the correct option. 

a. Print in the Backstage view 

b. The Print dialog box 

c. The View tab 

2. Which of the following can you specify when printing a message? 

Select all that apply. 

a. A single page to print 

b. Multiple pages to print 

c. A range of pages to print 

d. Print all pages 

3. Select ________________________ to specify which pages you want to print. 

Fill in the blank space. 

4. If a reply or forwarded message opens in the Reading Pane, use 
________________________ to open the message in the Message window. 

Fill in the blank space. 
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Lesson 3: Working with 
message attachments 
Overview 
In this lesson, you'll learn how to preview, open, and save attachments to email 
messages that you receive. You'll also learn how to add and remove attachments with 
messages that you send. The activities, discussions, and demonstrations in this lesson 
will strengthen your learning and give you the opportunity to practice what you learn 
about email attachments. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. An ________________________ is a file that you send as part of a message. 

Fill in the blank space. 

2. Which of the following will not automatically include attachments from the original 
message? 

Select all that apply. 

a. Forward 

b. Reply 

c. Reply All 

3. Which feature can you use to review an email attachment without opening a 
separate app? 

Select the correct option. 

a. Open 

b. Preview 

c. Save 

d. Save As 
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Topic 1: Preview, open, and save 
message attachments 

 Attachments have become a popular way to distribute a variety of files, such as 
images, Office documents, and PDF documents. In the modern workplace, you're likely 
to receive many email attachments, so knowing how to open, review, and save them is 
critical. An email message that includes one or more attachments will have a paper clip 
icon in the message list. 

Outlook also makes it possible to save an email message itself. This is useful when you 
must have a copy of a message that you have received or when you want to save a copy 
of an email that you plan to send. 

Preview an email attachment 
When receiving a message with an attachment, you might want to review it without 
saving the file or opening a different app. If you’re using the Reading Pane, select the 
attachment to preview its contents. The following screenshot depicts a message in the 
Reading Pane with the attachment highlighted: 

 
Figure 28: A message in the Reading Pane with the attachment highlighted 
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To return to the message, select Back to message within the preview, or you can select 
the Attachments tab, and then select Show Message in the Message group. The 
following screenshot depicts the Reading Pane while previewing an attachment with 
Back to message and Show Message highlighted: 

 
Figure 29: The Reading Pane while previewing an attachment with Back to message 
and Show Message highlighted 

Note: This preview feature will only work if you have the same version of Word, 
Microsoft PowerPoint, Microsoft Excel, and Outlook. 

 

Additional information 

For more information on previewing message attachments, go to: 
Preview attachments in Outlook 

Open or save an email attachment 
If you want to open an attachment in a different app, such as Word, double-click the 
attachment or select the drop-down arrow next to the attachment to open the 
attachment menu, and then select Open. The following screenshot depicts the 
attachment menu with Open highlighted: 

https://aka.ms/Preview-attachments-in-Outlook
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Figure 30: The attachment menu with Open highlighted 

You can also save attachments so that you have copies of those attachments on your 
computer, which you can then open to review or edit. Any changes that you make will 
only affect your saved copy of the file and won’t affect the attachment itself. 

Select the drop-down arrow next to the attachment to open the attachment menu. To 
save only the current attachment, select Save As, and then choose a location in the 
Save As dialog box. To save all attachments from the current message, select Save All 
Attachments. The following screenshot depicts the attachment menu with Save As and 
Save All Attachments highlighted: 
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Figure 31: The attachment menu with Save As and Save All Attachments highlighted 

If you select the Save All Attachments option, the Save All Attachments dialog box 
opens. By default, all attachments in a message are selected, but you can cancel the 
selection for any files you don’t want to save. The following screenshot depicts the Save 
All Attachments dialog box: 
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Figure 32: The Save All Attachments dialog box 

 

Did you know? 

You can also save an attachment by dragging the attachment from 
the message to your desktop or another location in File Explorer. 

 

Additional information 

For more information on opening message attachments, go to: Open 
or save attachments 

Save an email message as a file 
As you compose an email, Outlook automatically saves a copy in your Drafts folder until 
you send it. You can also save a message to a file, whether it’s a draft, a sent message, 
or a message that you received. 

https://aka.ms/open-or-save-attachments
https://aka.ms/open-or-save-attachments
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To save a message, you must first select it in the Mail Pane. You can also double-click 
the message or select it, and then select Enter to open it in the Message window. Select 
File on the ribbon, and then select Save As in the Backstage view to open the Save As 
dialog box. In the Folder Pane, navigate to the location where you want to save the file. 
The file name will default to the subject line of the email, but you can change it by 
selecting the File name box and editing the text. The following screenshot depicts the 
Save As dialog box in Outlook: 

 
Figure 33: The Save As dialog box in Outlook 

 

Did you know? 

You can save a message in a different format by changing the Save 
as type in the Save As dialog box. If you save a message as an HTML 
file, you can open it Word. 
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Additional information 

For more information on saving an email as a file, go to: Save a 
message as a file 

Activity: Pose a challenge 
In this activity, you’ll explore the ways to handle attachments in an incoming email. 

Resources required 
You’ll need the following resource for this activity: 

• Locate the message with the subject line Staff images. 

Activity instructions 
Participate in the activity by following these instructions: 

1. In the Inbox, select the message with the subject line Staff images. 

2. Try different ways to preview, open, and save the two message attachments. 

3. As directed by the teacher, share the techniques that you used with the group. 

Try-it: Preview, open, and save message 
attachments 

 In this leveled try-it activity, you’ll practice different approaches to handling files 
that are attached to incoming messages. You’ll preview an attachment in Outlook or 
save an attachment to your computer for offline review. 

Try-it 1 
In this try-it activity, you’ll preview an attachment in Outlook. 

Resources 
You’ll need the following resource for this try-it: 

• The message with the subject line No-till blueberries. 
  

https://aka.ms/save-a-message-as-a-file
https://aka.ms/save-a-message-as-a-file
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Instructions 
The following are the general tasks that you must perform during this try-it: 

1. In the Inbox, select the message with the subject line No-till blueberries. 

2. Preview the contents of the PDF attachment. 

3. Copy the No-till blueberries message to 
M2_module_PST_starter_Firstname_Lastname. 

Try-it 2 
In this try-it, you’ll save a message attachment so that you can review it offline and 
outside of Outlook. 

Resources 
You’ll need the following resource for this try-it: 

• The message with the subject line No-till blueberries. 

Instructions 
The following are the general tasks that you must perform during this try-it: 

1. In the Inbox, select the message with the subject line No-till blueberries. 

2. Save the PDF attachment to your student folder. 

3. Copy the No-till blueberries message to 
M2_module_PST_starter_Firstname_Lastname. 

Topic 2: Add and remove message 
attachments 

 When you want to send a file by email, you can include it as an attachment. The 
process is the same whether it’s a new message, a reply, or a forwarded message. Select 
New Email to open a new message in the Message window. Select the Message tab, 
and then select Attach File in the Include group. Outlook will display a list of recent 
items and options to attach a file from the web or from a location on your device. Select 
Browse This PC and choose the file that you want to attach. To attach multiple files, 
simply repeat the steps for each additional file. The following screenshot depicts the 
Attach File options: 
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Figure 34: The Attach File options 

Before you send the message, you can also remove an attachment. Select the drop-
down arrow for the attachment that you want to remove. On the menu that appears, 
select Remove Attachment. The following screenshot depicts the attachment menu 
with Remove Attachment highlighted: 

 
Figure 35: The attachment menu with Remove Attachment highlighted 
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Video 

To review the video on adding and removing email attachments, go 
to: Sending and receiving attachments 

Activity: Guess and tell 
In this activity, you’ll discuss limitations on message attachments. 

Resources required 
You’ll need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. As directed by the teacher, guess what kinds of files can and can’t be sent as email 
attachments. How do you think those limitations are determined? 

2. Share your guesses with the group. 

Try-it: Add and remove message attachments 
 In this leveled try-it activity, you’ll practice working with attachments to a message 

that you’re preparing to send. You’ll add an attachment to the message or remove an 
attachment from it. 

Try-it 1 
In this try-it, you’ll add an attachment to an email message that already includes a 
couple of attachments. 

Resources 
You’ll need the following resources for this try-it: 

• The message with the subject line Information for the media. 
• Farmer_Danielle_Gousse_agricultural_technologist_illustration.png in the Media 

folder. 
  

https://aka.ms/Sending_and_receiving_attachments
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Instructions 
The following are the general tasks that you must perform during this try-it: 

1. In the Drafts folder, select the message with the subject line Information for the 
media. 

2. Add the Farmer_Danielle_Gousse_agricultural_technologist_illustration.png file 
as an attachment. 

3. Copy the Information for the media message to 
M2_module_PST_starter_Firstname_Lastname. 

Try-it 2 
In this try-it, you’ll remove an attachment from an email message that already includes a 
couple of attachments. 

Resources 
You’ll need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you must perform during this try-it: 

1. In the Drafts folder, select the message with the subject line Information for the 
media. 

2. Remove the Staff_profiles.pdf attachment. 

3. Copy the Information for the media message to 
M2_module_PST_starter_Firstname_Lastname. 

Detach the module .pst file 
After you complete all try-its, you must detach your .pst file so your teacher can assess 
your work. To do this:  

1. In Outlook, on the Navigation Bar, select the ellipsis (Navigation Menu button), 
and then select Folders. 

2. Locate the folder called M2_module_PST_starter_Firstname_Lastname, and right-
click or access the context menu for the folder. 

3. On the context menu, select Close 
“M2_module_PST_starter_Firstname_Lastname”. 
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4. On your computer, open File Explorer, and then go to the path where the .pst file
resides.

5. Right-click or access the context menu for the file, and then select Rename.

6. Append your name to the end of the existing file name by using underscores instead
of spaces. For example, enter _Firstname_Lastname. The filename should now
resemble M2_module_PST_starter_Firstname_Lastname.

7. Copy the .pst file to the designated location for assessment.

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. How can you preview an email attachment?

Select the correct option.

a. Select the attachment

b. Double-click the attachment, or select it and then select Enter

c. Use the View tab on the ribbon

2. Which of the following is true of an attachment that you receive in a message?

Select the correct option.

a. Changes that you make to the file will affect all recipients' copies of the file

b. Changes that you make to the file will affect the sender's copy of the file

c. Changes that you make to the file won’t affect any other copies

3. When previewing an attachment, which command returns you to the body text of
the message?

Select all that apply.

a. Exit

b. Back to message

c. Remove Attachment

d. Show Message

4. When previewing an attachment, use ________________________ to return to the
message body.

Fill in the blank space.
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5. Use ________________________ to save a copy of a message to a file. 

Fill in the blank space. 

Glossary 
@mention A tag in the text of an email message that helps get the attention of 

an individual recipient. 

Attachment A file included with an email message. 

Blind courtesy 
copy 

A copy of an email message sent to a recipient not on the To or Cc 
lines. Other recipients won’t receive the name or email address of any 
blind copy recipient. 

Draft An email message that hasn’t yet been sent. Outlook automatically 
saves these in the Drafts folder. 

Follow Up flag A visual indicator that you must remember a response or task related 
to a message. 

Forward A copy of a message sent to an individual who didn’t originally 
receive it. 

read receipt A feature used to confirm that a sent message has been opened by a 
recipient. 

Reply A response sent only to the sender of a message. 

Reply All A response sent to all recipients on a message's To and Cc lines. 

Table 2: Glossary terms and definitions 
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Cornerstone 
Overview 
In this Cornerstone, you’ll manage communications that are related to the Farm’s no-till 
planting initiative and use of cover crops to prevent soil erosion. You’ll create, respond 
to, and forward email messages. You’ll also manage attachments for both incoming and 
outgoing messages, and you’ll format the content of messages that you’re composing. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding 
Microsoft Office Specialist (MOS) exam objectives. 

Cornerstone project objective MOS exam objectives 

Compose emails, add content, and format 
the content in emails. 

• 2.1.2: Designate recipients by using 
courtesy copy (CC) and blind courtesy 
copy (BCC) 

• 2.1.3: Use @mention to get someone’s 
attention 

• 2.1.5: Flag outgoing messages for 
follow-up 

• 2.1.6: Set the importance and 
sensitivity of outgoing messages 

• 2.2.1: Insert hyperlinks 
• 2.2.2: Insert images 

Reply to and forward email messages. • 1.4.2: Save message attachments 
• 2.1.4: Forward and reply to messages 

Add attachments to outgoing messages 
and manage attachments to incoming 
messages. 

• 1.4.4: Save messages in alternative 
formats 

• 2.1.1: Add or remove message 
attachments 

Table 3: Cornerstone objectives 

Duration 
50 minutes 
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Attach the Cornerstone .pst file  
To complete this Cornerstone, you must attach this .pst file into Outlook before you can 
perform any tasks. You’ll also store the results of your tasks in this .pst file so that your 
teacher can assess your working by examining that file. 

To open the .pst file in Outlook: 

1. Open Outlook. 

2. Select the File tab, and then select Open & Export. 

3. In the Open pane, select Open Outlook Data File. 

4. In the Open Outlook Data File dialog box, use the navigation pane to locate the .pst 
files provided by your instructor for your use throughout this module of the course. 

5. Open the file named M2_cornerstone_PST_starter. Note that a folder 
M2_cornerstone_PST_starter is now available in the navigation pane. This folder 
contains any required starter elements for the Cornerstone, such as emails, calendar 
appointments, tasks, and contacts. 

6. Right-click or access the context menu for the M2_cornerstone_PST_starter folder, 
and then select Properties. 

7. In the M2_cornerstone_PST_starter Properties dialog box, select Advanced. 

8. In the Outlook Data File dialog box, in the Name box, append your name to the 
end of the existing name by using underscores instead of spaces. For example, enter 
_Firstname_Lastname. The folder name should now resemble 
M2_cornerstone_PST_starter_Firstname_Lastname. 

9. Select OK twice. 
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Copy content into the Cornerstone .pst 
file 
As you proceed through this Cornerstone’s tasks, you should copy the resulting 
elements, such as emails, calendar appointments, tasks, and contacts, to the 
M2_cornerstone_PST_starter_Firstname_Lastname folder by using the following 
instructions: 

1. After you attach the .pst file, you should be able to observe duplicate folders for 
items such as emails, calendar appointments, tasks, and contacts. 

2. After you complete a try-it exercise, select your resulting items in the navigation 
pane. Make sure you select the items that are associated with your email account. 

3. In the details pane, right-click or access the context menu for each item, and then, 
select Copy or select Ctrl+C. 

4. Select the M2_cornerstone_PST_starter_Firstname_Lastname folder. 

5. Select Ctrl+V to copy the item to the .pst file. 

6. Repeat steps 3 through 5 for any additional items that you want to copy. 

Instructions 
1. Complete the following tasks for each file. 

2. When you finish the Cornerstone, assess your completion, and then enter the points 
you think you earned within the following task lists. You can get your teacher’s help 
if necessary. 

Tasks 
In addition to M2_cornerstone_PST_starter.pst, you’ll also need 
Munsons_logo_banner_large_illustration.png from the Media folder under Student 
Materials. 

The following sections describe the tasks you’ll need to do for this Cornerstone. 
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File 1: M2_cornerstone_PST_starter.pst 
Task: Compose email, add content, and format the content in 
emails (6 points) 
1. Create a new email message to marcos@munsonspicklesandpreserves.com with 

the subject line set to When do we plant the cover crops? Use the Cc line to 
include danielle@munsonspicklesandpreserves.com and 
eugenia@munsonspicklesandpreserves.com. The body of the message should 
read: 

Hi Marcos, 
I’m putting together some information to share with the community about our 
use of cover crops to prevent erosion on the hillier parts of the farm. When will 
we plant our cover crops this year? 

(1 point) (Exam objective 2.1.2) 

2. Add a flag to this new message reminding you to follow up next week. (1 point) 
(Exam objective 2.1.5) 

3. Set this new message to Low Importance, and then save a draft. (1 point) (Exam 
objective 2.1.6) 

4. Find the draft message with the subject Cover crops overview. Style the following 
three lines of text as Heading 1: Field 1, Field 4, and Field 7. Add an @mention for 
eugenia@munsonspicklesandpreservesfarm.com before the line that reads For 
your review. (1 point) (Exam objective 2.1.3) 

5. Insert the Munsons_logo_banner_large_illustration.png picture from the Media 
folder in the message body after the line of text that reads Learn more about the 
Farm. (1 point) (Exam objective 2.2.2) 

6. Make the text in the message body that reads Learn more about the Farm into a 
hyperlink to http://www.munsonspicklesandpreservesfarm.com. Save a draft of 
this message. (1 point) (Exam objective 2.2.1) 

Points scored: ________ /6 
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Task: Reply to and forward email messages (3 points) 
1. In the Inbox folder, find the message with the subject line Personnel working on 

the cover crops. Save the Pick_your_own.pdf attachment to your student folder. (1 
point) (Exam objective 1.4.2) 

2. Forward the Personnel working on the cover crops message with 
eugenia@munsonspicklesandpreservesfarm.com as the recipient. Add the 
following text to the message body: Here is the profile that we want to use. Can 
you please add a sentence or two about your interest in cover crops? (1 point) 
(Exam objective 2.1.4) 

3. In the Inbox folder, find the message with the subject Cover crops planting 
timeline Reply to all recipients, and then add the following to the beginning of the 
message body: I’ve requested this information and will let everyone know when 
I receive it. (1 point) (Exam objective 2.1.4) 

Points scored: ________ / 3 

Task: Add attachments to outgoing messages and manage 
attachments to incoming messages (3 points) 
1. Create a new message to ivan@munsonspicklesandpreserves.com with the subject 

line Proofreading request. Attach profile.docx from the previous task, and then 
add the following text to the message body: Can you please proofread this before 
we send it out? (1 point) (Exam objective 2.1.1) 

2. In the Drafts folder, find the message with the subject line Files for review. Remove 
the attachment named profile.docx. (1 point) (Exam objective 2.1.1) 

3. Add eugenia@munsonspicklesandpreservesfarm.com to the To line. 

4. Save the message as a file named M2_cornerstone_draft.msg. (1 point) (Exam 
objective 1.4.4) 

Points scored: ________ / 3 

TOTAL POINTS: ________ / 12 
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Detach the Cornerstone .pst file 
After you complete all tasks, you must detach your .pst file so that your teacher can 
assess your work. To do this: 

1. In Outlook, on the Navigation Bar, select the ellipsis (Navigation Menu button), 
and then select Folders. 

2. Locate the folder called M2_cornerstone_PST_starter_Firstname_Lastname, and 
right-click or access the context menu for the folder. 

3. On the context menu, select Close 
“M2_cornerstone_PST_starter_Firstname_Lastname”. 

4. On your computer, open File Explorer, and go to the path where the .pst file resides. 

5. Right-click or access the context menu for the file, and then select Rename. 

6. Append your name to the end of the existing file name by using underscores instead 
of spaces. For example, enter _Firstname_Lastname. The filename should now 
resemble M2_cornerstone_PST_starter_Firstname_Lastname. 

7. Copy the .pst file to the designated location for assessment. 
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Module overview 
Description 
Email is a vitally important communication tool in the modern workplace. With its 
prevalence in almost every aspect of your life, you might sometimes feel overwhelmed 
by all the email you receive. In this module, you’ll learn how to use Microsoft Outlook 
2019 to manage the messages in your Inbox. You’ll learn about Instant Search, filters, 
and Search Folders to quickly find the messages you need. You’ll also practice using 
folders, follow-up flags, and color categories to set up an organization system. And 
you’ll learn how to delete and recover messages. 

Lesson Learning objective Exam objective(s) 

Viewing email Observe mail messages with different views. • 2.3.1 
• 2.3.7 

Managing 
conversations 

Manage email conversations.  • 2.3.6 
• 2.3.7 

Tagging 
messages for 
action 

Categorize and follow up on messages. • 2.3.4 
• 2.3.5 

Searching and 
finding 
messages 

Search for content with specific criteria and 
locations. 

• 1.3.1 
• 1.3.2 
• 1.3.3 

Organizing 
messages with 
folders 

Organize messages by using folders. • 2.3.2 
• 2.3.3 

Deleting and 
recovering 
messages 

Remove and retrieve messages from 
mailbox folders. 

None  
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Lesson Learning objective Exam objective(s) 

Cornerstone: 
Managing 
festival 
communications 

Manage, tag, find, move, and organize email 
messages. 

• 1.3.1 
• 1.3.2 
• 2.3.1 
• 2.3.2 
• 2.3.3 
• 2.3.4 
• 2.3.5 
• 2.3.6 
• 2.3.7 

Table 1: Objectives by lesson 

Scenario 
A highlight of the summer at Munson’s Pickles and Preserves Farm is the Blueberries 
and Balloons Festival. The festival has been an annual attraction for many years. 
Thousands of people attend the festival and enjoy the fun family activities and good 
food. 

As the Media and Communications intern, it’s now your job to manage the festival 
communications. It’s a big job! Your mailbox is filling up quickly and you don’t want to 
miss urgent messages. It’s time to get organized. 

Cornerstone 
This module concludes with a cornerstone, in which you'll manage communications for 
the Blueberries and Balloons Festival. In the cornerstone you will search, sort, filter, and 
delete messages. You will work with conversations and follow-up flags, in addition to 
folders and Search Folders. 
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Lesson 1: Viewing email 
Overview 
In this lesson, you’ll learn how to customize how you observe messages by using sorts 
and filters. You'll change the way email is sorted in a folder, apply filters, and use the 
Focused Inbox to keep your most important messages separate. The activities, 
discussions, and demonstrations in this lesson will strengthen your learning and give 
you the opportunity to practice what you learn about observing email. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which of the following features separates your Inbox into two separate tabs? 

Select the correct option. 

a. Arrange By 

b. Filter 

c. Focused Inbox 

d. Sort 

2. Which command switches between ascending sort order and descending sort order? 

Select the correct option. 

a. Invert Sort 

b. Change Sort 

c. Reverse Sort 

d. Unread/Read 

e. Filter 
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3. What are the options for filtering a folder in Outlook? 

Select all that apply. 

a. All Mail 

b. Read Mail 

c. Unread Mail 

d. Mentioned Mail 

e. Flagged Mail 

4. To sort alphabetically by the sender's name, arrange by the ________________________ 
field. 

Fill in the blank space. 

5. On the ________________________ tab of the ribbon, you can find the commands for 
altering the way the message list is arranged and sorted. 

Fill in the blank space. 

6. After you open a message, Outlook marks it as ________________________. 

Fill in the blank space. 

Attach the module .pst file 
To provide the most effective learning experience, this module includes several starter 
elements such as email, calendar appointments, tasks, and contacts. These elements are 
stored in an external Outlook Data File, or .pst file. It resides in a location that your 
teacher will provide. To complete this module, you must attach this .pst file into Outlook 
before you can perform any try-its. You’ll also store the results of your try-its in this .pst 
file. This allows your teacher to assess your work by examining the .pst file’s contents.  

To open the .pst file in Outlook:  

1. Open Outlook. 

2. Select the File tab, and then select Open & Export. 

3. In the Open pane, select Open Outlook Data File. 

4. In the Open Outlook Data File dialog box, use the navigation pane to locate the .pst 
files provided by your instructor for your use throughout this module of the course. 
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5. Open the file named M3_module_PST_starter. Note that a folder 
M3_module_PST_starter is now available in the navigation pane. This folder 
contains any required starter elements for the module, such as email, calendar 
appointments, tasks, and contacts. 

6. Right-click or access the context menu for the M3_module_PST_starter folder, and 
then select Data File Properties. 

7. In the M3_module_PST_starter Properties dialog box, select Advanced. 

8. In the Outlook Data File dialog box, in the Name box, append your name to the 
end of the existing name by using underscores instead of spaces. For example, enter 
_ Firstname_Lastname. The folder name should now resemble 
M3_module_PST_starter_ Firstname_Lastname. 

9. Select OK twice. 

Topic 1: Sort and arrange email 
 Email is a key part of the modern workplace, and it's important to know how to 

sort your messages in the order that's most helpful to you. If you want to read all the 
messages you received from one person, you could sort with From. If you need to find a 
message you received last week but you can't remember who sent it, you could sort 
with By Date. 

Select an Arrange By field 
To change the sort order of the current mailbox, select Sort, Arrange, or Filter drop-
down menu in the mail pane, and then in the Arrange by section, select the sort field 
you want. The following screenshot depicts the mail pane with the Sort, Arrange, or 
Filter drop-down menu highlighted. 
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Figure 1: The mail pane with the Sort, Arrange, or Filter drop-down menu highlighted 

You can also arrange the messages by using commands on the ribbon. Select the View 
tab, and then in the Arrangement group, select the More command, which is depicted 
as a down-arrow, to expand the Arrangement gallery. (For some users, the gallery 
might already display.) From here, you can select the option you want to sort by, as the 
following screenshot depicts. 
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Figure 2: The Arrangement gallery after selecting More to expand the options 

Finally, you can select an arrangement from the column headers in the mail pane. Right-
click or access the context menu for the list heading, select Arrange By, and then select 
the field you want to use for arranging the messages. The following screenshot depicts 
the list heading context menu with Arrange By selected to activate the list of options. 

 
Figure 3: The list heading context menu with Arrange By selected to activate the list of 
options 
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Did you know? 

You can also set the Arrange By order by selecting the name of the 
field in the list headings of the mail pane.  

Select a sort order 
In addition to selecting the field you use to sort your messages, you can also choose to 
display the messages in ascending or descending order. For example, you can sort 
names from A to Z or from Z to A. 

To toggle between ascending and descending order, select the Sort Messages 
command. You can also change the sort order by selecting Sort, Arrange, or Filter to 
open the drop-down menu of options, and then select the order you want in Sort. The 
Sort section will always include two options, but the text will change depending on the 
Arrange by option you have selected. For example, if you have selected Date, the 
choices will be Oldest on Top and Newest on Top, but if you select From, the options 
will be A to Z and Z to A. The following screenshot depicts the Sort, Arrange, or Filter 
drop-down menu, with the Sort options highlighted. 
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Figure 4: The Sort, Arrange, or Filter drop-down menu, with the Sort options highlighted 

To change the sort order by using the ribbon, select the View tab, and then in the 
Arrangement group, select Reverse Sort. The following screenshot depicts the 
Arrangement group with Reverse Sort highlighted. 

 
Figure 5: The Arrangement group with Reverse Sort 
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To reverse the sort order by using the list heading in the mail pane, right-click or access 
the context menu for the list field heading in the mail pane. On the context menu, select 
Reverse Sort, as the following screenshot depicts. 

 
Figure 6: The list field heading context menu with Reverse Sort highlighted 

 

Did you know? 

You can choose different Arrange by and Sort selections for each 
folder in your mailbox, and Outlook will remember your choices for 
each different folder. 

Activity: Discuss and learn 
In this activity, the group will discuss different ways to arrange and sort email messages. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Participate in the discussion led by the teacher. 

2. Sort the messages in the Inbox folder as directed by the teacher. 
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Try-it: Sort and arrange email 
 In this leveled try-it activity, you’ll practice applying a new sort order to an email 

folder. 

Try-it 1 
In this try-it, you’ll use the drop-down menu from the Sort, Arrange, or Filter and Sort 
Messages commands to configure the arrangement of mail messages. 

Resources 
You will need the following resource for this try-it: 

• Messages in the L1_Inbox folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L1_Inbox folder. 

2. Use the Sort, Arrange, or Filter command to identify the current Arrange By 
settings. 

3. Change the settings to arrange the folder using the From field. 

4. Use the Sort Messages command to reverse the sort so that names are ordered 
from Z to A. 

Try-it 2 
In this try-it, you’ll use the context menu from the list headings in the mail pane to 
configure the arrangement of mail messages. 

Resources 
You will need the following resource for this try-it: 

• Messages in the L1_Inbox folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L1_Inbox folder. 

2. Use the context menu from the list headings in the mail pane to identify the current 
Arrange By settings. 
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3. Change the settings to arrange the folder using the From field. 

4. Use the same context-menu to select Reverse Sort to reverse the sort so that names 
are ordered from Z to A. 

Try-it 3 
In this try-it, you’ll use commands on the View tab of the ribbon to configure the 
arrangement of mail messages. 

Resources 
You will need the following resource for this try-it: 

• Messages in the L1_Inbox folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L1_Inbox folder. 

2. Select Attachment (paperclip icon) in the list headings of the mail pane. Observe 
that this arranges the mailbox so that messages are arranged by file attachment size, 
with larger files listed first. 

3. Navigate to the View tab, and select the More command to expand the 
Arrangement gallery. Notice that Size is selected. 

4. Select From in the Arrangement gallery, and then reverse the sort order. 

Topic 2: Filter email 
Arranging your messages to suit your preferences can help organize your Inbox and 
other folders, but you might still find that you have a lot of messages to go through. 
With Outlook, you can quickly narrow down the list to help you find the messages that 
matter to you right now. 

Outlook provide easy ways to filter the mail pane to display only the messages you 
haven't read, messages in which you are mentioned, or all messages in a folder. 
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To apply a filter to a folder, in the mail pane select the Sort, Arrange, or Filter drop-
down menu, and then select the Filter option you want. Selecting the All Mail option 
will remove the filter and display every message in the folder. Unread Mail will display 
only those messages in the folder that are marked as unread, and Mentioned Mail will 
display only the messages in the folder in which you are tagged with an @mention. The 
following screenshot depicts the mail pane with the Sort, Arrange, or Filter drop-down 
menu and the Filter options highlighted. 

 
Figure 7: The mail pane with the Sort, Arrange, or Filter drop-down menu activated and 
the Filter options highlighted 
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Additional information 

For more information on filtering messages, go to: View only unread 
messages 

Mark a message as read or unread 
Outlook marks each new email message you receive as Unread. After you open and 
read a message in the Reading Pane or open it in the Message window, Outlook marks 
the message as Read. The mail pane lists unread messages in bold and as you've 
learned, you can filter the email to only display those messages. 

Denoting messages as Unread or Read is often good enough, but sometimes you 
might want to change the status of a message yourself. For example, if you quickly 
review message but know you need to read it more carefully later, you might want to 
mark it again as Unread. And if you know the contents of an email before you read it 
but don't want to delete the message, you might want to mark it as Read. 

To mark a message as Unread or Read, select the Home tab, and then in the Tags 
group, select Unread/Read. This will switch the status of the email between Unread and 
Read. The following screenshot depicts the Tags group with the Unread/Read option 
highlighted. 

 
Figure 8: The Tags group with Unread/Read highlighted 

 

Did you know? 

You can also mark a message as read or unread by using keyboard 
shortcuts. Select a message, and then select Ctrl+U to mark it as 
Unread. Select Ctrl+Q to mark it as Read. 

  

https://aka.ms/View-only-unread-messages
https://aka.ms/View-only-unread-messages
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To mark a message as read or unread using a context menu, right-click or access the 
context menu for the message, and then select Mark as Read or Mark as Unread. The 
following screenshot depicts an email message’s context menu with Mark as Unread 
highlighted. 

 
Figure 9: Email message context menu with Mark as Unread highlighted 

 

Additional information 

For more information on marking messages as read or unread, go to: 
Mark a message as read or unread 

Activity: Show and tell 
In this activity, your teacher or a fellow student will demonstrate how to apply a filter to 
a folder. 

Resources required 
You will need the following resources for this activity: 

• None 

https://aka.ms/Mark-a-message-as-read-or-unread
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Activity instructions 
Participate in the activity by following along with the teacher’s demonstration. Ask any 
clarifying questions you might have. 

Try-it: Filter email 
 In this standalone try-it activity, you'll apply a filter to a folder and mark a 

message as read or unread. 

Resources 
You will need the following resource for this try-it: 

• Messages in the L1_Inbox folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L1_Inbox folder. 

2. Filter the folder to display only Mentioned Mail. 

3. Mark the only message displayed as Read. 

4. Filter the folder to display only Unread messages. 

Topic 3: Use the Focused Inbox 
 Even with filters and sorting, sometimes you might just get too many emails! In the 

modern workplace, inboxes fill up quickly and you might not be able to keep up. This is 
especially true if you spend time away from your computer like many of the staff at 
Munson's Pickles and Preserves Farm, who spend their days out in the fields. With so 
much incoming email, it's difficult to know what you need to focus on. 

The Focused Inbox feature separates the messages in your Inbox into two groups: 
Focused, and Other. Important and time-sensitive messages get placed on the Focused 
tab, while the rest of your messages go to the Other tab where they are out of the way 
but still easy to find. Focused Inbox uses an algorithm to intelligently determine which 
messages go to Focused. Each time you move a message from one tab to the other, 
Outlook gets better at sorting new messages the way you want. 
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Turn Focused Inbox on or off 
To enable or disable Focused Inbox, select the Inbox folder, and then select the View 
tab. In the Focused Inbox group, you can use the Show Focused Inbox command to 
toggle Focused Inbox on or off. The following screenshot depicts the Focused Inbox 
group with Show Focused Inbox selected. 

 
Figure 10: The Focused Inbox group with Show Focused Inbox selected 

You can also toggle Focused Inbox from the mail pane. To do so, select the Sort, 
Arrange, or Filter drop-down menu, and then select Show Focused Inbox. The 
following screenshot depicts the Sort, Arrange, or Filter drop-down menu with Show 
Focused Inbox highlighted. 
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Figure 11: The Sort, Arrange, or Filter drop-down menu with Show Focused Inbox 
highlighted 

After you turn it on, Focused Inbox will add the Focused tab and the Other tab to the 
mail pane. The following screenshot depicts the mail pane with the Focused and Other 
tabs highlighted. 
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Figure 12: The mail pane with the Focused and Other tabs highlighted 

Move a message between Focused and Other 
To move a message from Focused to Other, right-click or access the context menu for a 
message in Focused, and then select Move to Other. If you want all future messages 
from the sender to go to Other, select Always Move to Other. The following 
screenshot depicts the message context menu with Move to Other and Always Move 
to Other highlighted. 
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Figure 13: The message context menu with Move to Other and Always Move to Other 
highlighted 

If you’re moving a message from Other to Focused, the context menu will include 
Move to Focused and Always Move to Focused. 

 

Video 

To review the video on Focused Inbox, go to: Focused Inbox for 
Outlook 

Activity: Tell a story 
In this activity, the teacher will engage the class in a discussion related to Focused 
Inbox. 

  

https://aka.ms/Focused-Inbox-for-Outlook
https://aka.ms/Focused-Inbox-for-Outlook
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Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the group discussion. Then, observe the teacher’s demonstration or video 
and Ask any clarifying questions you might have. 

Try-it: Use the Focused Inbox 
 In this leveled try-it activity, you’ll either use, or explain how to use Focused Inbox. 

Try-it 1 
In this try-it activity, you’ll describe the function and use of Focused Inbox. 

Note: Complete this try-it if you do not have access to an email account with Focused 
Inbox. If you have this feature, you should complete Try-it 2. 

Resources 
You will need the following resources for this try-it: 

• None 

Instructions 
As directed by the teacher, answer the following questions in a Microsoft Word 
document or on a sheet of paper: 

1. In two to four sentences, explain how Focused Inbox changes the Inbox. 

2. Explain how to move a message from Focused to Other. 

Try-it 2 
In this try-it activity, you’ll practice enabling and disabling Focused Inbox and explore 
how it changes Inbox. 

Note: If the email account you use with Outlook doesn’t support Focused Inbox, you 
should complete Try-it 1. 

Resources 
You will need the following resource for this try-it: 

• An email account that supports Focused Inbox 
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Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. On the View tab of the ribbon, in the Focused Inbox group, select Show Focused 
Inbox to enable Focused Inbox. 

2. Select Other and observe the messages in the Other inbox. Then, select Focused 
and observe which messages display there. 

3. As time allows, move messages from Focused to Other. You can also move 
messages from Other to Focused. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Which of the following is not an option for the Arrange By setting? 

Select the correct option. 

a. Date 

b. From 

c. Junk 

d. Subject 

2. Which folders can use the Focused Inbox feature? 

Select all that apply. 

a. Any Outlook mail folder 

b. Drafts 

c. Inbox 

d. Sent 

3. Which of the following actions can you use to mark an email as read or unread? 

Select all that apply. 

a. A keyboard shortcut  

b. A command on the Home tab 

c. A command on the View tab 

d. The context menu for a message 

e. The Follow Up Flag command 
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4. To apply an Arrange By setting from the ribbon, select an option from the
________________________ gallery.

Fill in the blank space.

5. The Focused Inbox separates all Inbox messages into the Focused tab and the
________________________ tab.

Fill in the blank space.

6. To review only those messages in which you’re tagged with an @mention, use the
________________________ filter.

Fill in the blank space.
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Lesson 2: Managing 
conversations 
Overview 
In this lesson, you’ll learn about Outlook features for managing email conversations, 
including Conversation Clean Up and Ignore Conversation. The activities, discussions, 
and demonstrations in this lesson will strengthen your learning and give you the 
opportunity to practice what you learn about managing conversations. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. What is a group of messages that share the same subject line? 

Select the correct option. 

a. Conversation 

b. Thread 

c. Spam 

d. Group 

2. Which command is used to group conversations in the mail pane? 

Select the correct option. 

a. Filter 

b. Sort 

c. Show as Conversation 

d. Clean Up Conversation 

e. Clean Up Folder 

3. The Conversation Clean Up command will ________________________ duplicate 
messages in a conversation. 

Fill in the blank space. 
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4. The ________________________ tab on the ribbon contains the Show as Conversation
command.

Fill in the blank space.

Topic 1: Use Conversation view 
 Email is a useful way to send information to one or more individuals, but its real 

power is in enabling discussion involving multiple people that goes back and forth. For 
example, you can send an email out to your classmates asking for help with a concept 
from your science class that you don't understand. You could get responses from 
several other students, some offering suggestions and others saying that they need help 
as well. However, as these students respond to one another, they are generating many 
messages, and those messages can clutter up your Inbox. 

Outlook considers all these messages part of a single conversation, and by default it 
groups them together in the mail pane to help you stay organized and to keep them 
separated from other, unrelated messages. 

A Conversation includes all messages that have the same Subject. If someone changes 
the subject when they respond, their message will not be grouped with the rest of the 
messages in the Conversation. 

To turn the Conversation feature on or off, select the View tab of the ribbon, and then 
in the Messages group, select the Show as Conversations check box. The following 
screenshot depicts the Messages group with the Show as Conversations check box 
selected. 

Figure 14: The Messages group with Show as Conversations check box selected 

When you select the Show as Conversations check box, Outlook will activate a dialog 
box asking if you wish to apply the change to all mailboxes, or just the current mailbox. 
The following screenshot depicts the dialog box for selecting This folder or All 
mailboxes. 
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Figure 15: The dialog box for selecting This folder or All mailboxes 

When you have received messages with the same Subject, Outlook will automatically 
create a Conversation for the messages and group them together. This grouping is 
indicated with an expand/collapse (triangle) icon. Select this icon to expand or collapse 
the conversation. The following screenshot depicts the mail pane with the 
expand/collapse icon called out for the Blueberries and Balloons Conversation. 

 
Figure 16: The mail pane with the expand/collapse icon called out for the Blueberries 
and Balloons conversation 

 

Additional information 

For more information on arranging email messages by conversation, 
go to: View email messages by conversation 

https://aka.ms/View-email-messages-by-conversation
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Activity: Show and tell 
In this activity, your teacher or a fellow student will demonstrate Conversations in 
Outlook. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following along with the teacher’s demonstration. Ask any 
clarifying questions you might have. 

Try-it: Use Conversation view 
 In this standalone try-it, you’ll practice using conversations to organize messages 

within an email folder. 

Resources 
You will need the following resource for this try-it: 

• Messages in the L2_Inbox folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L2_Inbox folder. 

2. Turn on Conversations and apply the setting to This folder. 

3. Observe the change in the Inbox. Practice collapsing and expanding conversations 
to examine how this changes the Conversations display. 

Topic 2: Clean up conversations 
As more people reply to messages in a Conversation, messages will start adding up in 
your Inbox. In most cases, each reply will include complete copies of the previous 
messages in the Conversation. For example, Marcos sends out a message to all of the 
employees on the farm. Genevieve replies, and then Fen replies to Genevieve's message. 
Fen's message will include both Genevieve's response and Marcos' original message. 
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The Conversation Clean Up feature will check the Conversation for these kinds of 
duplications and will delete all the messages that are included in the replies. This makes 
your Inbox a lot easier to manage! To clean up your conversations, select the Home tab 
on the ribbon, and then in the Delete group, select Clean Up to activate a drop-down 
menu of the following Clean Up options: 

• Clean Up Conversation removes duplicate messages in the current Conversation. 
• Clean Up Folder removes duplicate messages in all conversations in the folder. 
• Clean up Folder & Subfolders removes duplicate messages in all conversations in 

the current folder and any folders it contains. 

The follow screenshot depicts the Clean Up options. 

 
Figure 17: Clean Up drop-down menu options 

A dialog box displays the option you have chosen. If you select Clean Up Conversation, 
the Clean Up Conversation dialog box appears from which you would select Clean Up, 
as in the following screenshot. 

 
Figure 18: The Clean Up Conversation dialog box 

 

Additional information 

For more information on Conversation Clean Up, go to: Use 
Conversation Clean Up to delete redundant messages 

https://aka.ms/Use-Conversation-Clean-Up-to-delete-redundant-messages
https://aka.ms/Use-Conversation-Clean-Up-to-delete-redundant-messages
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Activity: Pose a challenge 
In this activity, you’ll discuss the problems of having an overwhelming number of 
messages in your inbox. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Follow the scenario described by the teacher. 

2. Work with your classmates to find a solution to the problem. 

3. Be prepared to demonstrate your solution to the rest of the class. 

Try-it: Clean up conversations 
 In this standalone try-it activity, you’ll use Clean Up Conversation to remove 

duplicate messages. 

Resources 
You will need the following resource for this try-it: 

• Staff profiles message in the L2_Inbox folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L2_Inbox folder. 

2. Select the expand/collapse icon for the first Conversation in the folder, which has 
the subject Staff profiles. 

3. Observe the messages in the Conversation, noting the repetition. 

4. Use Clean Up Conversation to remove duplicates from only this conversation. 
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Topic 3: Ignore a conversation 
 If you find that you’re receiving unwanted messages, you can also go further than 

Clean Up Conversation. Although email is a valuable workplace productivity tool, it’s 
also sometimes misused. You might have classmates or colleagues who engage in email 
discussions that aren’t relevant to you or your job, and you don't want those discussions 
to clutter your inbox. Or perhaps you’re still receiving messages for a project or topic 
that you’re no longer involved in. 

You can keep an entire conversation out of the inbox with Ignore Conversation, which 
deletes all current messages in the conversation and automatically deletes future 
messages in the conversation. 

To ignore a conversation, select the conversation, or a message in the conversation. 
Select the Home tab on the ribbon, and then in the Delete group, select Ignore. The 
following screenshot depicts the Delete group with Ignore highlighted. 

 
Figure 19: The Delete group with Ignore highlighted 

 

Did you know? 

To ignore a conversation using a keyboard shortcut, you can select 
the Conversation or a message within it, and then select 
Ctrl+Shift+D. 
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The Ignore command or keyboard shortcut will open the Ignore Conversation dialog 
box, which the following screenshot depicts. Select Ignore Conversation. 

 
Figure 20: The Ignore Conversation dialog box 

 

Additional information 

For more information on ignoring conversations, go to: Ignore all 
email messages in a conversation 

 

Video 

To review the video on ignoring conversations, go to: Ignore 
conversations 

Activity: Tell a story 
In this activity, you’ll follow along as the teacher discusses a real-world problem and 
demonstrates how Ignore Conversation can address it. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following along as the teacher describes the problem and 
demonstrates a solution. Ask any clarifying questions you have along the way. 

  

https://aka.ms/ignore-all-email-messages-in-a-conversation
https://aka.ms/ignore-all-email-messages-in-a-conversation
https://aka.ms/Ignore_Conversations
https://aka.ms/Ignore_Conversations
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Try-it: Ignore a conversation 
 In this standalone try-it activity, you’ll use Ignore Conversation to clean up a 

conversation in an email folder. 

Resources 
You will need the following resource for this try-it: 

• Movie next weekend message in the L2_Inbox folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L2_Inbox folder. 

2. Select the Conversation with the subject Movie next weekend. 

3. Use the Ignore Conversation command to delete the Conversation and 
automatically delete all future messages about the Conversation. 

Wrap-up 
Use these questions to check what you learned in this lesson:  

1. Which command deletes duplicate messages within a conversation? 

Select the correct option. 

a. Delete 

b. Filter 

c. Clean Up Conversation 

d. Ignore Conversation 

2. Which command deletes all current and future messages in a conversation? 

Select the correct option. 

a. Delete 

b. Filter 

c. Clean Up Conversation 

d. Ignore Conversation 
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3. Outlook creates a conversation when you receive multiple messages with the same 
________________________. 

Fill in the blank space. 

4. To remove duplicate messages from all conversations in a folder, use the 
________________________ command. 

Fill in the blank space. 

  



Organizing email 
 

 
38 

Lesson 3: Tagging messages for 
action 
Overview 
In this lesson, you'll learn to use flags and categories to organize your messages, and to 
remind you of messages that require follow-up responses. The activities, discussions, 
and demonstrations in this lesson will strengthen your learning and give you the 
opportunity to practice what you learn about flags and categories. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which tab on the ribbon includes the commands for flags and categories? 

Select the correct option. 

a. Home 

b. Send / Receive 

c. Folder 

d. View 

2. Which of the following items are default options for the due date of a Follow Up 
Flag? 

Select all that apply. 

a. Today 

b. Next Monday 

c. Next Week 

d. Next Month 

3. You can use the ________________________ feature to assign color-coded tags to 
messages. 

Fill in the blank space. 
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4. The first time you use a category, Outlook will ask you to ________________________ it. 

Fill in the blank space. 

Topic 1: Flag messages for follow-up 
 You might often receive email messages that require a response, but you can't 

respond immediately. For example, a message might ask you a question that requires 
some research, or you might get the message right before you leave at the end of the 
day. Although you could mark that kind of message Unread to remind yourself to come 
back to it later, that means that you can no longer tell if a message is really unread or if 
you have read it but not responded. A Follow Up Flag will tag the message with an 
indication that it needs more attention, and you can integrate this feature with other 
Outlook features to remind you to respond. 

Messages in the mail pane includes a Flag column that indicates whether a message is 
flagged. The following screenshot depicts the mail pane with one flagged message and 
one unflagged message. 

 
Figure 21: The mail pane with one flagged message and one unflagged message 

When you flag a message, you can choose to associate the flag with a due date of 
Today, Tomorrow, This Week, or Next Week. If you want a different date, you can 
select Custom, and then manually set a date. Finally, you can select No Date if you 
don’t want to specify a deadline. If you do select a due date, Outlook will add a 
reminder for the selected date. Flagged messages appear in several other locations in 
Outlook, including the To-Do Bar, in Tasks, and in the Daily Task List in the Calendar. 

Flag a message using the ribbon 
To flag a message using the ribbon, select a message in the mail pane. Select the Home 
tab, and then in the Tags group, select the Follow Up drop-down menu. Select either 
No Date, or the due date you want. The following screenshot depicts the Tags group 
with the Follow Up drop-down menu options. 
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Figure 22: The Tags group with the Follow Up drop-down menu options 

If you’re reviewing a message in the Message window, the Follow Up command is also 
on the Home tab, in the Tags group. 

Flag a message with the context menu 
To flag a message using the context menu, right-click or access the context menu for 
the message in the mail pane. Select Follow Up, and then select the due date. The 
following screenshot depicts the context menu for a message in the mail pane with 
Follow Up selected. 
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Figure 23: The context menu in the mail pane with Follow Up selected 

Flag a message with the Flag as a to-do item 
option 
To flag a message with the Flag as a to-do item option, right-click or access the 
context menu for the Flag icon a message in the mail pane. This is the Flag indicator in 
the message’s Flag column. Then select the due date from the context menu. The 
following screenshot highlights the Flag as a to-do item option and depicts its context 
menu. 
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Figure 24: The context menu for the Flag as a to-do item option 

Select a custom due date 
If you select Custom from the due date options, Outlook will open the Custom dialog 
box. Select Due Date to choose the deadline for following up. To receive a pop-up 
reminder related to the flag, select Reminder, and then select the date and time for 
receiving the reminder. The following screenshot depicts the Custom dialog box. 
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Figure 25: The Custom dialog box 

Mark a flagged message as complete 
To indicate that you have finished the action required for a flagged message, select the 
message in the mail pane. Select the Home tab, and then in the Tags group, select 
Follow Up to open the drop-down menu of options. Select Mark Complete. The 
following screenshot depicts the Tags group with the Mark Complete option selected 
in the Follow Up drop-down menu. 

 

Did you know? 

The keyboard shortcut to add a flag is Ctrl+Shift+G, which opens the 
Custom dialog box. 



Organizing email 
 

 
44 

 
Figure 26: The Tags group with Mark Complete selected in the Follow Up drop-down 
menu 

You can also use the Flag as a to-do item option to mark a message as complete. 
Select the Flag as a to-do item option, which is depicted as a flag in the Flag column. 

 

Additional information 

For more information on follow-up flags, go to: Flag email messages 
for follow up 

Activity: Show and tell 
In this activity, your teacher or a fellow student will demonstrate flagging messages for 
follow-up. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following along with the teacher’s or student’s 
demonstration. Ask any clarifying questions you might have. 

https://aka.ms/flag-email-messages-for-follow-up
https://aka.ms/flag-email-messages-for-follow-up
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Try-it: Flag messages for follow-up 
 In this leveled try-it activity, you’ll practice flagging a message for follow up and 

marking a flagged message as complete. 

Try-it 1 
In this try-it activity, you’ll use the ribbon to flag a message for follow-up, and then mark 
a message as complete. 

Resources 
You will need the following resource for this try-it: 

• No-till blueberries and Cover crops planting timeline messages in the L3_Inbox 
folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L3_Inbox folder. 

2. Find the message with the subject No-till blueberries, and use the ribbon to set a 
follow-up flag for Next Week. 

3. Find the flagged message with the subject Cover crops planting timeline. Use the 
ribbon to mark this message as complete. 

Try-it 2 
In this try-it activity, you’ll use the Flag as a to-do item option to flag a message for 
follow-up and then mark a message complete. 

Resources 
You will need the following resource for this try-it: 

• No-till blueberries and Cover crops planting timeline messages in the L3_Inbox 
folder 
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Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L3_Inbox folder. 

2. Find the message with the subject No-till blueberries, and use the Flag as a to-do 
item option to set a follow-up flag for Next Week. 

3. Find the flagged message with the subject Cover crops planting timeline. Use the 
Flag as a to-do item option to mark this message as complete. 

Try-it 3 
In this try-it activity, you’ll use the context menu to flag a message for follow and then 
mark a message as complete. 

Resources 
You will need the following resource for this try-it: 

• No-till blueberries and Cover crops planting timeline messages in the L3_Inbox 
folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L3_Inbox folder. 

2. Find the message with the subject No-till blueberries and use the context menu to 
set a follow-up flag for Next Week. 

3. Find the flagged message with the subject Cover crops planting timeline. Use the 
context menu to mark this message as complete. 

Topic 2: Categorize messages 
 In addition to the Follow Up Flag for tagging messages that require action, 

Outlook also provides color-coded categories. You can use these tags to label related 
messages in a way that quickly identifies them in the mail pane. For example, you could 
use different color categories for different projects you're involved in, or different 
classes you're taking at school. This would make it easier to keep those different topics 
separate and organized. 

You can use default categories, which can be customized with a name, or you can create 
your own custom color category. You can assign multiple color categories to a message. 
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Category tags are indicated with the Toggle Quick Click category icon in the form of a 
square, colored box, in the mail pane in the Categories column. The following 
screenshot depicts the mail pane with the Categories column highlighted. 

 
Figure 27: The mail pane with the Categories column highlighted 

Tag a message with a color category 
To tag a message with a color category, select a message in the mail pane, select the 
Home tab, and then in the Tags group, select the Categorize drop-down menu. Select 
the color category you want. The following screenshot depicts the Tags group with the 
Categorize drop-down menu open. 

 
Figure 28: The Tags group with the Categorize drop-down menu open 

This drop-down menu will include the default color categories and any categories you 
have previously added. The first time you assign a default color category to a message, 
the Rename Category dialog box will prompt you for a new name. You can edit the 
name in the Name box, or you can keep the default name. You can also rename the 
category later. The following screenshot depicts the Rename Category dialog box. 
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Figure 29: The Rename Category dialog box 

You can also assign a color category with the context menu. To do so, right-click or 
access the context menu for a message, select Categorize, and then select the color 
category you want to apply. 

Similarly, you can right-click or access the context menu in the Categories column. You 
can then select the color category you want to apply from the context menu that opens. 

Rename a color category 
The default color categories have generic names that correspond with their color, such 
as Blue Category and Green Category. As you've learned, Outlook asks you to rename 
a category the first time you use it. You can keep the default names if you want, but you 
can also customize them with more descriptive or meaningful labels. Be aware that if 
you rename a color category that you’ve already assigned to messages, all of those 
messages will update to the new name. 

To rename a category, select the Home tab, and then in the Tags group, select the 
Categorize drop-down menu. Select All Categories to open the Color Categories 
dialog box, select the category you want to rename, and then select Rename. You can 
then change the text to the name you want. While in the Color Categories dialog box, 
you can repeat the steps to rename other categories at the same time, and then select 
OK. The following screenshot depicts the Color Categories dialog box with Rename 
called out. 
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Figure 30: The Color Categories dialog box with Rename called out 

Create a color category 
If you want, you can even create a color category of your own! Simply select the Home 
tab, and then in the Tags group, select the Categorize drop-down menu. Next, select 
All Categories to open the Color Categories dialog box, and then select New. The 
following screenshot depicts the Color Categories dialog box with New highlighted. 
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Figure 31: The Color Categories dialog box with New highlighted 

After Outlook opens the Add New Category dialog box, enter the name for the new 
category in the Name box. Select Color to choose a color for the new category, and 
then select OK. The following screenshot depicts the Add New Category dialog box. 

 
Figure 32: The Add New Category dialog box 

 

Did you know? 

You can also use the keyboard shortcut Alt+D to open the Color 
Categories dialog box, where you can create or rename categories. 
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Additional information 

For more information on color categories, go to: Create and assign 
color categories 

Activity: Show me how 
In this activity, your teacher or a fellow student will demonstrate how to use color 
categories with email messages. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following along with the teacher’s or student’s 
demonstration. Ask any clarifying questions you might have. 

Try-it: Categorize messages 
 In this leveled try-it activity, you’ll practice using color categories with email 

messages. 

Try-it 1 
In this try-it activity, you’ll use the ribbon to assign a color category to a message. 

Resources 
You will need the following resource for this try-it: 

• Blueberries and Balloons Event and Cover crops planting timeline messages in 
the L3_Inbox folder 

  

https://aka.ms/Create-and-assign-color-categories
https://aka.ms/Create-and-assign-color-categories
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Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L3_Inbox folder. 

2. Find the message with the subject Blueberries and Balloons Event, and use the 
ribbon to assign to it the Blue Category. 

3. Find the message with the subject Cover crops planting timeline, and use the 
ribbon to assign the Purple Category. 

Try-it 2 
In this try-it activity, you’ll use the context menu or the Toggle Quick Click category 
icon to assign a color category to a message. 

Resources 
You will need the following resource for this try-it: 

• Blueberries and Balloons Event and Cover crops planting timeline messages in 
the L3_Inbox folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L3_Inbox folder. 

2. Find the message with the subject Blueberries and Balloons Event, and use the 
context menu or the Toggle Quick Click category icon to assign it to the Blue 
Category. 

3. Find the message with the subject Cover crops planting timeline, and use the 
context menu or the Toggle Quick Click category icon to assign the Purple 
Category. 

Try-it 3 
In this try-it activity, you’ll create a color category and assign it to a message. 

Resources 
You will need the following resource for this try-it: 

• Staff profiles and Staff images messages in the L3_Inbox folder 
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Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L3_Inbox folder. 

2. Open the Color Categories dialog box and create a new category named Staff 
Information. For Color, select Gray. 

3. Find the conversation with the subject Staff profiles and assign it to the category 
Staff Information. 

4. Find the message with the subject Staff images and assign the category Staff 
Information. 

Wrap-up 
Use these questions to check what you learned in this lesson:  

1. What is the default name of the red color category? 

Select the correct option. 

a. Follow Up Category 

b. Priority Category 

c. Red Category 

d. Urgent Category 

2. Which dialog box do you use to create a new color category? 

Select the correct option. 

a. The Tags dialog box 

b. The Color Categories dialog box 

c. The Flags dialog box 

d. The Follow Up dialog box 

3. What happens if you change the name of a category that is already assigned to 
messages? 

Select all that apply. 

a. You cannot change the name to a category that has been used. 

b. Existing messages with that category are updated to the new name. 

c. Existing messages with that category keep the old name. 

d. None of the above 
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4. When you've finished the follow up action for a flagged message, you can mark it 
________________________. 

Fill in the blank space. 
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Lesson 4: Searching and finding 
messages 
Overview 
In this lesson, you’ll learn to find specific messages in your mailbox using Instant 
Search, the Advanced Find dialog box, and Search Folders. The activities, discussions, 
and demonstrations in this lesson will strengthen your learning and give you the 
opportunity to practice what you learn about searching messages. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which tab contains the Recent Searches command? 

Select the correct option. 

a. The Home tab 

b. The Folder tab 

c. The View tab 

d. The Search tab 

2. Which of the following features refers to a virtual folder that displays messages 
based on criteria? 

Select the correct option. 

a. Advanced Find 

b. Folder 

c. Instant Search 

d. Mailbox 

e. Search Folder 
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3. When are Search Folders updated?

Select the correct option.

a. Never

b. Every time you open Outlook

c. When you manually send and receive your messages

d. Continuously

4. Use ________________________ to search with criteria that are not available in Instant
Search.

Fill in the blank space.

Topic 1: Search and Find items 
 You have now learned how to organize and filter your email messages, but 

sometimes the easiest way to find the message you need is to search for it. Fortunately, 
Outlook has an efficient search feature named Instant Search to help you find your 
messages, no matter how cluttered your inbox might be. 

Instant Search is in the mail pane. It consists of a Search box where you input your 
query, and the Search Scope drop-down menu where you can specify  where you want 
to search. The following screenshot depicts the mail pane with the Search box and 
Search Scope highlighted. 

Figure 33: The mail pane with the Search box and the Search Scope 

To search for a term or phrase, select Search, and then enter a term—such as a name, 
word, or phrase. In additional to words or phrases in your messages, Instant Search 
also enables you to search by the first name, last name, or even partial name of 
someone in the message or conversation. 
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As you enter the text you want to search for, Instant Search display the search results, 
updating each time you add a new character. Results will list messages that contain the 
word or name with the search text highlighted. Instant Search will also present a drop-
down menu you can choose from with suggested search terms based on your input. 

Select a message in Results to review it in the Reading Pane. The following screenshot 
depicts an example of Results with the suggestion of staff profiles highlighted. 

 
Figure 34: An example of Results with the suggestion words highlighted 

Much like a search engine on the internet, you can refine your search results by 
changing how you enter search terms. For example: 

• Placing your terms in quotes will search for messages with that exact phrase. For 
example, "blueberries and balloons" will return messages with that phrase, but not 
messages with blueberries and balloons as separate words in the message. 

• Including AND (in all capital letters) between words will find messages with both 
words, but not necessarily together or in that order. Example: blueberries AND 
balloons will search for messages with blueberries and balloons as separate words 
in the message. 

• Including OR (in all capital letters) between words will find messages with either 
word, but not necessarily both. Example: blueberries OR balloons will search for 
messages with either blueberries or balloons as separate words in the message. 

• Including NOT (in all capital letters) between words will find messages with the first 
word, but not the second. Example: staff NOT images will search for messages with 
the word staff, but not include messages that also have the word images. 
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To change which locations Instant Search searches, select the Search Scope drop-
down menu. The default Search Scope is Current Mailbox, which limits results to 
messages in the current mailbox you have selected. The option Current Folder is 
commonly used when you know you moved the message you want to a folder and want 
to search there. Other options for Search Scope include Subfolders, All Mailboxes, 
and All Outlook Items. The following screenshot depicts Instant Search with the 
Search Scope drop-down menu highlighted. 

 
Figure 35: Instant Search with the Search Scope drop-down menu highlighted 

Outlook keeps track of your searches and makes it possible to review and reuse them. 
To review your recent searches, select the Search box, and note that the Search 
contextual tab displays on the ribbon. In the Options group, select Recent Searches to 
open a drop-down menu of recent searches. You can then select an option from the list 
to run that search again. The following screenshot depicts the Options group with the 
Recent Searches drop-down menu opened. 

 
Figure 36: The Options group with the Recent Searches drop-down menu 
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When you're finished using Instant Search, you can close Results from the ribbon. 
Select the Search contextual tab, and then in the Options group, select Close Search. 
You can also access the Close Search command in the Search box, where it’s depicted 
as an X. 

 

Did you know? 

The keyboard shortcut for the Instant Search command is Ctrl+E. 

Refine your search results 
The Search contextual tab includes a variety of commands to help narrow down the 
results provided by Instant Search. These commands are in the Refine group, as 
depicted in the following screenshot. 

 
Figure 37: The Refine group on the Search tab 

In the Refine group, select the command you want to use. Outlook will add 
corresponding text to the Search bar. Some commands in the Refine group require you 
to enter additional information. For example, to refine your search based on who the 
message is from, you'll need to select From, and then input the name of the sender. In 
that case, Outlook will position the cursor in the correct location for you to input the 
name. The following screenshot depicts the Search bar after the user has selected From, 
with the cursor positioned to add the name. 

 
Figure 38: The Search bar after the user has selected From 

When you start entering a full name, such as Marcos Serna, or a partial name, such as 
Marcos, the text Sender Name will be replaced with the entered name. Instant Search 
will update Results to display messages sent by Marcos. 
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You can add as many Refine commands to your search as you want. Each one will help 
filter the results to a smaller number of emails, making it easier to find the message 
you're searching for. The following table describes the predefined commands in the 
Refine group. 

From Only displays results from a specific person. 

Subject Only displays results based on the subject. 

Has Attachment Only displays emails that have attachments. 

Categorized Only displays results that have a specific category assigned to them. 

This Week Searches by when the email message was received: Today, 
Yesterday, This Week, Last Week, This Month, Last Month, This 
Year, or Last Year. 

Sent To Searches messages with the options Sent to You, Not Sent Directly 
to You, or Sent to Another Recipient. 

Unread Only displays unread messages. 

Flagged Only displays messages flagged by you. 

Important Only displays email marked as Important. 

More Filters your results based on more advanced criteria, such as Cc or 
Sensitivity. 

Table 2: Commands in the Refine group 

 

Additional information 

For more information on Instant Search, go to: Find a message or 
item with Instant Search 

 

Video 

To review the video on filtering email, go to: Search and filter email 

https://aka.ms/Find-a-message-or-item-with-Instant-Search
https://aka.ms/Find-a-message-or-item-with-Instant-Search
https://aka.ms/Search_and_filter_email
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Activity: Show and tell 
In this activity, your teacher or a fellow student will demonstrate how to find messages 
with Instant Search. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following along with the teacher’s or student’s 
demonstration. Ask any clarifying questions you might have. 

Try-it: Search and Find items 
 In this leveled try-it, you’ll practice using Instant Search to find messages in a 

mailbox. 

Try-it 1 
In this try-it activity, you’ll use a keyword search in Instant Search in the current folder. 

Resources 
You will need the following resource for this try-it: 

• Messages in the L4_Inbox folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L4_Inbox folder. 

2. Use the Search Scope drop-down menu to limit your search to Current Folder. 

3. Enter staff in the Search box, and notice how Results populates with every message 
containing the word staff. 

4. Continue entering text in the Search box, adding lunch so the complete search 
phrase is staff lunch. Observe that the results are narrowed down. 

5. Select Search Scope, and from the drop-down menu, select All Mailboxes. Notice 
that the Results window now displays messages from other mailboxes as well. 
Because the .pst file includes copies of the same messages in different folders, each 
instance is displayed. 
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Try-it 2 
In this try-it activity, you’ll use a keyword search in Instant Search and then refine the 
results. 

Resources 
You will need the following resource for this try-it: 

• Messages in the L4_Inbox folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L4_Inbox folder. 

2. Use the Search Scope drop-down menu to limit your search to Current Folder. 

3. Enter blueberries in the Search box, and observe how Results populates with every 
message containing the word blueberries. 

4. To narrow the search, use the Refine command Has Attachments to narrow the 
search down to messages that have attachments. 

Try-it 3 
In this try-it activity, you’ll use and refine a keyword search in Instant Search, and then 
repeat the search with Recent Searches. 

Resources 
You will need the following resource for this try-it: 

• Messages in the L4_Inbox folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L4_Inbox folder. 

2. Use the Search Scope drop-down menu to limit your search to Current Folder. 

3. Enter blueberries in the Search box, and observe how Results populates with every 
message containing the word blueberries. 

4. Use the Refine command From to narrow the search to messages from Marcos. 

5. Observe the results, and then close the search. 
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6. Create a new search for the term balloons, and observe those results. 

7. Use Recent Searches to reuse the search for messages from Marcos containing the 
word blueberries. 

Topic 2: Use Advanced Find 
 The Instant Search feature makes it possible to find messages with a variety of 

options to help narrow the results. Most of the time, Instant Search will be powerful 
enough to quickly find the message you're after. However, if you need a more advanced 
search tool, you can use Advanced Find. 

To access Advanced Find, select the Search box to gain access to the Search addition 
to the ribbon. Select the Search tab, and then in the Options group, select Search 
Tools. On the drop-down menu of commands, select Advanced Find, as exhibited in 
the following screenshot. 

 
Figure 39: The Options group with Search Tools selected, and Advanced Find 
highlighted 

 

Did you know? 

The keyboard shortcut for the Advanced Find command is 
Ctrl+Shift+F. 
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Selecting Advanced Find will open the Advanced Find dialog box, which you can use 
to build your search. In this dialog box, select the Advanced tab to access commands 
for building a search. The following screenshot depicts the Advanced Find dialog box 
with the Advanced tab selected. 

 
Figure 40: The Advanced Find dialog box with the Advanced tab selected 

In the Advanced Find dialog box, use commands in the Define more criteria section to 
specify search criteria one rule at a time. Select Field, and then select All Mail fields to 
open a list of all the fields you can use for a search. Some are familiar, such as Subject, 
From, and To. Others will be less obvious, as indicated in the following screenshot. 
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Figure 41: The Fields drop-down menu with All Mail fields selected 
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To build your search, select a Field from the drop-down menu. Next, select from the 
Condition drop-down menu. The choices will vary based on the field, but if you select 
Subject you can choose from contains, is (exactly), doesn't contain, word starts with, 
or phrase matches. After selecting a Condition, select Value, and enter a value. This 
process builds a criterion. For example, the following screenshot depicts Define more 
criteria with the options set to Subject, contains, meeting. 

 
Figure 42: Define more criteria with the options set to Subject, contains, meeting 

Select Add to List to make this criterion part of your search. Repeat the process to add 
more criteria, just as you added multiple keywords or Refine commands to Instant 
Search. When you finish adding criteria, select the Find Now button to run the search, 
and then review the results. The following screenshot depicts the Advanced Find dialog 
box displaying the results of a search, with the Find Now button called out. 
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Figure 43: The Advanced Find dialog box displaying the results of a search, with the Find 
Now button called out 

 

Additional information 

For more information on Instant Search, go to: Find a message or 
item with Instant Search 

  

https://aka.ms/Find-a-message-or-item-with-Instant-Search
https://aka.ms/Find-a-message-or-item-with-Instant-Search
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Activity: Pose a challenge 
In this activity, you or another student will use Advanced Find to create a new search 
with the help of the teacher. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Review the scenario described by the teacher. 

2. Demonstrate your solution to the class, asking for assistance from the teacher, as 
needed. If you don’t get a chance to demonstrate, follow along and ask any 
clarifying questions you might have. 

Try-it: Use Advanced Find 
 In this standalone try-it activity, you’ll create a search with Advanced Find. 

Resources 
You will need the following resource for this try-it: 

• A message in the L4_Inbox folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L4_Inbox folder. 

2. Open the Advanced Find dialog box. 

3. On the Advanced tab, select Field, and the, from the All Mail fields menu, select 
Subject. 

4. Set the Condition to contains. 

5. Edit the Value to meeting, and then add the criterion to the list. 

6. Create a second criterion with Field set to From, Condition set to contains, and 
Value set to Marcos. Add this criterion to the list. 

7. Run the search and notice that it found one message sent by Marcos that contains 
the word meeting in the Subject. 
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Topic 3: Create and use Search Folders 
 You can also extend the power of the Outlook search features into a useful 

organizational tool. A Search Folder is a virtual folder that provides an overview of all 
email messages matching specific search material. It displays like a folder in your 
mailbox, but messages aren't actually in the Search Folder, they are just listed there. 

For example, you could create a Search Folder for each message with a Follow Up 
Flag. When you select this Search Folder, you could observe every message with a 
Follow Up Flag, regardless of which folder they are in. Many people use a Search 
Folder to display all of their unread mail, so they can go to one place to catch up on 
reading messages even when the messages are saved in different folders within their 
mailbox. 

Create a Search Folder 
To create a search folder, select the Folder tab on the ribbon, and then in the New 
group, select New Search Folder. The following screenshot depicts the New group with 
New Search Folder highlighted. 

 
Figure 44: The New group with New Search Folder highlighted 

You can also access New Search Folder from the Folder Pane. To do so, right-click or 
access the context menu for Search Folders, and then select New Search Folder. The 
following screenshot depicts the context menu for Search Folders with New Search 
Folder selected. 



Organizing email 
 

 
70 

 
Figure 45: The context menu for Search Folders with New Search Folder selected 

The New Search Folder command opens the New Search Folder dialog box. The 
Select a Search Folder list includes a variety of predefined Search Folder settings to 
address the most common uses of the feature. The following screenshot depicts the 
New Search Folder dialog box with a predefined Search Folder for Unread mail 
selected. 
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Figure 46: The New Search Folder dialog box with a predefined Search Folder for 
Unread mail selected 

In this example, select OK to create the new Search Folder for Unread mail. If the 
predefined Search Folder has customization options, Customize Search Folder will 
display fields for entering the necessary information. The following screenshot depicts 
the New Search Folder with Categorized mail selected and the fields in Customize 
Search Folder selected. 
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Figure 47: The New Search Folder with Categorized mail selected and the fields in 
Customize Search Folder selected 

Select the Choose button to specify criteria for the Search Folder. Select OK to close 
the New Search Folder dialog box and create the Search Folder. 

 

Did you know? 

In addition to the predefined Search Folder configurations, you can 
create customized Search Folders with more complex criteria. 
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View messages in a Search Folder 
When you review a Search Folder, it will contain a list of messages that meet the criteria 
you specified when you created it. The list is updated each time you review it, so new 
messages or messages that have changed (through the addition of a Follow Up Flag, 
for example) will be added to the list if they meet the criteria. 

To review the contents of a Search Folder, navigate to the Folder Pane and select the 
Search Folder. The results will display in the mail pane. This is similar to any other 
folder with a column in the list heading named In Folder, which specifies the folder in 
which each message is saved. 

The ribbon includes commands for modifying Search Folders. To modify a Search 
Folder, select the folder in the Folder Pane, and then select the Folder tab. The Actions 
group includes: 

• Rename Folder, which you can use to change the name of the Search Folder. 
• Delete Folder, which will delete the Search Folder. 

Note: Because messages are saved in a different folder, deleting a Search Folder will 
not delete or change any of the messages contained within it. 

• Customize This Search Folder, which you can use to modify a predefined Search 
Folder. If you create a customized Search Folder, you use this option to edit 
customizations. 

The following screenshot depicts the Actions group on the Folder tab. 

 
Figure 48: The Actions group in the Folder tab 

 

Additional information 

For more information on Search Folders, go to: Use Search Folders to 
find messages or other Outlook items 

 

Video 

To review the video on Search Folders, go to: Create or delete a 
search folder 

https://aka.ms/Use-Search-Folders-to-find-messages-or-other-Outlook-items
https://aka.ms/Use-Search-Folders-to-find-messages-or-other-Outlook-items
https://aka.ms/Video-Create-or-delete-a-search-folder
https://aka.ms/Video-Create-or-delete-a-search-folder
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Activity: Pose a challenge 
In this activity, the teacher will challenge you to create a solution to keep email 
messages more organized. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the teacher-led discussion and offer ideas for solving the proposed 
challenge. Then observe demonstrations and ask clarifying questions if necessary. 

Try-it: Create and use Search Folders 
 In this standalone try-it activity, you’ll create several Search Folders by using 

predefined Search Folder configurations. 

Resources 
You will need the following resource for this try-it: 

• Messages in the L4_Inbox folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L4_Inbox folder. 

2. Use the ribbon to create a Search Folder for all email sent by Marcos Serna. 

3. Use the context menu in the Folder Pane to create a Search Folder for all messages 
with the word meeting in the Subject. 

4. Use either method to create a Search Folder for all messages with attachments. 
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Wrap-up 
Use these questions to check what you learned in this lesson:  

1. Which group contains commands for narrowing down Instant Search results? 

Select the correct option. 

a. Options 

b. Refine 

c. View 

d. Tags 

2. What happens to messages when you delete a Search Folder? 

Select the correct option. 

a. Messages contained in the Search Folder are deleted. 

b. Messages contained in the Search Folder are moved to their previous folders. 

c. Messages contained in the Search Folder are not affected.  

d. A Search Folder cannot be deleted if it contains messages. 

3. The Search box and Search Scope drop-down menu are part of the 
________________________ feature. 

Fill in the blank space. 

4. Use the ________________________ tab in the Advanced Find dialog box to add criteria 
to a new search. 

Fill in the blank space. 
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Lesson 5: Organizing messages 
with folders 
Overview 
In this lesson, you’ll learn how to create and use folders to organize email messages. The 
activities, discussions, and demonstrations in this lesson will strengthen your learning 
and give you the opportunity to practice what you learn about Outlook folders. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which of the following describes containers for saving email messages? 

Select the correct option. 

a. Attachments 

b. Filters 

c. Folders 

d. Panes 

2. Which tab on the ribbon includes commands for moving messages? 

Select the correct option. 

a. Home 

b. Folder 

c. View 

d. Search 

3. You can make new ________________________ to organize your email messages. 

Fill in the blank space. 
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Topic 1: Create folders 
 Folders offer a way to organize your email messages and other Outlook items. Just 

like paper folders in a file cabinet, you can use Outlook folders to group related items 
and make them easier to find. You can create any organization system you want, but 
many people create folders for different purposes, such as: 

• Projects they are working on. 
• Tasks they must complete. 
• People or customers they are communicating with. 
• Classes or programs at school. 

To create a folder, begin by going to the Folder Pane and right-clicking or accessing 
the context menu for the folder to which you want to add a new folder; for example, 
Inbox. From the context menu, select New Folder. The following screenshot depicts the 
context menu in the Folder Pane with New Folder highlighted. 
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Figure 49: The context menu in the Folder Pane with New Folder highlighted 

In the Name box that displays, enter a name for the new folder. Be sure to be 
descriptive so you can recognize it later. The following screenshot depicts the Name 
box for a new folder named Internship. 

 
Figure 50: The Name box for a new folder named Internship 

You can also create a new folder by using commands on the ribbon. Select the Folders 
tab, and then in the New group, select New Folder. The following screenshot depicts 
the New group with New Folder highlighted. 
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Figure 51: The New group with New Folder highlighted 

The New Folder command opens the Create New Folder dialog box. Select the Name 
box and enter a name for the new folder. Under Select where to place the folder, 
select a location, such as Inbox, and then select OK. The following screenshot depicts 
the Create New Folder dialog box. 

 
Figure 52: The Create New Folder dialog box 

 

Additional information 

For more information on creating folders, go to: Create a folder in 
Outlook 

  

https://aka.ms/Create-a-folder-in-Outlook
https://aka.ms/Create-a-folder-in-Outlook
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Activity: Show me how 
In this activity, your teacher or a fellow student will demonstrate how to create folders in 
Outlook. 

Resources required 
You will need the following resource for this activity: 

• The L5_Inbox folder 

Activity instructions 
Participate in the activity by demonstrating how to create a folder, or by following along 
with the teacher’s or student's demonstration. Ask any clarifying questions you might 
have. 

Try-it: Create folders 
 In this leveled try-it activity, you’ll practice creating folders to organize email 

messages. 

Try-it 1 
In this try-it activity, you’ll create a new folder by using the context menu. 

Resources 
You will need the following resource for this try-it: 

• The L5_Inbox folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L5_Inbox folder. 

2. Use the context menu to create a new folder named Media Information. 

3. Use the context menu to create a subfolder within Media Information with the 
name Events. 
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Try-it 2 
In this try-it activity, you’ll create a new folder by using the ribbon. 

Resources 
You will need the following resource for this try-it: 

• The L5_Inbox folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L5_Inbox folder. 

2. Use the ribbon to create a new folder named Media Information. 

3. Use the ribbon to create a subfolder within Media Information with the name 
Events. 

Topic 2: Move messages between 
folders 

 After you’ve created folders, there are several different ways to move messages 
from one folder to another. You can move messages to a new folder by using drag and 
drop. Simply select the message you want to move, and then drag it to the destination 
folder. The ribbon also includes commands for moving messages to a different folder. 
To move a message, select the message you want to move, select the Home tab, and 
then in the Move group, select the Move drop-down menu. Now select the destination 
folder. The following screenshot depicts the destination folder options in the Move 
drop-down menu in the Move group on the Home tab. 
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Figure 53: The Move drop-down menu in the Move group on the Home tab 

If the folder you want is not listed, select Other Folder to open the Move Items dialog 
box, and then select the desired folder. The following screenshot depicts the Move 
Items dialog box. 

 
Figure 54: The Move Items dialog box. 
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You can also move messages by using the context menu in the mail pane. To do so, 
right-click or access the context menu for the message, and then select Move. This will 
display a list of destination folders. Select a folder from the menu, or select Other 
Folder if the desired folder is not listed. The following screenshot depicts the context 
menu for the Move option in the mail pane. 

 
Figure 55: The context menu in the mail pane with Move selected. 

 

Did you know? 

You can also use the Cut and Copy commands to move messages 
from one folder to another. 
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Additional information 

For more information on moving messages between folders, go to: 
Move or copy an item to another folder 

Activity: Show me how 
In this activity, your teacher or a fellow student will demonstrate how to create folders in 
Outlook. 

Resources required 
You will need the following resource for this activity: 

• The L5_Inbox folder 

Activity instructions 
Participate in the activity by demonstrating how to move email messages, or by 
following along with the teacher’s or student's demonstration. Ask any clarifying 
questions you might have. 

Try-it: Move messages between folders 
 In this leveled try-it activity, you’ll practice moving messages from one folder to 

another. 

Try-it 1 
In this try-it activity, you’ll move messages by using commands on the ribbon. 

Resources 
You will need the following resources for this try-it: 

• The Company overview and No-till blueberries messages in the L5_Inbox folder 
• The Media Information and Events folders that you created in the previous try-it 

activities 
  

https://aka.ms/Move-or-copy-an-item-to-another-folder
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Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L5_Inbox folder. 

2. Find the message with the subject Company overview. The message will be at the 
end of the message list. Use the ribbon to move the message to the Media 
Information folder that you created in the previous try-it activity. 

3. Find the message with the subject No-till blueberries. The message will be at the 
end of the message list. Use the ribbon to move the message to the Events 
subfolder within the Media Information folder that you created in the previous try-
it activity. 

Try-it 2 
In this try-it activity, you’ll move messages with the commands on the context menu. 

Resources 
You will need the following resources for this try-it: 

• The Company overview and No-till blueberries messages in the L5_Inbox folder 
• The Media Information and Events folders that you created in the previous try-it 

activities 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L5_Inbox folder. 

2. Find the message with the subject Company overview. The message will be at the 
end of the message list. Use the context menu to move the message to the Media 
Information folder that you created in the previous try-it activity. 

3. Find the message with the subject No-till blueberries. The message will be at the 
end of the message list. Use the context menu to move the message to the Events 
subfolder within the Media Information folder that you created in the previous try-
it activity. 
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Wrap-up 
Use these questions to check what you learned in this lesson:  

1. Which of the following can you use to create a folder? 

Select all that apply. 

a. Commands on the Home tab 

b. Commands on the Folders tab 

c. The context menu 

d. Drag and drop 

2. Which of the following can you use to move a message between folders? 

Select all that apply. 

a. Commands on the Home tab 

b. Commands on the Folders tab 

c. The context menu 

d. Drag and drop 

3. When you’re creating a folder, you must specify its name and ________________________. 

Fill in the blank space. 
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Lesson 6: Deleting and 
recovering messages 
Overview 
In this lesson you’ll learn how to delete messages and recover messages from the 
Deleted Items folder. You’ll also learn how to permanently remove messages from the 
Deleted Items folder. The activities, discussions, and demonstrations in this lesson will 
strengthen your learning and give you the opportunity to practice what you learn about 
deleting and recovering messages. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. What happens when you delete a message in Outlook? 

Select the correct option. 

a. It’s permanently removed as soon as you delete it. 

b. It’s moved to the Deleted Items folder. 

c. It’s moved to the hidden Recoverable Items folder. 

d. It’s moved to a .pst file. 

2. How do you recover a message from the Deleted Items folder? 

Select the correct option. 

a. Move it to another folder. 

b. Use the Recover Deleted Items dialog box. 

c. Contact you email administrator. 

d. You cannot recover a message from the Deleted Items folder. 

3. Deleted messages are permanently removed when you empty the 
________________________ folder. 

Fill in the blank space. 
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4. In place of a Deleted Items folder, your account could have a folder named 
________________________. 

Fill in the blank space. 

Topic 1: Delete messages 
The methods you’ve learned in this module can help you keep your mailbox organized. 
However, with new messages arriving all the time, you’ll want to delete messages that 
you don’t need anymore. There are several ways to delete a message in Outlook. 

Delete a message 
The first way you can delete a message is to select the message in the mail pane. Next, 
select the Home tab on the ribbon, and then in the Delete group, select Delete. The 
following screenshot depicts the Delete group, with Delete highlighted. 

 
Figure 56: The Delete group, with Delete highlighted. 

You can also delete a message using the message’s context menu. Right-click or access 
the context menu for the message in the mail pane, and then select Delete. The 
following screenshot depicts the message context menu with Delete highlighted. 
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Figure 57: The message context menu with Delete highlighted 

 

Did you know? 

There are two more ways to delete messages. When you hover over a 
message, the Delete the item option displays. It’s depicted as an X in 
the last column of the message list. Select the Delete the item icon 
to delete the message. You can also select a message, and then select 
the Delete key on your keyboard. 

No matter which method you use to delete a message, it will be moved to the Deleted 
Items folder. However, you can still recover the message from here if you change your 
mind, as you’ll learn in upcoming parts of this lesson. 

 

Additional information 

For more information on deleting messages, go to: Delete a message 

https://aka.ms/Delete-a-message
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Activity: Discuss and learn 
In this activity, you’ll discuss different ways to delete email messages. 

Resources required 
You will need the following resource for this activity: 

• Messages in the L6_Inbox folder 

Activity instructions 
Participate in the activity by following these instructions: 

1. Participate in the discussion led by the teacher. 

2. Observe as the teacher demonstrates different ways to delete messages. 

Try-it: Delete messages 
 In this standalone try-it, you’ll practice multiple ways of deleting messages. 

Resources 
You will need the following resource for this try-it: 

• Messages in the L6_Inbox folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L6_Inbox folder. 

2. Find the message with the subject Time sheets. Delete the message using the 
ribbon. 

3. Find the message with the subject Thank You. Delete the message using the context 
menu. 

4. Find the message with the subject Information for the media. Delete the message 
using the ribbon, the context menu, the Delete the item option, or the keyboard 
shortcut. 
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Topic 2: Empty deleted items 
When you delete a message in Outlook, it’s moved to a folder named Deleted Items. 
Much like the Recycle Bin in Windows, Deleted Items gives you the chance to recover 
deleted items before they are permanently removed. However, this folder can 
accumulate several messages, which could take up a lot of space on your computer or 
email server, especially if you have a lot of attachments with your messages. 

Note: If your Outlook account is not connected to Microsoft Office 365, Outlook.com, or 
Microsoft Exchange Server, your deleted messages could be moved to a folder named 
Trash instead of Deleted Items. 

To permanently remove these messages and free up space, you must empty the 
Deleted Items folder. To empty the Deleted Items folder, select the Folder tab on the 
ribbon, and then in the Clean Up group, select Empty Folder. This command is only 
available when the Deleted Items folder is selected. The following screenshot depicts 
the Clean Up group with Empty Folder highlighted. 

 
Figure 58: The Clean Up group with Empty Folder highlighted 

 

Did you know? 

If you empty the Deleted Items folder, you cannot reverse this action 
or recover those messages, so think carefully before emptying this 
folder! 

You can also empty the Deleted Items folder by using the context menu. Right-click or 
access the context menu for the Deleted Items folder, and then on the context menu, 
select Empty Folder, as in the following screenshot. 
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Figure 59: The context menu for Deleted Items with Empty Folder highlighted 

Because the Empty Folder command permanently deletes everything in the Deleted 
Items folder, you will be prompted to confirm your decision. To permanently remove 
items in the Deleted Items folder, select Yes. To cancel the command and keep the 
items in Deleted Items, select No. The following screenshot depicts the confirmation 
dialog box. 

 
Figure 60: The Empty folder confirmation box 
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Did you know? 

You can configure Outlook to automatically empty the Deleted Items 
folder. The setting for this is in Outlook Options. 

 

Additional information 

For more information on emptying deleted messages, go to: Empty 
the Deleted Items folder in Outlook 

Activity: Discuss and learn 
In this activity, you’ll discuss the Deleted Items folder and permanently removing email 
messages. 

Resources required 
You will need the following resource for this activity: 

• Messages in the L6_Inbox folder 

Activity instructions 
Participate in the activity by following these instructions: 

1. Participate in the discussion led by the teacher. 

2. Follow along as the teacher demonstrates emptying Deleted Items. 

Try-it: Empty deleted messages 
 In this standalone try-it, you’ll practice emptying the Deleted Items folder. 

Resources 
You will need the following resources for this try-it: 

• None 

https://aka.ms/empty-the-deleted-items-folder-in-outlook
https://aka.ms/empty-the-deleted-items-folder-in-outlook
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Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the Deleted Items folder in M3_module_PST_starter. 

2. Use the ribbon to empty the folder. Confirm the action when prompted. 

3. Observe that there are now no messages in the Deleted Items folder. 

4. Use the context menu to repeat the process. 

Topic 3: Recover deleted items 
If you accidentally delete a message or realize that you still need a message you deleted, 
you can recover it providing it’s still in the Deleted Items folder. Deleted messages stay 
in the Deleted Items folder until it’s emptied, either by you, or by Outlook if you have 
configured it to empty the folder automatically. 

To review the Deleted Items folder contents, select Deleted Items in the Folder Pane. 
After you find the message you are searching for in the pane, move it to another folder, 
such as Inbox, using one of the methods you learned about in the previous lesson. The 
following screenshot depicts the Folder Pane with Deleted Items highlighted. 

 
Figure 61: The Folder Pane with Deleted Items highlighted 

But what happens if you’ve already emptied Deleted Items, or Outlook is configured to 
do it automatically? If you can’t find the message in Deleted Items, is it gone forever? It 
might be, but there is still one place to check: Recoverable Items. 

When messages are deleted from Deleted Items, they are moved to a folder named 
Recoverable Items. This is a hidden folder that acts as a temporary container for 
permanently deleted messages. It’s not listed with the other folders in the Folder Pane, 
so you have to access it by using different commands. 
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Note: The Recoverable Items folder is not available for a .pst file, and is not available 
for accounts that have a Trash folder in place of Deleted Items. If your account doesn’t 
offer the Recoverable Items feature, you won’t be able to complete some of the 
activities in this topic. However, you can still learn how the feature works. 

To recover an item from The Recoverable Items folder, select the Home tab on the 
ribbon, and then in the Actions group, select Recover Deleted Items from the Server, 
as in the following screenshot. 

 
Figure 62: The Actions group and Recover Deleted Items from the Server 

You can also access this feature from Deleted Items. In the Folder Pane, select Deleted 
Items. Select the Folder tab on the ribbon, and then in the Clean Up group, select 
Recover Deleted Items. The following screenshot depicts the Clean Up group with 
Recover Deleted Items highlighted. 

 
Figure 63: The Clean Up group with Recover Deleted Items highlighted 

Selecting either command opens the Recover Deleted Items dialog box. Find and 
select the message you want to recover, and then be sure to select Restore Selected 
Items. Then select OK. The message or messages you selected will be moved back to 
their original folders. The following screenshot depicts the Recover Deleted Items 
dialog box with the option to Restore Selected Items highlighted. 



Organizing email 
 

 
96 

 
Figure 64: The Recover Deleted Items dialog box with the option to Restore Selected 
Items highlighted 

 

Additional information 

For more information on recovering deleted messages, go to: Recover 
deleted items in Outlook for Windows 

Activity: Discuss and learn 
In this activity, the group will discuss options for recovering deleted items in Outlook. 

Resources required 
You will need the following resource for this activity: 

• Messages in the L6_Inbox folder 

https://aka.ms/Recover-deleted-items-in-Outlook-for-Windows
https://aka.ms/Recover-deleted-items-in-Outlook-for-Windows
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Activity instructions 
Participate in the activity by following these instructions: 

1. Participate in the discussion led by the teacher. 

2. Observe as the teacher demonstrates options for recovering deleted items. 

Try-it: Recover deleted items 
 In this standalone try-it, you’ll practice deleting and recovering items. 

Resources 
You will need the following resources for this try-it: 

• None 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the L6_Inbox folder. 

2. Delete the message with the subject Staff lunch on Friday? 

3. Delete the message with the subject New equipment for the Festival. 

4. Navigate to the Deleted Items (or Trash) folder and move Staff lunch on Friday? 
back to L6_Inbox. 

5. Empty the Deleted Items folder. 

6. If Outlook is connected to an account that supports Recoverable Items, open the 
Recover Deleted Items dialog box, and recover one message. Go to the original 
folder to confirm that it’s recovered. You can also use Instant Search to find the 
message. 

Detach the module .pst file 
After you complete all try-its, you must detach your .pst file so your teacher can assess 
your work. To do this: 

1. In Outlook, on the Navigation Bar, select the ellipsis (Navigation Menu button), 
and then select Folders. 

2. Locate the folder named M3_module_PST_starter_ Firstname_Lastname, and 
right-click or access the context menu for the folder. 
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3. On the context menu, select Close “M3_module_PST_starter_ 
Firstname_Lastname.” 

4. On your computer, open File Explorer, and then browse to where the .pst file 
resides. 

5. Right-click or access the context menu for the file, and then select Rename. 

6. Append your name to the end of the existing file name by using underscores instead 
of spaces. For example, enter _Firstname_Lastname. The filename should now 
resemble M3_module_PST_starter_Firstname_Lastname. 

7. Copy the .pst file to the designated location for assessment. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Which of the following options is a hidden folder used to temporarily store deleted 
items? 

Select the correct option. 

a. Deleted Items 

b. Drafts 

c. Recoverable Items 

d. Trash 

2. When are the contents of the Deleted Items folder removed? 

Select the correct option. 

a. When you empty the folder 

b. When you run Clean Up Conversations 

c. Once per year, on January 1 

d. Every day at noon 

3. When the Deleted Items folder is emptied, messages are moved to 
________________________. 

Fill in the blank space. 
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Glossary 
Advanced Find A tool for creating more advanced or complex searches than Instant 

Search. 

Arrange By The setting that determines which message field, such as From or 
Date, is used to arrange the message list in the mail pane. 

Color categories A set of color-coded tags that can be applied to a message to help 
keep messages organized. 

Conversation A group of messages that have the same subject. 

Deleted Items A folder that stores deleted messages. 

Filter A feature that reduces the number of messages listed in the mail 
pane by displaying only messages that meet specified criteria. 

Focused Inbox A feature that intelligently sorts Inbox messages into Focused or 
Other tabs to make the inbox more manageable.  

Folder A container for email messages that is used to organize mail into 
groups. 

Follow Up Flag A tag that can be applied to a message to indicate that further action 
is required.  

Instant Search A feature that searches messages based on a name, word, or phrase. 
Results are displayed in the mail pane. 

Recoverable Items A hidden folder that temporarily retains items that have been 
permanently deleted, such as when Deleted Items is emptied. 

Search Folder A virtual folder that groups together messages that meet specified 
criteria without moving messages from their original folders. 

Sort The setting that determines if messages in the mail pane are listed in 
ascending or descending order. 

Table 3: Glossary terms and definitions 
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Cornerstone 
Overview 
In this cornerstone, you’ll organize email messages related to one of Munson’s Pickles 
and Preserve Farm’s biggest and most popular events, the Blueberries and Balloons 
Festival. You’ll utilize Outlook features to find and display messages efficiently. You’ll 
clean up conversations to minimize duplication of emails. You’ll need to use flags and 
categories to organize messages for the event, and you’ll use Search Folders to keep 
related email together. Finally, you’ll need to delete messages you no longer need, and 
make sure you haven’t deleted anything you’ll want later. 

Objectives 
The following table outlines the cornerstone objectives and their corresponding 
Microsoft Office Specialist (MOS) exam objectives. 

Cornerstone project objectives Exam objective(s) 

Sort and filter messages. • 2.3.1: Sort messages 
• 2.3.7: Change the display of messages 

Manage conversations. • 2.3.6: Ignore conversations 

Flag and categorize messages. • 2.3.5: Flag received messages 

Search for and categorize messages. • 1.3.2: Search for messages, calendar 
items, contacts, and tasks 

• 2.3.4: Categorize messages 

Create Search Folders. • 1.3.1: Create search folders 

Create and use a folder. • 2.3.2: Create folders 
• 2.3.3: Move messages between 

folders 

Delete a message. • None 

Table 4: Cornerstone objectives 
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Duration 
50 minutes 

Attach the Cornerstone .pst file 
To complete this Cornerstone, you must attach this .pst file into Outlook before you can 
perform any tasks. You’ll also store the results of your tasks in this .pst file so that your 
teacher can assess your working by examining that file. 

To open the .pst file in Outlook: 

1. Open Outlook. 

2. Select the File tab, and then select Open & Export. 

3. In the Open pane, select Open Outlook Data File. 

4. In the Open Outlook Data File dialog box, use the navigation pane to locate the .pst 
files provided by your instructor for your use throughout this module of the course. 

5. Open the file named M3_cornerstone_PST_starter. Note that a folder 
M3_cornerstone_PST_starter is now available in the navigation pane. This folder 
contains any required starter elements for the Cornerstone, such as email, calendar 
appointments, tasks, and contacts. 

6. Right-click or access the context menu for the M3_cornerstone_PST_starter folder, 
and then select Data File Properties. 

7. In the M3_cornerstone_PST_starter Properties dialog box, select Advanced. 

8. In the Outlook Data File dialog box, in the Name box, append your name to the 
end of the existing name by using underscores instead of spaces. For example, enter 
_Firstname_Lastname. The folder name should now resemble 
M3_cornerstone_PST_starter_Firstname_Lastname. 

9. Select OK twice. 

Instructions 
1. Complete the following tasks for each file. 

2. When you’re done with the cornerstone, assess your completion and enter the 
points you think you earned within the following task lists. You can ask for the help 
of your teacher if required. 
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Tasks 
You’ll work with one file in this cornerstone. The following steps are the tasks you need 
to complete within each file. 

File 1: M3_cornerstone_PST_starter.pst 
Task: Sort and filter email (2 points) 
1. Select Inbox and arrange the messages by date. (1 point) (Exam objective 2.3.1) 

2. Change the filter to display All Mail. (1 point) (Exam objective 2.3.7) 

Points scored: ________ / 2 

Task: Manage conversations (4 points) 
1. Enable Show as Conversations in the Inbox. (1 point) 

2. Use the Clean Up Conversation command to clean up the Honey sampling 
conversation. (2 points) 

3. Ignore the Pickle Camp conversation. (1 point) (Exam objective 2.3.6) 

Points scored: ________ / 4 

Task: Flag messages for follow up (2 points) 
1. Find the message with the subject In the field. Set a flag to follow up next week. (1 

point) (Exam objective 2.3.5) 

2. Find the flagged message with the subject New equipment for the Festival. Mark 
the message as completed. (1 point) (Exam objective 2.3.5) 

Points scored: ________ / 2 

Task: Search for and categorize messages (3 points) 
1. Search the Inbox for messages that contain the word committee. Apply a yellow 

color category to each message it finds. (2 points) (Exam objectives 1.3.2 and 2.3.4) 

2. Name the yellow category Planning Committee. (1 point)   

Points scored: ________ / 3 

  



Organizing email 
 

 
103 

Task: Create Search Folders (3 points) 
1. Create a Search Folder for messages that are flagged. (1 point) (Exam objective 

1.3.1) 

2. Create a Search Folder for all messages that contain the word Blueberries. (2 
points) (Exam objective 1.3.1) 

Points scored: ________ / 3 

Task: Create and use a folder (3 points) 
1. Create a folder named Company Info in M3_cornerstone_PST_starter. (1 point) 

(Exam objective 2.3.2) 

2. Find the message with the subject Staff images, and move it to the Company Info 
folder. Find the message with the subject Company overview, and move it to the 
Company Info folder. (2 points) (Exam objective 2.3.3) 

Points scored: ________ / 3 

Task: Delete a message (1 point) 
1. Delete the message with the subject Daily Recap. (0 points) 

2. Delete the conversation with the subject Personnel working on the cover crops. (1 
point) 

Points scored: ________ / 1 

FILE 1 TOTAL POINTS: ________ / 18 

Detach the Cornerstone .pst file 
After you complete all tasks, you must detach your .pst file so that your teacher can 
assess your work. To do this:  

1. In Outlook, on the Navigation Bar, select the ellipsis (Navigation Menu button), 
and then select Folders. 

2. Locate the folder named M3_cornerstone_PST_starter_ Firstname_Lastname, and 
right-click or access the context menu for the folder. 

3. On the context menu, select Close “M3_cornerstone_PST_starter_ 
Firstname_Lastname”. 

4. On your computer, open File Explorer, and browse to where the .pst file resides. 

5. Right-click or access the context menu for the file, and then select Rename. 
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6. Append your name to the end of the existing file name by using underscores instead 
of spaces. For example, enter _ Firstname_Lastname. The filename should now 
resemble M3_cornerstone_PST_starter_ Firstname_Lastname. 

7. Copy the .pst file to the designated location for assessment. 
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Module overview 
Description 
Email is a great tool for communication; however, it can be taxing to manage large 
volumes of email. By automating a few processes, you can simplify email management 
and organization. Microsoft Outlook 2019 offers Quick Steps, Quick Parts, and rules to 
help manage your Outlook account. In this module, you'll learn about these options and 
use them to manage your email at Munson's Pickles and Preserves Farm. The following 
table outlines the lessons in this module and their corresponding learning objectives. 

Lesson Learning objective Exam objective(s) 

Using Quick 
Steps and 
Quick Parts 

Create, run, and manage automated message 
processes. 

Not mapped 

Using rules to 
manage mail 

Use rules to automatically manage messages. Not mapped 

Cornerstone: 
Automating 
email and 
tasks 

Automate mail message workflows and 
processes. 

Not mapped 

Table 1: Objectives by lesson 

Scenario 
It's the end of the summer, and you've been working at Munson's Pickles and Preserves 
Farm for several months. Munson's has planned upcoming events and special activities 
that the Munson's Media and Communications department must coordinate. You're 
finding it difficult to manage your time to efficiently handle the communications related 
to the special events in addition to your daily communications responsibilities. To help 
you save time and focus on more creative project tasks, you need to automate as many 
email-management processes as possible. As the Media and Communications intern, 
you manage the team's email account. You need to create a system to keep up with the 
many emails, find related information, and create useful reminders. 
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Cornerstone 
At the end of this module, you'll complete a Cornerstone project, which will put into 
practice the concepts you'll learn. You'll use Outlook Quick Steps, Quick Parts, and 
rules to automate your email management at the farm. 
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Lesson 1: Using Quick Steps and 
Quick Parts 
Overview 
When you're planning a major event, you might find yourself sending out repetitive 
messages and replying to many similar questions. You could copy and paste your 
message and responses, but Outlook offers two time-saving methods to help with these 
repetitive tasks. In this lesson, you'll learn how to use the Quick Steps and Quick Parts 
features to more efficiently manage email communication. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which of the following is true about Quick Steps? 

Select the correct option. 

a. You can use Quick Steps to reply to and create a new email. 

b. You can only use Quick Steps to create a new email. 

c. You can only use Quick Steps to reply to an email. 

d. You can use Quick Steps with graphics. 

2. Which of the following is true about Quick Parts? 

Select the correct option. 

a. Quick Parts offers the option to delete an email after replying to it. 

b. You can use Quick Parts to create an email to your team or manager. 

c. You can use Quick Parts to create a reusable block of text. 

d. Quick Parts offers the option to file an email within a folder. 

3. Elise works in the admissions office of a local college answering emailed questions 
about the admissions process. She finds herself composing new emails with the 
same text frequently. You recommend that Elise use _________________________ to help 
Elise with her work. 

Fill in the blank space. 
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4. Place the following items in the correct order for creating a Quick Step. 

Indicate the correct sequence by adding numbers 1-4 next to the following items. 

a. Create New - _________________________ 

b. Home - _________________________  

c. Quick Steps - _________________________ 

d. Add Action - _________________________ 

Attach the module .pst file 
To provide the most effective learning experience, this module includes several starter 
elements such as emails, calendar appointments, tasks, and contacts. These elements are 
stored in an external Outlook Data File, or .pst file. It resides in a location that your 
teacher will provide. To complete this module, you must attach this .pst file into Outlook 
before you can perform any try-its. You’ll also store the results of your try-its in this .pst 
file. This allows your teacher to assess your work by examining the .pst file’s contents.  

To open the .pst file in Outlook: 

1. Open Outlook. 

2. Select the File tab, and then select Open & Export. 

3. In the Open pane, select Open Outlook Data File. 

4. In the Open Outlook Data File dialog box, use the navigation pane to locate the 
.pst files provided by your instructor for your use throughout this module of the 
course. 

5. Open the file named M4_module_PST_starter. Note that a folder 
M4_module_PST_starter is now available in the navigation pane. This folder 
contains any required starter elements for the module, such as emails, calendar 
appointments, tasks, and contacts. 

6. Right-click or access the context menu for the M4_module_PST_starter folder, and 
then select Data File Properties. 

7. In the M4_module_PST_starter Properties dialog box, select Advanced. 

8. In the Outlook Data File dialog box, in the Name box, append your name to the 
end of the existing name by using underscores instead of spaces. For example, enter 
_Firstname_Lastname. The folder name should now resemble 
M4_module_PST_starter_Firstname_Lastname. 

9. Select OK twice. 
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Copy content into the module .pst file 
As you proceed through this module’s try-its, you should copy the resulting elements, 
such as emails, calendar appointments, tasks, and contacts, to the 
M4_module_PST_starter_Firstname_Lastname folder by using the following 
instructions: 

1. After you attach the .pst file, you should be able to observe duplicate folders for 
items such as emails, calendar appointments, tasks, and contacts. 

2. After you complete a try-it exercise, select your resulting items in the navigation 
pane. Make sure you select the items that are associated with your email account. 

3. In the details pane, right-click or access the context menu for each item, and then 
select Copy or select Ctrl+C. 

4. Select the M4_module_PST_starter_Firstname_Lastname folder. 

5. Select Ctrl+V to copy the item to the .pst file. 

6. Repeat steps 3 through 5 for any additional items that you want to copy. 

Topic 1: Create and use a Quick Step 
When reading your email, you might find yourself using the same processes over and 
over again. By using Quick Steps, you can define a process to complete these repetitive 
tasks and improve your efficiency. 

For example, Quick Steps can be helpful when you're receiving many related emails and 
want to move them to a folder. In this module's scenario, you're receiving numerous 
emails concerning different events happening at the farm. You can create a Quick Step 
to file all the event-related emails into one folder. 

Use a prebuilt Quick Step 
To use a prebuilt Quick Step, perform the following steps: 

1. Select the email message to which you wish to apply a Quick Step. 

2. On the Home tab, locate the Quick Steps group. 

 
Figure 1: Quick Steps group 
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3. Select the Quick Step that you wish to apply to your chosen email, based on the 
following descriptions: 

o Move to: ?. Use this option to move the email to a chosen folder. The first time 
you use this option, you must define where to move the email. Outlook saves this 
action for future use, but you can choose to move different emails to any folder 
that you specify. 

o Team Email. Use this option to forward an email to the other members of your 
team. You can select those team members the first time that you use this option. 
You must name your team the first time that you access this feature. 

o Reply & Delete. Use this option to create a reply to the person who sent the 
email and then delete the email from your account. 

o To Manager. Use this option to forward a message to your manager. The first 
time that you use this option, you'll specify your manager. 

o Done. Use this option to move an email to the folder that you specify, mark the 
email as read, and mark the email as complete. 

o Create New. Use this option to create a new Quick Step. 

Create a new email by using a Quick Step 
By using Quick Steps, you can make it much easier and faster to send an email with a 
similar message to the same recipients multiple times. 

1. On the Home tab, in the Quick Steps group, select Create New. 

 
Figure 2: Quick Steps group 

2. In the Edit Quick Step dialog box, in the Name box, enter a name for the Quick 
Step that you'll create. 

 
Figure 3: Edit Quick Step dialog box 
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3. Select the Icon option to assign an icon for your Quick Step. 

 
Figure 4: Icon option 

4. In the Actions section of the Edit Quick Step dialog box, in the Choose an Action 
drop-down box, select an action for your Quick Step. In this case, to create a new 
email, select New Message. 

 
Figure 5: New Message option 

5. Some actions will require more information, in which case a dialog box displays with 
options for you to enter this additional information. To create a new message, you 
must enter the email address in the To box, as the following screenshot depicts. 
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Figure 6: The To box in the New Message action 

6. If you want to add the carbon copy (Cc), blind carbon copy (Bcc), and the text for 
your message to your email, select Show Options, which the following screenshot 
highlights. 

 
Figure 7: Show Options 

7. The Edit Quick Step dialog box expands and displays additional options, including 
the Add Cc and Add Bcc options. In the Text box, you can enter the text that you 
want to use in the message each time that you send the email. After entering the 
information, select Hide Options. 
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Figure 8: Add Cc, Add Bcc, and Text options 

8. If you would like to delete an action, select the Delete icon. If you want to add an 
additional action for the Quick Step, select Add Action. 

 
Figure 9: Delete and Add Action options 

9. In the Optional section, you can create a shortcut key for your Quick Step and add 
tooltip text. 
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Figure 10: Optional section 

 

Did you know? 

Tooltips are included in all the Office apps. Tooltips give the user 
more information about the option, before they select it. You can 
access this information by hovering over the option. 

10. Select Finish. The Quick Step that you created now displays in the Quick Steps 
group. 
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Use a Quick Step 
1. To use a Quick Step, on the Home tab, in the Quick Steps group, select Quick Step. 

2. Enter the information for the email. 

3. Select Send. 

Manage a Quick Step 
You might need to edit or delete a Quick Step. If your Quick Step needs modification, 
you might want to change it to do something different. For any of these actions, 
perform the following steps: 

1. On the Home tab, in the Quick Steps group, select the dialog box launcher. 

 
Figure 11: Quick Steps dialog box launcher 

2. In the Manage Quick Steps dialog box, select the Quick Step that you want to 
manage. 



Automating messages 
 

 
15 

 
Figure 12: Manage Quick Steps 

3. Select Edit, Duplicate, or Delete. 

4. Selecting Edit will return you to the Edit Quick Step dialog box where changes to 
the Quick Step can be made. 

5. Selecting Duplicate will make a copy of the Quick Step and return you to the Edit 
Quick Step dialog box where you can make changes to the Quick Step. 

6. Selecting a Quick Step and selecting Delete will delete the Quick Step. 

 

Additional information 

To review more information on Quick Steps, go to: Automate 
common or repetitive tasks with Quick Steps 

Activity: Guess and tell 
How many steps do you think it would take to send an email to the Sales Team? The 
email needs to include the Sales Team in the To field and at least one individual in the 
Cc field, a subject line, a typed message, and an attachment. Record your guess. 

https://aka.ms/Automate-common-or-repetitive-tasks-with-Quick-Steps
https://aka.ms/Automate-common-or-repetitive-tasks-with-Quick-Steps
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Count the steps to send an email that meets the task requirements as your teacher 
performs the steps. Now, let's assume you are sending a similar email every day. How 
many steps would it take each month to send these similar emails? 

Follow along as your teacher demonstrates how to create a Quick Step to respond to 
these emails in just one step. 

Resources required 
You'll need the following resources for this activity: 

• Locate L1_T1_act_daily_recap_starter.docx in this lesson’s Learning Activity 
Resources. 

Activity instructions 
Participate in the activity by following these instructions: 

1. Create a Quick Step named New Email with the following actions: 

a. Email should be sent to the Sales Team. 

b. The email should be copied to another Munson’s employee. 

c. The Subject line should read Daily Recap. 

d. The text in the message should be: 

Please find attached the daily recap of action items from yesterday. 

2. Use the Quick Step to send the email, adding the Daily Recap document as an 
attachment. 

How many steps did it take to send the email by using the Quick Step? 

Try-it: Create and use a Quick Step 
 In this leveled try-it activity, you'll practice creating and using Quick Steps. You’ll 

discover for yourself how the Quick Step feature saves you time and effort. 

Try-it 1 

Resources 
You'll need the following resources for this try-it: 

• Locate the email sent with Fall Apple Picking Event in the subject (go to the  
Lesson 1 folder). 
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Instructions 
The following are the general tasks that you must perform during this try-it: 

1. Using a Quick Step named Apple, reply to and delete the message. 

2. Use the following text for your reply: Our Fall Apple Picking Events are held each 
Friday, Saturday, and Sunday, August through October, from noon to 6 p.m. 
We'll have Red Delicious, Golden Delicious, and Rome apples for $20 a bushel 
when you pick your own. 

3. From the Sent folder, copy the reply to Fall Apple Picking Event message to 
M4_module_PST_starter_Firstname_Lastname. 

Try-it 2 

Resources 
You'll need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you must perform during this try-it: 

1. Create a Quick Step to send a new email. 

2. Use the name Peaches and the email address provided by your teacher. 

3. Use the Subject: Peach Availability. 

4. Enter the following for a message: Could you please give me the dates for the 
availability of peaches? Thank you, Danielle Gousse 

5. From the Sent folder, copy the Peach Availability message to 
M4_module_PST_starter_Firstname_Lastname. 

Try-it 3 

Resources 
You'll need the following resources for this try-it: 

• Locate L1_T1_try3_weekly_recap_starter.docx in this lesson’s Learning Activity 
Resources. 
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Instructions 
The following are the general tasks that you must perform during this try-it: 

1. In Outlook, go to M4_module_PST_starter folder and Contacts. 

2. Select all items (three contacts and a group called Executives) and copy to your 
Contacts folder in your mailbox. 

3. Create a Quick Step. 

4. Name the Quick Step Weekly Events Report. 

5. Add the action New Message. 

6. Enter the Executives distribution list in the To box. 

7. Add the Cc name and email address for Marcos Serna. 

8. Use Weekly Events Report for the Subject box. 

9. Enter the following message in the Text box: 

Please find attached our Weekly Events Recap. I hope this will be helpful during 
your end-of-the-week management meeting. If you need more information, 
please feel free to contact me, and I'll do my best to provide additional 
information. 

10. Create a Shortcut key by using Ctrl+SHIFT+1. 

11. Create an email by using the Shortcut key, and then attach the 
L1_T1_try3_weekly_report.docx to the email. 

12. From the Sent folder, copy the Weekly Events Report message to 
M4_module_PST_starter_Firstname_Lastname. 

Topic 2: Use Quick Parts 
Quick Parts are another feature in Outlook that help you save time. You can use Quick 
Parts to create a block of text, a graphic, or a combination of both, and save them so 
that you can use them over and over. Using Quick Parts is easier and faster than using 
Copy and Paste because of the time and steps involved in using those options. 

Create a Quick Part 
To create a Quick Part, perform the following steps: 

1. Open a new email message. 

2. In the message body, enter the text and graphics that you want to use multiple times 
for an email. 
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3. Select the text and graphics. 

4. On the Insert tab, in the Text group, select Quick Parts. 

 
Figure 13: Text group 

5. Select Save Selection to Quick Part Gallery. 

 
Figure 14: Quick Parts options 

6. In the Create New Building Block dialog box, give your Quick Part a name, verify 
that the Gallery is Quick Parts and that the Category is General. You can provide a 
description if you like.  

 
Figure 15: Create New Building Block dialog box 

7. Select OK. 

  



Automating messages 
 

 
20 

Use a Quick Part 
To use a Quick Part that you've created, perform the following steps: 

1. In a new email message or in an email message where you want to insert the Quick 
Part, on the Insert tab, in the Text group, select Quick Parts. 

2. In the General dialog box, select the Quick Part that you wish to insert into your 
email. 

 
Figure 16: General dialog box 

The Quick Part will be inserted into your email. 

Manage a Quick Part 
To edit the properties of a Quick Part or to delete it, perform the following steps: 

1. On the Insert tab, in the Text group, select Quick Parts, 

2. Right-click or access the context menu for the Quick Part that you wish to manage. 

3. In the context menu, select Edit Properties to change the name of the Quick Part or 
Organize and Delete to delete the Quick Part. 
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Figure 17: Context menu for a Quick Part 

4. Perform one of the following steps: 

a. If you’re changing the name of a Quick Part, enter the new name in the Name 
box of the Modify Building Block dialog box, and then select OK. 

b. If you’re deleting a Quick Part, verify that you’ve selected the correct Quick Part 
in the Building Blocks Organizer, select Delete, select Yes to confirm the 
deletion of the Quick Part, and then select Close. 

 

Did you know? 

Did you know that you can also use Quick Parts in Microsoft Word? 
This Did you know? section was inserted using a Quick Part as well 
as the Additional Information link. 

If you'd like to know more about using Quick Parts in Microsoft 
Word, go to: Use Quick Parts and AutoText in Word 

 

Additional information 

To review more information on Quick Parts, go to: Quick Parts 

To review more information on creating reusable text blocks, go to: 
Create reusable text blocks for email messages 

  

https://aka.ms/Use-Quick-Parts-and-AutoText-in-Word
https://aka.ms/Quick_Parts
https://aka.ms/Create-reuseable-text-blocks-for-email-messages
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Activity: Switch 
During this activity, you'll partner with one of your classmates. You'll create the Quick 
Part assigned to you by your teacher, and your partner will create the other Quick Part. 
After you've both completed your tasks, email your partner by using the Quick Part that 
you created. 

You'll be creating a Quick Part to remind Munson’s employees within your department 
to submit their timesheets. Your partner will create a Quick Part to remind employees 
within your department to submit their weekly status reports. 

Resources required 
You'll need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Pair up with a partner. 

2. One partner should create a Quick Part by using the following text: 

Name: Time Sheet 

Please be sure to submit your time sheet by Wednesday this week so that the 
Payroll Department will be able to process your pay for the Friday payday. 
Time sheets are due by Wednesday at 5 p.m. Thank you for your cooperation. 

When sending this message, use the Subject: Time Sheet Reminder. 

3. The other partner should create a Quick Part by using the following text: 

Name: Status 

Please remember to submit your weekly status report to me by the end of the 
day each Friday. I must submit a department status report each week on 
Tuesday, and I need your weekly status report to create our department report. 

When sending this message, use the Subject: Weekly Status Report. 

4. Send an email to your partner by using the Quick Part. 

5. From the Sent folder, copy the Time Sheet or Status message to 
M4_module_PST_starter_Firstname_Lastname. 

  



Automating messages 
 

 
23 

Try-it: Use Quick Parts 
 In this leveled try-it activity, you’ll practice creating and using Quick Parts. You’ll 

discover for yourself how the Quick Part feature saves you time and effort. 

Try-it 1 
Resources 
You'll need the following resources for this try-it: 

• Locate the email with the subject line Sales Projections. 

Instructions 
The following are the general tasks that you must perform during this try-it: 

1. Open the email and copy the text. 

2. Create a Quick Part by using the message in the email. 

3. Create a new message and insert the Quick Part. 

4. Send the message to your teacher, using the Subject: Try-It 1. 

5. From the Sent folder, copy the Try-it 1 message to 
M4_module_PST_starter_Firstname_Lastname. 

Try-it 2 
Resources 
You'll need the following resources for this try-it: 

• The Quick Part that you created for Sales. 
• Munsons_logo_banner_large_illustration.png in the Media folder under Student 

Materials. 

Instructions 
The following are the general tasks that you must perform during this try-it: 

1. Create a new Quick Part and name it Logo. Use the text from the Sales Quick Part 
and add the Munsons_logo_banner_large_illustration.png to the Quick Part. 

2. Resize the logo to fit the screen with the text under it. 

3. Use the Quick Part to send an email to your teacher, using the Subject: Try-it 2. 
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4. Edit the properties of the Logo Quick Part and rename it Sales Logo. 

5. Delete the Time Sheet and Status Quick Parts. 

6. From the Sent folder, copy the Try-it 2 message to 
M4_module_PST_starter_Firstname_Lastname. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Which of the following is true about Quick Parts? 

Select the correct option. 

a. You can use Quick Parts with text and graphics. 

b. You can only use Quick Parts to reply to an email. 

c. Quick Parts are useful for forwarding email. 

d. All the above are true. 

2. Which of the following is true about Quick Steps? 

Select the correct option. 

a. You can use a Quick Step to include graphics in a block of text. 

b. Quick Steps offers a quick way to send repetitive messages to many different 
individuals. 

c. Quick Steps offers different options that you can perform on received email. 

d. None of the above are true. 

3. Ivan is working to answer emails for a large business. He would like to find a way to 
quickly manage his incoming email. You suggest that Ivan try using 
_________________________ to help manage his incoming email. 

Fill in the blank space. 
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4. Match the appropriate features to the tasks that follow. 

o Quick Steps 
o Quick Parts 
Categorize the following items by adding the appropriate feature next to each item. 

a. Includes five prebuilt options - _________________________ 

b. Use for managing incoming email - _________________________ 

c. Use to create reusable blocks of text - _________________________ 

d. Offers the option to create a shortcut key - _________________________ 
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Lesson 2: Using rules to manage 
mail 
Overview 
In Lesson 1, you learned how to quickly create repeating emails and reply to them. In 
this lesson, you'll learn about the Outlook rules, which you can use to create and apply 
rules to incoming email. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which of the following is a true statement about rules? 

Select the correct option. 

a. You can create a rule and apply it to emails that you've already received. 

b. A rule will automatically sort email as you receive it. 

c. A rule will organize emails into folders. 

d. All above are true about rules. 

2. When can a rule run? 

Select all that apply. 

a. A rule can only run automatically, and you cannot control it. 

b. A rule that you previously created will run automatically when you receive an 
email. 

c. You can only run a rule after you receive an email. 

d. You can run a rule any time you wish. 

3. To edit a rule that you previously created, you must use the _________________________ 
option. 

Fill in the blank space. 
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4. Place the following selections in the correct order to create a rule. 

Indicate the correct sequence by adding numbers 1-4 next to the following items. 

a. Create Rule - _________________________ 

b. Home - _________________________ 

c. Move - _________________________ 

d. Rules - _________________________ 

Topic 1: Create and run a rule 
You can use Outlook rules to define a set of actions to perform when an email meets a 
set of criteria. This is another feature that can save time and make managing your 
workflow much easier. In this topic, you’ll learn how to create and run rules. 

Create a rule 
There are two ways to start the process for creating a rule for email. You can either: 

1. Select the email, and on the Home tab, in the Move group, select the Rules drop-
down. 

 
Figure 18: Move group 

2. Select Create Rule. 

 
Figure 19: Rules menu 

Or 
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1. Right-click or access the context menu for an email, select Rules, and then select 
Create Rule. 

 
Figure 20: Email context menu 

2. In the Create Rule dialog box, you can create a set of actions for email that meet a 
set of criteria. 
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Figure 21: Create Rule dialog box 

3. Select and make changes to the appropriate items in the When I get email with all 
the selected conditions section. The From check box displays the name of the 
person who sent you the email that you selected. The Subject contains box displays 
the subject of the email you selected, but you can edit this field. 

4. Make selections and changes in the Do the following section. If you select the Play 
a selected sound option check box, you'll have to assign a sound by selecting 
Browse. If you select the Move the item to folder check box, you'll have to select 
the Select Folder option. 

5. The Rules and Alerts dialog box displays in which you can choose a folder. If you 
need to create a new folder, you can do this by selecting New. 

 
Figure 22: Rules and Alerts dialog box 

6. Select OK. 

 

Additional information 

To review more information on email rules, go to: Manage email 
messages by using rules 

  

https://aka.ms/Manage-email-messages-by-using-rules
https://aka.ms/Manage-email-messages-by-using-rules
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Activity: Tell a story 
In this activity, you’ll use rules to separate out the email related to the Pick Your Own 
Strawberries event from other email. 

Resources required 
You'll need the following resources for this activity: 

• Locate the Pick Your Own Strawberries email. 

Activity instructions 
Participate in the activity by following these instructions: 

1. Create a rule to Always move messages with the subject Pick Your Own 
Strawberries to a Strawberries folder and have it display in the New Item Alert 
window. You'll need to create a new folder called Strawberries. 

2. To test this rule, send the Pick Your Own Strawberries email to a partner. If the rule 
works, the email will be filed in the Strawberries folder. An Alert Window will appear 
to alert you that the message has been filed. 

Try-it: Create and run a rule 
 In this leveled try-it activity, you’ll practice creating a rule. 

Try-it 1 
Resources 
You'll need the following resources for this try-it: 

• You'll need a partner for this try-it. 
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Instructions 
The following are the general tasks that you must perform during this try-it: 

1. Create a rule to move any emails from your partner to a folder named for your 
partner. 

2. After you've finished creating the rule, test the rule by having your partner send you 
an email. 

Try-it 2 
Resources 
You'll need the following resources for this try-it: 

• Locate the Job Opportunity email. 

Instructions 
The following are the general tasks that you must perform during this try-it: 

1. Create a rule to Always move messages with the subject Job Opportunity to a 
folder named Jobs and display the message in the New Item Alert window. 

2. After you've finished creating the rule, test the rule by having your partner send the 
Job Opportunity email to you. 

Topic 2: Manage rules 
In Topic 1, you learned how to create rules. In this topic, you'll learn how to manage 
rules by making a copy, modifying, and deleting rules. 

Change a rule 
To make changes to a rule, perform the following steps: 

1. On the Home tab, in the Move group, select Rules, and then select Manage Rules 
and Alerts. 

2. The Rules and Alerts dialog box displays the rules that you have created. 
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Figure 23: Rules and Alerts dialog box 

3. Select the rule that you want to change, select Change Rule, and then select Edit 
Rule Settings. 

 
Figure 24: Change Rule menu 
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4. The Rules Wizard appears, in which you can make changes to the rule by using the 
four dialog boxes that the wizard takes you through. After you've made your 
changes on one dialog box, select Next or Finish on the last dialog box. 

 
Figure 25: Rules Wizard 

5. When you’re making a change to a rule, you might need to provide more 
information. If you select the option in Step 2 of the Rules Wizard, you can enter the 
required information to create the rule. For example, the from people or public 
group option needs the names of the people or group. After you select this option, 
you can select the phrase in the Step 2 box to add the names or group in the dialog 
box. 
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Figure 26: Step 2 of the Rules Wizard 

6. The Rule Address dialog box allows you to select the people or group. 

 
Figure 27: Rule Address dialog box 

7. Select Finish after you've made all your changes. 

8. Select OK. 

Copy a rule 
To copy a rule, perform the following steps: 

1. On the Home tab, in the Move group, select Rules, and then select Manage Rules 
and Alerts. 

2. The rules that you've created will display in the Rules and Alerts dialog box. 
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3. Select the rule that you want to change, and then select Copy. 

4. In the Copy rule to dialog box, you can specify the folder to copy the rule to. By 
default, the rule is copied to the Inbox folder. 

 
Figure 28: Copy rule to dialog box 

5. Select OK. 

Choose when to run a rule 
By default, a rule runs when a message arrives. If you want to choose when to run a rule, 
you can perform the following steps: 

1. On the Home tab, in the Move group, select Rules, and then select Manage Rules 
& Alerts. 

2. The rules that you've created will display in the Rules and Alerts dialog box. 

3. Select Run Rules Now. 

4. In the Run Rules Now dialog box, you can choose one or multiple rules to run. 
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Figure 29: Run Rules Now dialog box 

5. Select Run Now. 

6. When you've finished running all the rules that you wish to run, select Close. 

Delete a rule 
To delete a rule, perform the following steps: 

1. On the Home tab, in the Move group, select Rules, and then select Manage Rules 
& Alerts. 

2. The rules that you've created will display in the Rules and Alerts dialog box. 

3. Select the rule that you wish to delete, and then select Delete. 

4. Confirm the deletion of the rule by selecting Yes. 

 

Additional information 

To review more information on editing a rule, go to: Edit an Outlook 
rule 

https://aka.ms/Edit-an-Outlook-rule
https://aka.ms/Edit-an-Outlook-rule
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Activity: Pose a challenge 
In this activity, you’ll following along as your teacher demonstrates the steps to manage 
a rule. 

Resources required 
You'll need the following resources for this activity: 

• Open the Pickle Camp email. 

Activity instructions 
Participate in the activity by following these instructions: 

Send the Pickle Camp email to your teacher, but don't use the subject Pickle Camp. Use 
something else in the subject line. After your teacher has received all the emails in their 
inbox, follow along as the teacher demonstrates, by performing the following steps: 

1. Create a rule to file emails with the subject Pickle Camp in a folder called Pickle 
Camp. 

2. Make a copy of the rule. 

3. In the copy of the rule, clear the with specific words in the subject option. 

4. Change the rule to search for the words Pickle Camp in the subject or the body of 
the message. 

5. Run the new rule, called Copy of Pickle Camp now. 

6. Delete the original rule. 

Try-it: Manage rules 
 In this leveled try-it activity, you’ll manage Outlook rules. 

Try-it 1 
Resources 
You'll need the following resources for this try-it: 

• Locate the Job Opportunities rule created in Topic 1 of this lesson. 
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Instructions 
The following are the general tasks that you must perform during this try-it: 

1. Run the Job Opportunities rule. 

2. Make a copy of the Job Opportunities rule. 

Try-it 2 
Resources 
You'll need the following resources for this try-it: 

• Locate the Pick Your Own Strawberries rule created in Topic 1 of this lesson. 

Instructions 
The following are the general tasks that you must perform during this try-it: 

1. Make a copy of the Pick Your Own Strawberries rule. 

2. Change the copy of the rule by searching for specific words in the body. 

3. Enter information as the specific word to search for in the body. 

4. Delete the original rule. 

Detach the module .pst file 
After you complete all try-its, you must detach your .pst file so your teacher can assess 
your work. To do this: 

1. In Outlook, on the Navigation Bar, select the ellipsis (Navigation Menu button), 
and then select Folders. 

2. Locate the folder called M4_module_PST_starter_Firstname_Lastname, and right-
click or access the context menu for the folder. 

3. On the context menu, select Close 
“M4_module_PST_starter_Firstname_Lastname”. 

4. On your computer, open File Explorer, and then go to the path where the .pst file 
resides. 

5. Right-click or access the context menu for the file, and then select Rename. 
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6. Append your name to the end of the existing file name by using underscores instead 
of spaces. For example, enter _Firstname_Lastname. The filename should now 
resemble M4_module_PST_starter_Firstname_Lastname. 

7. Copy the .pst file to the designated location for assessment. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Which of the following are criteria that you can set for managing email by using 
rules? 

Select all that apply. 

a. Move to a folder 

b. Play a sound 

c. Create a reply 

d. Display in an Alert Window 

2. Which of the following are options you can use to manage a rule? 

Select all that apply. 

a. Delete 

b. Change 

c. Run now 

d. Copy 

3. To delete a rule, you must use the _________________________ option in the Rules 
group. 

Fill in the blank space. 

4. Tina hopes to clean up her inbox. She has several emails concerning next month's 
grand opening. You suggest that Tina create a rule to move all email concerning the 
grand opening to a _________________________. 

Fill in the blank space. 

5. Tina has several emails concerning next month's grand opening already in her inbox. 
You suggest that Tina use the _________________________  option to move these emails 
to the appropriate folder. 

Fill in the blank space. 
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Glossary 
Bcc Bcc stands for blind carbon copy and is used to conceal a recipient 

email address from the other recipients. 

Cc Cc stands for carbon copy and sends a copy of an email to another 
recipient. 

Distribution list A reusable list of two or more email addresses created within your 
contacts list, with an assigned name for the list. 

Rule A set of user-defined criteria to help manage email.  

Quick Parts A way to create a library of blocks of text to be used repeatedly. The 
block of text could include graphics. You can also use Quick Parts in 
Microsoft Word. 

Quick Step A set of user-defined criteria that you can apply to email messages. 

Table 2: Glossary terms and definitions 
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Cornerstone 
Overview 
In this Cornerstone, you'll automate email message workflows and processes. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding MOS 
exam objectives. 

Cornerstone project objectives Exam OD 

Create, run, and manage automated 
message processes 

• Not mapped 

Use rules to automatically manage 
messages 

• Not mapped 

Table 3: Cornerstone objectives 

Duration 
50 minutes 

Attach the Cornerstone .pst file 
To complete this Cornerstone, you must attach this .pst file into Outlook before you can 
perform any tasks. You’ll also store the results of your tasks in this .pst file so that your 
teacher can assess your working by examining that file. 

To open the .pst file in Outlook: 

1. Open Outlook. 

2. Select the File tab, and then select Open & Export. 

3. In the Open pane, select Open Outlook Data File. 

4. In the Open Outlook Data File dialog box, use the navigation pane to locate the .pst 
files provided by your instructor for your use throughout this module of the course. 
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5. Open the file named M4_cornerstone_PST_starter. Note that a folder 
M4_cornerstone_PST_starter is now available in the navigation pane. This folder 
contains any required starter elements for the Cornerstone, such as emails, calendar 
appointments, tasks, and contacts. 

6. Right-click or access the context menu for the M4_cornerstone_PST_starter folder, 
and then select Data File Properties. 

7. In the M4_cornerstone_PST_starter Properties dialog box, select Advanced. 

8. In the Outlook Data File dialog box, in the Name box, append your name to the 
end of the existing name by using underscores instead of spaces. For example, enter 
_Firstname_Lastname. The folder name should now resemble 
M4_cornerstone_PST_starter_Firstname_Lastname. 

9. Select OK twice. 

Copy content into the Cornerstone .pst 
file 

As you proceed through this Cornerstone’s tasks, you should copy the resulting 
elements, such as emails, calendar appointments, tasks, and contacts, to the 
M4_cornerstone_PST_starter_Firstname_Lastname folder by using the following 
instructions: 

1. After you attach the .pst file, you should be able to observe duplicate folders for 
items such as emails, calendar appointments, tasks, and contacts. 

2. After you complete a try-it exercise, select your resulting items in the navigation 
pane. Make sure you select the items that are associated with your email account. 

3. In the details pane, right-click or access the context menu for each item, and then, 
select Copy or select Ctrl+C. 

4. Select the M4_cornerstone_PST_starter_Firstname_Lastname folder. 

5. Select Ctrl+V to copy the item to the .pst file. 

6. Repeat steps 3 through 5 for any additional items that you want to copy. 
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Instructions 
1. Complete the following tasks. 

2. When you’re done with the Cornerstone, assess your completion and enter the 
points that you think you earned within the task lists. You can ask your teacher for 
help if required. 

Tasks 
In this Cornerstone, you'll manage emails by using Outlook and you'll work with one file. 
The following are the tasks you need to do within this file. 

File – M4_cornerstone_PST_starter.pst 
Task: Create and use a Quick Step (9 points) 
1. Create a Quick Step to send out an email message named Blueberries and 

Balloons Weekly. (2 points) 

2. Set the Quick Step to send a message to your teacher. (2 points) 

3. Set the subject for the message as Blueberries and Balloons vendor spaces. (2 
points) 

4. Enter the following for the message text: Time is running out to sign up for a 
vendor space at the 2020 Blueberries and Balloons Festival. The deadline to 
reserve a vendor space is May 15, 2020. Reserve your space before they’re all 
gone! (2 points) 

5. Send the email by using the Blueberries and Balloons Quick Step to your teacher. 
(1 point) 

6. From the Sent folder, copy the Blueberries and Balloons vendor spaces message 
to M4_cornerstone_PST_starter_Firstname_Lastname. 

Points scored: ______ / 9 
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Task: Create a Quick Part (6 points) 
1. Create a Quick Part with the following message: Our Blueberries and Balloons 

Festival will be held Friday, June 26 through Sunday, June 28, 2020, from noon 
to 8 p.m. each day at the Munson’s farm. Plan to join us for three days of fun 
activities and try our delicious farm-grown food. Admission is free (with a small 
fee for pony and hot air balloon rides). You can find information about hotel 
accommodations on our website. You can also stay at our campground. Contact 
our campground manager for pricing and details. We hope you'll join us at the 
Blueberries and Balloons festival this June! (2 points) 

2. Name the Quick Part as BB Event by using the default settings. (2 points) 

3. Use the BB Event Quick Part to respond to the Blueberries and Balloons Event 
email. (2 points) 

4. From the Sent folder, copy the reply to the Blueberries and Balloons Event 
message to M4_cornerstone_PST_starter_Firstname_Lastname. 

Points scored: ______ / 6 

Task: Create, edit, delete, and run a rule (8 points) 
1. Create a rule to file any emails with the subject Blueberries and Balloons in a folder 

called Blueberries and Balloons. (3 points) 

2. Copy the Blueberries and Balloons rule. (1 point) 

3. Edit the copied Blueberries and Balloons rule so that if the email subject or the 
message body contain the words Blueberries and Balloons, the message is filed in 
the Blueberries and Balloons folder. (2 points) 

4. Run the rule so that it will apply to any message in your inbox. (1 point) 

5. Delete the original Blueberries and Balloons rule. (1 point) 

Points scored: ______ / 8 

TOTAL POINTS: ______ / 23 
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Detach the Cornerstone .pst file 
After you complete all tasks, you must detach your .pst file so that your teacher can 
assess your work. To do this: 

1. In Outlook, on the Navigation Bar, select the ellipsis (Navigation Menu button), 
and then select Folders. 

2. Locate the folder called M4_cornerstone_PST_starter_Firstname_Lastname, and 
right-click or access the context menu for the folder. 

3. On the context menu, select Close 
“M4_cornerstone_PST_starter_Firstname_Lastname”. 

4. On your computer, open File Explorer, and go to the path where the .pst file resides. 

5. Right-click or access the context menu for the file, and then select Rename. 

6. Append your name to the end of the existing file name by using underscores instead 
of spaces. For example, enter _Firstname_Lastname. The filename should now 
resemble M4_cornerstone_PST_starter_Firstname_Lastname. 

7. Copy the .pst file to the designated location for assessment. 
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Module overview 
Description 
Microsoft Outlook 2019 provides an extensive array of features to help you send, 
receive, and manage email communication. However, Outlook is more than just an email 
app. You can also use it to help with your time management skills by scheduling 
appointments, events, and meetings, and customizing your calendar. 

By the end of this module, you’ll be able to use Outlook to manage appointments and 
events. You’ll also be able to create and manage meetings and respond to or forward 
meeting requests. Finally, you’ll be able to use the Outlook Calendar to manage your 
schedule and coordinate with others to help maintain structure in an otherwise busy 
work environment. 

 

Video 

Review the concept video to learn about using Outlook to organize 
your projects and manage your time more effectively. 

The following table provides an outline of the specific lessons and learning objectives 
that are covered in this module. 

Lesson Learning objective Exam objective(s) 

Creating 
appointments 
and events 

Use Outlook to create appointments, events, 
and recurring events. 

• 3.1.1 
• 3.2.1 
• 3.2.4 
• 3.2.6 
• 3.3.2 

Creating and 
managing 
meetings 

Use Outlook to create new meetings, create 
meetings from messages, and update or 
cancel meetings. 

• 3.2.2 
• 3.2.3 
• 3.2.4 
• 3.2.5 
• 3.2.6 
• 3.3.3 
• 3.3.5 

https://aka.ms/video-managing-a-busy-schedule
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Lesson Learning objective Exam objective(s) 

Responding 
to meeting 
requests 

Respond to or forward a meeting request. • 3.3.1 
• 3.3.2 
• 3.3.4 

Coordinating 
your 
schedule with 
others 

Manage multiple calendars, share calendars, 
and create calendar groups. 

• 1.1.1 
• 3.1.2 

Printing and 
sharing your 
availability 

Print calendar information, send availability in 
a message, and create automatic replies. 

• 1.4.1 
• 1.1.3 

Cornerstone: 
Managing 
and 
coordinating 
schedules 

Create, respond to, and manage calendar 
appointments, meetings, and schedules. 

• 1.1.1 
• 1.1.3 
• 1.4.1 
• 3.1.1 
• 3.1.2 
• 3.2.1 
• 3.2.2 
• 3.2.3 
• 3.2.4 
• 3.2.5 
• 3.2.6 
• 3.3.1 
• 3.3.2 
• 3.3.3 
• 3.3.4 
• 3.3.5 

Table 1: Objectives by lesson 
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Scenario 
There’s never a dull moment working as the Media and Communications department 
intern at Munson’s Pickles and Preserves Farm! The Honey Fest is coming up soon and it 
will require quite a bit of planning. Several volunteers have already registered for their 
participation. Most of the farm employees will also be chipping in and helping with the 
fest. To manage everything smoothly, you’ll have to track and manage everyone’s 
schedules to avoid conflicts, and to plan tasks. 

Cornerstone 
This module concludes with a cornerstone project, in which you’ll use the Outlook 
Calendar to manage appointments, events, and meetings. During the cornerstone, you 
will: 

• Create appointments and events. 
• Create and manage meetings. 
• Manage multiple calendars. 
• Share calendar details and availability. 
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Lesson 1: Creating 
appointments and events 
Overview 
As you progress through your busy day, it can become challenging to effectively 
manage your appointments and events. In addition to tracking your current 
appointments, you must also manage your recurring appointments. These might be 
weekly, monthly, or yearly, and you must set reminders for them. Fortunately, you can 
now use the Outlook Calendar to accomplish these tasks, instead of relying on paper 
calendars and appointment books. Just imagine the time, effort, and paper you end up 
saving! 

In this lesson, you’ll learn how to create basic appointments and events. You’ll learn how 
to configure appointments and events as recurring items. You’ll also learn how to set 
reminders to help you manage your current and future scheduling needs. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Which of the following options is an activity that has a start and end date and time, 
and does not involve inviting other people or resources? 

Select the correct option. 

a. Event 

b. Appointment 

c. Meeting 

d. Session 

2. What do you call an activity that usually lasts 24 hours or more? 

Select the correct option. 

a. Event 

b. Appointment 

c. Meeting 

d. Session 
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3. When would you want to create a recurring appointment in the Outlook Calendar? 

________________________ 

Fill in the blank space. 

Attach the module .pst file 
To provide the most effective learning experience, this module includes several starter 
elements such as email, calendar appointments, tasks, and contacts. These elements are 
stored in an external Outlook Data File, or .pst file. It resides in a location that your 
teacher will provide. To complete this module, you must attach this .pst file into Outlook 
before you can perform any try-its. You’ll also store the results of your try-its in this .pst 
file. This allows your teacher to assess your work by examining the .pst file’s contents.  

To open the .pst file in Outlook:  

1. Open Outlook. 

2. Select the File tab, and then select Open & Export. 

3. In the Open pane, select Open Outlook Data File. 

4. In the Open Outlook Data File dialog box, use the navigation pane to locate the .pst 
files provided by your instructor for your use throughout this module of the course. 

5. Open the file named M5_module_PST_starter. Note that a folder 
M5_module_PST_starter is now available in the navigation pane. This folder 
contains any required starter elements for the module, such as email, calendar 
appointments, tasks, and contacts. 

6. Right-click or access the context menu for the M5_module_PST_starter folder, and 
then select Data File Properties. 

7. In the M5_module_PST_starter Properties dialog box, select Advanced. 

8. In the Outlook Data File dialog box, in the Name box, append your name to the 
end of the existing name by using underscores instead of spaces. For example, enter 
_Firstname_Lastname. The folder name should now resemble 
M5_module_PST_starter_Firstname_Lastname. 

9. Select OK twice. 
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Copy content into the module .pst file 
As you proceed through this module’s try-its, you should copy the resulting elements, 
such as email, calendar appointments, tasks, and contacts, to the 
M5_module_PST_starter_Firstname_Lastname folder by using the following 
instructions: 

1. After you attach the .pst file, you should be able to observe duplicate folders for 
items such as email, calendar appointments, tasks, and contacts. 

2. After you complete a try-it exercise, select your resulting items in the navigation 
pane. Make sure you select the items that are associated with your email account. 

3. In the details pane, right-click or access the context menu for each item, and then 
select Copy or select Ctrl+C. 

4. Select the M5_module_PST_starter_Firstname_Lastname folder. 

5. Select Ctrl+V to copy the item to the .pst file. 

6. Repeat steps 3 through 5 for any additional items that you want to copy. 

Topic 1: Create an appointment 
 An appointment refers to a scheduled activity in the Outlook Calendar that usually 

only pertains to the user. Creating an appointment doesn’t involve inviting other people 
or reserving resources. For example, you might want to schedule a doctor’s appointment 
for a specific date and time. You might also want to create an appointment to remind 
you of a final exam coming up in the next couple of weeks. 

A typical appointment has a start time and an end time. You can configure it as a one-
time appointment or as a recurring appointment. A recurring appointment is one that 
repeats multiple times, or on a regular scheduled basis. 

Create appointments 
Outlook provides several methods that you can use to create a new appointment. The 
most common methods include using the New items menu or navigating directly to the 
Calendar to create the appointment. 
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Use the New Items drop-down menu 
The New Items drop-down menu is located on the Home tab of the Outlook ribbon. 
The primary benefit of using the New Items drop-down menu to create an appointment 
is that the menu is available in all Outlook workspaces. For example, if you’re busy 
composing an email and need to quickly schedule an appointment, you don’t have to 
switch workspaces to display the Calendar. 

As the following screenshot depicts, the New Items menu provides a central location 
for you to create new items for all of Outlook’s features. These include email messages, 
appointments, meetings, groups, contacts, and tasks, as in the following screenshot. 

 
Figure 1: New Items menu 

Use the Calendar 
The Outlook Calendar is the place to go to review upcoming appointments and 
meetings. It’s also most likely the place where you’ll create your new appointments. 

As discussed in Module 1: Getting started with Outlook, when you select the Calendar 
workspace, your first task is to determine which view is the most appropriate for your 
needs. The following screenshot depicts the Calendar with the Day view selected. 
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Figure 2: Calendar workspace with Day view selected 

Notice that the Calendar contains half-hour increments for you to schedule your 
appointments. The Work Week and Week views also provide half-hour increments for 
displaying and scheduling appointments. 

 

Did you know? 

As previously discussed in Module 1: Getting started with Outlook, be 
sure to configure your Work time settings in Outlook Options. 
Remember that others can only schedule meetings with you during 
the days and hours you establish as your workdays. Times and days 
not included in the Work time settings display in your calendar as 
grayed-out time slots. 
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The following screenshot depicts the Work time settings that you can modify. 

 
Figure 3: Work time settings 

Enter a new appointment in the calendar 
To create a simple appointment, select the intended time slot on the Calendar and 
enter the subject name of the appointment. When you select an appointment after 
creating it, a new Appointment tab displays on the ribbon, as in the following 
screenshot. 

 
Figure 4: Appointment options 

You can configure several additional settings for an appointment. The following groups 
on the Appointment tab contain these settings: 

• Actions. In the Actions group, you can open the selected appointment, delete the 
appointment, or forward the appointment to an email recipient. 

• Attendees. The Attendees group contains the Invite Attendees command. This 
essentially turns the appointment into a meeting and allows you to invite other 
people or assign resources to the item. 
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• Options. The Options group includes the following commands: 
o Show As. You can use this command to specify whether the appointment should 

block time in your calendar to indicate unavailability for other potential meeting 
invites. You can select from Free, Working Elsewhere, Tentative, Busy, or Out 
of Office. By default, when you create a new simple appointment, the Busy 
indicator is assigned to it. 

o Reminder. This command provides time periods to set a reminder related to the 
appointment. By default, a new simple appointment is configured with a 15-
minute reminder to appear before the appointment start time. 

o Recurrence. This command specifies a setting to indicate that the appointment is 
a recurring item which repeats daily, weekly, monthly, or yearly. 

• Tags. The Tags group contains the following commands: 
o Categorize. This command organizes Outlook items into color-coded categories. 
o Private. You can select this tag to mark the item as private, so others can’t 

observe the details of the appointment if they have shared access to your 
Calendar. 

o High Importance. You can select this tag to mark the item with a high 
importance indicator for your reference. 

o Low Importance. You can select this tag to mark the item with a low importance 
indicator for your reference. 

 

Did you know? 

If you need to schedule an appointment for more than the 30-minute 
time slot, you can simply select and drag the cursor to highlight the 
desired start and end time. You can also hold the Shift key on the 
keyboard and select the end time to schedule a larger appointment 
duration. 

Use the New Appointment command 
Another method you can use to create a new appointment in the Calendar is to select 
the New Appointment command. You can use this method when you input additional 
information, such as the location and specific start and end time periods. You can also 
use this method if you want to configure an event use the Scheduling Assistant to 
assist in inviting additional attendees, or if you need to configure an online meeting by 
using Skype or Microsoft Teams. As the following screenshot depicts, the New 
Appointment command opens the Appointment window, where you can customize 
advanced options for the appointment. 
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Figure 5: Appointment window 

Create an appointment from an email message 
At times, you might receive an email message that results in creating an appointment. 
For example, a work associate might send you an email to invite you to lunch. You can 
simply select the email item in the inbox, and then use the Move command on the 
ribbon to move or copy the email item to the Calendar. An Appointment dialog box 
opens with details such as the Subject, Start and End times, Show As setting to Busy, 
and a 15-minute reminder. The appointment will also include details of the email 
message as an attachment or in the memo area, depending on whether you move or 
copy the message. 

 

Did you know? 

If you choose to move an email message to the Calendar, the email 
item is attached to the appointment and removed from the inbox. If 
you choose to copy an email from the inbox, the message content is 
added to the memo area of the appointment. 

 

Video 

To review the video on creating appointments, go to: Create 
appointments and meetings 

https://aka.ms/Create_appointments_and_meetings
https://aka.ms/Create_appointments_and_meetings
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Activity: Show and tell 
In this activity, your teacher will demonstrate ways to create a new appointment and 
configure appointment options in the Outlook Calendar. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Pay close attention as your teacher demonstrates the following tasks: 

1. Review Outlook Options for the Calendar. 

2. Create a new appointment by entering it in the Calendar. 

3. Create a new appointment by using the New Appointment command. 

4. Configure options for appointments. 

Try-it: Create an appointment 
 In this leveled try-it activity, you’ll verify Outlook settings, create new 

appointments, and configure appointment options in the Outlook Calendar. 

Try-it 1 
Resources 
You will need to open and configure the following resources for this try-it: 

1. Open M5_module_PST_starter in this module’s Learning Activity Resources folder. 
You’ll complete all tasks within this Outlook Data File. 

2. On the Calendar workspace, in the Folder Pane, select the Calendar – 
M5_module_PST_starter check box. 

3. To display only the course-related calendar, clear the check box next to the default 
calendar in Outlook. 
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Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

• Open the Outlook Options dialog box, and verify that the Calendar settings are 
configured as follows: 
o Work hours: 8:00 AM to 5:00 PM 
o Work week: Monday to Friday 
o First day of the week: Sunday 

Try-it 2 
Resources 
You will need to open and configure the following resources for this try-it: 

1. Open M5_module_PST_starter in this module’s Learning Activity Resources folder. 
You’ll complete all tasks within this Outlook Data File. 

2. On the Calendar workspace, in the Folder Pane, select the Calendar – 
M5_module_PST_starter check box. 

3. To display only the course-related calendar, clear the check box next to the default 
calendar in Outlook. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. In the Module 5 Calendar, select the intended date and time and then enter a new 
appointment with the following information: 

o Date: Use tomorrow’s date 
o Time: 11:00 AM 
o Subject: Pick up Munson’s event flyers from printer 

2. In the Module 5 Calendar, use the New Appointment command to create a new 
appointment with the following information: 

o Date: Use tomorrow’s date 
o Start time: 12:00 PM 
o End time: 1:30 PM 
o Subject: Lunch with Marcos 
o Location: Munson’s lunchroom 
o Memo: Bring schedule to discuss upcoming events 
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Try-it 3 
Resources 
You will need to open and configure the following resources for this try-it: 

1. Open M5_module_PST_starter in this module’s Learning Activity Resources folder. 
You’ll complete all tasks within this Outlook Data File. 

2. On the Calendar workspace, in the Folder Pane, select the Calendar – 
M5_module_PST_starter check box. 

3. To display only the course-related calendar, clear the check box next to the default 
calendar in Outlook. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. In the Module 5 Calendar, select the 11:00 AM appointment with the Pick up 
Munson’s event flyers from printer subject line. 

2. Modify the following options for the appointment: 

o Show As: Out of Office 
o Reminder: 30 minutes 

3. In the Module 5 Calendar, select the 12:00 PM appointment with the Lunch with 
Marcos subject line. 

4. Open the appointment and then configure the following options for the 
appointment: 

o Show As: Busy 
o Reminder: 10 minutes 
o High Importance: Selected 

 

Did you know? 

You can create new Outlook Calendar items by using the keyboard. 
From the Calendar workspace, select the Alt key on the keyboard to 
display keyboard commands on the ribbon. For example, to create a 
new appointment, you can select Alt+H+I, and then select A. You can 
use this for other calendar types as well. Select E for meetings and V 
for all day events. 
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Topic 2: Create an all-day event 
 An event is different from an appointment in that it’s an activity that lasts at least 24 

hours or longer. For example, imagine that you’re out of the office to attend a seminar 
that lasts a couple of days. You can schedule the seminar as an event in your Outlook 
Calendar. You can only configure the start and end dates for events because they don’t 
have specific start and end time periods. 

To create an event, in the New Appointment window, select the All day event check 
box, as highlighted in the following screenshot. 

 
Figure 6: New event options 

After you select the All day event option, observe the following changes: 

• The Start time and End time only allows changes to the date. The times are greyed 
out. 

• The Show As indicator is set to Free. 
• The Reminder indicator is set to 0.5 days. 
• The Appointment tab and window are renamed to Event. 



Managing calendars 
 

 
20 

 

Did you know? 

As you create a new event, be sure to modify the Show As and 
Reminder settings as needed. By default, others will observe your 
time as free and potentially add you to meeting requests during the 
event duration. 

 

Additional information 

For more information on creating an all-day event, go to: Create an 
all-day event 

Activity: Discuss and learn 
In this activity, your teacher will initiate a discussion about the types of events and 
provide examples. Talk to your classmates and teacher about events in Outlook and ask 
any questions you might have about all-day events. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Discuss with your teacher the following concepts: 

1. What are some good examples of all-day events? 

2. What options do you need to consider when configuring an all-day event in the 
Outlook Calendar? 

Try-it: Create an all-day event 
 In this leveled try-it activity, you’ll create an all-day event and configure event 

options in the Outlook Calendar. 

  

https://aka.ms/create-an-all-day-event
https://aka.ms/create-an-all-day-event
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Try-it 1 
Resources 
You will need to open and configure the following resources for this try-it: 

1. Open M5_module_PST_starter in this module’s Learning Activity Resources folder. 
You’ll complete all tasks within this Outlook Data File. 

2. On the Calendar workspace, in the Folder Pane, select the Calendar – 
M5_module_PST_starter check box. 

3. To display only the course-related calendar, clear the check box next to the default 
calendar in Outlook. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

• In the Module 5 Calendar, use the New Appointment command to create a new 
event with the following information: 
o Start Time: Use next Tuesday’s date 
o Subject: Hilary’s birthday 
o All day event: Selected 
o Reminder: 1 day 
o Memo: Have the team sign her birthday card! 

Try-it 2 
Resources 
You will need to open and configure the following resources for this try-it: 

1. Open M5_module_PST_starter in this module’s Learning Activity Resources folder. 
You’ll complete all tasks within this Outlook Data File. 

2. On the Calendar workspace, in the Folder Pane, select the Calendar – 
M5_module_PST_starter check box. 

3. To display only the course-related calendar, clear the check box next to the default 
calendar in Outlook. 
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Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

• In the Module 5 Calendar, use the New Appointment command to create a new 
event with the following information: 
o Start time: Use Monday two weeks from today 
o End time: Use Friday two weeks from today 
o Subject: Munson’s Blueberry Seminar 
o All day event: Selected 
o Location: Event center 
o Show As: Out of Office 
o Reminder: 1 day 

Topic 3: Create a recurring 
appointment or event 

 Sometimes you might want to configure an appointment or event to occur multiple 
times. For example, you might have to attend soccer practice from 4 PM to 5 PM every 
Tuesday for the next six weeks. Instead of entering six separate appointments in the 
Outlook Calendar, you can create a single recurring appointment that covers the 
appropriate time period over the next six weeks. 

 

Did you know? 

Examples of recurring events that take place on the same date each 
year might be birthdays, anniversaries, and holidays.  

Create a recurring item 
To create a recurring appointment or event, you must either first select an existing item 
or create a new item. Then, on the Meeting contextual tab, in the Options group, select 
Recurrence. The Appointment Recurrence dialog box opens, as in the following 
screenshot. 
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Figure 7: Appointment Recurrence dialog box 

The Appointment Recurrence dialog box contains the following options: 

• Appointment time. Specify the start and end time of the recurring item. You can 
also specify the duration of the activity that you’re scheduling. 

• Recurrence pattern. Configure the frequency of the recurring activity. First, you can 
select from a Daily, Weekly, Monthly, or Yearly occurrence. You can then provide 
more granular settings such as which day, week, or month to repeat the 
appointment or event. 

• Range of recurrence. Specify how long the recurring activity should take place. You 
can choose to have no end date, end after a set number of occurrences, or end by a 
specific date. 

• Remove Recurrence. Remove the recurrence setting from an existing appointment 
or event. 

Modify or remove a recurring item 
A recurring item contains many repeating instances of the calendar entry. If you need to 
modify or remove a specific appointment in the series, you need to ensure that you 
open the appropriate setting to be configured. The following screenshot depicts the 
Open Recurring Item prompt that displays when you attempt to open a recurring item 
in the Outlook Calendar. 
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Figure 8: Open Recurring Item dialog box 

From this dialog box, you can choose from the following options: 

• Just this one. Opens only the instance of the item that you have selected. This 
allows you to modify the specific options or delete the item without affecting the 
rest of the recurring series of items. 

• The entire series. Opens the instance that you have selected. However, any changes 
you make to the options will affect the entire series of the recurring item. If you 
delete the item, you will delete the entire series of items as well. 

 

Did you know? 

If you need to just remove the recurrence setting on a calendar item, 
simply open the entire series and select Recurrence. Select Remove 
Recurrence to remove the repeating items and keep the original 
appointment or event intact. 

Activity: Show and tell 
In this activity, your teacher will demonstrate how to create and modify a recurring 
appointment in the Outlook Calendar. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Pay close attention as your teacher demonstrates the following tasks: 

1. Create a new appointment. 

2. Configure the new appointment as a recurring item. 
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3. Modify a single instance of the recurring item. 

4. Modify the entire series of the recurring item. 

Try-it: Create a recurring appointment or event 
 In this leveled try-it activity, you’ll create and modify a recurring item in the 

Outlook Calendar. 

Try-it 1 
Resources 
You will need to open and configure the following resources for this try-it: 

1. Open M5_module_PST_starter in this module’s Learning Activity Resources folder. 
You’ll complete all tasks within this Outlook Data File. 

2. On the Calendar workspace, in the Folder Pane, select the Calendar – 
M5_module_PST_starter check box. 

3. To display only the course-related calendar, clear the check box next to the default 
calendar in Outlook. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

• In the Module 5 Calendar, use the New Appointment command to create a new 
recurring appointment with the following information: 

o Start time and End time: Next Monday from 9:00 AM to 9:30 AM 
o Subject: Deliver produce to local food bank 
o Location: Local Food Bank 
o Reminder: 1 day 
o Show As: Busy 
o Recurrence: Every Monday with no end date 
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Try-it 2 
Resources 
You will need to open and configure the following resources for this try-it: 

1. Open M5_module_PST_starter in this module’s Learning Activity Resources folder. 
You’ll complete all tasks within this Outlook Data File. 

2. On the Calendar workspace, in the Folder Pane, select the Calendar – 
M5_module_PST_starter check box. 

3. To display only the course-related calendar, clear the check box next to the default 
calendar in Outlook. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

• In the Module 5 Calendar, use the New Appointment command to create a new 
recurring item with the following information: 

o Start time and End time: Next Thursday from 5:00 PM to 6:00 PM 
o Subject: Munson’s Honey Growers User Group 
o Location: Munson’s meeting room 
o Reminder: 0.5 days 
o Show As: Busy 
o Recurrence: On the second Thursday of every month which ends after 5 

occurrences. 

Try-it 3 
Resources 
You will need to open and configure the following resources for this try-it: 

1. Open M5_module_PST_starter in this module’s Learning Activity Resources folder. 
You’ll complete all tasks within this Outlook Data File. 

2. On the Calendar workspace, in the Folder Pane, select the Calendar – 
M5_module_PST_starter check box. 

3. To display only the course-related calendar, clear the check box next to the default 
calendar in Outlook. 
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Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

• In the Outlook Calendar, modify and cancel the third instance of the Munson’s 
Honey Growers User Group item. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. Describe the difference between an appointment and an event. 

 

Fill in the blank space. 

2. Which of the following are valid Show As indicators? 

Select all that apply. 

a. Free 

b. Busy 

c. Out for lunch 

d. Working Elsewhere 

e. Working at home 

3. You want to enter your friend’s birthday in the Outlook Calendar. Which Outlook 
item works best for this task? 

Select the correct option. 

a. Meeting 

b. Appointment 

c. Event 

d. Task 
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4. You need to ensure that an appointment is repeated every Tuesday over the next 
three weeks. Which option should you configure? 

Select the correct option. 

a. Reminder 

b. End time 

c. Show As 

d. Recurrence 
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Lesson 2: Creating and 
managing meetings 
Overview 
Another important aspect of using the Outlook Calendar is the ability to send a meeting 
request to one or more people. When integrated with email systems such as Microsoft 
Office 365 or Microsoft Exchange, you’ll be able to: 

• Determine available time periods for people and resources. 
• Keep track of who accepts meeting requests. 
• Use the Outlook Calendar to manage scheduled meetings. 
In this lesson, you’ll learn how to create and manage meeting requests. You’ll also learn 
how to configure advanced meeting options such as scheduling, utilizing the room 
finder, and working with time zones. Finally, you’ll learn how to update or cancel 
meeting requests. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Describe the difference between an appointment and a meeting. 

 

Fill in the blank space. 

2. As you configure a meeting request, you need to display available times for several 
required attendees. Which command on the ribbon will provide this information? 

Select the correct option. 

a. Room Finder 

b. Scheduling Assistant 

c. Address Book 

d. Check Names 
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3. You can use Outlook to reserve resources such as rooms and equipment for 
meetings. 

Select the correct option. 

a. True 

b. False 

Topic 1: Create a meeting 
A meeting is an Outlook Calendar appointment that includes sending invitations to 

request other people to participate. Depending upon the email system that you’re using, 
you can also use the meeting request to reserve additional resources such as meeting 
rooms or equipment. 

To create a meeting request, switch to the Outlook Calendar workspace and on the 
Home tab. In the New group, select New Meeting. The Meeting window opens as the 
following screenshot depicts. 

 
Figure 9: New meeting request 

A meeting request is like an appointment. However, it contains a number of additional 
settings related to scheduling and sending email invitations to potential attendees. 
Some of these additional settings include: 

• To. Opens the address book to select attendees for the meeting. 
• Rooms. Opens the address book, which is automatically filtered to display only room 

resources. This option is dependent on the email system that you’re connected to 
and its proper configuration by your email administrator. 

  



Managing calendars 
 

 
31 

• Attendees group. Contains a number of commands related to meeting requests: 
o Cancel Invitation. Cancels the invitation before it’s sent to other people. 
o Address Book. Opens the address book for you to select attendees and 

resources. This command is similar to the To option. 
o Check Names. Resolves the names that you enter in the To box to verify that 

their email addresses are correct and match your contact list. 
o Response Options. Enable or disable recipients to respond to your meeting 

request and allow new time proposals for the meeting. 
• Send. Send the meeting request to the recipients listed in the To box. In addition to 

sending the request, the meeting is also scheduled on your calendar during the start 
and end time specified in the invitation. 

Invite attendees to a meeting 
Your first step to creating a meeting invitation is to select the attendees. Similar to a 
standard email message, you can invite participants by providing their email addresses 
or contact information in the To box of the Meeting window. 

If you enter the email address directly into the To box, it’s assumed that the listed name 
is required for the meeting. However, you might want to include optional attendees as 
well. Selecting the Address Book in the ribbon, or simply selecting the To option opens 
the Select Attendees and Resources dialog box. 

In the Select Attendees and Resources dialog box, you can select potential attendees 
from all the address books available to your profile (as in the following screenshot). 
Address books might include your own personal contacts in addition to preconfigured 
address books from your email system. 
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Figure 10: Select Attendees and Resources dialog box 

The Select Attendees and Resources dialog box provides the following options: 

• Search. Use this option to search large address lists for specific names. 
• Address Book. This is a drop-down menu of address books and filtered views to 

help you find specific attendees and resources. 
• Required. If you select a name and then select Required, it’s assumed that the 

participant is expected to attend and accept the meeting request. 
• Optional. Use this option to specify potential participants that are not critical to the 

meeting, but might want to attend if time permits. 
• Resources. Use this option to specify resources that you might need for the meeting. 

This might include a conference room, media equipment, or any other resources that 
your email administrator might have configured within the email system. 

Use the Scheduling Assistant 
When inviting multiple people to a meeting, it’s often difficult to find a date and time 
that fits everyone’s schedule. The Scheduling Assistant helps you to find a meeting 
time where all of your attendees and resources are available. 

After entering the Subject of the meeting and adding the recipients into the To field, on 
the Meeting tab, in the Show group, select Scheduling Assistant. The Scheduling 
Assistant provides a representation of the free and busy information related to each 
invited attendee, in addition to Room Finder information if selected, as indicated in the 
following screenshot. 
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Figure 11: Scheduling Assistant 

 

Did you know? 

The Scheduling Assistant provides two methods to quickly find 
available times. You can use the AutoPick feature or the Room 
Finder. You can access AutoPick from the Options command. You 
can access Room Finder from the Options group on the Meeting 
tab, which displays the Room Finder pane with all available 
conference rooms and suggested times for the meeting. 

After the Options button and the start and end times, boxes with color coding and 
patterns display. These colors and patterns represent whether a potential attendee is 
Busy, Tentative, Out of Office, or Working Elsewhere, and are key to determining 
free/busy states for attendees. Your goal is to find a time period where all of your 
required attendees are available and don’t have any other appointments scheduled. For 
example, in the previous screenshot, the first time all attendees are available is Thursday 
from 11:30 AM to 12:00 PM. 

After you have determined a successful meeting time, select Send to send email 
invitations to each of the recipients. Resources such as rooms will automatically accept 
the meeting request as configured by the email administrator. 
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Configure meeting options 
Similar to appointments and events, you can categorize meetings with the following 
options: 

• Show As. Specify marked time on the calendar. Options include Free, Working 
Elsewhere, Tentative, Busy, and Out of Office. These same indicators are used on 
the Scheduling Assistant to illustrate free/busy time. 

• Reminder. Specify when you want to receive a reminder for the start of the meeting. 
The default setting is 15 minutes. 

• Recurrence. Schedule the meeting to repeat at a specified interval. The options are 
identical to what was previously discussed with recurring appointments and events. 

Work with multiple time zones 
Sometimes, you might need to arrange online meetings with attendees from various 
time zones. In such situations, you can find it helpful to display multiple time zones in 
your Outlook Calendar. 

To add time zones to your calendar, open Outlook Options, and then select the 
Calendar section. As the following screenshot depicts, you can configure two time 
zones with labels to be displayed on your Outlook Calendar. 

 
Figure 12: Configuring time zones 
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The following screenshot depicts an example of two time zones configured with Pacific 
and Central labels. 

 
Figure 13: Calendar depicting two time zones 

 

Additional information 

For more information on scheduling meetings using Outlook, go to: 
Schedule a meeting with other people or Use the Scheduling Assistant 
and Room Finder for meetings in Outlook 

Activity: Show and tell 
In this activity, your teacher will demonstrate how to create a meeting invitation with 
multiple recipients in the Outlook Calendar. 

Resources required 
You will need the following resources for this activity: 

• None 
  

https://aka.ms/schedule-a-meeting-with-other-people
https://aka.ms/use-scheduling-assistant-and-room-finder-for-meetings-in-outlook
https://aka.ms/use-scheduling-assistant-and-room-finder-for-meetings-in-outlook


Managing calendars 
 

 
36 

Activity instructions 
Pay close attention as your teacher demonstrates the following tasks: 

1. Create a new meeting in the Outlook Calendar. 

2. Invite attendees to a meeting. 

3. Determine availability using the Scheduling Assistant. 

4. Review options for meetings. 

Try-it: Create a meeting 
 In this leveled try-it activity, you’ll create new meetings, invite attendees, and 

configure meeting options in the Outlook Calendar. 

Try-it 1 
Resources 
You will need the following resources for this try-it: 

• One or more partners as assigned by your teacher. 
• Email addresses for each of your assigned partners. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

• In the Outlook Calendar, create a new meeting invite using the following 
information: 
o To: Add the email addresses of your assigned partners 
o Subject: Blueberry festival Planning Session 
o Location: Conference Room 1 
o Start time: Tomorrow at 10:30 AM 
o End time: Tomorrow at 11:30 AM 

Try-it 2 
Resources 
You will need the following resources for this try-it: 

• One or more partners as assigned by your teacher. 
• Email addresses for each of your assigned partners. 
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Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

• In the Outlook Calendar, use the Scheduling Assistant to help create a new 
meeting invite by using the following information: 
o To: Add the email addresses of your assigned partners 
o Subject: Munson’s weekly status meeting 
o Location: Conference Room 1 
o Use the Scheduling Assistant to determine the best time to schedule a meeting 

on either a Tuesday or Wednesday. 
o Recurrence: Every week on the day and time you have determined by using the 

Scheduling Assistant. 

Topic 2: Create a meeting from a 
message 

 Sometimes, you might receive email messages that lead to a need for meetings. For 
example, your coworker might have an important question about a project that has an 
approaching deadline. To figure out the best approach, you might need to set up a 
meeting with your coworker and/or others. In such situations, in addition to standard 
responses, you can also respond to an email message by replying with a meeting 
request. 

As the following screenshot depicts, the Respond group contains the Meeting 
command, which you can use to reply to a message with a meeting request. The 
Respond group is located on the ribbon of the Mail workspace and on the ribbon of an 
open email message. 

 
Figure 14: Meeting response option 
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When you select Meeting as a response to an email message, the standard Meeting 
window displays, as the following screenshot depicts. The memo section of the meeting 
request also includes the content of the email message. 

 
Figure 15: Meeting response from an email message 

The meeting response provides access to all of the standard meeting options such as 
the Scheduling Assistant, Room Finder, Reminder, Recurrence, and other options, as 
previously discussed. 

 

Did you know? 

If your original email contains multiple recipients, your meeting 
request will automatically include all recipients from the To and Cc 
lines. 
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Activity: Show and tell 
In this activity, your teacher will demonstrate how to respond to an email message with 
a meeting invitation in the Outlook Calendar. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Pay close attention as your teacher demonstrates the following tasks: 

1. Respond to an email message with a meeting request. 

2. Invite attendees to a meeting. 

3. Review additional options for meetings. 

Try-it: Create a meeting from a message 
 In this leveled try-it activity, you’ll create a meeting response from an email 

message in Outlook. 

Try-it 1 
Resources 
You will need the following resources for this try-it: 

• One partner as assigned by your teacher. 
• Email address for yourself and for your assigned partner. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Send a new email message to your partner with the following information: 

o To: Add the email address of your assigned partner 
o Subject: Meet for lunch 
o Content: Hi there, let’s meet for lunch to discuss plans for the cookbook 

edits. 
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2. From your partner’s inbox, select the message with the subject “Meet for lunch.” 
Respond by creating a new meeting invite by using the following information: 

o To: Verify that your assigned partner’s email address is listed 
o Subject: Meet for lunch 
o Location: Lunch Room 
o Start time: Tomorrow at 12:00 PM 
o End time: Tomorrow at 1:00 PM 

Try-it 2 
Resources 
You will need the following resources for this try-it: 

• One partner as assigned by your teacher. 
• Email address for yourself and your assigned partner. 
• Additional email addresses for potential attendees. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Send a new email message to your partner with the following information: 

o To: Add the email address of your assigned partner 
o Subject: Meet to discuss project plan for festival 
o Content: Hi there, can we organize a meeting to discuss the project plan for 

the Blueberry festival? Let’s invite the rest of the team. I should be available 
sometime later this or next week. 

2. From your partner’s inbox, select the message with the subject “Meet to discuss 
project plan for festival.” Respond by creating a new meeting invite by using the 
following information: 

o To: Add the additional email addresses of your assigned attendees. 
o Subject: Meet to discuss project plan for festival 
o Location: Conference Room 1 
o Use the Scheduling Assistant to determine the best time to schedule a meeting 

on either a Wednesday or Thursday. 

 

Video 

To review the video on how to create a meeting request from an email 
message, go to: Respond to an email message with a meeting request 

https://aka.ms/Respond-to-an-email-message-with-a-meeting-request
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Topic 3: Track, update, or cancel a 
meeting 

 After you have sent a meeting request and the attendees have responded, you 
might want to display tracking status to determine how each recipient has responded to 
the request. There might also be times when you need to change meeting details after 
scheduling it. For example, you might need to change the meeting time or the 
attendees, or you might even have to cancel the meeting altogether. 

Display tracking status 
When you’re organizing a meeting, it’s beneficial to keep track of who has responded to 
the meeting request. The Outlook Calendar provides a meeting tracking feature, which 
contains a list of all the proposed attendees and their responses. 

To use the tracking feature, select or open a current meeting request to display the 
options on the Meeting tab ribbon. When you select the Tracking button in the Show 
group, the tracking status opens, as depicted in the following screenshot. 

 
Figure 16: Displaying tracking status for a meeting 

The tracking status provides information such as: 

• People who have invites to the meeting. 
• Whether a person is a required or optional attendee. 
• The attendee’s current response to the meeting invite. 
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Update a meeting 
You can update a scheduled meeting at any time, regardless of how many people have 
responded to the request. When you open a scheduled meeting, all the same options 
are available as when you created the new meeting. You can change options such as the 
Subject, Location, Start time, End time, Show As, and Reminder. You can also add or 
remove attendees, or use the Scheduling Assistant to find a new meeting time, if 
needed. 

As the following screenshot depicts, the primary difference between scheduling and 
updating a meeting is the Send Update button. Selecting this sends a new email to the 
list of attendees notifying them of the changes requesting approval. 

 
Figure 17: Updating a meeting request 

Cancel a meeting 
To cancel a scheduled meeting, select or open the meeting in your Outlook Calendar. 
On the ribbon, in the Actions group, select Cancel Meeting. 

As the following screenshot depicts, you can select the Send Cancellation button to 
send a new email to the attendees notifying them of the cancellation. 
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Figure 18: Cancelling a meeting request 

After you send the cancellation message, Outlook removes the scheduled meeting from 
your calendar. All other attendees receive an email message with a notification that the 
meeting is cancelled. They will also receive an option to remove the meeting from their 
calendar. 

 

Additional information 

For more information on cancelling a meeting, go to: Cancel a 
meeting 

Activity: Each one, teach one 
In this activity, you’ll work with a partner to research how to cancel a meeting. You’ll 
then teach each other what you’ve learned. Your teacher will guide the class through 
this activity. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Pair up with a classmate. 

2. Search Outlook Help or open a support article about how to cancel a meeting 
request. 

3. Teach your partner what you learned, and then discuss with them what they learned. 

https://aka.ms/Cancel-a-meeting
https://aka.ms/Cancel-a-meeting
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Try-it: Track, update, or cancel a meeting 
 In this leveled try-it activity, you’ll update and cancel a meeting in the Outlook 

Calendar. 

Try-it 1 
Resources 
You will need the following resources for this try-it: 

• Two partners as assigned by your teacher. 
• Email addresses for each of your assigned partners. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. In the Outlook Calendar, create a new meeting invite using the following 
information: 

o To: Add the email address of one of your assigned partners 
o Subject: Budget planning 
o Location: Conference Room 1 
o Start time: Next Tuesday at 2:00 PM 
o End time: Next Tuesday at 3:00 PM 

2. In the Outlook Calendar, create a new meeting invite using the following 
information: 

o To: Add the email address of all your assigned partners 
o Subject: Lunch Meeting 
o Location: Lunch Room 
o Start time: Next Thursday at 12:00 PM 
o End time: Next Thursday at 1:00 PM 

3. Update the Budget planning meeting with the following changes: 

o To: Add the email address of your second assigned partner 
o Start time: Next Wednesday at 2:00 PM 
o End time: Next Wednesday at 3:00 PM 
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Try-it 2 
Resources 
You will need the following resources for this try-it: 

• Two partners as assigned by your teacher. 
• Email addresses for each of your assigned partners. 
• Completed Try-it 1. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

• Cancel the meeting with the subject of Lunch Meeting that was scheduled for next 
Thursday. 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. The To option opens the ________________________, which contains a list of names and 
email addresses. 

Fill in the blank space. 

2. After attendees accept your meeting request, you cannot make any changes to the 
meeting options. 

Select the correct option. 

a. True 

b. False 

3. The Scheduling Assistant can depict if a potential attendee is working elsewhere 
during the proposed meeting time. 

Select the correct option. 

a. True 

b. False 
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4. You need to determine which attendees have responded to your meeting request. 
Which option provides this information? 

Select the correct option. 

a. Scheduling Assistant 

b. Response Options 

c. Show As 

d. Tracking 
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Lesson 3: Responding to 
meeting requests 
Overview 
When you receive a meeting request, you need to submit an appropriate response to 
the organizer. Responding to the invite is important so that the organizer can accurately 
track details of the meeting and set expectations on who will or will not be in 
attendance for the meeting. 

In this lesson, you’ll learn how to respond to a meeting request. You’ll also learn how to 
work with reminders and forward a meeting request to other potential attendees. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Describe why it’s important to respond to a meeting request. 

 

Fill in the blank space. 

2. You have received a meeting request; however, the meeting time will not work with 
your schedule. You have an alternate time that is open. Which of the following 
options should you use to respond to the meeting request? 

Select the correct option. 

a. Accept 

b. Propose New Time 

c. Move to 

d. Follow Up 
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3. You receive a reminder to attend a meeting in 30 minutes. You would like to be 
reminded again five minutes before the meeting starts. Which of the following 
options would you select? 

Select the correct option. 

a. Snooze 

b. Dismiss 

c. Tentative 

d. Follow Up 

Topic 1: Respond to a meeting request 
 Responding to a meeting request means that you’re communicating your intentions 

for attending the meeting. Depending upon your available time and interest, you have 
options to provide various responses to the meeting organizer. 

When you open a meeting request message, the Meeting tab contains the Respond 
group of commands, as in the following screenshot. 

 
Figure 19: Responding to a meeting request 

Possible responses to the meeting request include: 

• Accept. Accept the proposed date and time for the meeting. 
• Tentative. Indicate that you might attend, depending on availability. 
• Decline. Indicate that you will not be able to attend the meeting on the proposed 

date and time. 
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When you select any of the previous responses, you can choose from various additional 
options for the organizer. Possible options for each response include: 

• Edit the Response before Sending. Provide additional information in the form of an 
email response to the meeting organizer. 

• Send the Response Now. Send the meeting response without any additional 
information or communication. 

• Do Not Send a Response. Choose not to send any response or communication to 
the meeting organizer. Note that if you select this option, the meeting organizer will 
not know whether you have accepted the meeting request or plan on attending the 
meeting. 

If a meeting request doesn’t work for you at the specified date or time, you can respond 
to the request by selecting the Propose New Time option. When you select this option, 
you can choose to tentatively accept the request but propose a new time. You can also 
decline the original request and propose a new time. 

After you make the appropriate selection, the Propose New Time dialog box opens, as 
in the following screenshot. This feature is quite similar to the Scheduling Assistant. 

 
Figure 20: Propose a new time for a meeting request 

After you select the newly proposed time, select Propose Time to send the response to 
the meeting organizer. 
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Configure automatic response settings 
The Calendar section of the Outlook Options dialog box provides settings to 
automatically accept or decline meeting requests based upon specific circumstances. As 
the following screenshot depicts, after you select Auto Accept/Decline, the Automatic 
Accept or Decline dialog box opens. 

  
Figure 21: Configuring Automatic accept or decline 

In the Automatic Accept or Decline dialog box, you can specify how automatic 
responses occur by selecting from the following options: 

• Automatically accept meeting requests and remove canceled meetings. Select 
this option to have Outlook automatically accept and schedule all meeting requests 
in your calendar, and automatically remove all canceled meetings. 

• Automatically decline meeting requests that conflict with an existing 
appointment or meeting. When you select this option, Outlook automatically 
declines any meeting request that conflicts with an existing appointment or meeting 
in your calendar. Outlook also sends a decline notice to the meeting organizer for 
tracking. 

• Automatically decline recurring meeting requests. Select this option to 
automatically decline any meeting requests that are configured with a recurrence 
setting. 

Work with reminders 
Before sending a meeting request, the organizer often configures a default reminder to 
ensure that attendees are reminded of the start to the scheduled meeting. As the time 
for the meeting gets closer, the Reminder window displays as configured by the 
organizer. 

As the following screenshot depicts, the Reminder window provides information about 
an upcoming meeting. This information includes the subject line, the start time, and the 
amount of time until the meeting starts. 
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Figure 22: Reminder window 

You can also select from the following options as a response to the reminder: 

• Dismiss. Selecting this option stops reminders for the meeting. 
• Dismiss All. Select this option if you have several meetings and/or appointments 

scheduled within the configured time period. This option dismisses all the listed 
items at once. By choosing this option you won’t have to select and dismiss each 
meeting or appointment one at a time. 

• Snooze. Set another reminder to prompt you again closer to the actual meeting or 
appointment time. The drop-down menu provides time periods from 5 minutes to 2 
weeks. 

 

Did you know? 

You can set reminders for all calendar items, including appointments, 
events, and meeting requests. 

Activity: Show and tell 
In this activity, your teacher will demonstrate how to respond to a meeting request in 
the Outlook Calendar. 
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Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Pay close attention as your teacher demonstrates the following tasks: 

1. Create a new meeting in the Outlook Calendar and invite attendees. 

2. Observe the email that contains the meeting invite. 

3. Review the response options and then respond to the meeting invite. 

4. Review the reminder options. 

Try-it: Respond to a meeting request 
 In this leveled try-it activity, you’ll create new meetings, invite attendees, and 

configure meeting options in the Outlook Calendar. 

Try-it 1 
Resources 
You will need the following resources for this try-it: 

• Three partners as assigned by your teacher. 
• Email addresses for each of your assigned partners. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Partner 1 only: In the Outlook Calendar, create a new meeting invite using the 
following information: 

o To: Add the email addresses of your assigned partners 
o Subject: Plan Munson’s Shareholder’s meeting 
o Location: Conference Room 1 
o Start time: next Monday at 8:30 AM 
o End time: next Monday at 10:00 AM 

2. Partners 2 and 3 only: When you receive the meeting invitation from Partner 1 in 
your inbox, accept the meeting and send the response now. 
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Try-it 2 
Resources 
You will need the following resources for this try-it: 

• One to three partners as assigned by your teacher. 
• Email addresses for each of your assigned partners. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Partner 2 only: In the Outlook Calendar, create a new meeting invite using the 
following information: 

o To: Add the email addresses of your assigned partners 
o Subject: Discuss work schedule for seasonal cleanup 
o Location: Conference Room 1 
o Start time: next Wednesday at 3:30 PM 
o End time: next Wednesday at 4:30 PM 

2. Partners 1 and 3 only: When you receive the meeting invitation from Partner 2 in 
your inbox, tentatively accept the meeting and edit the response before sending. For 
your edited response, provide a reason why you might not attend the meeting, and 
then send the response. 

Try-it 3 
Resources 
You will need the following resources for this try-it: 

• One to three partners as assigned by your teacher. 
• Email addresses for each of your assigned partners. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Partner 3 only: In the Outlook Calendar, create a new meeting invite using the 
following information: 

o To: Add the email addresses of your assigned partners 
o Subject: Lunch Meeting 
o Location: Local restaurant 
o Start time: next Friday at 12:00 PM 
o End time: next Friday at 1:00 PM 
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2. Partners 1 and 2 only: When you receive the meeting invitation from Partner 3 in 
your inbox, propose a new time by declining the meeting and send an alternate time 
for the meeting. 

Topic 2: Forward a meeting 
 When you schedule and manage meetings with your contacts, there might be 

situations in which you need to forward a meeting request to another person. For 
example, imagine that a friend lets you know a week before your revision meetup that 
they want to join as well. You want to add your friend, who was not on the original 
attendee list. As the meeting organizer, you can update the original meeting to add 
friend. Any of your other friends on the original invite can also forward the invite to your 
friend. 

To forward a meeting to another person, open the meeting and on the Meeting Series 
tab, in the Actions group, select Forward. The following screenshot highlights this 
option. 

 
Figure 23: Forwarding a meeting 

After you select Forward, a standard email message opens, which contains the meeting 
details. The message also indicates that the invite is sent on behalf of the meeting 
organizer. 

Note: When you forward a meeting to another person, Outlook sends an email 
notification to the meeting organizer as the following screenshot depicts. However, 
existing attendees are not notified when you forward a meeting request to another 
person. 
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Figure 24: Meeting forward notification 

 

Additional information 

For more information on how to forward a meeting, go to: Forward a 
meeting 

Activity: Show and tell 
In this activity, your teacher will demonstrate how to forward a meeting invitation in the 
Outlook Calendar. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Pay close attention as your teacher demonstrates the following tasks: 

1. Create a new meeting in the Outlook Calendar and invite attendees. 

2. Observe the received email that contains the meeting invite. 

3. From the recipient calendar, forward the meeting to another person. 

4. Review the Meeting Forward Notification from the organizer’s inbox. 

https://aka.ms/forward-a-meeting
https://aka.ms/forward-a-meeting
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Try-it: Forward a meeting 
 In this standalone try-it activity, you’ll create a new meeting request, and then 

forward a meeting request to a new recipient. 

Resources 
You will need the following resources for this try-it: 

• Three partners as assigned by your teacher. 
• Email addresses for each of your assigned partners. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Partner 1 only: In the Outlook Calendar, create a new meeting invite using the 
following information: 

o To: Add the email address of Partner 2 
o Subject: Plan Honey Festival Print Media 
o Location: Conference Room 1 
o Start time: next Monday at 10:30 AM 
o End time: next Monday at 11:00 AM 

2. Partner 2 only: When you receive the meeting invitation from Partner 1 in your 
inbox, accept the meeting and send the response now. 

3. Partner 2 only: Forward the meeting invitation to Partner 3. 

4. Partner 3 only: When you receive the meeting invitation from Partner 2 in your 
inbox, accept the meeting and send the response now. 

5. Partner 1 only: Review the Meeting Forward Notification in the Outlook inbox. 
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Wrap-up 
Use these questions to check what you learned in this lesson: 

1. You can use the ________________________ response option to indicate that you might 
attend as time or circumstance allows. 

Fill in the blank space. 

2. The ________________________ is the person that creates the meeting request and sends 
the meeting invitations. 

Fill in the blank space. 

3. Any required attendee can cancel a scheduled meeting. 

Select the correct option. 

a. True 

b. False 

4. When you forward a meeting to another person, meeting attendees are not notified. 

Select the correct option. 

a. True 

b. False 

5. You can configure Outlook to automatically respond to meeting requests. 

Select the correct option. 

a. True 

b. False 
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Lesson 4: Coordinating your 
schedule with others 
Overview 
An interesting aspect of organizing a meeting is the ability to use the Scheduling 
Assistant to discover other people’s available times. However, there might be times 
when you would like to review a coworker’s actual calendar to determine availability. 
You might also need to coordinate your schedule and share your calendar with other 
people. Or, you might be part of a project team that needs access to a shared project-
based calendar to organize specific tasks. 

In this lesson, you’ll learn how to coordinate your schedule with others by using various 
methods to share and provide access to your calendar. You’ll also learn how to create 
new calendars and display multiple calendars in a more efficient manner. You’ll do this 
by using features such as side-by-side mode, Overlay mode, and Calendar Groups. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Describe some of the challenges in sharing your calendar information with other
users.

Fill in the blank space.

2. You need to share your calendar information with a person outside of your
organization. The calendar will be updated on a regular basis. Which of the following
is the best option?

Select the correct option.

a. Email your calendar.

b. Publish your calendar to an online Web-based Distributed Authoring and
Versioning (WebDAV) server.

c. Modify calendar permissions to allow access to the user.

d. Share your calendar using Outlook.
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3. Which of the following options will merge multiple calendars on top of each other? 

Select the correct option. 

a. Overlay mode 

b. Schedule view 

c. Calendar Groups 

d. Side-by-side mode 

Topic 1: Manage multiple calendars 
 As you use the Outlook Calendar to manage your schedule, you’ll quickly learn that 

it can do more than just keep track of your personal appointments and meetings. You 
might belong to one or several committees at school, or maybe you manage the 
schedule for a sports team. You might also need a way to track bookings for a resource, 
such as a room or equipment, without having to rely on the email administrator to set it 
up in the email system. The Outlook Calendar supports the creation and management 
of multiple calendars so that you can organize your various schedules. 

For each of these scenarios, creating a new calendar specifically for the project or 
committee enables you to: 

• Focus only on a resource or committee schedule without having to filter through 
unrelated personal calendar entries. 

• Keep your personal schedule separate from the specific resource or committee 
calendars. 

• Share calendar information more securely, without having to worry about people 
inadvertently viewing items in your personal calendar. 

Create and display multiple calendars  
If you engage in various committee or project team activities, you’ll know that each 
project likely has its own schedule made up of meetings and deadlines. To help manage 
each specific schedule, you can create a new calendar by using one of the following 
methods: 

• From the Calendar workspace, on the Home tab of the ribbon, select Open 
Calendar, and then select Create New Blank Calendar. 

• From the Calendar workspace, on the Folder tab of the ribbon, select Create New 
Calendar. 
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Either method opens the Create New Folder dialog box, as the following screenshot 
depicts. 

 
Figure 25: Create a new calendar using the Create New Folder dialog box 

To create a new calendar, enter an appropriate name in the Name box, and in the 
Folder contains drop-down menu, select Calendar Items. For the final step, select 
where to place the folder. This location would typically be in your main Outlook data 
file. 

As the following screenshot depicts, each of your calendars are listed in the Folder 
Pane, under the My Calendars group on the Calendar workspace. Multiple calendars 
are, by default, displayed in side-by-side mode. 



Managing calendars 
 

 
61 

 
Figure 26: Viewing multiple calendars 

You can also hide or display specific calendars by selecting the check box next to the 
calendar name. 

Use Overlay mode to display multiple calendars 
Comparing the schedules of multiple calendars can be difficult when displayed in side-
by-side mode. This can become increasingly cumbersome when you have multiple 
calendars to select, display, and manage. 

Overlay mode provides a way to display a merged version of multiple selected 
calendars. The following screenshot illustrates Overlay mode with Calendar and 
Munson’s Shareholders Event Calendar selected. Note that scheduled items from 
both calendars display in a single window. Calendar items are also color-coded to help 
distinguish which calendar the scheduled item belongs to. 

To display selected calendars in Overlay mode, on the Calendar workspace, select the 
View tab. As depicted in the following screenshot, the Overlay option enables the 
merged view. You can also select the Overlay option to revert back to side-by-side 
mode as needed. 
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Figure 27: Displaying calendars using Overlay mode 

 

Additional information 

For more information on creating and displaying multiple calendars, 
go to: Create additional calendars and View multiple calendars at the 
same time 

Activity: Show and tell 
In this activity, your teacher will demonstrate how to manage multiple calendars in 
Outlook. 

Resources required 
You will need the following resources for this activity: 

• None 
  

https://aka.ms/create-additional-calendars
https://aka.ms/view-multiple-calendars-at-the-same-time
https://aka.ms/view-multiple-calendars-at-the-same-time
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Activity instructions 
Pay close attention as your teacher demonstrates the following tasks: 

1. Create a new Outlook Calendar. 

2. Hide and display calendars in the Calendar workspace. 

3. Compare multiple calendars using side-by-side mode and Overlay mode. 

Try-it: Manage multiple calendars 
 In this standalone try-it activity, you’ll create a new calendar and manage the 

display of multiple calendars. 

Resources 
You will need the following resources for this try-it: 

• None 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. In the Outlook Calendar workspace, create a new calendar using the following 
information: 

o Name: Munson’s Summer Event Committee Calendar 
o Folder contains: Calendar Items 
o Select where to place the folder: Select your default Outlook profile. 

2. Select the Munson’s Summer Event Committee Calendar, and then select New 
Appointment to create a new recurring appointment with the following information: 

o Start time and End time: Next Tuesday from 10:00 AM to 11:00 AM 
o Subject: Event Committee Status Meeting 
o Location: Conference Room 
o Reminder: 1 day 
o Show As: Busy 
o Recurrence: Every Tuesday with no end date 

3. In the Outlook Calendar workspace, create a new calendar using the following 
information: 

o Name: Soccer Team Practice and Game Schedule 
o Folder contains: Calendar Items 
o Select where to place the folder: Select your default Outlook profile. 



Managing calendars 
 

 
64 

4. Select Soccer Team Practice and Game Schedule, and then select New 
Appointment to create a new recurring appointment with the following information: 

o Start time and End time: Next Tuesday from 4:00 PM to 5:00 PM 
o Subject: Team Practice 
o Location: Soccer field 1 
o Reminder: 1 day 
o Show As: Busy 
o Recurrence: Every Tuesday with no end date 

5. Enable Overlay mode using only the Munson’s Summer Event Committee 
Calendar and the Soccer Team Practice and Game Schedule calendars. 

6. Review how the appointments display. (You might need to browse to the date on 
which you created the appointments.) 

7. Switch back to side-by-side mode to display only the Munson’s Summer Event 
Committee Calendar and the Soccer Team Practice and Game Schedule 
calendars. 

Topic 2: Share calendars 
When you’re working on committees or project teams, you often need to share calendar 
information between team members. For example, at times you might need to only 
share available time and details from your calendar. Sometimes, you might go one step 
further and create a shared calendar for all team members to manage a project 
schedule. Depending on your specific requirements, Outlook provides several options 
for sharing and opening calendar information between users. 

 

Did you know? 

Many of Outlook’s calendar-sharing features require a connection to 
a supported and configured email system such as Office 365 or 
Microsoft Exchange Server. Check with your email administrator to 
verify which features will work in your school or organization. 
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Open user and resource calendars 
By default, all users in the same Office 365 or Microsoft Exchange organization have the 
ability to open and display user and resource calendars. However, only free/busy details 
will display, similar to what the Scheduling Assistant provides. You will not be able to 
observe, add, or edit any additional calendar details. 

 

Did you know? 

You can use the Calendar Permissions command on the Home or 
Folder tabs to change the default permissions assigned to your 
calendar to provide full access to other users in your organization. 
This is only recommended for specific scenarios and should be 
changed with caution. Consult with your email administrator on 
proper sharing policies within your school or organization. 

To open another user’s calendar or resource calendar, switch to the Calendar 
workspace, and then on the Home or Folder tabs of the ribbon, select Open Calendar. 
the following screenshot depicts the options in the Open Calendar drop-down menu. 

 
Figure 28: Open Calendar options 

You can use the following Open Calendar options for opening other people’s shared 
calendars: 

• From Address Book. This option opens the Address Book, where you can select a 
contact name and open their shared calendar. You can also use this option to select 
resource calendars that have been configured as user accounts in Exchange. 

• From Room List. Selecting this option opens a filtered display of the Address Book 
with only the configured room resources from the email system. 

• From Internet. Use this option to open the New Internet Calendar Subscription 
dialog box, where you can connect to and open calendars that have been published 
to supported internet locations. 
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• Create a New Blank Calendar. This option creates a new calendar. 
• Open Shared Calendar. This option prompts you to enter the name of a specific 

person or resource to open its shared calendar. 

 

Did you know? 

You can only open a user or resource’s default calendar by using the 
From Address Book and Open Shared Calendar commands. 
Additional calendars must be directly shared with you with 
appropriate permissions assigned by the owner of the calendar. 

Share calendars with users in your organization 
Members of the same committee or project team often work with a shared calendar to 
manage schedules and organize meetings and events. As discussed previously, you can 
create additional calendars to support the scheduling needs of your project teams.  

After creating a new calendar for the team, you need to share the calendar with users 
that require access and assign them appropriate permissions. To share a calendar, 
switch to the Calendar workspace and in the Folder Pane select the calendar. In the 
Share group, select Share Calendar as depicted in the following screenshot. 

 
Figure 29: Share Calendar 
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After you select Share Calendar, Outlook opens a Sharing invitation email message, as 
the following screenshot depicts. 

 
Figure 30: Sharing invitation email message 

The Sharing invitation email contains the following options that you must fill out 
before sending the invitation to recipients: 

• To. Enter the name or names of the users that should have access to the shared 
calendar. 

• Subject. Enter a subject related to the invitation. By default, the subject line will be 
filled in with the name of the selected calendar to be shared. 

• Recipient can add, edit, and delete items in this calendar. Select this check box to 
ensure that users can have full access to add and remove items from the calendar. If 
you don’t select this check box, recipients have read-only access to the calendar. 

After you send the invitation, all listed recipients receive the Sharing invitation email in 
their inbox. As the following screenshot depicts, recipients can select Open this 
Calendar to display the calendar in the Calendar workspace, and to add the calendar to 
their folder list. 
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Figure 31: Sharing invitation received 

Publishing calendar information to the internet 
On occasion you might need to share calendar information with people outside of your 
organization. Outlook 2019 provides a feature to publish your calendar online to a 
WebDAV server. WebDAV is a common protocol used for file and calendar-hosting 
services. When you publish calendar information, you’re still able to control the amount 
of information that is published and synchronized with the service. 

 

Did you know? 

If you’re connected to Office 365, you might observe the Publish This 
Calendar command. If you select this command, you’re directed to 
your online account settings to configure calendar publishing using 
Office 365. Consult with your email administrator for more 
information about publishing calendars with Office 365. 
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To publish your calendar to a WebDAV server, on the Home tab, in the Share group, 
select Publish Online, and then select Publish to WebDAV Server. The Publish 
Calendar to Custom Server dialog box opens as depicted in the following screenshot. 

 
Figure 32: Publish calendar details 

In the Publish Calendar to Custom Server dialog box, complete the following fields: 

• Location. Enter the URL of the online WebDAV sharing service. 
• Time Span. Select the amount of time that you want to publish online. By default, 

Whole calendar is selected. However, you can specify a specific range of time to 
minimize the amount of information published. 

• Detail. Select the amount of detail that you want to publish online. Options include: 
o Availability only. Only displays Free, Busy, Tentative, Working Elsewhere, or 

Out of Office. 
o Limited details. Includes availability indicators, but also includes the subject of 

each calendar item. 
o Full details. Includes all availability and provides full details of calendar items. 

• Advanced. Provides more advanced settings, including update frequency and 
whether you want to include details of items that are marked private. 

Activity: Show and tell 
In this activity, your teacher will demonstrate how to share an Outlook Calendar. 

Resources required 
You will need the following resources for this activity: 

• None 
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Activity instructions 
Pay close attention as your teacher demonstrates the following tasks: 

1. Open a user’s calendar to display default information. 

2. Create a new Outlook Calendar. 

3. Share an Outlook Calendar with a group of users. 

Try-it: Share calendars 
 In this standalone try-it activity, you’ll create a new calendar and then share a 

calendar with a partner. 

Resources 
You will need the following resources for this try-it: 

• A partner as assigned by your teacher. 
• Email addresses for each of your assigned partners. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Partner 1 only: In the Outlook Calendar workspace, create a new calendar using the 
following information: 

o Name: Munson’s Media Booking Calendar 
o Folder contains: Calendar Items 
o Select where to place the folder: Select your default Outlook profile. 

2. Partner 2 only: In the Outlook Calendar workspace, create a new calendar using the 
following information: 

o Name: Munson’s Honey Festival Committee Calendar 
o Folder contains: Calendar Items 
o Select where to place the folder: Select your default Outlook profile. 

3. Partner 1 only: Share the Munson’s Media Booking Calendar with Partner 2. 
Choose to allow your partner to add, edit, and delete items in the calendar. 

4. Partner 2 only: Share the Munson’s Honey Festival Committee Calendar with 
Partner 1. Choose to allow your partner to add, edit, and delete items in the 
calendar. 

5. From your inbox, review the Sharing invitation email received from your partner 
and then open the shared calendar. Verify that the calendar is displayed in your 
folder list. 
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Topic 3: Create calendar groups 
You can use a calendar group to organize and display several calendars at the same 
time. For example, you might find it beneficial to create a calendar group that contains 
your project team’s individual calendars. By doing so, you can quickly observe 
everyone’s calendars at the same time to determine availability. 

To create a calendar group, on the Home tab of the ribbon, select Calendar Groups, as 
in the following screenshot. 

 
Figure 33: Creating a Calendar Group 

When you select Calendar Groups, two options are available: 

• Create a New Calendar Group. Select this option to create a new calendar group of 
user’s default calendars. When you select this option, you’re prompted to provide a 
name for the group and then select team members from the address list. 

• Save as New Calendar Group. Select this option to create a new calendar group 
from a set of selected calendars in your folder pane. This option is for organizing 
calendars that you might already have in your folder list, and which you frequently 
review at the same time. 
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The following screenshot depicts an example of a calendar group named Event 
Planning Team Members. This calendar group contains four calendars that are 
displayed in the Calendar workspace. 

 
Figure 34: Calendar group listed in the Folder Pane 

As discussed previously, you can select or clear the check box next to each user calendar 
to enable or disable the calendar in the workspace. 

To remove a calendar group, right-click or access the context menu for the group name 
and then select Delete Group. Be careful with this option, because if you select it, all 
calendars within the group will also be removed from your folder list. If you need to 
keep the attached calendars in your folder list, move the calendars to an alternate group 
before deleting the current group. 

 

Video 

To review the video on how to use a calendar group, go to: Create, 
view, or delete a calendar group 

Activity: Tell a story 
In this activity, your teacher will describe a scenario and perform a demonstration to 
help you understand how to create a calendar group. 

Resources required 
You will need the following resources for this activity: 

• None 
  

https://aka.ms/create-view-or-delete-a-calendar-group
https://aka.ms/create-view-or-delete-a-calendar-group
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Activity instructions 
You teacher will use the Outlook Calendar to create a calendar group. Pay close 
attention as your teacher explains and demonstrates the following tasks: 

1. Open recipient Outlook calendars. 

2. Create a new calendar group using the address book. 

3. Create a new calendar group using existing recipient calendars in the folder list. 

Try-it: Create calendar groups 
 In this standalone try-it activity, you’ll create a new calendar group and add group 

members. 

Resources 
You will need the following resources for this try-it: 

• Three partners as assigned by your teacher. 
• Email addresses for each of your assigned partners. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. In the Outlook Calendar workspace, create a new calendar group using the following 
information: 

o Name: Munson’s Executive Group Calendar 
o Members: Add your partner’s names to the calendar group 

2. Review the folder list to verify that the group is created and that your partners are 
members of the group. 

Wrap-up 
Use these questions to check what you learned in this lesson:  

1. You can use the ________________________ command to share a calendar with a user in 
your organization. 

Fill in the blank space. 

2. A ________________________ is used to organize and display multiple calendars together. 

Fill in the blank space. 
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3. By default, when you share your calendar, users have permission to create new 
calendar items. 

Select the correct option. 

a. True 

b. False 

4. When you delete a calendar group, all group members automatically move to the 
My Calendars group. 

Select the correct option. 

a. True 

b. False 

5. You can use the Publish Online command to share calendar information with 
internet users. 

Select the correct option. 

a. True 

b. False 
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Lesson 5: Printing and sharing 
your availability 
Overview 
In this lesson, you’ll learn about the various formats you can use to print your calendar 
information. You’ll also learn how to share calendar availability by emailing information 
to users. Finally, you’ll learn how to configure automatic reply settings for email 
communication. 

Warm-up 
Use these questions to find out what you already know about this lesson’s topics: 

1. Describe the difference between the Availability only and Limited details settings 
when you send a calendar by email. 

 

Fill in the blank space. 

2. You can set separate automatic reply settings for inside your organization and 
outside of your organization. 

Select the correct option. 

a. True 

b. False 

3. Which of the following are default printing styles for an Outlook calendar? 

Select all that apply. 

a. Tri-fold Style 

b. Weekly Calendar Style 

c. Yearly Style 

d. 12-hour Style 

e. Weekly Agenda Style 
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Topic 1: Print calendar information 
 There might be times when you need to take a copy of your Outlook Calendar with 

you, especially when you’re away from your computer or device. Outlook has several 
printing styles that you can select from and print. Calendar print options also provide 
flexibility on what exactly you print for your calendar details. 

To print your calendar information, perform the following tasks: 

1. From the Calendar workspace, arrange the calendar to display the date range to be 
printed. 

2. On the ribbon, select the File tab and then select Print. 

3. As the following screenshot depicts, you can select the printer to print from, modify 
Print Options, and select from a variety of print styles. 

 
Figure 35: Print Calendar 
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Outlook Calendar print styles 
Outlook provides many different print styles to choose from. Table 2 describes each of 
the default styles available in the Outlook Calendar. 

Daily Style This style prints the calendar details for a single day, and includes a 
daily task list and a notes section. 

Weekly Agenda 
Style 

Use this style to print a week of calendar details in a format similar to 
a day planner. 

Weekly Calendar 
Style 

This style will print a week of calendar details in a format similar to 
the Week view of the Calendar workspace. 

Monthly Style This style prints your calendar items as a full month calendar.  

Tri-fold Style Use this style to print your calendar items in three columns, including 
hourly appointments, a daily task list, and a week summary. 

Calendar Details 
Style 

This style prints full details of your calendar items grouped by day. 

Table 2: Calendar print styles 

 

Did you know? 

You can edit each of the default styles to change style elements such 
as the font, layout, and header/footer settings. You can also copy the 
default styles and create new styles to meet your specific printing 
requirements. 
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Define print options 
Print options provide additional settings that you can use to print only what you 
specifically need. The following screenshot depicts the print options for Outlook 
calendars. 

 
Figure 36: Print options 

Calendar-specific printing settings include the following: 

• Print this calendar. Select a specific calendar to print from your folder list. 
• Print style. Modify and define new print styles. You can also modify certain elements 

of the default styles. 
• Print range. Specify the start and end date for the calendar printout. 
• Hide details of private appointments. Select this check box to ensure that any 

appointment tagged with the private setting will not display any details in the 
printout. 

 

Additional information 

For more information on printing your calendar, go to: Print a calendar 
showing appointments and meetings 

  

https://aka.ms/Print-a-calendar-showing-appointments-and-meetings
https://aka.ms/Print-a-calendar-showing-appointments-and-meetings
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Activity: Popcorn 
In this activity, your teacher will display various print styles on the overhead projector. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Pay close attention as your teacher displays various calendar print styles. When you 
know the style being displayed, call out “Popcorn” and provide your answer. The styles 
that you can choose from include: 

• Daily Style 
• Weekly Agenda Style 
• Weekly Calendar Style 
• Monthly Style 
• Tri-fold Style 
• Calendar Details Style 

Try-it: Print calendar information 
 In this standalone try-it activity, you’ll print your calendar information using various 

print styles. 

Resources 
You will need the following resources for this try-it: 

• None 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. In the Outlook Calendar workspace, display a date range that contains various 
appointments, meetings, or events. 

2. Print your calendar using the following options: 

o Printer: Microsoft Print to PDF (If you do not have this option, check with your 
teacher for guidance on which printer to use.) 

o Settings: Weekly Agenda Style 
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o Print Options: Hide details of private appointments 
o Save Print Output As: Select a location as directed by your teacher. 

3. Print your calendar again using the following options: 

o Printer: Microsoft Print to PDF (If you do not have this option, check with your 
teacher for guidance on which printer to use.) 

o Settings: Monthly Style 
o Save Print Output As: Select a location as directed by your teacher 

4. Create and send a new email message with the following options: 

o To: Your own email address 
o Subject: Calendar PDF Printouts 
o Attach File: Attach the two PDF files that you saved in the previous steps. 

Topic 2: Send availability in an email 
message 
In Lesson 4: Coordinating your schedule with others, you primarily focused on ways to 
share your calendar with people within your organization. To share calendar information 
with people outside of your organization, Lesson 4 also explained how to publish 
calendar information to an online service location. 

Another way you can send calendar availability is in an email message. The primary 
benefit of this method is that you can send information to anyone without requiring any 
specific online service. However, calendar information that you email is a static snapshot 
of your calendar. It won’t update automatically when you make changes to your 
calendar in Outlook. 
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To email your calendar information, switch to the Calendar workspace. On the Home 
tab, select Email Calendar. The Send a Calendar via Email dialog box opens as in the 
following screenshot. 

 
Figure 37: Send a Calendar via Email dialog box 

The options in the Send a Calendar via Email dialog box include: 

• Calendar. Select the calendar that you want to email. 
• Date Range. Select a date range such as Today, Tomorrow, Next 7 days, Next 30 

days, Whole calendar, or a specified date range. 
• Detail. Select the amount of detail that you want to include in the email message. 

Your options include: 
o Availability only. This setting only displays Free, Busy, Tentative, Working 

Elsewhere, or Out of Office. 
o Limited details. Select this setting to include availability indicators, but also to 

include the subject of each calendar item. 
o Full details. This setting includes all availability and provides full details of the 

calendar items. 
o Show time within my working hours only. Use this setting to help ensure that 

only calendar items within your specified working hours are included in the email. 
• Advanced. This option provides more advanced settings such as: 

o Include details of items marked private. Select this option to include details for 
calendar items that have been tagged with the private setting. This option is only 
available when you select Limited details or Full details. 
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o Include attachments with calendar items. Select this option to include 
additional attachments such as agenda or supplemental information for 
appointments or meetings. 

o Email Layout. Specify the layout for the calendar information in the email. Your 
options include Daily schedule or List of events. 

After specifying the Send Calendar via Email options, an email message is created. The 
following screenshot depicts an example of calendar information being sent via an email 
message. 

 
Figure 38: Sending calendar information in an email message 

 

Did you know? 

When you send your calendar as an email message, an attachment is 
included, which is your calendar information in iCalendar (.ics) format. 
This is a universal calendar file format and you can open it on various 
email and calendar platforms. 
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Additional information 

For more information on sending your calendar details as an email 
message, go to: Send an Outlook calendar in an email message 

Activity: Tell a story 
In this activity, your teacher will describe and demonstrate a scenario to help you 
understand how to send calendar information in an email message. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
You teacher will send calendar information in an email message. Pay close attention as 
your teacher explains and demonstrates the following tasks: 

1. Display the Outlook Calendar information. 

2. Email calendar information using the email calendar options. 

Try-it: Send availability in an email message 
 In this leveled try-it activity, you’ll send your calendar availability information in an 

email message. 

Try-it 1 
Resources 
You will need the following resources for this try-it: 

• One or more partners as assigned by your teacher. 
• Email addresses for each of your assigned partners. 
  

https://aka.ms/Send-an-Outlook-calendar-in-an-email-message
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Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

• In the Outlook Calendar, email your calendar information using the following 
information: 
o Date Range: Next 7 days 
o Detail: Availability only 
o To: Add the email addresses of your assigned partners 

Try-it 2 
Resources 
You will need the following resources for this try-it: 

• One or more partners as assigned by your teacher. 
• Email addresses for each of your assigned partners. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

• In the Outlook Calendar, email your calendar information using the following 
information: 
o Date Range: Next 30 days 
o Detail: Full details 
o To: Add the email addresses of your assigned partners 
o Email Layout: List of events 

Topic 3: Create automatic replies 
 Hopefully, there are times when you can take a break from email and a busy 

schedule. If you’re on vacation or don’t have access to email, you can configure 
automatic replies to notify others that you’re not available to respond to messages. 
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Did you know? 

Automatic replies are also commonly known as Out of Office 
messages. 

To create an automatic reply in Outlook, select the File menu, and then on the Info tab, 
select Automatic Replies. The following screenshot depicts an example of the 
Automatic Replies dialog box that opens. 

 
Figure 39: Configuring automatic replies 

When you configure automatic replies, consider the following options: 

• Do not send automatic replies. Select this option to disable automatic replies. This 
is the default setting. 

• Send automatic replies. Select this option to enable automatic replies. You can also 
select the Only send during this time range check box. This option provides a start 
time and an end time to the automatic replies. 
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• Inside My Organization. Use this section to enter an automatic reply message to 
anyone that sends you an email message from within the same organization as you. 
This option is only available if you’re connected to an email system such as Office 
365 or Exchange. 

• Outside My Organization. Use this section to enter an automatic reply message to 
anyone that sends you an email message from outside of your organization. You can 
also specify to only automatically reply to contacts, or to anyone outside of your 
organization. 

• Rules. Use this option to configure and apply rules to email messages that you 
receive while the Automatic Replies feature is active. For example, along with 
enabling Automatic Replies, you might want to enable a rule to automatically move 
all messages received from project committee members to a specific folder in 
Outlook. 

 

Video 

To review the video on configuring an automatic reply, go to: Set-up 
an automatic reply 

Activity: Show and tell 
In this activity, your teacher will demonstrate how to configure automatic replies in 
Outlook. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Pay close attention as your teacher demonstrates the following tasks: 

1. Enable and create an automatic reply for inside and outside of the organization. 

2. Configure a start and end time for the automatic reply. 

Try-it: Create automatic replies 
 In this leveled try-it activity, you’ll enable and configure an automatic reply in 

Outlook. 

  

https://aka.ms/Set_up_an_automatic_reply
https://aka.ms/Set_up_an_automatic_reply
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Try-it 1 
Resources 
You will need the following resources for this try-it: 

• One or more partners as assigned by your teacher. 
• Email address for yourself and for each of your assigned partners. 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. In Outlook, create an automatic reply using the following information: 

o Send automatic replies: Enabled 
o Inside My Organization: Hi there. I am out of the office for a produce seminar 

in Seattle. I will be gone until Friday. If you need to contact me, text me on 
my phone. 

o Outside My Organization: I am out of the Office until Friday. For urgent 
matters please contact the main office and they will direct you to an 
appropriate person. 

o Auto-reply to people outside my organization: Enabled 
o Anyone outside my organization: Enabled 

2. Direct a partner to send you an email message to verify that the automatic reply 
works as expected. 

Try-it 2 
Resources 
You will need the following resources for this try-it: 

• None 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

• In Outlook, modify the automatic reply settings to only send replies during the 
following time range: 
o Start time: Next Monday at 8:00 AM 
o End time: Next Friday at 5:00 PM 
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Wrap-up 
Use these questions to check what you learned in this lesson:  

1. The ________________________ style prints the calendar details for a single day and 
includes a daily task list and a notes section. 

Fill in the blank space. 

2. The ________________________ format is a universal calendar file format that various 
email and calendar platforms use. 

Fill in the blank space. 

3. The Availability only setting includes all availability and subject names for each 
calendar item. 

Select the correct option. 

a. True 

b. False 

4. By default, when you send your calendar details through email, items marked with 
the private tag are included. 

Select the correct option. 

a. True 

b. False 

5. Automatic Replies can respond to email messages sent either from inside your 
organization or outside of your organization. 

Select the correct option. 

a. True 

b. False 

Detach the module .pst file 
After you complete all try-its, you must detach your .pst file so your teacher can assess 
your work. To do this: 

1. In Outlook, on the Navigation Bar, select the ellipsis (Navigation Menu button), 
and then select Folders. 

2. Locate the folder named M5_module_PST_starter_ Firstname_Lastname, and 
right-click or access the context menu for the folder. 
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3. On the context menu, select Close 
“M5_module_PST_starter_Firstname_Lastname.” 

4. On your computer, open File Explorer, and then browse to where the .pst file 
resides. 

5. Right-click or access the context menu for the file, and then select Rename. 

6. Append your name to the end of the existing file name by using underscores instead 
of spaces. For example, enter _ Firstname_Lastname. The filename should now 
resemble M5_module_PST_starter_ Firstname_Lastname. 

7. Copy the .pst file to the designated location for assessment. 

Glossary 
Appointment A scheduled activity in the Outlook Calendar that doesn’t include 

other attendees or resources. 

Calendar group Used to organize and display several calendars simultaneously. 

Event A scheduled activity that doesn’t have a specific start and end time, 
and is blocked out for the entire day or for multiple days. 

Meeting A scheduled appointment that involves inviting other people or 
resources. 

Overlay mode A display setting in the Outlook Calendar that merges multiple 
calendars on top of each other. 

Recurrence An Outlook Calendar item such as an appointment, event, or 
meeting that repeats at regular intervals throughout the calendar. 

Resource An account or email system configuration that represents a room or 
piece of equipment that can be reserved for meetings. 

Side-by-side mode A display setting in the Outlook Calendar that displays multiple 
calendars next to each other. 

Table 3: Glossary terms and definitions 
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Cornerstone 
Overview 
The Honey Fest at Munson’s Pickles and Preserves Farm is coming up soon and it will 
require quite a bit of planning. Several volunteers have already registered for their 
participation. Most of the farm employees will also be chipping in and helping with the 
festival. To manage everything smoothly, you’ll use the Outlook Calendar to manage 
appointments, events, and meetings. 

Objectives 
The following table outlines the cornerstone objectives and their corresponding 
Microsoft Office Specialist (MOS) exam objectives. 

Cornerstone project objectives Exam OD 

Create appointments and 
events. 

• 3.1.1: Set calendar work times 
• 3.2.1: Create recurring calendar items  
• 3.2.4: Set calendar item times and time zones 
• 3.2.6: Set availability for calendar items 
• 3.3.2: Configure reminders 

Create and manage meetings. • 3.2.2: Cancel meetings 
• 3.2.3: Create calendar items from messages 
• 3.2.5: Set up meetings by using the scheduling 

assistant 
• 3.3.1: Forward calendar items 
• 3.3.3: Invite meeting recipients 
• 3.3.4: Respond to invitations 
• 3.3.5: Update individual or recurring calendar 

items 

Manage multiple calendars. • 1.1.1: Change the display of messages, 
calendar items, contact records, and tasks 

• 3.1.2: Manage multiple calendars 
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Cornerstone project objectives Exam OD 

Share calendar details and 
availability. 

• 1.1.3: Configure automatic replies 
• 1.4.1: Print message, calendar, contact, and task 

information 

Table 4: Cornerstone objectives 

Duration 
50 minutes 

Attach the Cornerstone .pst file 
To complete this cornerstone, before you can perform any tasks you must attach the 
Cornerstone .pst file into Outlook. You’ll also store the results of your tasks in this .pst 
file so that your teacher can assess your work by examining the file. 

To open the .pst file in Outlook: 

1. Open Outlook. 

2. Select the File tab, and then select Open & Export. 

3. In the Open pane, select Open Outlook Data File. 

4. In the Open Outlook Data File dialog box, use the navigation pane to locate the .pst 
file provided by your instructor for your use throughout this module of the course. 

5. Open the file named M5_cornerstone_PST_starter. Note that a folder named 
M5_cornerstone_PST_starter is now available in the navigation pane. This folder 
contains any required starter elements for the cornerstone, such as email, calendar 
appointments, tasks, and contacts. 

6. Right-click or access the context menu for the M5_cornerstone_PST_starter folder, 
and then select Data File Properties. 

7. In the M5_cornerstone_PST_starter Properties dialog box, select Advanced. 

8. In the Outlook Data File dialog box, in the Name box, append your name to the 
end of the existing name by using underscores instead of spaces. For example, enter 
_Firstname_Lastname. The folder name should now resemble 
M5_cornerstone_PST_starter_Firstname_Lastname. 

9. Select OK twice. 
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Copy content into the Cornerstone .pst 
file 
As you proceed through this cornerstone’s tasks, you should copy the resulting 
elements—such as email, calendar appointments, tasks, and contacts—to the 
M5_cornerstone_PST_starter_Firstname_Lastname folder by using the following 
instructions: 

1. After you attach the .pst file, you should find duplicate folders for items such as 
email, calendar appointments, tasks, and contacts. 

2. After you complete a try-it exercise, select your resulting items in the navigation 
pane. Make sure you select the items that are associated with your email account. 

3. In the details pane, right-click or access the context menu for each item, and then 
either select Copy or select Ctrl+C. 

4. Select the M5_cornerstone_PST_starter_Firstname_Lastname folder. 

5. Select Ctrl+V to copy the item to the .pst file. 

6. Repeat steps 3 through 5 for any additional items that you want to copy. 

Instructions 
1. Complete the tasks for each file. 

2. When you’re done with the cornerstone, assess your completion and enter the 
points you think you earned within the Task list. You can ask for the help of your 
teacher if required. 

Tasks 
The following steps are the tasks you need to do in this cornerstone. 
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Task 1: Create appointments and events (12 points) 
Note: Complete the following steps in your 
M5_cornerstone_PST_starter_Firstname_Lastname Calendar. 

1. Configure your Outlook Calendar work time as follows: (2 points) (Exam objective: 
3.1.1) 

o Start time: 9:00 AM or 09:00 
o End time: 5:00 PM or 17:00 
o Work week: Monday to Friday 

2. In the Outlook Calendar, create a new appointment with the following details: (5 
points) (Exam objectives: 3.2.4, 3.2.6, 3.3.2) 

o Subject: Pick up Honey Fest pamphlets from print vendor 
o Location: Print Vendor 
o Start time: Tomorrow at 10:30 AM or 10:30 
o End time: Tomorrow at 11:30 AM or 11:30 
o Show As: Busy 
o Reminder: 30 minutes 
o Time Zones: your current time zone 

3. In the Outlook Calendar, create a recurring all-day event with the following details: 
(5 points) (Exam objectives: 3.2.1, 3.2.4, 3.2.6, 3.3.2) 

o Subject: Annual Honey Fest  
o Location: Munson’s event center 
o Start time: Second Monday in April 
o End time: Third Friday in April 
o Show As: Out of Office 
o Reminder: 1 day 
o Recurrence: Every year on the second Monday in April 
o Range of recurrence: No end date 

Points scored: ________ / 12 
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Task 2: Create and manage meetings (15 points) 
Note: Complete the following steps with a partner as assigned by your teacher, in your 
M5_cornerstone_PST_starter_Firstname_Lastname Calendar. 

1. Partner 1 only: Create and send a new meeting invitation with the following details: 
(5 points) (Exam objectives: 3.2.5, 3.3.3) 

o To: Your partner’s email address 
o Subject: Honey Fest Status Meeting 
o Location: Conference Room 1 
o Scheduling Assistant: Use the Scheduling Assistant and verify that the following 

time period is available for your partner: 

 Start time: Tomorrow at 1:00 PM or 13:00 

 End time: Tomorrow at 2:00 PM or 14:00 

o Show As: Busy 
o Reminder: 30 minutes 

2. Partner 2 only: Create and send a new meeting invitation with the following details: 
(5 points) (Exam objectives: 3.2.5, 3.3.3) 

o To: Your partner’s email address 
o Subject: Budget Review for Honey Fest 
o Location: Conference Room 1 
o Scheduling Assistant: Use the Scheduling Assistant and verify that the 

following time period is available for your partner: 

 Start time: Tomorrow at 3:00 PM or 15:00 

 End time: Tomorrow at 4:00 PM or 16:00 

o Show As: Busy 
o Reminder: 30 minutes 

3. Respond to your partner’s meeting invitation by accepting the meeting request and 
sending the response now. (2 points) (Exam objective: 3.3.4) 

4. Forward your partner’s meeting invitation to your teacher’s email address. (2 points) 
(Exam objective: 3.3.1) 
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5. Partner 1 only: Create and send a new email message with the following details: (2 
points) 

o To: Your partner’s email address 
o Subject: Lunch Meeting 
o Details: Hi there! Can you set up a time for us to meet for lunch to discuss 

the upcoming Honey Fest details? Thanks! 
6. Partner 2 only: Create and send a new email message with the following details: (2 

points) 

o To: Your partner’s email address 
o Subject: Review Print Media 
o Details: We need to meet at the publishing company to review the print 

media. See you there! 
7. Very that you have received the email message from your partner and then reply 

with a meeting request. Use the Scheduling Assistant to invite your partner and 
schedule an appropriate time for next Wednesday. (2 points) (Exam objective: 3.2.3) 

8. Partner 1 only: Cancel the Review Print Media meeting. (2 points) (Exam objective: 
3.2.2) 

9. Partner 2 only: Cancel the Lunch Meeting. (2 points) (Exam objective: 3.2.2) 

Points scored: ________ / 15 

Task 3: Manage multiple calendars (8 points) 
1. Create a new calendar named Honey Fest Committee Calendar. Store the calendar 

in your M5_cornerstone_PST_starter_Firstname_Lastname folder. (2 points) (Exam 
objective: 3.1.2) 

2. Create a new calendar named Budget Committee Calendar. Store the calendar in 
your M5_cornerstone_PST_starter_Firstname_Lastname folder. (2 points) (Exam 
objective: 3.1.2) 

3. Select both the Budget Committee Calendar and the Honey Fest Committee 
Calendar, and create a new calendar group named Munson’s Calendars. (2 points) 
(Exam objective: 3.1.2) 

4. Select all the calendars in the Munson’s Calendars group, and then change the 
display to Overlay mode. (2 points) (Exam objective: 1.1.1) 

Points scored: ________ / 8 
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Task 4: Share calendar details and availability (5 points) 
1. In Outlook, create an automatic reply with the following details: (3 points) (Exam 

objective: 1.1.3) 

o Only send automatic replies starting next Monday at 8:00 AM or 08:00 and 
ending next Friday at 5:00 PM or 17:00. 

o Inside My Organization message: I am out of the office. If you have any 
questions, contact Marcos as he is handling all the details while I am away. 

o Outside My Organization message: Sorry, I am out of the office until next 
Friday. I will check my email periodically for urgent messages. 

2. Print your calendar details with the following settings: (2 points) (Exam objective: 
1.4.1) 

o Settings: Weekly Agenda Style 
o Printer: Select Microsoft Print to PDF. Save the PDF file in a location for use in 

the next step. (If this option is not available, consult with your teacher.) 
3. Email the PDF file to yourself as an attachment, and then move the email message 

with attachment to the M5_cornerstone_PST_starter_Firstname_Lastname folder. 

Points scored: ________ / 5 

TOTAL POINTS: ________ / 40 

Detach the Cornerstone .pst file 
After you complete all tasks, you must detach your .pst file so that your teacher can 
assess your work. To do this: 

1. In Outlook, on the Navigation Bar, select the ellipsis (Navigation Menu button), 
and then select Folders. 

2. Locate the folder named M5_cornerstone_PST_starter_Firstname_Lastname, and 
right-click or access the context menu for the folder. 

3. On the context menu, select Close 
M5_cornerstone_PST_starter_Firstname_Lastname. 

4. On your computer, open File Explorer, and browse to where the .pst file resides. 

5. Right-click or access the context menu for the file, and then select Rename. 

6. Append your name to the end of the existing file name by using underscores instead 
of spaces. For example, enter _Firstname_Lastname. The filename should now 
resemble M5_cornerstone_PST_starter_Firstname_Lastname. 

7. Copy the .pst file to the designated location for assessment. 
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Module overview 
Description 
To communicate with your friends, colleagues, suppliers, or customers, you need to 
have their email addresses, telephone numbers, and other contact information. You can 
maintain and access this information by using Contacts in Microsoft Outlook 2019. In 
Outlook, you can manage all aspects of your contacts, and even synchronize them 
across your other devices, including your phone. 

 

Additional information 

If you use the Outlook app on your iOS or Android phone, you can 
synchronize your contacts to and from your Microsoft email account, 
whether it’s a personal account or a Microsoft 365 account. 

The following table outlines the lessons in this module and their corresponding learning 
objectives. 

Lesson Learning objective Exam 
objective(s) 

Creating and updating 
contacts 

Add a contact from an email, create and 
update contacts, and import contacts 
from external sources. 

1.1.1 

4.1.1 

4.1.2 

Using contact groups Create, update, and delete contact 
groups. 

4.2.1 

4.2.2 

4.2.3 

4.2.4 

Sharing contacts Create, share, and print contact 
information. 

1.4.1 
2.3.2 
4.1.3 
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Lesson Learning objective Exam 
objective(s) 

Managing contacts Categorize and flag contacts, and review 
contacts by category and follow-up flag. 

None 

Cornerstone: Managing 
volunteer contact 
details 

Create, share, and manage contacts and 
contact groups. 

All of the 
above 

Table 1: Objectives by lesson 

Scenario 
Munson’s Pickles and Preserves Farm hosts many community events, and it relies on 
volunteers to help. The volunteer coordinator at the farm manages the volunteers’ 
contact details, availability, and other information. In your role as the intern, it’s now 
your job to assist the volunteer coordinator by managing the volunteer program 
communications. To prepare for next season, you need to administer the farm volunteer 
contact list and keep the volunteer coordinator informed. 

Cornerstone 
This module concludes with a cornerstone in which you’ll work with contacts and 
contact groups. During the cornerstone, you will: 

• Create and update contacts. 
• Use contact groups. 
• Share and categorize contacts. 
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Lesson 1: Creating and updating 
contacts 
Overview 
As your list of contacts grows, you might need to update contact details from time to 
time. By doing so, you can keep track of changes to your contacts' information, and 
manage your contacts better. In this lesson, you will learn how to create and update 
your contacts. 

Warm-up 
Ask your neighbor if they have any questions about the topics covered in the previous 
module. Help them if you can, and then use these questions to find out what you 
already know about this lesson’s topics. 

1. You must define a contact's email address before you can save the contact. 

Select the correct option. 

a. True 

b. False 

2. Which of the following options can you not assign as tags to contacts? 

Select the correct option. 

a. Views 

b. Categories 

c. Follow Ups 

d. Private 
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3. What element can you assign to a contact for the purpose of signing email messages
that you send them?

Select the correct option.

a. A password

b. A certificate

c. A picture

d. A full name

4. The ________________________ property in a contact determines how a contact displays
in a list.

Fill in the blank space.

5. You can use the ________________________ option to locate a contact's address on a
digital map.

Fill in the blank space.

6. By using the ________________________ view, you can observe a simple pictorial
summary of a contact's critical details.

Fill in the blank space.

Attach the module .pst file 
To provide the most effective learning experience, this module includes several starter 
elements such as emails, calendar appointments, tasks, and contacts. These elements are 
stored in an external Outlook Data File, or .pst file. It resides in a location that your 
teacher will provide. To complete this module, you must attach this .pst file into Outlook 
before you can perform any try-its. You’ll also store the results of your try-its in this .pst 
file. This allows your teacher to assess your work by examining the .pst file’s contents. 

To open the .pst file in Outlook: 

1. Open Outlook.

2. Select the File tab, and then select Open & Export.

3. In the Open pane, select Open Outlook Data File.

4. In the Open Outlook Data File dialog box, use the navigation pane to locate the .pst
files provided by your instructor for your use throughout this module of the course.
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5. Open the file named M6_module_PST_starter. Note that a folder 
M6_module_PST_starter is now available in the navigation pane. This folder 
contains any required starter elements for the module, such as emails, calendar 
appointments, tasks, and contacts. 

6. Right-click or access the context menu for the M6_module_PST_starter folder, and 
then select Data File Properties. 

7. In the M6_module_PST_starter Properties dialog box, select Advanced. 

8. In the Outlook Data File dialog box, in the Name box, append your name to the 
end of the existing name by using underscores instead of spaces. For example, enter 
_Firstname_Lastname. The folder name should now resemble 
M6_module_PST_starter_Firstname_Lastname. 

9. Select OK twice. 

Copy content into the module .pst file 
As you proceed through this module’s try-its, you should copy the resulting elements, 
such as emails, calendar appointments, tasks, and contacts, to the 
M6_module_PST_starter_Firstname_Lastname folder by using the following 
instructions: 

1. After you attach the .pst file, you should be able to observe duplicate folders for 
items such as emails, calendar appointments, tasks, and contacts. 

2. After you complete a try-it exercise, select your resulting items in the navigation 
pane. Make sure you select the items that are associated with your email account. 

3. In the details pane, right-click or access the context menu for each item, and then 
select Copy or select Ctrl+C. 

4. Select the M6_module_PST_starter_Firstname_Lastname folder. 

5. Select Ctrl+V to copy the item to the .pst file. 

6. Repeat steps 3 through 5 for any additional items that you want to copy. 

Topic 1: Create and update a contact 
 To work efficiently in Outlook, you need to know how to create contacts and add 

relevant data to them. It's also important to know how to make changes to contacts. In 
this topic, you'll learn how to create, update, observe, and search for contacts. 
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What is a contact? 
A contact is an Outlook item that stores information about a person with whom you 
communicate, as depicted in the following screenshot. 

 
Figure 1: A contact in Outlook 

You can create a contact by only specifying a person's name, but you'll typically want to 
provide more information about them. The following table defines the general 
configurable options for contacts in Outlook. 

Full Name  The person's full name, usually derived from their first and 
last names in most address lists. However, you can edit this 
option to suit your requirements. 

Company The assumption for most contacts is that they are work 
colleagues, and therefore, it's helpful to know which 
company they work for. This is not a mandatory field, so if 
the contact is personal, you don’t have to enter the 
company information. 
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Job title Similar to Company, the job title is relevant if the contact is 
someone you know through work. 

File as This field is important because it defines how your contact 
will display in a list of contacts. The default behavior is to 
sort contacts by last name and then first name. However, 
you can select to sort by first name and then last name. You 
can also choose to file the contact by company, by full name 
and company, or even by company and full name. This field 
is automatically generated, but you can change it to suit 
your needs. Also note that some apps on phones and tablets 
use their own mechanism for sorting and displaying 
contacts. This option defines the sorting characteristics for 
Outlook only. 

Email In most situations, you will define an email address for a 
contact. Outlook lets you define multiple email addresses, to 
which you can ascribe a Display as property. For example, if 
a contact has two email addresses, one for personal use and 
one for work, assign the Display as label as Personal and 
Work (in addition to their name). 

Web page address Many contacts might not have a website address, but for 
those that do, this field can be a timesaver when you’re 
trying to locate their website. 

Phone numbers By default, four number fields display: Business, Home, 
Business Fax, and Mobile. However, you can change the 
text label for these fields, and choose from Assistant, 
Business, Business 2, Car, Company, Other, Pager, and 
many others. 

Addresses You can assign three postal addresses: Business, Home, and 
Other. You can assign one of the defined addresses as the 
mailing address for the contact. If you're connected to the 
internet, you can map the address, so its location displays 
within the contact. 
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Picture You can browse and select a picture for your contact. Note 
that if your contacts are generated from your phone contact 
list and you assign a picture to them, the contact details 
should synchronize with the picture for the contact into 
Outlook. 

Notes This is a text box where you can add additional details about 
the contact. 

Table 2: General contact options 

In addition to these fundamental contact elements, you can also configure additional 
details by selecting Details on the Show group on the Contact tab, as depicted in the 
following screenshot. 

 
Figure 2: Additional contact details 
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The following table describes some of the advanced contact details and elements. 

Department / 
Office / Profession 

If the contact represents a work contact, then you can use 
the Department, Office, and Profession fields to define 
additional information about the contact's place of work. 

 

Nickname Use this box to provide information about a contact's 
nickname. For example, in the screenshot, the contact 
Danielle might be addressed as Dani in informal situations. 
This field can be useful in helping you get that right. 

 

Title If necessary, provide the contact's preferred title, such as Dr., 
Prof., Mr., or Ms. You can also enter text into this field if the 
preferred title is not listed. 

 

Suffix You typically use this option for contacts that have Junior or 
Senior as a suffix. However, you can also add your own text 
here as well. 

 

Manager's name / 
Assistant's name 

These options are most useful for business colleagues. You 
can use them to define business relationships between 
contacts. 

 

Spouse / Partner Knowing the names of your contacts' partners or spouses 
can be really helpful, especially if you’ve already defined the 
partner or spouse as a separate contact. 

 

Birthday / 
Anniversary 

You can use this option to add information about special 
events and receive a useful reminder on those days.  

 

Table 3: Advanced contact elements 
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You can also select All Fields in the Show group to view and modify all configurable 
options for a contact. As the following screenshot depicts, you can select between User-
defined fields in this item, Frequently-used fields, Address fields, Email fields, and 
others. 

 
Figure 3: Viewing additional fields 

What can I do with an open contact? 
When you're working with a contact, the Contact tab on the ribbon provides a number 
of commands, as depicted in the following screenshot. These commands include saving 
and deleting, displaying additional details, selecting communication options, and 
tagging. 

 
Figure 4: Contact actions via the ribbon 
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The following table describes each of the groups on the Contact tab and some of the 
actions you can perform from these groups. 

Actions This group contains the primary contact tools for creating 
and deleting contacts. It includes the Save & Close, Delete, 
Save & New, and Forward commands. 

Show You can use the commands in this group to observe general 
contact information, detailed information, all fields, and also 
to view digital certificates associated with the contact.  
Note: Digital certificates are used to identify a user when 
they communicate with you by using email. Certificates are 
used for message signing and sealing, which were discussed 
in an earlier module in this course. 

Communicate You can use the commands in this group to initiate 
communication with a contact. You can choose to send an 
email, set up a meeting, call the contact, visit their webpage, 
assign the contact a task, or find their address on a map. 
Note that these options might change when you add 
additional functionality to your email account. For example, 
Microsoft 365 users can also create online meetings, such as 
Microsoft Teams meetings. However, most users do this by 
using the calendaring feature in Outlook. 

Names You can use the commands in this group to verify that the 
names and email addresses you have defined for the contact 
are valid or correctly formatted. 

Options Commands in this group enable you to configure and review 
a business card for the contact, and update the contact's 
picture. 

Tags You can use tags from this group to assign categories, 
follow up, and privacy settings for the contact. 

Zoom This group contains only one command of the same name, 
which you can use to change the current zoom level in the 
selected view. 

Table 4: Actions that you can perform on contacts from the ribbon 
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After you create and save a contact, Outlook displays a list of contacts in the Contacts 
window. On the Home tab, which is depicted in the following screenshot, you can use 
the commands to perform a number of tasks, such as creating, deleting, and tagging 
contacts, and customizing the Current View options for contacts. 

 
Figure 5: Contact actions via the Home tab on the ribbon 

The following table describes each of the groups on the Home tab and some of the 
actions you can perform from these groups. 

New Select and create a new contact, a new group, a new contact 
group, and other new Outlook items. 

Delete Delete the currently selected contact (or contacts). 

Communicate Initiate communications with the contact. You can choose to 
send an email, set up a meeting, call the contact, visit their 
webpage, assign the contact a task, or find their address on 
a map. 

Current View Choose between the default People view, and Business 
Card, Card, Phone, and List views. You can also access 
options to create and configure your own custom views. 

Actions Select Move to relocate the contact to a different folder. 
You can also select Mail Merge to use your contacts list as 
the source for a mail merge activity. 

Share You can share a specific contact by forwarding it, or you can 
choose to share your entire contact list with colleagues. You 
can also view the contacts list for other users by choosing 
Open Shared Contacts. However, the other user must have 
granted you permissions to share their contacts list. 

Tags Use tags to assign follow up, categories, and privacy settings 
for the contact(s). 
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Groups Create new email groups or manage existing groups. 

Find Locate a specific contact (or contacts) by searching by name, 
by address book, or by filtering email, rather than simply 
browsing through a list. 

Table 5: Actions that you can perform on contacts from the ribbon 

 

Did you know? 

Although you can share your contacts with colleagues, in a 
workplace, typically you will have access to a list of contacts via the 
Global Address List (GAL) for your organization. The GAL can also be 
made available offline. In addition to the GAL, you or your 
organizational administrator can create more address lists that meet 
specific needs. For example, you might create an address list that 
contains only customers from the local area, or employees from a 
certain department. 

Create a new contact 
To create a contact: 

1. Open Outlook, and then from the Navigation Bar, select People. 

2. On the ribbon, select New Contact. 

3. In the Untitled - Contact window, enter the following information, and then select 
Save & Close: 

o Full Name 
o File as 

You can define additional options as required, but these are the minimum. Note that 
Outlook automatically generates the File as field when you enter the Full Name. 

Update a contact 
To update a contact: 

1. Within Outlook, and from the Navigation Bar, select People. 

2. In the list of contacts, double-click the contact you wish to update, or select the 
contact, and then select Enter. If the list is long, in the Search Contacts box, enter 
the name, or part of the name you want to locate. 

3. In the opened contact, make the desired changes and then select Save & Close. 
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Search contacts 
If you select the Search contextual tab in Contacts (depicted in the following 
screenshot) you can scope and refine your search by using the command groups that 
the following screenshot highlights. 

 
Figure 6: Contact search options 

The following table describes the command groups in the Search contextual tab in 
Contacts. 

Scope Limit the scope of the search to All Contact Items, the 
Current Folder, specific Subfolders, or widen the search to 
All Outlook Items. 

Refine Refine the search and only return results that meet certain 
criteria, such as a specific category, phone number, 
addressing information, or other factors, including all 
available contact fields. 

Options Select from recent searches, or use a multitude of search 
tools to review and configure search options, including 
indexing, and locations to search. 

Table 6: Search scope and refine options for contacts 
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Did you know? 

You aren’t limited to searching only by name. You can enter any 
searchable element from any field into the Search Contacts box. 
For example, you can enter a partial (or complete) telephone 
number, or web address. 

Review contacts 
To review your contacts: 

1. In Outlook, on the Navigation Bar, select People. The default Contacts view 
displays (which is People). You can now browse the list of contacts, or else use search 
to locate the contact you want to view. 

2. To change the view, select from the available options in the Current View group of 
the ribbon, as highlighted in the following screenshot. 

 
Figure 7: Changing the contacts view 

3. Alternatively, select the Change view arrow that is adjacent to the list of views, and 
then select from People, Business Card, Card, Phone, and List. You can also select 
Manage Views to create your own view. 
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4. From the Manage All Views dialog box (depicted in the following screenshot), you 
can create additional views or customize existing views. 

 
Figure 8: Customizing views in the Manage All Views dialog box 

5. To create a new view, select New. 

6. In the Create a New view dialog box, in the Name of new view box, enter a 
suitable name. 

7. In the Type of view list, select the appropriate option from Table, Timeline, Card, 
Icon, and others, and then select OK. 

8. In the Advanced View Settings: dialog box, select the appropriate columns, filters, 
and sort options, and then select OK twice. 

You are now ready to assign the view to your contacts from the Current View list. 

Activity: Pose a challenge 
In this activity, you’ll create a new contact. Your teacher will guide the class through this 
activity. 
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Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Open Outlook. 

2. From the Navigation Bar, select People. 

3. From the ribbon, select New Contact, or select Ctrl+N. 

4. In the Untitled - Contact window, enter the information provided by your teacher, 
and then select Save & Close. 

Try-it: Create and update a contact 
 In this leveled try-it activity, you'll create and update contacts. 

Try-it 1 
In this try-it, you'll create a contact from the ribbon. 

Resources 
• None 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. If necessary, open Outlook 2019, and then select People. 

2. From the ribbon, select New Contact. 

3. Create a new contact with the following properties: 

o Full Name: Danielle Gousse 
o Company: Munson's Pickles and Preserves 
o Job title: Agricultural technologist 
o File as: Gousse, Danielle 
o Email: Danielle@munsonspicklesandpreservesfarm.com 
o Business phone number: 555 0123 
o If available on your computer, add the appropriate image for this contact. 
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Try-it 2 
In this try-it, you'll create a contact by using a keyboard shortcut. 

Resources 
• None 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. In Outlook 2019, in People, select Ctrl+N. 

2. Create a new contact with the following properties: 

o Full Name: Fen Long 
o Company: Munson's Pickles and Preserves 
o Job title: Irrigation engineer 
o File as: Long, Fen 
o Email: Fen@munsonspicklesandpreservesfarm.com 
o Business phone number: 555 0123 
o If available on your computer, add the appropriate image for this contact. 

Try-it 3 
In this try-it, you'll modify the properties of a contact. 

Resources 
• None 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Open the Fen Long contact. 

2. Add the following website address: MunsonsPicklesAndPreservesFarm.com 

3. Save the contact. 

4. Open the Danielle Gousse contact. 

5. Add the following website address: MunsonsPicklesAndPreservesFarm.com 

6. Save the contact. 
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Additional information 

For more information on adding contacts, go to: Add a contact 

Topic 2: Add a contact from an email 
message 

 If you find yourself regularly communicating with a person by using email, Outlook 
makes it easy to add that person as a contact from within an email. This topic explains 
how you can do this. 

Add a contact from an email 
To add a contact from an email: 

1. Open Outlook. 

2. From the Navigation Bar, switch to Mail. 

3. Locate the appropriate message and open it. 

4. In the email header, directly beneath the ribbon, right-click or access the context 
menu for the email originator (that's the person the email came from), and then 
select Add to Outlook Contacts, as the following screenshot depicts. 

https://aka.ms/add-a-contact
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Figure 9: Adding a contact from the originator of an email message 

5. A new contact dialog box opens with the appropriate details already populated, such 
as Email, Full Name, and File As. Note that other details might be available 
depending on where the user's email account resides and the level of access you 
have to that account. For example, if the user exists within your Microsoft 365 
Exchange Online environment, your contact will populate with many more additional 
details. 

6. Select Save & Close. 

 

Did you know? 

You can also add as a contact any of the recipients on the To or CC 
lines in the email, as depicted in the following screenshot. 
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Figure 10: Adding a contact from the To list in an email 

Activity: Show and tell 
In this activity, your teacher will demonstrate how to add a contact from an email. 
Follow along and ask any questions you might have. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Open Outlook. 

2. From the Navigation Bar, switch to Mail. 

3. Locate a message and open it. 

4. In the email header, directly beneath the ribbon, right-click or access the context 
menu for the email originator, and then select Add to Outlook Contacts. 

5. A new contact dialog box opens with the appropriate details completed, such as 
Email, Full Name, and File As. Add any additional details and then select Save & 
Close. 
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Try-it: Add a contact from an email message 
 In this leveled try-it activity, you'll add contacts from received email headers. 

Try-it 1 
In this try-it, you'll add a contact by using a message originator in an email. 

Resources 
• The message with the subject line Staff profiles 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. In Outlook 2019, switch to Mail. 

2. Locate and open the Staff profiles email, which is in the Inbox folder of the 
M6_module_PST_starter_Firstname_Lastname .pst file you attached earlier. 

3. Right-click or access the context menu for the message originator, Genevieve 
Rollins, and then select Add to Outlook Contacts. 

4. Save the contact. 

Try-it 2 
In this try-it, you'll add additional details to a contact from an email. 

Resources 
• The message with the subject line Staff profiles 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. In Outlook 2019, switch to Mail. 

2. Locate and open the Staff profiles email, which is in the Inbox folder of the 
M6_module_PST_starter_Firstname_Lastname .pst file you attached earlier. 

3. Right-click or access the context menu for email recipient Hilary Brennan, and then 
select Add to Outlook Contacts. 

4. In the Hilary Brennan - Contact dialog box, in the Company field, enter Munson's 
Pickles and Preserves. 

5. In the File as list, select Hilary Brennan. 
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6. In the Email list, change the email address to 
Hilary@Munsonspicklesandpreservesfarm.com. 

7. Save the contact. 

8. Close the email message, and then and switch to People. 

9. Open Genevieve Rollins. 

10. In the Genevieve Rollins - Contact window, in the Company field, enter Munson's 
Pickles and Preserves. 

11. In the File as list, select Genevieve Rollins. 

12. In the Email list, change the email address to 
Genevieve@Munsonspicklesandpreservesfarm.com. 

13. If available on your computer, add the users' pictures to their contact profiles. 

14. Save the contact. 

Topic 3: Import contacts from external 
sources 

 You’ve probably had to copy contacts from an old phone to a new one at some 
point. It's also possible that you have a list of contacts in another email system or stored 
in an external file of some sort that you might want to access through Outlook. In this 
topic, you'll learn how to do that. 

Outlook supports a number of import locations for contacts. These include: 

• .pst files 
• vCARD files 
• Comma-separated value (CSV) files 

Import a .pst file 
As part of the setup for this module, you already know how to import a .pst file. The 
following steps are a reminder of the process: 

1. Open Outlook. 

2. Select the File tab, and then select Open & Export. 

3. In the Open pane, select Open Outlook Data File. 
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4. In the Open Outlook Data File dialog box, use the navigation pane to locate and 
select the .pst file that contains the contacts you want to import. Note: A new folder 
is now available in the navigation pane. This folder contains the required contacts. 

Import a vCARD file 
vCARD files have a .vcf file extension. Many software companies use vCARD files to store 
contact information. This wide usage means that they’re ideal for moving contacts 
between different email systems. If you receive a vCARD file, the easiest way to import in 
into Outlook is to double-click the file or select it, and then select Enter. Outlook will 
open the contact in a new window, and you will have the option to save the contact. 

Another way to import a vCARD is to use the Import and Export Wizard. To access the 
wizard: 

1. Open Outlook. 

2. Select the File tab, and then select Open & Export. 

3. In the Open pane, select Import/Export. 

4. In the Import and Export Wizard (depicted in the following screenshot), select 
Import a vCARD file (.vcf), and then select Next. 

 
Figure 11: Using the Import and Export Wizard to import a contact from a vCARD 

5. In the vCARD File dialog box, browse and locate the vCARD file and then select 
Open. The contact is imported and saved automatically in your contact list. 
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Import a CSV file 
Another commonly used file format is CSV. As depicted in the following screenshot, the 
file stores the contact information in fields separated by a comma. 

 
Figure 12: A CSV file 

To import a CSV file: 

1. Open Outlook. 

2. Select the File tab, and then select Open & Export. 

3. In the Open pane, select Import/Export. 

4. In the Import and Export Wizard, select Import from another program or file, 
and then select Next. 
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5. In the Import a File dialog box, select Command Separated Values, and then select 
Next, as depicted in the following screenshot. 

 
Figure 13: Importing a CSV file 

6. In the Import and File dialog box, next to the File to import text box, select 
Browse. 

7. Locate your CSV file, and either double-click it or select it, and then select Enter. 

8. Under Options, as depicted in the following screenshot, select either Replace 
duplicates with items imported, Allow duplicates to be created, or Do not 
import duplicate items, and then select Next. 
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Figure 14: Defining what to do with duplicate entries 

9. In the next Import a File dialog box, select the destination location, and the select 
Next. (The default location, Contacts, is usually appropriate.) 

10. Finally, on the summary page, select Finish. 

 

Did you know? 

When you import more complex lists from a CSV file, you can 
perform custom mapping for specific fields. This means that certain 
fields in the CSV file will map to specific elements in your contacts in 
Outlook. 

  



Creating and managing contacts 
 

 
31 

Activity: Show me how 
In this activity, your teacher will display a short video on how to import contacts from a 
Microsoft Excel spreadsheet. 

 

Video 

To review the video about importing contacts from an Excel 
spreadsheet, go to: Import contacts 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Review the video with your class. If you have any questions, ask your teacher. 

Try-it: Import contacts from external sources 
 In this standalone try-it activity, you'll export your contacts to a CSV file, and then 

import them back in. 

Resources 
• None 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. In Outlook 2019, switch to People. 

2. Select the File tab, and then select Open & Export. 

3. In the Open pane, select Import/Export. 

4. In the Import and Export Wizard, select Export to a file, and then select Next. 

5. Select Comma Separated Values, and then select Next. 

6. In the Export to a File dialog box, make sure Contacts is selected, and then select 
Next. 

7. Select Browse, and then in the Browse dialog box, in the navigation pane, select 
Desktop. 

https://aka.ms/Import_contacts
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8. Make sure the File name box displays Contacts, and then select OK. 

9. Select Next, and then select Finish. 

10. Browse to the Desktop on your computer and verify the presence of the file. 

11. In Outlook, select the File tab, and then select Open & Export. 

12. In the Open pane, select Import/Export. 

13. In the Import and Export Wizard, select Import from another program or file, 
and then select Next. 

14. In the Import a File dialog box, select Command Separated Values, and then select 
Next. 

15. In the Import a File dialog box, next to the File to import text box, browse and 
open your Contacts CSV file (on the desktop). 

16. Ensure you select Allow duplicates to be created. 

17. In the next Import a File dialog box, select the destination location (use the default, 
Contacts), and then select Next. 

18. Finally, on the summary page, select Finish. You should be able to observe 
duplicates of your original contacts because you selected to allow duplicates. 

19. Delete the newly created duplicates. 

 

Additional information 

For more information on importing contacts, go to: Import contacts to 
Outlook 

Wrap-up 
Use these questions to check what you learned in this lesson:  

1. A contact must have a File as property defined. 

Select the correct option. 

a. True 

b. False 

  

https://aka.ms/import-contacts-to-outlook
https://aka.ms/import-contacts-to-outlook
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2. In the Communicate group for a contact, what communication methods are
available?

Select all that apply.

a. Fax

b. Email

c. Call

d. Visit

3. You are performing a search for a contact. You have far too many records returned
and need to limit the returned results. Which of the following would help you do
that?

Select the correct option.

a. Limit the search scope

b. Refine the search

c. Both

d. Neither

4. If you search for a contact based on its category, you are ________________________ your
search results.

Fill in the blank space.

5. You can use the ________________________ view to display the picture, full name, job,
and company details of a contact.

Fill in the blank space.

6. To add a contact from an email message, right-click or access the context menu for
the appropriate person in the email header, and then select ________________________.

Fill in the blank space.



Creating and managing contacts 
 

 
34 

Lesson 2: Using contact groups 
Overview 
If you are managing a number of contacts that are related, it can be useful to group 
them together. Perhaps your contacts are working on the same project with you, or they 
work at the same company as you. Grouping makes it easier to email the contacts 
because you don’t need to specify each recipient individually. In this lesson, you'll learn 
how to create and manage Outlook contact groups. 

Warm-up 
In preparation for this lesson, answer the following questions to check what you might 
already know about using contact groups in Outlook. 

1. Which of the following statements is correct about an Outlook contact group? 

Select the correct option. 

a. It provides a place for shared email, files, and shared calendar. 

b. It’s a collection of contacts, similar to an email distribution list. 

c. Both a and b 

d. None of the above 

2. You can assign tags to contact groups. 

Select the correct option. 

a. True 

b. False 

3. In addition to a membership list, you must also define the ________________________ of 
the contact group. 

Fill in the blank space. 

4. A contact group can contain members from your Outlook Contacts, an address list, 
or a new contact with an ________________________. 

Fill in the blank space. 
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Topic 1: Create a contact group 
 You create Outlook contact groups from the People workspace in Outlook. In this 

topic, you will learn how to create a contact group and practice your skills in the try-it 
activity. 

How to create a contact group 
To create a contact group: 

1. Open Outlook, and then select People. 

2. On the Home tab, in the New group, select New Contact Group, as depicted in the 
following screenshot. 

 
Figure 15: Creating a new contact group 

3. In the Untitled - Contact Group window, in the Name text box, enter a meaningful 
name, as depicted in the following screenshot. 

 
Figure 16: Defining the group's name 
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4. To add members, on the Contact Group tab, in the Members group, select Add 
Members, and then, as depicted in the following screenshot, select the location of 
the members’ contact information. 

 
Figure 17: Selecting the location of the members’ contact information 

5. You can add members from existing contacts, or from an address list such as a 
Global Address List (GAL) from Microsoft Exchange Server or Exchange Online. 

You can also add new contacts to the group: 

1. On the Contact Group tab, in the Members group, select From Outlook Contacts. 

2. In the Select Members: Contacts dialog box (depicted in the following screen shot), 
select one or more contacts, select Members, and then select OK. 
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Figure 18: Adding members 

3. Select Save & Close. Your contact group will now display in your contacts list. 

After you have created your contact group, you can make changes to it by adding or 
removing members (which the next topic explains). You can also email the group, set up 
a meeting with group members, or forward the group for someone else to use. 

Activity: Show and tell 
The teacher will guide the class through this activity by demonstrating how to create a 
contact group. Follow along and ask any questions you have. 

Resources required 
You will need the following resources for this activity: 

• None 
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Activity instructions 
Participate in the activity by following these instructions: 

1. Open Outlook and select People. 

2. On the ribbon, select New Contact Group. 

3. In the Untitled - Contact Group dialog box, in the Name text box, enter the text 
Munson's Employees. 

4. Select Add Members on the ribbon, and then select From Outlook Contacts. 

5. In the Select Members: Contacts dialog box, select all listed contacts, select 
Members, and then select OK. 

6. Select Save & Close. 

Try-it: Create a contact group 
 In this try-it activity, you'll create a new contact group called CSA Program 

Volunteers. 

Resources 
• None 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. In Outlook 2019, switch to People. 

2. On the ribbon, select New Contact Group. 

3. Enter the name CSA Program Volunteers. 

4. Select the Add Members button on the ribbon, and then select From Outlook 
Contacts. 

5. In the Select Members: Contacts dialog box, select all listed contacts. Select 
Members, select OK, and then save the group. 

 

Additional information 

For more information on creating Contact Groups, go to: Create a 
contact group or distribution list in Outlook for PC 

https://aka.ms/create-a-contact-group-or-distribution-list-in-outlook-for-pc
https://aka.ms/create-a-contact-group-or-distribution-list-in-outlook-for-pc


Creating and managing contacts 
 

 
39 

Topic 2: Update contacts within contact 
groups 

 On occasion you might need to change the membership of your contact groups. For 
example, you might need to add or remove contacts within a group. This topic explains 
the available options for updating contact groups. 

Add new contacts to a group 
To add contacts to an existing group: 

1. Open Outlook and switch to People. 

2. Locate your contact group and double-click it, or select it, and then select Enter. 

3. To add members, select Add Members on the ribbon, and then choose the location 
of your contacts. For example, select From Address Book. 

4. Select the contacts that you want to add, and for each, select Members. 

5. When you complete the changes, select OK. 

6. In the open Contact Group dialog box, select Save & Close. 

 

Did you know? 

You can add a member to a contact group even though they’re not 
currently a contact and don’t appear in your address list. To do this, 
all you need is the contact's email address. To add them as a 
member, use the previous procedure, and then when prompted for 
the contact source select New E-mail Contact. You can then specify 
the contact's Display name or E-mail address, and add them to the 
group. 

Remove contacts from a group 
To remove contacts from a contacts group: 

1. Open Outlook and switch to People. 

2. Locate your contact group and double-click it, or select it, and then select Enter. 
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3. To remove members, select the appropriate member, and then on the ribbon, select 
Remove Member. 

4. When you have removed all the contacts that you want, select Save & Close. 

Activity: Pose a challenge 
In this activity, your teacher will pose a challenge to the class. You or one of your 
classmates will take up this challenge and demonstrate how to create a contact, add it 
to a group, and then remove it from that group. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Open Outlook and switch to People. 

2. Locate the Munson's Employees contact group. 

3. Create a contact for a user named Alex Nino who works at Best For You Organics 
Company. His email address is Alex@bestforyouorganics.com. 

4. With guidance from the teacher and your colleagues, add this new contact to the 
group. 

5. Remove the new contact from the group. 

6. Add a user named Danielle to the group. Use the email address of danielle@ 
bestforyouorganics.com. 

7. Remove the new contact from the group. 

Try-it: Update contacts within contact groups 
 In this standalone try-it activity, you'll modify contact group membership by 

adding and removing contacts from your contact group. 

Resources 
• None 
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Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Create a new contact with the following properties: 

o Full Name: Alex Nino 
o Company: Best For You Organics Company 
o Email address: Alex@bestforyouorganics.com 
o Job title: Manager 
o File as: Alex Nino 

2. In the contacts list, double-click the CSA Program Volunteers contact group. 

3. Add the newly created contact, Alex Nino, to the group. 

4. Remove Fen Long from the group. 

5. Save the changes. 

 

Additional information 

For more information on adding contacts to groups, go to: Add 
people to a contact group in Outlook for PC 

Topic 3: Delete a contact group 
 After you complete a project, you might want to delete the contacts and contact 

groups associated with it. Likewise, when people leave an organization or move 
between teams at that organization, you might need to delete project groups. This topic 
explains how to do this. 

Delete a contact group 
To delete contact groups: 

1. Open Outlook, and then select People. 

2. Locate the contact group that you want to delete and select it. 

3. On the ribbon, select Delete. 

  

https://aka.ms/add-people-to-a-contact-group-in-outlook-for-pc
https://aka.ms/add-people-to-a-contact-group-in-outlook-for-pc
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Activity: Tell a story 
In this activity, your teacher will present a story about a defunct committee. You need to 
delete the contact group for this committee. Follow along and ask questions as your 
teacher demonstrates the steps. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Open Outlook. 

2. Select People, and then select the Munson's Employees group. 

3. On the ribbon, select Delete. 

Try-it: Delete a contact group 
 In this try-it activity, you'll delete a contact group. 

Resources 
• None 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. If necessary, open Outlook. 

2. Select People. 

3. In the Contacts list, select the CSA Program Volunteers contact group. 

4. On the ribbon, select Delete. 
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Wrap-up 
Use these questions to check what you learned in this lesson:  

1. Which view displays only a contact’s full name and their image? 

Select the correct option. 

a. Card 

b. Business Card 

c. People 

d. List 

2. You can add users from an address list to a contact group. 

Select the correct option. 

a. True 

b. False 

3. After creating a contact group, you can email the group or set up a 
________________________ with the group members. 

Fill in the blank space. 

4. To remove a contact group, from People, on the ribbon, select 
________________________. 

Fill in the blank space. 
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Lesson 3: Sharing contacts 
Overview 
You've now learned how to create and update contacts. However, Outlook also enables 
you to share your contacts. You can build your network and greatly improve 
communication by sharing contacts with others. In this lesson, you’ll learn how to share 
contacts, create new contact folders, forward contacts, and print contact information. 

Warm-up 
Answer the following questions to determine what you already know about sharing 
contacts. 

1. How can you share contacts? 

Select all that apply. 

a. By sharing a folder of contacts 

b. By emailing a colleague with an attached contact 

c. By sharing an individual contact 

d. By configuring a category of Shared Contacts 

2. What is the default view in Outlook People? 

Select the correct option. 

a. Business Card 

b. People 

c. List 

d. Card 

3. After you create a folder, you must ________________________ your contacts into it. 

Fill in the blank space. 

4. By default, shared folders have ________________________ permissions for your 
colleagues. 

Fill in the blank space. 
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Topic 1: Create and share a contacts 
folder 

 By organizing your contacts into folders, you can manage them more easily. You can 
also coordinate certain tasks more easily within Outlook. For example, you might want 
to share a group of contacts with someone else within your organization, without 
necessarily sharing your entire contact list. By creating contact folders within Outlook, 
you can share your contact groups in a timely and efficient manner, and exert more 
control over which contacts you specifically want to share. 

Create a contacts folder 
To create a contacts folder: 

1. Open Outlook and switch to People. 

2. In the navigation pane, right-click or access the context menu for the Contacts 
folder, and then select New Folder, as the following screenshot depicts. 

 
Figure 19: Creating a new contact folder 
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3. In the Create New Folder dialog box, in the Name box, enter a meaningful name for 
the contacts folder, and then select OK. 

 
Figure 20: Create New Folder dialog box 

4. Add contacts to the new contacts folder by performing one of the following 
procedures: 

o Select the individual contacts that you want to add to the new contacts folder 
and drag them into the folder. 

o Right-click or access the context menu for the contact, select Move, and then 
select Other Folder. In the Move Items dialog box, select the new contact folder, 
and then select OK. 

o Select the contact, and then, go to the Home tab. In the Actions group, select 
Move, and then select Other Folder. In the Move Items dialog box, select the 
new contact folder, and then select OK. 

5. Select the folder to verify that the contacts are now part of the new contacts folder. 
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Share a contacts folder 
After you have created a folder for your contacts, you might want to share these 
contacts. To share a contacts folder: 

1. Locate the folder you want to share in the navigation pane, right-click or access the 
context menu for the folder, select Share, and then select Share Contacts. 

 
Figure 21: Sharing a contacts folder 

2. In the Sharing invitation window, in the To box, enter the list of recipients that you 
want to share the folder with. 

 
Figure 22: Sharing a contacts folder 

3. By default, your recipients can only read your contacts in the shared folder. If you 
want to grant a higher level of access, select the Recipient can add, edit, and 
delete items in this contacts folder check box. Note that this permissions option 
can only apply to users within your organization. 
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4. When you have completed the required information, select Send. 

5. In the Microsoft Outlook dialog box, confirm that you wish to share your folder 
with the listed recipients by selecting Yes. 

 
Figure 23: Confirming that you want to share the folder 

Open a shared contacts folder 
If someone has shared their contacts folder with you, you can open it by using the email 
invitation they sent. To open a shared contacts folder: 

1. Switch to Mail. 

2. In the list of emails, select the one with the subject that starts with the text Sharing 
invitation. 

3. In the details pane, select Open this Contacts Folder. 

 
Figure 24: Accepting the invitation to share the folder 
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When Outlook switches to People, the new shared folder displays in the navigation 
pane within the Shared Contacts folder. 

 
Figure 25: Viewing the shared folder from People 

 

Did you know? 

You can share contact folders (and contacts) with users outside your 
organization, but your email administrator must enable this setting. 

Activity: Show and tell 
In this activity, your teacher will demonstrate how to create a folder for contacts. 

Resources required 
You will need the following resources for this activity: 

• None 
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Activity instructions 
Participate in the activity by following these instructions: 

1. In Outlook, switch to People. 

2. In the navigation pane, right-click or access the context menu for the Contacts 
folder, and then select New Folder. 

3. Name the folder My Contacts Folder. 

4. In the list of contacts, right-click or access the context menu for Fen Long, select 
Move, and then select My Contacts Folder. 

5. Repeat step 4 for Danielle Gousse. 

6. Select My Contacts Folder to verify that the contacts are now part of the new 
contacts folder. 

7. To share the folder, right-click or access the context menu for the My Contacts 
Folder, select Share, and then select Share Contacts. 

8. In the Sharing invitation window, in the To box, enter the list of recipients that you 
want to share this folder with. For example, enter the email address for Genevieve 
Rollins. (Ideally, this will be an email address that is part of your organization and to 
which you have access.) 

9. Select the Recipient can add, edit, and delete items in this contacts folder check 
box, and then select Send. 

10. In the Microsoft Outlook dialog box, confirm that you wish to share your folder 
with the listed recipients by selecting Yes. A message is sent to the recipient (or 
recipients). 

11. Sign in as the recipient you used earlier, and open Outlook. 

12. Switch to Mail. 

13. In the list of emails, select the one with the subject that starts with the text Sharing 
invitation. 

14. In the details pane, select Open this Contacts Folder. 

15. Outlook switches to People. In the navigation pane, the new shared folder displays 
within the Shared Contacts folder. 
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Try-it: Create and share a contacts folder 
 In this standalone try-it activity, you'll create and share a contacts folder. 

Resources 
You will need the following resources for this try-it: 

• The contacts that you have created within the other activities in Lesson 1 and  
Lesson 2 

• The email address of a partner with whom you want to share the contacts folder 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. In Outlook, switch to People. 

2. In the navigation pane, right-click or access the context menu for the Contacts 
folder, and then select New Folder. 

3. Name the folder Soil management project. 

4. In the list of contacts, right-click or access the context menu for Fen Long, select 
Move, and then select Soil management project. 

5. Repeat step 4 for Danielle Gousse. 

6. Select Soil management project to verify that the contacts are now part of the new 
contacts folder. 

7. To share the folder, right-click or access the context menu for the Soil management 
project, select Share, and then select Share Contacts. 

8. In the Sharing invitation window, in the To box, enter the list of recipients that you 
want to share this folder with. Ideally, this will be an email address that is part of your 
organization and to which you have access. Enter the email address of your partner. 

9. Ensure that the Recipient can add, edit, and delete items in this contacts folder 
check box is cleared, and then select Send. 

10. In the Microsoft Outlook dialog box, confirm that you wish to share your folder 
with the listed recipients by selecting Yes. The recipient(s) will receive a message. 

11. Switch to Mail. 

12. In the list of emails, select the one with the subject that starts with the text Sharing 
invitation. This should come from your partner. 

  



Creating and managing contacts 
 

 
52 

13. In the details pane, select Open this Contacts Folder. 

14. Outlook switches to People. In the navigation pane, the Soil management project 
shared folder displays within the Shared Contacts folder. 

 

Additional information 

For more information on sharing contact folders, go to: Share a 
contacts folder with others 

Topic 2: Forward a contact 
 If one of your contacts needs information and contact details about another of your 

contacts, you can forward that contact to them. The process of forwarding a contact is 
straightforward and helps remove the possibility of error that might be present if you 
were to manually enter contact details and forward it. Forwarding contacts is an 
essential skill that can save you time and effort as you collaborate with your teammates. 

Forward a contact 
To forward a contact, you must first select that contact in your contact list. In People, on 
the Home tab, in the Share group, select Forward Contact, as the following screenshot 
depicts. 

 
Figure 26: Forwarding a contact 

  

https://aka.ms/share-a-contacts-folder-with-others
https://aka.ms/share-a-contacts-folder-with-others
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The options to forward are As a Business Card and As an Outlook Contact. The 
following screenshot depicts forwarding a contact by using the As a Business Card 
option. 

 
Figure 27: Forwarding a contact as a Business Card 

The following screenshot depicts forwarding a contact by using the As an Outlook 
Contact option. 

 
Figure 28: Forwarding a contact as an Outlook Contact 

When you use the As an Outlook Contact option, the contact’s information is 
forwarded as an email attachment, and therefore includes more detailed information. 
When you receive an email with contact information (as displayed in the following 
screenshot), you must open the attachment, and then save the contact. 
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Figure 29: A forwarded contact in an email 

The forwarded contact will then display in your contacts list. 

 

Additional information 

For more information about forwarding contacts, go to: Forward a 
contact. 

Activity: Pose a challenge 
In this activity, you’ll attempt to forward a contact to a colleague in the class. Your 
teacher will guide the class during this activity. Make sure to bring up any questions with 
your teacher and the rest of the class. 

Resources required 
You will need the following resources for this activity: 

• None 
  

https://aka.ms/forward-a-contact
https://aka.ms/forward-a-contact
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Activity instructions 
Participate in the activity by following these instructions: 

1. In Outlook, switch to People. 

2. Follow your teacher’s guidance and work with your classmates to learn about 
forwarding a contact. 

Try-it: Forward a contact 
 In this try-it activity, you'll forward a contact to one of your classmates or your 

teacher. 

Try-it 1 
In this try-it, you'll forward a contact from the contact card. 

Resources 
You will need the following resources for this try-it: 

• The contacts that you created within the other Lesson 1 and Lesson 2 activities 
• A partner that has a functioning email that can send and receive email 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. In Outlook, in People, on the ribbon, select Change View, and then select Business 
Card. 

2. Right-click or access the context menu for Fen Long, and then select Forward 
Contact. 

3. Select As a Business Card. 

4. In the Fen Long email message, in the To box, enter the email address of a 
classmate or your teacher, and then select Send. 

5. Switch to Mail. 

6. Open the message from your classmate or teacher, which begins with the text Fen 
Long. View the attached business card. It’s not necessary to save the card. 
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Try-it 2 
In this try-it, you'll forward a contact from the contact list. 

Resources 
You will need the following resources for this try-it: 

• The contacts that you created within the other Lesson 1 and Lesson 2 activities 
• A partner that has a functioning email that can send and receive email 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. In People, on the ribbon, select Change View, and then select List. 

2. Right-click or access the context menu for Danielle Gousse, and then select 
Forward Contact. 

3. Select As an Outlook Contact. 

4. In the FW: Danielle Gousse email message, in the To box, enter the email address of 
a classmate or your teacher, and then select Send. 

5. Switch to Mail. 

6. Select the message from your student colleague or teacher, which begins with the 
text FW: Danielle Gousse. View the attached Outlook Contact. It’s not necessary to 
save the contact. 

Topic 3: Print contact information 
 You probably connect with many people throughout the day at work, school, and in 

your personal life. You might also interact with people through different online methods 
such as social media. By printing your contact information, you can create a hard copy 
as a quick reference or to save your contact list more securely. 

To print an individual contact: 

1. In Outlook, switch to People. 

2. Open a specific contact. 

3. On the File tab, select Print. 

4. Select the appropriate printer. 
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Note: The Settings are configured for Memo Style because you have selected an 
individual contact. Memo Style displays a single page for a contact, as the following 
screenshot depicts. 

 
Figure 30: Printing a contact’s information 

5. When ready, select Print. 

To print multiple contacts: 

1. In Outlook, switch to People. 

2. Select multiple contacts. 

3. From the File tab, select Print. 

4. Select the appropriate printer, and then, under the Settings header, select between 
Table Style and Memo Style. Table Style displays a list of all contacts, as the 
following screenshot depicts. 
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Figure 31: Printing multiple contacts with Table Style 

5. When ready, select Print. 

There are a number of other print styles available, depending on the contacts you have 
selected and the contact view you are using: 

• Card Style. Displays an alphabetic list of contacts. 
• Small Booklet Style. Displays your contacts in an alphabetized list, but divided into 

separate pages. 
• Medium Booklet Style. Displays your contacts in an alphabetized list, but divided 

into separate pages containing fewer contacts per page and using more paper. 
• Phone Directory Style. Displays an alphabetized list of contacts displaying names 

and phone numbers only. 
  



Creating and managing contacts 
 

 
59 

The following screenshot depicts some of the different print style options. 

 
Figure 32: Selecting a print style 

 

Additional information 

For more information about printing contacts, go to: Print contacts, 
messages, or other Outlook items 

Activity: Discuss and learn 
In this activity, you will discuss with a partner the reasons you might want to keep and 
print a hard copy of Outlook contacts information. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Your teacher will guide you through this discussion. As you discuss with your partner, 
consider making a list of questions or concerns you have, and then sharing them with 
the class. 

  

https://aka.ms/print-contacts-messages-or-other-outlook-items
https://aka.ms/print-contacts-messages-or-other-outlook-items
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Try-it: Print contact information 
 In this leveled try-it activity, you will print contact information from the contact 

card. 

Try-it 1 
In this try-it, you'll print a contact from the contact card. 

Resources 
You will need the following resources for this try-it: 

• The contacts that you have created within the other Lessons 1 and 2 activities 
• The Microsoft Print to PDF printer or another physical printer in your classroom 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. If necessary, open Outlook and switch to People. 

2. On the ribbon, select Change View, and then select Business Card. 

3. Open the contact card for Fen Long. 

4. On the ribbon, select File, and then select Print. 

5. From the Printer list select Microsoft Print to PDF, and then select Print. 

6. In the Save Print Output As dialog box, in the navigation pane, select Desktop. 

7. In the File name box, enter Business Card, and then select Save. 

8. Optionally, you could choose to review your output by navigating to the desktop 
and opening the PDF file. 

Try-it 2 
In this try-it, you'll print contacts from the contact list. 

Resources 
You will need the following resources for this try-it: 

• The contacts that you have created within the other Lessons 1 and 2 activities 
• The Microsoft Print to PDF printer or another physical printer in your classroom 
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Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. If necessary, open Outlook and switch to People. 

2. On the ribbon, select Change View, and then select List. 

3. Select all contacts, on the ribbon, select File, and then select Print. 

4. Select Microsoft Print to PDF in the Printer list. 

5. Select Table Style in Settings. 

6. Select Print. 

7. In the Save Print Output As dialog box, in the navigation pane, select Desktop. 

8. In the File name box, enter List and then select Save. 

9. Optionally, you could choose to review your output by navigating to the desktop 
and opening the PDF file. 

Try-it 3 
In this try-it, you'll print a list of contacts as a phone list. 

Resources 
You will need the following resources for this try-it: 

• The contacts that you have created within the other Lessons 1 and 2 activities 
• The Microsoft Print to PDF printer or another physical printer in your classroom 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. If necessary, open Outlook, and switch to People. 

2. On the ribbon, select Change View, and then select Phone. 

3. Select all contacts, on the ribbon, select File, and then select Print. 

4. Select Microsoft Print to PDF in the Printer list. 

5. In Settings, select Table Style, and then select Print. 

6. In the Save Print Output As dialog box, in the navigation pane, select Desktop. 

7. In the File name box, enter Phone list, and then select Save. 

8. Optionally, you could choose to review your output by navigating to the desktop 
and opening the PDF file. 
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Wrap-up 
Answer the following questions to determine what you learned in this lesson. 

1. By default, when you share a folder of contacts, you can do so with anyone. 

Select the correct option. 

a. True 

b. False 

2. To print a list of contacts, which print layout must you choose? 

Select the correct option. 

a. Table Style 

b. Memo Style 

3. To help ensure that a shared contact is editable, you must select the 
________________________ check box when sharing the contact. 

Fill in the blank space. 

4. A shared contact appears in your ________________________ folder. 

Fill in the blank space. 
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Lesson 4: Managing contacts 
Overview 
Managing contacts is a practice that can greatly improve your productivity. If you have 
correctly imported, updated, and categorized your contacts, you can coordinate your 
messages with the correct recipients much more efficiently. In this lesson, you will learn 
how to perform all these tasks in the People workspace. 

Warm-up 
In the previous lesson, you learned how to share contacts. In this lesson, you’ll learn how 
to manage contacts. Use these questions to find out what you already know about this 
lesson’s topics: 

1. The default categories are named after projects. 

Select the correct option. 

a. True 

b. False 

2. You can categorize contacts in custom categories. 

Select the correct option. 

a. True 

b. False 

3. When working with categories for the first time, you are prompted to 
________________________ the category. 

Fill in the blank space. 

4. If you want to print the details of an individual contact, you can do so by selecting 
________________________. 

Fill in the blank space. 

Topic 1: Categorize contacts  
You can categorize contacts to increase your productivity when emailing multiple 
people within a group. In addition to sorting contacts by individual names, you can also 
sort contacts within your categories. 
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Create a category 
To create a category, in the People workspace, on the Home tab, in the Tags group, 
select Categorize. The Categorize command provides a number of category options 
that are named by color, as the following screenshot depicts. 

 
Figure 33: The default color-coded categories 

You can change the name of each category by selecting All Categories, and then 
renaming a category in the Color Categories dialog box. You can add categories to 
your contacts, just as you can with tasks, notes, email messages, and calendar invites. To 
do this, select a person from the Contacts list. On the ribbon, select Categorize, and 
then select the appropriate category. As depicted in the following screenshot, the 
contact now has a color bar in the contact window. To view your contacts in individual 
windows, simply double-click the appropriate contact name, or select it, and then select 
Enter. 
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Figure 34: An individual Business Card contact with the Orange Category applied 

 

Additional information 

For more information on managing contact categories, go to: Add 
contacts to color categories 

 

Video 

To review a video on managing and assigning categories, go to: Set 
categories, flags, reminders, or colors 

Activity: Think-pair-share 
In this activity, you’ll work with a partner to determine names of categories you might 
use for assigning to your contacts. 

Resources required 
You will need the following resources for this activity: 

• None 

https://aka.ms/add-contacts-to-color-categories
https://aka.ms/add-contacts-to-color-categories
https://aka.ms/Set_categories_flags_reminders_or_colors
https://aka.ms/Set_categories_flags_reminders_or_colors
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Activity instructions 
Your teacher will guide you through this activity. 

Try-it: Categorize contacts 
 In this try-it activity, you'll learn how to work with categorizing contacts. 

Try-it 1 
In this try-it, you'll categorize a contact from the Business Card view. 

Resources 
You will need the following resources for this try-it: 

• None 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. If necessary, in Outlook, switch to People. 

2. On the ribbon, select Change View, and then select Business Card. 

3. Open the Fen Long contact. 

4. On the ribbon, in Tags, select Categorize, and then select Yellow Category. 

5. In the Rename Category dialog box, in the Name box, notice that it currently 
displays Yellow Category. Enter the text Project 1, and then select Yes. 

6. On the ribbon, select Save & Close. 

Try-it 2 
In this try-it, you'll categorize contacts from the List view. 

Resources 
You will need the following resources for this try-it: 

• None 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. On the ribbon, select Change View, and then select List. 

2. Select the first two contacts. 
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3. On the ribbon, in Tags, select Categorize, and then select Red Category. 

4. In the Rename Category dialog box, in the Name box, notice that it displays Red 
Category. Enter the text Project 2, and then select Yes. 

Topic 2: Flag a contact for follow-up 
A Follow Up flag is a useful reminder that helps you stay up to date with ongoing tasks 
or communication. Similar to tasks, a Follow Up flag alerts you to still need to complete 
an action that you probably needed more information on, or time to work on. 

Flag a contact 
To flag a contact, select the appropriate contact. On the Home tab, in the Tags group, 
select Follow Up, and then select the timeline for the follow-up, as the following 
screenshot depicts. 

 
Figure 35: Assigning follow up for a contact 
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To verify the follow-up duration, select the contact, and then select Enter. This will 
display the full contact detail and the follow-up commitment. The following screenshot 
depicts a contact card with the follow-up flag. 

 
Figure 36: Reviewing follow-up information for a contact 

Activity: Discuss and Learn 
In this activity, you will discuss reasons and real-life scenarios in which you would use 
Follow Up flags in Outlook. Share experiences in which a follow up would have been 
helpful and important to have. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Your teacher will guide you through this discussion. Use the following points to help 
with the discussion: 

1. Consider scenarios in which you would use a flag that would require a follow-up. 

2. Identify how a follow-up flag displays in the contact’s detail page. 
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Try-it: Flag a contact for follow-up 
 In this leveled try-it activity, you'll flag a contact for follow-up by using the Home 

tab. 

Try-it 1  
In this try-it, you'll apply a follow-up flag to the contact card. 

Resources 
You will need the following resources for this try-it: 

• None 

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. If necessary, in Outlook, switch to People. 

2. On the View tab, in the Current View group, select Change View, and then select 
Card. 

3. Right-click or access the context menu for Fen Long. 

4. From the context menu, select Follow Up. 

5. Select Next Week. 

6. Open Fen Long’s contact information, and verify that follow up is configured for 
next week. 

7. Close the contact. 

Try-it 2 
In this try-it, you'll apply a follow-up flag to a contact by using the contact List view. 

Resources 
You will need the following resources for this try-it: 

• None 
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Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. On the View tab, in the Current View group, select Change View, and then select
List.

2. Select and open the Danielle Gousse contact.

3. On the ribbon for the open contact, select Follow Up, and then select Tomorrow.

4. Select Save & Close.

Try-it 3 
In this try-it, you'll apply a follow-up flag to multiple contacts. 

Resources 
You will need the following resources for this try-it: 

• None

Instructions 
The following steps are the general tasks that you need to perform during this try-it: 

1. Select the first three contacts, and then on the Home tab, in the Tags group, select
Follow Up.

2. Select This Week.

3. Open one of the contacts you modified, and verify that Follow Up is for this week.

4. Close the contact.

Wrap-up 
Answer the following questions to determine what you learned in this lesson. 

1. You want a colleague to have access to a number of your contacts. How can you do
this quickly and efficiently?

Select all that apply.

a. Copy the contact details into the Office Clipboard, and paste them into an email.

b. Forward a contact by email to your colleague.

c. Share a contact with your colleague

d. Print a contact list and deliver it to your colleague.
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2. You want to forward a contact to a colleague in your organization. Which of the
following options is a supported format?

Select all that apply.

a. List

b. Business Card

c. Card

d. Outlook Contact

3. You want to print a list of your contacts’ telephone numbers as an alphabetical list.
To do this, you need to choose the ________________________ print style.

Fill in the blank space.

4. It’s important to get back in touch with one of your contacts. You need to set a
________________________ on the contact for Next Week.

Fill in the blank space.

Glossary 
The following table defines the key terms used in the module. 

Categorize A command that you can use to organize your contacts in user-
defined categories. 

Forward Contact A command that you can use to share a contact with a colleague. 

Navigation Bar Icons that you can use to switch between Mail, Calendar, People, 
Tasks, Notes, Folders, and Shortcuts. 

Print Preview A pane that displays your print output without actually printing the 
output. Outlook always creates a preview on the Print page. 

Tag A means to highlight a contact with a Follow Up flag, or with high or 
low importance. 

View Preset or customizable ways to review information in Outlook 
workspaces. 

Table 7: Glossary terms and definitions 
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Detach the module .pst file 
After you complete all try-its, you must detach your .pst file so your teacher can assess 
your work. To do this: 

1. In Outlook, on the Navigation Bar, select the ellipsis (Navigation Menu button), 
and then select Folders. 

2. Locate the folder named M6_module_PST_starter_Firstname_Lastname, and right-
click or access the context menu for the folder. 

3. On the context menu, select Close 
“M6_module_PST_starter_Firstname_Lastname”. 

4. On your computer, open File Explorer, and then browse to where the .pst file 
resides. 

5. Right-click or access the context menu for the file, and then select Rename. 

6. Append your name to the end of the existing file name by using underscores instead 
of spaces. For example, enter _Firstname_Lastname. The filename should now 
resemble M6_module_PST_starter_Firstname_Lastname. 

7. Copy the .pst file to the designated location for assessment. 
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Cornerstone 
Overview 
In this cornerstone, you’ll help the volunteer coordinator at Munson’s Pickles and 
Preserves Farm by managing the farm volunteer contact list. 

Objectives 
The following table outlines the cornerstone objectives and their corresponding 
Microsoft Office Specialist (MOS) exam objectives. 

Cornerstone project objectives Exam objective(s) 

Create and update contacts • 1.1.1: Change the display of 
messages, calendar items, contact 
records, and tasks 

• 4.1.1: Import contacts from external 
sources 

• 4.1.2: Edit contact information 

Use contact groups • 4.2.1: Create and delete contact 
groups 

• 4.2.2: Add contacts to existing contact 
groups 

• 4.2.4: Delete contact group members 

Share and categorize contacts • 4.1.3: Share contacts 

Table 8: Cornerstone objectives 

Duration 
50 minutes 

Attach the Cornerstone .pst file 
To complete this Cornerstone, you must attach this .pst file into Outlook before you can 
perform any tasks. You’ll also store the results of your tasks in this .pst file so that your 
teacher can assess your working by examining that file. 
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To open the .pst file in Outlook: 

1. Open Outlook. 

2. Select the File tab, and then select Open & Export. 

3. In the Open pane, select Open Outlook Data File. 

4. In the Open Outlook Data File dialog box, use the navigation pane to locate the .pst 
files provided by your instructor for your use throughout this module of the course. 

5. Open the file named M6_cornerstone_PST_starter. Note that a folder 
M6_cornerstone_PST_starter is now available in the navigation pane. This folder 
contains any required starter elements for the Cornerstone, such as emails, calendar 
appointments, tasks, and contacts. 

6. Right-click or access the context menu for the M6_cornerstone_PST_starter folder, 
and then select Data File Properties. 

7. In the M6_cornerstone_PST_starter Properties dialog box, select Advanced. 

8. In the Outlook Data File dialog box, in the Name box, append your name to the 
end of the existing name by using underscores instead of spaces. For example, enter 
_Firstname_Lastname. The folder name should now resemble 
M6_cornerstone_PST_starter_Firstname_Lastname. 

9. Select OK twice. 

Copy content into the Cornerstone .pst 
file 
As you proceed through this Cornerstone’s tasks, you should copy the resulting 
elements, such as emails, calendar appointments, tasks, and contacts, to the 
M6_cornerstone_PST_starter_Firstname_Lastname folder by using the following 
instructions: 

1. After you attach the .pst file, you should be able to observe duplicate folders for 
items such as emails, calendar appointments, tasks, and contacts. 

2. After you complete a try-it exercise, select your resulting items in the navigation 
pane. Make sure you select the items that are associated with your email account. 

3. In the details pane, right-click or access the context menu for each item, and then, 
select Copy or select Ctrl+C. 

4. Select the M6_cornerstone_PST_starter_Firstname_Lastname folder. 
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5. Select Ctrl+V to copy the item to the .pst file. 

6. Repeat steps 3 through 5 for any additional items that you want to copy. 

Instructions 
1. Complete the following tasks for each file. 

2. When you’re done with the cornerstone, assess your completion and enter the 
points you think you earned within the following task lists. You can ask for the help 
of your teacher if required. 

Tasks 
The following sections describe the tasks you’ll need to do for this cornerstone. 

File 1: M6_cornerstone_PST_starter.pst 
Task 1: Create contacts (15 points) 
1. In Outlook 2019, switch to People. 

2. Create a new contact with the following properties: 

o Full Name: Danielle Gousse 
o Company: Munson's Pickles and Preserves 
o Job title: Agricultural technologist 
o File as: Gousse, Danielle 
o Email: Danielle@munsonspicklesandpreservesfarm.com 
o Business phone number: 555 0123 
o If available on your computer, add the appropriate image for this contact (3 

points) (Exam objective: 4.1.2) 
3. Create a new contact with the following properties: 

o Full Name: Fen Long 
o Company: Munson's Pickles and Preserves 
o Job title: Irrigation engineer 
o File as: Long, Fen 
o Email: Fen@munsonspicklesandpreservesfarm.com 
o Business phone number: 555 0123 
o If available on your computer, add the appropriate image for this contact (3 

points) (Exam objective: 4.1.2) 
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4. In Mail, locate and open the Staff profiles message. This will reside in the Inbox 
folder of the M6_cornerstone_PST_starter_Firstname_Lastname .pst you attached 
earlier. 

5. Right-click or access the context menu for the message originator, Genevieve 
Rollins, and then select Add to Outlook Contacts. 

6. Save the contact. (4 points) (Exam objective: 4.1.2) 

7. Right-click or access the context menu for one of the recipients, Hilary Brennan, 
and then select Add to Outlook Contacts. 

8. Modify the Company field, changing it to Munson's Pickles and Preserves. 

9. Change File as to Hilary Brennan. 

10. In the Email box, enter Hilary@Munsonspicklesandpreservesfarm.com. 

11. Save the contact. 

12. Switch to People. 

13. Open Genevieve Rollins. 

14. In the Company box, enter Munson's Pickles and Preserves. 

15. Change File as field to Genevieve Rollins. 

16. Modify the Email field to Genevieve@Munsonspicklesandpreservesfarm.com. 

17. Save the contact. (5 points) (Exam objective: 4.1.2) 

Points scored: ________ /15 

Task 2: Export and import contacts (10 points) 
1. In Outlook 2019, in People, select the File tab, and then select Open & Export. 

2. In the Open pane, select Import/Export. 

3. Select Export to a file. 

4. Select Comma Separated Values. 

5. In the Export to a File dialog box, make sure Contacts is selected. 

6. Browse to and select Desktop. 

7. Save the file as Contacts. 

8. Browse to the Desktop on your computer and verify the presence of the file. (5 
points) 

9. In Outlook, select the File tab, and then select Open & Export. 
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10. In the Open pane, select Import/Export. 

11. In the Import and Export Wizard, select Import from another program or file. 

12. Select Command Separated Values. 

13. Browse to and open your Contacts .csv file (on the desktop). 

14. Select Allow duplicates to be created. 

15. In the next window, Import a File, select the destination location. The default, 
Contacts, is appropriate. 

16. After the import, verify that you have duplicates of your original contacts because 
you selected to allow duplicates. 

17. Delete the newly created duplicates. (5 points) (Exam objective: 4.1.1) 

Points scored: ________ /10 

Task 3: Manage contact groups (15 points) 
1. In Outlook 2019, select People, and on the ribbon, select New Contact Group. 

2. Name the group CSA Program Volunteers. 

3. Add all available contacts to the group and save the group. (5 points) (Exam 
objectives: 4.2.1, 4.2.2) 

4. Create a new contact with the following properties: 

o Full Name: Alex Nino 
o Company: Best For You Organics Company 
o Email address: Alex@bestforyouorganics.com 
o Job title: Manager 
o File as: Alex Nino 

5. Add the newly created contact, Alex Nino, to the CSA Program Volunteers group. 

6. Remove Fen Long from the group, and then save the changes. (5 points) (Exam 
objectives: 4.2.1, 4.2.4) 

7. In the contacts list, select the CSA Program Volunteers contact group. 

8. On the ribbon, select Delete. (5 points) (Exam objective: 4.2.1) 

Points scored: ________ /15 
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Task 4: Manage contacts (10 points) 
1. Select Danielle Gousse.

2. On the ribbon, select Share Contacts.

3. In the Sharing invitation - Contacts - Share dialog box, in the To box, enter the
email address of a fellow student or your teacher, and then select Send.

4. When prompted, select Yes to set the contacts list as read-only for your partner. (4
points)

5. In the contacts list, select Fen Long. On the ribbon, select Forward Contact, and
then select As a Business Card.

6. In the Fen Long - Munson's Pickles and Preserves - Message (HTML) dialog box,
in the To box, enter the email address of a student or your teacher, and then select
Send. (4 points) (Exam objectives: 1.1.1, 4.1.3)

7. Switch to Mail and locate the email messages your student partner has sent to you.
These are a Sharing Invitation and a contact business card. Review these messages.

8. In the Sharing Invitation message, select Open this Contacts folder. You should
observe the contact list from your colleague.

9. Switch back to Mail.

10. Open the remaining email, and verify that a business card displays in the details of
the message. (2 points) (Exam objective: 4.1.3)

Points scored: ________ /10 

TOTAL POINTS: ________ /50 

Detach the Cornerstone .pst file 
After you complete all tasks, you must detach your .pst file so that your teacher can 
assess your work. To do this:  

1. In Outlook, on the Navigation Bar, select the ellipsis (Navigation Menu button),
and then select Folders.

2. Locate the folder called M6_cornerstone_PST_starter_Firstname_Lastname, and
right-click or access the context menu for the folder.

3. On the context menu, select Close
“M6_cornerstone_PST_starter_Firstname_Lastname”.

4. On your computer, open File Explorer, and go to the path where the .pst file resides.

5. Right-click or access the context menu for the file, and then select Rename.
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6. Append your name to the end of the existing file name by using underscores instead 
of spaces. For example, enter _Firstname_Lastname. The filename should now 
resemble M6_cornerstone_PST_starter_Firstname_Lastname. 

7. Copy the .pst file to the designated location for assessment. 
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Module overview 
Description 
With our busy lives and all that we must remember, it's not surprising that we 
occasionally forget to do something. You can use the Calendar in Microsoft Outlook 
2019 to manage appointments, such as meetings and calls, but there are some events 
that you cannot easily categorize as either meetings or calls. 

Currently, you might jot down tasks, reminders, and notes in a diary or desk organizer, 
or even on the back of an envelope. While this practice is simple, it also has limits. For 
example, you must remember to observe your paper list, and where necessary, take the 
list (such as a shopping list) with you. 

Often overlooked, the Tasks and Notes views in Outlook provide a convenient means of 
managing simple events and reminders and can help replace paper-based lists and 
notes. This module describes how you can use Outlook to manage your tasks and notes. 

The following table outlines the lessons in this module and their corresponding learning 
objectives. 

Lesson Learning objective Exam 
objective(s) 

Creating and printing 
your tasks 

Create, update, tag, and print tasks. • 4.3.1 

Using task assignments Create and manage task assignments 
and send status reports. 

• 1.1.1 
• 1.4.1 
• 4.3.1 

Creating and sharing 
notes 

Create, customize, print, and forward 
notes. 

None 

Cornerstone: Creating 
tasks and notes to 
organize your workload 

Organize your workload by using tasks 
and notes in Outlook. 

All of the 
above 

Table 1: Objectives by lesson 
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Scenario 
Your work at Munson’s Pickles and Preserves Farm has been very rewarding over the 
past year. Even though winter is a slow season for outside activities, the farm is busy 
planning next year’s events and readying farm equipment for spring planting. 

Paper to-do lists and personal notes clutter your desk. This is the perfect time to 
organize your notes and lists in your Outlook mailbox. 

Cornerstone 
This module concludes with a Cornerstone, in which you’ll work with both tasks and 
notes. In the Cornerstone, you’ll: 

• Create and print tasks. 
• Assign tasks. 
• Create and share notes. 
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Lesson 1: Creating and printing 
your tasks 
Overview 
You can create a task as a reminder to do something. Once the task is complete, you 
can check it off your list. However, you can do much more with Outlook tasks. You can 
flag them, categorize them, add multiple steps to them (like a simple project plan), 
assign them to team members, configure a completion schedule, and more. You can 
also easily take your tasks with you, because Outlook stores them and they are available 
across your Windows (and other) devices. 

Warm-up 
Ask your neighbor if they have any questions about the topics covered in Module 6. 
Help them if you can, then use these questions to find out what you already know about 
this lesson’s topics. 

1. Which of the following is a task tag? 

Select the correct option. 

a. Private 

b. High Importance 

c. Follow Up flag 

d. All of the above 

2. Which of the following is a valid Follow Up flag? 

Select the correct option. 

a. High Importance 

b. Call 

c. Reminder 

d. Private 
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3. If you delete a task, from where can you recover it?

Select the correct option.

a. The Deleted Items folder in Outlook

b. The Recycle Bin in Windows

c. The Garbage folder in Tasks

d. There is no way to recover deleted tasks

4. You can customize your task list view by accessing the ________________________ button
on the ribbon in Tasks.

Fill in the blank space.

5. To print a list of tasks, select the ________________________ in the print window.

Fill in the blank space.

6. Tasks which are due highlight in ________________________ in the task list.

Fill in the blank space.

Attach the module .pst file 
To provide the most effective learning experience, this module includes an external 
Outlook Data File, or .pst file. It resides in a location that your teacher will provide. To 
complete this module, you must attach this .pst file into Outlook before you can 
perform any try-its. You’ll also store the results of your try-its in this .pst file. This allows 
your teacher to assess your work by examining the .pst file’s contents. 

To open the .pst file in Outlook: 

1. Open Outlook.

2. Select the File tab, and then select Open & Export.

3. In the Open pane, select Open Outlook Data File.

4. In the Open Outlook Data File dialog box, use the navigation pane to locate the
.pst files provided by your instructor for your use throughout this module of the
course.

5. Open the file named M7_module_PST_starter. Note that a folder
M7_module_PST_starter is now available in the navigation pane. This folder
contains any required starter elements for the module, such as emails, calendar
appointments, tasks, and contacts.
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6. Right-click or access the context menu for the M7_module_PST_starter folder, and 
then select Properties. 

7. In the M7_module_PST_starter Properties dialog box, select Advanced. 

8. In the Outlook Data File dialog box, in the Name box, append your name to the 
end of the existing name by using underscores instead of spaces. For example, enter 
_Firstname_Lastname. The folder name should now resemble 
M7_module_PST_starter_Firstname_Lastname. 

9. Select OK twice. 

Copy content into the module .pst file 
As you proceed through this module’s try-its, you should copy the resulting elements, 
such as emails, calendar appointments, tasks, and contacts, to the 
M7_module_PST_starter_Firstname_Lastname folder by using the following 
instructions: 

1. After you attach the .pst file, you should be able to observe duplicate folders for 
items such as emails, calendar appointments, tasks, and contacts. 

2. After you complete a try-it exercise, select your resulting items in the navigation 
pane. Make sure you select the items that are associated with your email account. 

3. In the details pane, right-click or access the context menu for each item, and then 
select Copy or select Ctrl+C. 

4. Select the M7_module_PST_starter_Firstname_Lastname folder. 

5. Select Ctrl+V to copy the item to the .pst file. 

6. Repeat steps 3 through 5 for any additional items that you want to copy. 

Topic 1: Create and flag tasks 
 In this topic, you'll create a task, use a Follow Up flag for a task, and add tags to 

tasks. Before learning the details of using and managing tasks, it's important that you 
know how to access tasks. To access tasks, locate the Tasks view from the Navigation 
Bar, which the following screenshot depicts. 
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Figure 1: The Tasks folder in Outlook 2019 

When you select Tasks, there are two default nodes or folders, To-Do List and Tasks, in 
the navigation pane. The following screenshot highlights these folders. 

 
Figure 2: The To-Do List and Tasks folders 
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The To-Do List folder contains a structured list of your tasks and works very much like a 
checklist of tasks that you might typically write in a notepad. You can use the context 
menu to check off tasks easily once they are complete, which the following screenshot 
depicts: 

 
Figure 3: Modifying the properties of a task using the context menu 

The Tasks folder contains a more generic list of your tasks. You can choose between a 
simple list or a detailed view, which the following screenshot depicts: 

 
Figure 4: Selecting a suitable view for your tasks 

You can create additional lists, or folders, under the My Tasks node. 
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Did you know? 

You can also download and install the Microsoft To Do app from the 
Microsoft Store. You can use this app to view and manage your 
tasks outside of Outlook. 

The following screenshot depicts the Tasks pane in the Microsoft To Do app: 

 
Figure 5: Viewing tasks by using the Microsoft To Do app 
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Additional information 

The Outlook app for iOS and Android does not provide access to 
Tasks. However, versions of the Microsoft To Do app are available for 
your iOS or Android phone. 

Create a task 
To create a task, use the following procedure: 

1. In Outlook, select the Tasks view. 

2. In the navigation pane, select the Tasks folder. 

3. On the ribbon, on the Home tab, in the New group, select New Task, which the 
following screenshot depicts: 

 
Figure 6: Creating a new task from the ribbon 

4. In the Untitled - Task window, in the Subject text box, enter Contact preserve jar 
sales team. 

5. Select the text box for the task and enter Telephone the jam jar suppliers and 
order additional units. 

6. On the ribbon, select Save & Close, as the following screenshot depicts. Your task is 
now saved to the Tasks list. 
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Figure 7: Configuring task details and saving a task 

Create a task using a Follow Up flag 
You can use a Follow Up flag to set start and end dates and a reminder on a task. 
Available options are to set a Follow Up flag for Today, Tomorrow, This Week, Next 
Week, or Custom. To create a task with a Follow Up flag set, use the following 
procedure: 

1. In Outlook, select the Tasks view. 

2. In the navigation pane, select the Tasks folder. 

3. On the ribbon, on the Home tab, in the New group, select New Task. 

4. In the Untitled - Task window, in the Subject text box, enter Flagged task. 

5. Select the text box for the task, and enter This task is flagged. 
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6. On the ribbon, select Tags, select Follow Up, and then select Custom, which the 
following screenshot depicts: 

 
Figure 8: Adding a custom Follow Up flag to a task 

7. In the Custom dialog box, in the Flag to list, you can choose between: Call, Do not 
forward, Follow up, For Your Information, Forward, No Response Necessary, 
Read, Reply, Replay to All, and Review. 

8. In this case, select For Your Information and then set the Start date as two days 
from now. 

9. Select the Reminder check box, set the reminder date for tomorrow at 16:00, and 
then select OK, as the following screenshot depicts.  

Note: if your computer is configured to display time in a 12-hour clock format, then 
set the reminder for 4:00 PM. 
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Figure 9: Configuring a custom Follow Up tag 

10. Verify the flag in the Info Bar, which is at the top of the Flagged task - Task 
window, and beneath the ribbon. The following screenshot depicts this flag: 

 
Figure 10: Verifying the Follow Up information with the summary 
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11. Also notice that the task has been updated with details for Start date, Due date, and 
Reminder details, as the following screenshot depicts. These options should reflect 
the information you entered. On the ribbon, select Save & Close. 

 
Figure 11: Viewing the details of the Follow Up tag 

To set a Follow Up on an existing task, use the following procedure: 

1. In the Tasks folder, in the list of tasks, right-click or access the context menu for the 
appropriate task. In this case, right-click or access the context menu for Contact 
preserve jar sales team, select Follow Up, and then select Tomorrow, as the 
following screenshot depicts: 
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Figure 12: Assigning a Follow Up tag for tomorrow 

2. Right-click or access the context menu for Contact preserve jar sales team, select 
Follow Up, and then select Add Reminder. 

3. In the Custom dialog box, in the Flag to list, select Call, and then select OK, as the 
following screenshot depicts: 

 
Figure 13: Configuring a custom Follow Up tag 
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What can you do with a task? 
When you select a task in either the To-Do List or the Tasks list, you can perform 
several actions on the task. The actions are available on the context menu for a task and 
also on the Home tab of the ribbon, above your task list, as the following screenshot 
depicts: 

 
Figure 14: The Home tab in tasks 

The following table describes the available actions. 

Forward / Forward 
as an Attachment  

You can forward a task to another person. This option opens 
a new email dialog box. You must then identify the recipient 
and complete the email text. Note that Outlook 
automatically assigns the label of the task’s name to the 
Subject box. 

Mark Complete If you mark an item as complete, it will no longer display in 
the To-Do List. However, if you mark an item as complete 
when you are viewing tasks from the Tasks list, the text for 
the marked item displays with strikethrough formatting. If 
you mark a task as complete in error, immediately select 
Ctrl+Z to undo the operation. Otherwise, go to the Tasks 
list, select the completed task, and then select Mark 
Complete. This marks the item as not completed. 

Remove from List When you finish a task, you can remove it completely, both 
from the To-Do List and the Tasks list, by using the 
Remove from List option. Effectively, the task is deleted. 

Follow Up You can use this option to configure actions to perform on 
your task, such as assigning a start and end date, together 
with reminders. 

Current View You can use this option to change the current view in the 
selected list. You can also create and manage additional or 
existing views and customize them to your needs. We'll 
discuss views later in this module. 
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Move Use this option to move a task between lists. 

Tags You can use this option to assign a category for the task, 
and to set the status of the task as Private, High 
Importance, or Low Importance. 

Assign a Task If you have a task that you would like someone else to 
perform, you can assign the task to them. This option is only 
available from the context menu. You will learn more details 
later in this module. 

Table 2: Available task actions 

 

Did you know? 

If you want to recover a deleted task item, you must recover it from 
the Deleted Items folder like any other deleted Outlook item. To do 
this, switch to Folder view, select Deleted Items, select the deleted 
task you want to recover, select Move on the ribbon, and then 
select the Tasks folder. 

Create a task in the To-Do Bar 
You can enable the To-Do Bar view from the View tab in Outlook. To enable and use 
the To-Do Bar to create a task, use the following procedure: 

1. In Outlook, on the ribbon, select the View tab. 

2. On the View tab, select To-Do Bar, and then select Tasks, as the following 
screenshot depicts. The To-Do Bar displays on the far right of the Outlook ribbon. 

 
Figure 15: Enabling the To-Do Bar 
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3. Right-click or access the context menu for the To-Do Bar, and then select New Task, 
as the following screenshot depicts: 

 
Figure 16: The To-Do Bar  

4. The Untitled - Task window displays. Complete the dialog box and then select Save 
& Close. 

From within the To-Do Bar, you can reorganize your tasks by category, start date, due 
date, folder, type, and importance. To do this, at the top of the To-Do Bar, select 
Arrange by, and then select the appropriate option. For example, select Due Date, as 
the following screenshot depicts: 
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Figure 17: Rearranging tasks by due date 

Add tags to the tasks 
You can use tags to assign several properties to your tasks to help you filter, identify, or 
prioritize your tasks. 

To assign tags, in the Tasks list, select the appropriate task, and then, on the ribbon, 
from the Tags group, select either Categorize, Private, High Importance, or Low 
Importance. 

The following screenshot depicts how to assign tags: 

 
Figure 18: Tagging tasks 
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The following table describes the available tags. 

Categorize You can use this tag to allocate a category to a particular 
task. The same categories that you use in the Outlook 
Calendar feature are available here. Default categories are 
labeled by color; for example, blue, green, and so on. You 
can rename these defaults, and create additional categories 
as required. When you assign a category, the view for the 
task automatically updates with the color of that category in 
the tasks list. 

Private You can use this tag to prevent others from observing a 
particular task. Only you can observe the task properties. 

High Importance As with emails, you can mark a task as having high 
importance. Tasks marked this way appear with a red 
exclamation point in front of the task subject. 

Low Importance You can also mark tasks with a low importance. Tasks with 
low importance appear with a blue downward arrow before 
the task subject. 

Table 3: Available task tags 

Activity: Each one, teach one 
In this activity, you’ll work with a partner to research how to create tasks, and then teach 
each other what you’ve learned. Your teacher will guide the class through this activity. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Open Outlook. 

2. Reach out to a classmate and form a pair. 

3. Open Help in Outlook and search for topics on creating tasks. 
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4. Select a topic while your partner selects another topic. 

5. Research the topic and teach each other what you’ve learned. 

Try-it: Create and flag tasks 
  In this leveled try-it activity, you'll learn how to create tasks, and how to flag them. 

Try-it 1 
In this try-it, you'll create a task from the ribbon. 

Resources 
You will need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. If necessary, open Outlook 2019. 

2. Switch to the Tasks view. 

3. Create a new task from the ribbon. 

4. In Subject, enter Created from Ribbon and, if desired, enter Start date and Due 
date information. 

5. Assign the task High Importance. 

6. Save the task. 

Try-it 2 
In this try-it, you'll create a task by using a keyboard shortcut. 

Resources 
You will need the following resources for this try-it: 

• None 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In Outlook, in Tasks, select Ctrl+N to create a new task. 

2. In Subject, enter Created from Shortcut and, if desired, enter Start date and Due 
date information. 

3. Assign the task the Blue category. 

4. Save the task. 

 

Additional information 

For more information on creating tasks and to-do items, go to: Create 
tasks and to-do items 

Topic 2: Update a task 
 As your workday evolves, you might need to update your tasks. In this topic, you'll 

learn how to do that quickly and easily. 

Update a task 
You can update a task from the Tasks list. Select your task from the Tasks view, which is 
located beneath the My Tasks node. Once you have selected your task, you can use the 
available options on the ribbon, or from the context menu for the task, to update it. 
Typical actions might include marking a task as complete, removing a task from a list, or 
assigning Follow Up or tags. 

To perform more detailed changes, in your selected list view, use the following 
procedure: 

1. Open the appropriate task. 

2. In the Task name - Task window, on the Task tab, in the Show group, select Task, 
as the following screenshot depicts: 

https://aka.ms/create-tasks-and-to-do-items
https://aka.ms/create-tasks-and-to-do-items
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Figure 19: Viewing task information 

3. You can change the following options: 

o Subject 
o Start date 
o End date 
o Reminder details 
o Status (choose from Not Started, In Progress, Completed, Waiting on 

someone else, and Deferred) 
o Priority 
o % Complete 

4. On the ribbon, in the Show group, select Details, as the following screenshot 
depicts: 
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Figure 20: Viewing task details 

5. You can change the following options: 

o Date completed 
o Total work 
o Actual work 
o Company 
o Mileage 
o Billing information 

6. From the ribbon, you can also configure the following additional settings: 

o Mark Complete 
o Assign Task 
o Send Status Report 
o Recurrence 
o Tags 

Activity: Think-pair-share 
In this activity, your teacher will pose questions about updating tasks. Your teacher will 
guide the class through this activity, as you share your answers with classmates. 
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Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Think about the answers to the questions your teacher asked. 

2. Share your answers with a neighboring classmate and discuss answers with them. 

Try-it: Update a task 
 In this standalone try-it activity, you'll update a task. 

Resources 
You will need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In Outlook, in Tasks, open the Created from ribbon task you created earlier. 

2. Modify the Status and %Complete values to indicate progress on the task, but do 
not mark it complete. 

3. Save the task. 

4. From the ribbon, mark the task as complete. 

Topic 3: Observe and print tasks 
Often, if you have many tasks, changing the current list's view can help you easily 

know what's urgent, and what can wait. It can also be very handy to have a printed copy 
of all your current tasks, or the details for a specific task. In this topic, you'll learn how to 
create and change task views, and how to print tasks. 
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Change views by using the Current View options 
on the Home tab 
Once you start using tasks in your workplace, you might find you have an increasing 
number to manage. Using the appropriate view can help you more effectively manage 
your tasks. To change your current task view, from the Home tab on the ribbon, in the 
Current View group, select Change View. You can choose between Detailed, Simple 
List, To-Do List, Prioritized, Active, Completed, Today, Next 7 Days, Overdue, 
Assigned, and Server Tasks, as the following screenshot depicts: 

 
Figure 21: Changing the task view 

In addition to the list of available views, you can also select Manage Views, Save 
Current View As a New View, and Apply Current View to Other Task Folders. 

To create a new view, use the following procedure: 

1. Select Manage Views. 

2. Review the existing views in the Manage All Views dialog box, as the following 
screenshot depicts: 
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Figure 22: Modifying default views 

3. To create a new view, select New. 

4. In the Create a New View dialog box, depicted in the following screenshot, in the 
Name of new view box, enter a name, and then select the type of view. You can 
choose Table, Timeline, Card, Business Card, People, Day/Week/Month, and Icon. 
You can also select whether the view is available on this folder only or on all folders, 
and whether the view displays only to you, or to everyone. When you have selected 
the appropriate settings, select OK. 
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Figure 23: Creating a new custom view 

5. In the Advanced View Settings: view name dialog box, you can define several 
formatting options, including Columns, Group By, Sort, and Filter, which the 
following screenshot depicts: 

 
Figure 24: Configuring advanced view settings 
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6. When you finish updating your view settings, select OK twice. 

7. To assign the view, from the ribbon, select Change View, and then select the new 
view. 

Print a task 
To print all your current tasks as a list, select the appropriate view, and then use the 
following procedure: 

1. On the ribbon, select the File tab. 

2. Select Print. 

3. On the Print page, select Table Style, as the following screenshot depicts: 

 
Figure 25: Printing a list of tasks using Table Style 

4. If necessary, select the appropriate printer from the Printer list. 

5. Select Print. 

If you want to print the detail for a specific task, or tasks, use the following procedure: 

1. In the appropriate tasks list, select the item(s) you want to print. 

2. On the ribbon, select the File tab. 

3. Select Print. 

4. On the Print page, select Memo Style, as the following screenshot depicts: 
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Figure 26: Printing a specific task in Memo Style 

5. If necessary, select the appropriate printer from the Printer list. 

6. Select Print. 

Activity: Show and tell 
In this activity, your teacher will demonstrate how to create, observe, and print tasks. 
Follow along and ask your teacher if you have any questions. 

Resources required 
You will need the following resources for this activity: 

• Ideally, your computer is configured with a Microsoft Print to PDF printer. If not, 
you can use any local printer to preview the settings. 

Activity instructions 
Follow along with your classmates as your teacher helps you to: 

1. If necessary, open Outlook. 

2. Select Tasks. 

3. In Tasks, select the Tasks folder. 

4. On the ribbon, on the Home tab, in the New group, select New Task. 

5. In the Untitled - Task window, in the Subject text box, enter Demonstration task. 
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6. In the body text, enter This is a demonstration task. 

7. On the ribbon, select High Importance, and then select Save & Close. 

8. Create two additional tasks named Second Demonstration task and Third 
demonstration task. 

9. Assign Low Importance to the second task and save and close both. 

10. On the ribbon, select Change View and then select Prioritized. Notice that tasks are 
grouped by importance. 

11. Select Change View and then select Simple List. 

12. Highlight all three tasks, and then select the File tab on the ribbon. 

13. Select Print. 

14. Ensure that the Printer is set to Microsoft Print to PDF. If that's not available, 
choose any other available printer for this demonstration. 

15. In the Settings area, select Table Style. 

16. Zoom in to the preview area. 

17. In the Settings area, select Memo Style. 

18. In the Preview area, select Preview and then go through each page. 

19. You do not need to print anything. Select Back to return to Tasks. 

Try-it: Observe and print tasks 
  In this standalone try-it activity, you'll change task views and use print preview. 

Resources 
You will need the following resources for this try-it: 

• Your computer should have Microsoft Print to PDF as a printer option. If not, 
choose another local printer, or else just skip the printing step. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In Outlook, create a new task. 

2. In the Subject box, enter Test Print. 

3. Enter Start date and Due date information. 

4. Save the task and close it. 
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5. From the Tasks list, open your newly created task. 

6. On the ribbon, go to File, and then select Print. You can observe a preview on the 
right side of the display. 

7. If, under Printer, Microsoft Print to PDF is available, print the task and save the PDF 
file to your desktop with the same name as your task. 

8. Close the task. 

9. On the ribbon, go to Tasks, and select Change View to explore the available 
options. Try a few different views, and then return to the default view. 

 

Additional information 

For more information on creating and printing Outlook items, visit: 
Print contacts, messages, or other Outlook items 

Wrap-up 
Use these questions to check what you learned in this lesson: 

1. In which view do completed tasks not display by default? 

Select the correct option. 

a. To-Do List 

b. Tasks 

2. If you want to set a Follow Up flag, which button must you select in an open task? 

Select the correct option. 

a. Follow Up 

b. Tags 

c. Reminder 

d. Flag 

3. If you set a Follow Up for tomorrow, then Tasks  ________________________ 
automatically create a reminder. 

Fill in the blank space. 

  

https://aka.ms/print-contacts-messages-or-other-outlook-items
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4. If you want to indicate that a task is underway, you must set the 
________________________ property for the task. 

Fill in the blank space. 
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Lesson 2: Using task 
assignments 
Overview 
You've now learned how to create and manage tasks. One of the more useful features of 
tasks in Outlook is the ability to assign tasks to other individuals. In this lesson, you'll 
learn how to assign a task, and accept and update a task that's been assigned to you. 

Warm-up 
In the previous lesson you learned how to create and edit tasks. In this lesson you will 
learn how to use task assignments. Use these questions to find out what you already 
know about this lesson’s topics: 

1. When you assign a task, at what stage can you request a status report? 

Select the correct option. 

a. The task is edited 

b. The task is completed 

c. The task is deleted 

d. All of the above 

2. When you accept a task, you can choose between which two options? 

Select the correct two options. 

a. Send the response now 

b. Delete owner's copy of task 

c. Edit the response before sending 

d. Send status report 

3. You can assign a task to anyone for whom you have ________________________. 

Fill in the blank space. 

4. Assigned tasks arrive as ________________________ 

Fill in the blank space. 
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Topic 1: Assign a task 
It's quite likely that you’ll want to assign a task to someone else within your 

organization. Fortunately, with Tasks in Outlook, this process is straightforward, and it 
uses the email and contacts capabilities of Outlook. 

Assign a task 
To assign a task, use the following procedure: 

1. Select the appropriate task view and then locate the task you want to assign. 

2. Right-click or access the context menu for the task, and then select Assign Task. 

3. Go to the Task name - Task window, select the To text box, and enter the email 
address of the recipient of your task, as the following screenshot depicts. 
Alternatively, select To and browse and locate the recipient's name from an address 
list, if available. 

 
Figure 27: Assigning a task 
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4. Configure any additional properties, such as categories and tags. 

5. Select Send. 

The person to whom you have assigned a task must now respond to the assignment. 
The next topic examines that process in more detail. 

 

Did you know? 

You can choose to keep an updated copy of the assigned task in 
your own tasks list. This option is enabled by default. Additionally, 
you can request a status report when the task has been completed; 
this option is also enabled by default. 

Review assignment options and use tags on 
assignments 
You can review task properties after you assign and accept a task. To view assignment 
options, locate the task that you assigned in your list of tasks and open it. The following 
screenshot depicts a task window. 
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Figure 28: Viewing an assigned task 

From the Task Name - Task window, you can observe and update the following 
properties. 

Show Select the Task button to observe a summary of the status 
of the task. Select the Details button to view more detailed 
status, including hours spent, company, mileage, and billing 
information. 

Manage Task Select Send Status Report to generate an email message 
that sends the current details of the task to a designated 
recipient. 
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Tags You can use Tags on assignments in the same way that you 
can on any other task. Select the task you want to modify, 
and then, using the ribbon or context menu, configure tags 
such as categories, privacy, and importance. You can assign 
these values when you create a task. Alternatively, you or the 
person to whom you assigned the task, can assign these 
values later. 

Table 4: Configurable task properties 

Activity: Pose a challenge 
In this activity, your teacher will present a scenario and ask for your help in assigning 
some tasks. Think of different ways in which you can assign and manage tasks and help 
your teacher. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

• Engage in the discussion and activity with the teacher. 

• Ask and answer any questions. 

Try-it: Assign a task 
 In this leveled try-it activity, you'll learn how to assign tasks. 

Try-it 1 
In this try-it, you'll assign a task using the Task card. 

Resources 
You will need the following resources for this try-it: 

• An email address. You will only be able to assign a task properly if you have email 
accounts for other students or your teacher. 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In Outlook, go to Tasks, and create a new task called Assigned Task. 

2. Right-click or access the context menu for Assigned Task, and then select Assign 
Task. 

3. Enter your partner or teacher’s email address, as instructed. 

4. Keep an updated copy of the task on your task list, so that you receive a status 
report upon completion. 

5. Send the email task assignment. 

Try-it 2 
In this try-it, you'll assign a task using the Task card and flag it for Follow Up. 

Resources 
You will need the following resources for this try-it: 

• An email address. You will only be able to assign a task properly if you have email 
accounts for other students or your teacher. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Create a new task called Second Assigned Task. Save the task and then select it. 

2. On the ribbon, select Assign Task. 

3. Enter your partner or teacher’s email address, as instructed. 

4. Keep an updated copy of the task on your task list, so that you receive a status 
report upon completion. 

5. On the ribbon, select Follow Up, and then configure a Follow Up for this time next 
week. 

6. Send the email task assignment. 

Try-it 3 
In this try-it, you'll assign a task using the Task card and mark it with importance. 
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Resources 
You will need the following resources for this try-it: 

• An email address. You will only be able to assign a task properly if you have email 
accounts for other students or your teacher. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Create a third task called Third Assigned Task. 

2. On the ribbon, select Assign Task. 

3. Enter your partner or teacher’s email address, as instructed.  

4. Keep an updated copy of the task on your task list, so that you receive a status 
report upon completion. 

5. On the ribbon, set the High Importance tag. 

6. Send the email task assignment. 

 

Additional information 

For more information on assigning and tracking tasks, visit: Assign and 
track tasks 

Topic 2: Accept and update a task 
 If somebody assigns you a task, you must know how to accept the task, and then, as 

you proceed through the assignment, how to update the task. It's also important that 
you understand how to notify the task owner of any change in the task's status. 

Accept a task 
When someone assigns you a task, you will receive an email notification. To observe this 
notification, switch to Mail view and then locate the message with the subject that 
begins with Task Request, as the following screenshot depicts: 

https://aka.ms/assign-and-track-tasks
https://aka.ms/assign-and-track-tasks
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Figure 29: Accepting a task and viewing the email assignment 

If you don't wish to accept the task, select Decline in the message body. If you wish to 
accept the task, select Accept. In both cases, you are prompted to edit a response 
before sending it, as the following screenshot depicts: 

 
Figure 30: Accepting a task assignment 

If you choose to edit the response, an email window will open, as the following 
screenshot depicts. Add any text to the response, configure any options, such as start 
and due dates, and then select Send. 
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Figure 31: Editing the task assignment response email 

If you switch to your Tasks view, the task is listed. 

Update task progress 
Whenever you update a task that someone has assigned to you, the status automatically 
updates in all copies of the task, including the copy of the person who assigned it. To 
update any assigned task, simply open the task and make the necessary changes, as 
with your own tasks. When you complete a task, the task owner receives an email 
message confirming this, as the following screenshot depicts: 
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Figure 32: Viewing the Task Completed email for an assigned task 

In addition, the task is marked as complete in the task owner's Tasks list, as depicted in 
the following screenshot. 

 
Figure 33: Viewing completed tasks 

  



Managing tasks and notes 
 

 
46 

Send a status report 
You can send a status report for any assigned task (or unassigned task). To do this, open 
the task properties, and select Send Status Report, as the following screenshot depicts: 

 
Figure 34: Preparing to send a status report 

If the task is assigned, the default recipient of the report is the task owner. However, you 
can add additional recipients. When you complete the recipients list, update the text 
with any details about the task, and then select Send, as the following screenshot 
depicts: 



Managing tasks and notes 
 

 
47 

 
Figure 35: Sending a status report for a task 

 

Additional information 

For more information on sending status reports, visit: Send a task 
status report 

Activity: Think-pair-share 
In this activity, you will work with a partner to learn about viewing, accepting, and 
updating tasks. Your teacher will guide the class through this activity. 

Resources required 
You will need the following resources for this activity: 

• None 
  

https://aka.ms/send-a-task-status-report
https://aka.ms/send-a-task-status-report


Managing tasks and notes 
 

 
48 

Activity instructions 
Participate in the activity by following these instructions: 

1. Open Outlook. 

2. Reach out to a classmate and form a pair. 

3. Follow your teacher’s guidance and work with your partner to learn about viewing, 
accepting, and updating tasks. 

Try-it: Accept and update a task 
 In this leveled try-it activity, you'll accept assigned tasks and manage the task 

status. 

Try-it 1 
In this try-it, you'll accept a task request from a classmate. 

Resources 
You will need the following resources for this try-it: 

• You must work with a partner. The partner must already have assigned you a task. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In Outlook, switch to Mail. 

2. You should have at least one email from a partner or your instructor with the prefix 
Task Request. (It is likely that you have three invites). 

3. Select the first of these emails, and then accept the assignment request. 

Try-it 2 
In this try-it, you'll accept a task from a classmate and update the status. 

Resources 
You will need the following resources for this try-it: 

• You must work with a partner. The partner must assign you a task before the try-it. 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In Outlook, switch to Mail. 

2. You should have at least one email from a partner or your instructor with the prefix 
Task Request. (It is likely that you have three invites). 

3. Select the second email, and then accept the assignment request. 

4. Switch to Tasks. 

5. Open the newly accepted task. 

6. Update the Status to In Progress and save and close the task. 

Try-it 3 
In this try-it, you'll accept a task from a classmate, update it as complete and send a 
status report. 

Resources 
You will need the following resources for this try-it: 

• You must work with a partner. The partner must already have assigned you a task. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In Outlook, switch to Mail. 

2. You should have at least one email from a partner or your instructor with the prefix 
Task Request. (It is likely that you have three invites). 

3. Select the third email, and then accept the assignment request. 

4. In Outlook, in Tasks, open the newly accepted task. 

5. Mark the task as complete. 
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Wrap-up 
Use these questions to check what you learned in this lesson: 

1. When you complete an assigned task, which of the following happens? 

Select the correct option. 

a. Outlook automatically marks the task as complete in your tasks list. 

b. Outlook automatically marks the task as complete in the original task owner's list. 

c. The original task owner receives a status report. 

d. All of the above. 

2. When someone assigns you a task, and before you accept it, where can you observe 
the task? 

Select the correct option. 

a. In your task list 

b. In the owner's task list 

c. In the email message the owner sent you 

3. Outlook automatically sends a status report to the assigned task's owner every time 
you make a change to the task. 

Select the correct option. 

a. True 

b. False 

4. All email messages that contain a task assignment begin with the following words: 
________________________ 

Fill in the blank space. 

5. When you have ________________________ an assigned task, the owner receives a status 
report. 

Fill in the blank space. 

6. The default recipient for status reports for assigned tasks is the original 
________________________  

Fill in the blank space. 
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Lesson 3: Creating and sharing 
notes 
Overview 
Think of Outlook Notes as sticky notes that you can use to jot down quick notes and 
stick them on your desktop or on your Notes window. You can also use the Notes 
feature to record detailed notes on a specific meeting or event. 

Before you begin working with Outlook Notes, you must be familiar with the primary 
user interface. The Notes feature, displayed in the following screenshot, enables you to 
create, modify, and delete notes. 

 
Figure 36: The Notes module in Outlook 2019 
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Warm-up 
In the previous lesson, you learned how to assign tasks. In this lesson, you will learn how 
to create and share notes. Use these questions to find out what you already know about 
this lesson’s topics: 

1. Which of the following is the default view for notes? 

Select the correct option. 

a. Last 7 Days 

b. Icon 

c. Notes List 

2. You can assign notes to someone just as you can assign tasks. 

Select the correct option. 

a. True 

b. False 

3. You share notes by ________________________ them. 

Fill in the blank space. 

4. If you want to print the details of a note, choose the ________________________ style 
when printing. 

Fill in the blank space. 

Topic 1: Create and categorize notes 
Just like the repositionable sticky notes you might have on your desk, you can use 
Outlook Notes to keep important information that might not relate to any contact or 
project. 

Create and customize notes 
To create a note, go to the Notes view. On the ribbon, select the Home tab, and in the 
New group, select New Note. The following screenshot depicts the Home tab on the 
ribbon in Notes view. 

 
Figure 37: The Outlook 2019 Home tab on the ribbon in Notes view 
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A new note appears. You can enter any text here.  

 

Did you know? 

Outlook automatically derives the note title from the text you enter 
on the first line of the note. 

You can add categories to your notes, just as you can with tasks. To do this, select a 
note from the Notes list, and then, on the ribbon, select Categorize. Then, select the 
appropriate category. You will notice that the note icon changes color to match that of 
the assigned category, as the following screenshot depicts: 

 
Figure 38: Assigning categories to notes 

 

Additional information 

For more information on creating notes, visit: Create a note 

https://aka.ms/create-a-note
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You can also change the Notes view from Icon, which is the default, to Notes List, 
which is depicted in the following screenshot. You can also change it to Last 7 Days to 
view more recent notes. 

 
Figure 39: Changing the notes default view 

 

Additional information 

For more information on customizing notes, visit: Customize notes 

Activity: Each one, teach one 
In this activity, you’ll work with a partner to research how to create and categorize notes, 
and then teach each other what you learned. Your teacher will guide the class through 
this activity. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Open Outlook. 

2. Reach out to a classmate and form a pair. 

3. Search Outlook Help or open a support article about how to create and modify 
notes. 

4. Teach your partner what you learned, and then discuss with them what they learned. 

  

https://aka.ms/customize-notes
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Try-it: Create and categorize notes 
  In this leveled try-it activity, you'll learn how to work with notes. 

Try-it 1 
In this try-it, you'll create a note from the ribbon. 

Resources 
You will need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In Outlook, select the Notes view. 

2. Create a new note from the ribbon entitled My First Note. 

Try-it 2 
In this try-it, you'll create a note using the keyboard. 

Resources 
You will need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In Outlook, select the Notes view. 

2. Select Ctrl+N to create a note entitled My Second Note. 

Try-it 3 
In this try-it, you'll create and categorize a note. 

Resources 
You will need the following resources for this try-it: 

• None 
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Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In Outlook, select the Notes view. 

2. Create two new notes entitled My Third Note and My Fourth Note. 

3. Assign a new category to each note (which will change the note's color). 

4. Resize the notes. 

Topic 2: Observe and print notes 
As with tasks, it can be useful to print a list of your notes and specific note contents. 

To observe your notes, double-click the appropriate note, or select it and then select 
Enter. You can edit text and then save the note by closing it. The following screenshot 
depicts a note: 

 
Figure 40: Adding text to a note 

To print a note, open it, select File on the ribbon, and then select Print. On the Print 
page, select Memo Style, and then select Print, as the following screenshot depicts: 
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Figure 41: Print notes in Memo Style 

To print a list of notes, select multiple notes in the notes list, select File, and then select 
Print. On the Print page, select Table Style and then select Print, , as the following 
screenshot depicts: 
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Figure 42: Printing a list of notes 

Use Print preview 
If you want to observe the note, you can use the print preview option. Note that a 
preview will automatically display on the Print page, to the right of the Print button. On 
the Print page, select Print Options, and then, in the Print dialog box, select Preview, 
as the following screenshot depicts: 
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Figure 43: Configuring print options and selecting a preview 

From the Print dialog box, you can print selected pages, configure page setup options, 
and define print styles. 

Activity: Tell a story 
In this activity, you'll review scenarios with your teacher and classmates and discuss 
reasons why people might choose different views for notes and why they would print 
them. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Consider scenarios in which you would change the Notes view and print a note. 

2. Participate in the discussion. 

3. Ask your teacher clarifying questions. 
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Try-it: Observe and print notes 
 In this leveled try-it activity, you'll learn how to change notes views and print 

preview notes. 

Try-it 1 
In this try-it, you'll observe the notes as large icons. 

Resources 
You will need the following resources for this try-it: 

• Your computer should have Microsoft Print to PDF as a printer option. If not, 
choose another local printer, or else just skip the printing step. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In Notes, change the view to use Notes List. 

2. Change the view to Icon. 

Try-it 2 
In this try-it, you'll observe notes grouped by category. 

Resources 
You will need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Change the view to Notes List. 

2. In the columns, select the Categories column to sort the view by category. 

Try-it 3 
In this try-it, you'll preview your notes. 
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Resources 
You will need the following resources for this try-it: 

• None 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. Go to the Notes view. On the ribbon, select File, and then select Print. 

2. Choose Table Style and then print your list of notes to Microsoft Print to PDF, if 
available. If not, simply examine the preview on the right side of the screen.  

Topic 3: Forward a note by using email 
Unlike paper notes, with Outlook Notes, you can make use of Outlook's email 
capabilities and send your notes via an email to colleagues. 

Forward a note by email 
To forward a note by email, locate the note, or notes, right-click or access the context 
menu, and then select Forward, as the following screenshot depicts: 

 
Figure 44: Forwarding a note 
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A standard email template loads, with your note attached. Enter the desired recipients, 
and then select Send. The following screenshot depicts an email with a note: 

 
Figure 45: Viewing the email for a forwarded note 

When the recipient of your note receives your email, they can select the attachment and 
observe the note directly, as the following screenshot depicts: 

 
Figure 46: Viewing a forwarded note with email 
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Activity: Think-pair-share 
In this activity, you’ll pair up with a classmate and research how to send each other 
notes. Your teacher will guide the class through this activity. 

Resources required 
You will need the following resources for this activity: 

• None 

Activity instructions 
Participate in the activity by following these instructions: 

1. Connect to the Internet and search for documents relating to Outlook Notes and 
how to forward them. 

2. Share your research with your partner. 

Try-it: Forward a note by using email 
  In this standalone try-activity, you'll forward a note to a classmate. 

Resources 
You will need the following resources for this try-it: 

• You must work with a partner. You must have that partner's email address. 

Instructions 
The following are the general tasks that you need to perform during this try-it: 

1. In Notes, select your first note. 

2. On the ribbon, select Forward. 

3. Enter a partner's email address and send the note. 

4. If your partner has sent you a note, switch to Mail. 

5. Open the email item, and then select the attachment. It should open in preview. If 
not, double-click the attachment, or select it and then select Enter. 
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Wrap-up 
Use these questions to check what you learned in this lesson: 

1. You can assign Follow Up tags to notes.

Select the correct option.

a. True

b. False

2. To save a note, what do you need to do?

Select the correct option.

a. Select Save & Close on the ribbon.

b. Select Save on the context menu.

c. Close the note.

3. You cannot assign notes, but you can ________________________ them.

Fill in the blank space.

4. Outlook automatically derives the name of a note from the ________________________
line of text in the note.

Fill in the blank space.

Detach the module .pst file 
After you complete all try-its, you must detach your .pst file so your teacher can assess 
your work. To do this: 

1. In Outlook, on the Navigation Bar, select the ellipsis (Navigation Menu button),
and then select Folders.

2. Locate the folder called M7_module_PST_starter_Firstname_Lastname, and right-
click or access the context menu for the folder.

3. On the context menu, select Close
“M7_module_PST_starter_Firstname_Lastname”.

4. On your computer, open File Explorer, and then go to the path where the .pst file
resides.

5. Right-click or access the context menu for the file, and then select Rename.
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6. Append your name to the end of the existing file name by using underscores instead 
of spaces. For example, enter _Firstname_Lastname. The filename should now 
resemble M7_module_PST_starter_Firstname_Lastname. 

7. Copy the .pst file to the designated location for assessment. 
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Cornerstone 
Overview 
In this Cornerstone, you will use tasks and notes in Outlook to manage your workload at 
Munson's Pickles and Preserves Farm. You'll create, print, and assign tasks. You'll also 
create and share notes with your coworkers. 

Objectives 
The following table outlines the Cornerstone objectives and their corresponding 
Microsoft Office Specialist (MOS) exam objectives. 

Cornerstone project objectives MOS exam objectives 

Create and print tasks. • 4.3.1: Create and manage tasks 
Assign tasks. • 1.1.1: Change the display of 

messages, calendar items, contact 
records, and tasks 

• 1.4.1: Print message, calendar, 
contact, and task information 

• 4.3.1: Create and manage tasks 
Create and share notes. None 

Table 5: Cornerstone objectives 

Duration 
50 minutes 

Attach the Cornerstone .pst file 
To complete this Cornerstone, you must attach this .pst file into Outlook before you can 
perform any tasks. You’ll also store the results of your tasks in this .pst file so that your 
teacher can assess your working by examining that file. 

To open the .pst file in Outlook: 

1. Open Outlook. 

2. Select the File tab, and then select Open & Export. 
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3. In the Open pane, select Open Outlook Data File. 

4. In the Open Outlook Data File dialog box, use the navigation pane to locate the 
.pst files provided by your instructor for your use throughout this module of the 
course. 

5. Open the file named M7_cornerstone_PST_starter. Note that a folder 
M7_cornerstone_PST_starter is now available in the navigation pane. This folder 
contains any required starter elements for the Cornerstone, such as emails, calendar 
appointments, tasks, and contacts. 

6. Right-click or access the context menu for the M7_cornerstone_PST_starter folder, 
and then select Data File Properties. 

7. In the M7_cornerstone_PST_starter Properties dialog box, select Advanced. 

8. In the Outlook Data File dialog box, in the Name box, append your name to the 
end of the existing name by using underscores instead of spaces. For example, enter 
_Firstname_Lastname. The folder name should now resemble 
M7_cornerstone_PST_starter_Firstname_Lastname. 

9. Select OK twice. 

Copy content into the Cornerstone .pst 
file 
As you proceed through this Cornerstone’s tasks, you should copy the resulting 
elements, such as emails, calendar appointments, tasks, and contacts, to the 
M7_cornerstone_PST_starter_Firstname_Lastname folder by using the following 
instructions: 

1. After you attach the .pst file, you should be able to observe duplicate folders for 
items such as emails, calendar appointments, tasks, and contacts. 

2. After you complete a try-it exercise, select your resulting items in the navigation 
pane. Make sure you select the items that are associated with your email account. 

3. In the details pane, right-click or access the context menu for each item, and then, 
select Copy or select Ctrl+C. 

4. Select the M7_cornerstone_PST_starter_Firstname_Lastname folder. 

5. Select Ctrl+V to copy the item to the .pst file. 

6. Repeat steps 3 through 5 for any additional items that you want to copy. 
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Instructions 
1. Complete the following tasks.

2. When you finish the Cornerstone, assess your completion and enter the points you
think you earned within the following task lists. Ask your teacher for help if needed.

Tasks 
The following are the tasks you need to do in this Cornerstone. 

Task 1: Create and manage tasks (10 points) 
1. Create a new task called Cornerstone Task. (2 points)

2. Assign the task High Importance. (2 points)

3. Modify the task to include a Follow Up flag for next week. (2 points)

4. Set a reminder for your new task. (2 points)

5. Create two additional tasks (entitled Cornerstone Task 2 and Cornerstone Task 3)
and assign each a Follow Up flag. Assign one Low Importance. (2 points)

Points scored: ________ / 10 

Task 2: Manage task views (10 points) 
1. Change the current view to sort your tasks by priority. (2 points)

2. Modify the % Complete status of each of your tasks. Choose a different value for
each task. (2 points)

3. Create a new view called Munson’s Cornerstone View that sorts by % Complete. (4
points)

4. Change back to the default view. (2 points)

Points scored: ________ / 10
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Task 3: Assign tasks (10 points) 
1. Create a new task called Cornerstone Task 5 that requires a Follow Up tomorrow. 

(2 points) 

2. Assign the task to either a classmate or your teacher, as instructed. (2 points) 

3. Accept your classmate's task assignment. (2 points) 

4. Complete your assigned task, and then review the status report you receive for the 
task your partner has completed. (4 points) 

Points scored: ________ / 10 

Task 4: Print tasks (4 points) 
1. Print all tasks as a list to a PDF file, if available. If not, simply preview the list of tasks. 

(2 points) 

2. Print a specific task's details to a PDF file, if available. If not, preview the output. (2 
points) 

Points scored: ________ / 4 

Task 5: Create and share notes (6 points) 
1. Switch to Notes and create two demonstration notes called Note One and Note 

Two. (2 points) 

2. Assign each note a different category. (2 points) 

3. Forward one of your notes to a partner. (2 points) 

Points scored: ________ / 6 

TOTAL POINTS: ________ / 40 

Detach the Cornerstone .pst file 
After you complete all tasks, you must detach your .pst file so that your teacher can 
assess your work. To do this: 

1. In Outlook, on the Navigation Bar, select the ellipsis (Navigation Menu button), 
and then select Folders. 

2. Locate the folder called M7_cornerstone_PST_starter_Firstname_Lastname, and 
right-click or access the context menu for the folder. 

3. On the context menu, select Close 
“M7_cornerstone_PST_starter_Firstname_Lastname”. 
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4. On your computer, open File Explorer, and go to the path where the .pst file resides. 

5. Right-click or access the context menu for the file, and then select Rename. 

6. Append your name to the end of the existing file name by using underscores instead 
of spaces. For example, enter _Firstname_Lastname. The filename should now 
resemble M7_cornerstone_PST_starter_Firstname_Lastname. 

7. Copy the .pst file to the designated location for assessment. 
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